
ibm.com/redbooks

A Sample Solution for
Records Management withh
Process Choreography

Jan Antos
Mike Kerzee

Therese Sroujian
Budi Darmawan

Bart Jacob

Explore records management concepts

Design and develop a records 
management application

Use process 
choreography to control 
document life cycles

Front cover
 

 

 

 

http://www.redbooks.ibm.com/
http://www.redbooks.ibm.com/


 

 

 

 



A Sample Solution for Records Management with 
Process Choreography

March 2005

International Technical Support Organization

SG24-6481-00

 

 

 

 



© Copyright International Business Machines Corporation 2005. All rights reserved.
Note to U.S. Government Users Restricted Rights -- Use, duplication or disclosure restricted by GSA ADP
Schedule Contract with IBM Corp.

First Edition (March 2005)

Note: Before using this information and the product it supports, read the information in 
“Notices” on page xi.

 

 

 

 



Contents

Notices  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xi
Trademarks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xii

Preface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xiii
The team that wrote this redbook. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xiii
Become a published author . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xiv
Comments welcome. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xv

Part 1.  Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Chapter 1.  Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
1.1  Problem statement and solution overview. . . . . . . . . . . . . . . . . . . . . . . . . . 5

1.1.1  Employee productivity inhibitors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
1.1.2  Information management  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
1.1.3  Locating information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
1.1.4  Business risks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

1.2  Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Chapter 2.  Solution context and overview  . . . . . . . . . . . . . . . . . . . . . . . . . 13
2.1  Solution perspective  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
2.2  Solution scenarios . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

2.2.1  Use case: Analyst research reporting . . . . . . . . . . . . . . . . . . . . . . . . 15
2.2.2  Use case: Collaborating on work products . . . . . . . . . . . . . . . . . . . . 16
2.2.3  Use case: Meetings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
2.2.4  Use case: Managing product information . . . . . . . . . . . . . . . . . . . . . 18
2.2.5  Use case: Managing information presented in the workplace. . . . . . 19
2.2.6  Use case: Monthly fund performance report . . . . . . . . . . . . . . . . . . . 21
2.2.7  Use case: Application integration . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

2.3  Business processes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
2.4  Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Part 2.  Design and development . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Chapter 3.  Architectural decisions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
3.1  Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
3.2  Solution component architectural concepts. . . . . . . . . . . . . . . . . . . . . . . . 33

3.2.1  High-level solution overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
3.2.2  User roles and work flow. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
3.2.3  Security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

 

 

 

 

© Copyright IBM Corp. 2005. All rights reserved. iii



3.2.4  Portal. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
3.2.5  Business integration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
3.2.6  Content and records management . . . . . . . . . . . . . . . . . . . . . . . . . . 40

3.3  Information life-cycle management solution  . . . . . . . . . . . . . . . . . . . . . . . 41
3.3.1  Solution description. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
3.3.2  Solution components. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
3.3.3  Process choreography components . . . . . . . . . . . . . . . . . . . . . . . . . 45

3.4  Planning and solution deployment topology . . . . . . . . . . . . . . . . . . . . . . . 45
3.4.1  Solution topology. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
3.4.2  Node prerequisites  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

3.5  Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

Chapter 4.  Component design and development. . . . . . . . . . . . . . . . . . . . 51
4.1  Solution technology . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

4.1.1  Portlet application concepts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
4.1.2  Enterprise JavaBeans (EJB) concepts . . . . . . . . . . . . . . . . . . . . . . . 58

4.2  Solution details  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
4.2.1  AuditAdmin portlet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
4.2.2  New ReportCU project  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
4.2.3  RecordsAdmin project. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
4.2.4  ReportTasks portlet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
4.2.5  PortalToCM project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
4.2.6  ReportApproval project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

4.3  Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

Chapter 5.  Development environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
5.1  Install the development node  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

5.1.1  Install Microsoft Windows operating system . . . . . . . . . . . . . . . . . . . 74
5.1.2  Install IBM WebSphere Studio Application Developer Integration Edition 

V5.1.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
5.1.3  Install IBM Portal Toolkit V5.0.2.3 . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

5.2  Import the source code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
5.3  Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

Part 3.  Installation and configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

Chapter 6.  Portal node installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
6.1  IBM DB2 Universal Database installation . . . . . . . . . . . . . . . . . . . . . . . . . 89

6.1.1  Install DB2 UDB V8.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
6.1.2  Install DB2 UDB V8.1 Fix Pack 4a  . . . . . . . . . . . . . . . . . . . . . . . . . . 90
6.1.3  Verify DB2 UDB  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

6.2  IBM WebSphere Portal V5.0 installation . . . . . . . . . . . . . . . . . . . . . . . . . . 92
6.2.1  Install WebSphere Portal V5.0  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
6.2.2  Verify WebSphere Portal V5.0  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

 

 

 

 

iv Records Management and Process Choreography



6.3  IBM WebSphere Application Server V5.0 Fix Pack 2 installation . . . . . . . 98
6.3.1  Download WebSphere Application Server V5.0 Fix Pack 2 . . . . . . . 99
6.3.2  Stop the servers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
6.3.3  Install WebSphere Application Server V5.0 Fix Pack 2  . . . . . . . . . 100

6.4  WebSphere Application Server Enterprise V5.0 Fix Pack 2 installation . 101
6.4.1  Download IBM WebSphere Application Server Enterprise V5.0 Fix 

Pack 2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
6.4.2  Stop the servers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
6.4.3  Install WebSphere Application Server Enterprise V5.0 Fix Pack 2 . 103

6.5  IBM WebSphere Application Server V5.0.2 Fixes installation. . . . . . . . . 104
6.5.1  Download WebSphere Application Server V5.0.2 Fixes . . . . . . . . . 104
6.5.2  Stop the servers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
6.5.3  Install WebSphere Application Server V5.0.2 Fixes . . . . . . . . . . . . 105
6.5.4  Verify WebSphere Application Server V5.0.2 . . . . . . . . . . . . . . . . . 106

6.6  IBM WebSphere Portal V5.0 Fix Pack 2 installation . . . . . . . . . . . . . . . . 107
6.6.1  Download and unpack WebSphere Portal V5.0 Fix Pack 2  . . . . . . 108
6.6.2  Stop the servers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
6.6.3  Install WebSphere Portal V5.0 Fix Pack 2  . . . . . . . . . . . . . . . . . . . 108
6.6.4  Update the WebSphere Portal configuration. . . . . . . . . . . . . . . . . . 109
6.6.5  WebSphere Portal Content Publisher V5.0. . . . . . . . . . . . . . . . . . . 110
6.6.6  Document Manager search index . . . . . . . . . . . . . . . . . . . . . . . . . . 110
6.6.7  Verify the WebSphere Portal V5.0.2 . . . . . . . . . . . . . . . . . . . . . . . . 111

6.7  WebSphere Application Server V5.0.2 Cumulative Fix 2 installation  . . . 111
6.7.1  Download and unpack WebSphere Application Server V5.0.2 

Cumulative Fix 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
6.7.2  Stop the servers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
6.7.3  Install WebSphere Application Server V5.0.2 Cumulative Fix 2 . . . 112

6.8  IBM WebSphere Application Server Enterprise V5.0.2 Cumulative Fix 2 
installation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

6.8.1  Download and unpack WebSphere Application Server Enterprise V5.0.2 
Cumulative Fix 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114

6.8.2  Stop the servers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114
6.8.3  Install WebSphere Application Server Enterprise V5.0.2 Cumulative 

Fix 2  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114
6.9  WebSphere Application Server V5.0.2 Cumulative Fix 3 installation  . . . 115

6.9.1  Download and unpack WebSphere Application Server V5.0.2 
Cumulative Fix 3 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

6.9.2  Stop the servers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
6.9.3  Install WebSphere Application Server V5.0.2 Cumulative Fix 3 . . . 116

6.10  IBM WebSphere Application Server V5.0.2.3 Fixes installation . . . . . . 117
6.10.1  Download and unpack Application Server V5.0.2.3 Fixes  . . . . . . 118
6.10.2  Stop the servers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119
6.10.3  Install WebSphere Application Server V5.0.2.3 Fixes. . . . . . . . . . 119

 

 

 

 

 Contents v



6.10.4  Verify WebSphere Application Server V5.0.2.3  . . . . . . . . . . . . . . 120
6.11  IBM WebSphere Portal V5.0.2 Cumulative Fix 1 installation  . . . . . . . . 121

6.11.1  Download and unpack Portal V5.0.2 Cumulative Fix 1 . . . . . . . . . 121
6.11.2  Stop the servers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
6.11.3  Prepare WebSphere Portal V5.0.2 for installation  . . . . . . . . . . . . 122
6.11.4  Install WebSphere Portal V5.0.2 Cumulative Fix 1 . . . . . . . . . . . . 123
6.11.5  Verify WebSphere Portal V5.0.2 . . . . . . . . . . . . . . . . . . . . . . . . . . 125

6.12  IBM Tivoli Directory Server Version 5.2 installation  . . . . . . . . . . . . . . . 125
6.12.1  Create an administrator user and assign user rights  . . . . . . . . . . 125
6.12.2  Install IBM GSKit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
6.12.3  Install IBM Tivoli Directory Server . . . . . . . . . . . . . . . . . . . . . . . . . 129

6.13  Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131

Chapter 7.  Business Integration node installation. . . . . . . . . . . . . . . . . . 133
7.1  WebSphere Business Integration Server Foundation V5.1 installation. . 135

7.1.1  Install WebSphere Business Integration Server Foundation V5.1  . 135
7.1.2  Verify WebSphere Business Integration Server Foundation V5.1  . 138

7.2  IBM WebSphere Application Server V5.1 Fix Pack 1 installation . . . . . . 138
7.2.1  Download fix pack and WebSphere Update Installer application . . 139
7.2.2  Stop the server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139
7.2.3  Install WebSphere Application Server V5.1 Fix Pack 1  . . . . . . . . . 139

7.3  IBM WebSphere Business Integration Server Foundation V5.1 Fix Pack 1 
installation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141

7.3.1  Download and unpack the fix pack . . . . . . . . . . . . . . . . . . . . . . . . . 142
7.3.2  Stop the server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142
7.3.3  Install WebSphere Business Integration Server Foundation V5.1 Fix 

Pack 1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142
7.3.4  Verify Business Integration Server Foundation V5.1.1 . . . . . . . . . . 143

7.4  Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144

Chapter 8.  Content Management node installation . . . . . . . . . . . . . . . . . 145
8.1  Microsoft Windows 2000 Server installation . . . . . . . . . . . . . . . . . . . . . . 147

8.1.1  Windows 2000 Service Pack 4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147
8.1.2  Windows 2000 service levels  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147
8.1.3  Create system users and assign user rights . . . . . . . . . . . . . . . . . . 147
8.1.4  Add users to Administrators group . . . . . . . . . . . . . . . . . . . . . . . . . 148
8.1.5  User rights assignments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148

8.2  IBM DB2 Universal Database installation . . . . . . . . . . . . . . . . . . . . . . . . 149
8.2.1  Install DB2 UDB V8.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
8.2.2  Install DB2 UDB V8.1 Fix Pack 4a  . . . . . . . . . . . . . . . . . . . . . . . . . 150
8.2.3  Verify DB2 UDB  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152

8.3  Microsoft Visual C++ installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
8.3.1  Install Microsoft Visual C++ V6.0  . . . . . . . . . . . . . . . . . . . . . . . . . . 153

 

 

 

 

vi Records Management and Process Choreography



8.3.2  Configure Microsoft Visual C++ V6.0  . . . . . . . . . . . . . . . . . . . . . . . 153
8.3.3  Verify Microsoft Visual C++ V6.0  . . . . . . . . . . . . . . . . . . . . . . . . . . 155

8.4  IBM WebSphere Application Server installation . . . . . . . . . . . . . . . . . . . 155
8.4.1  Install WebSphere Application Server V5.0  . . . . . . . . . . . . . . . . . . 156
8.4.2  Install WebSphere Application Server V5 Fix Pack 2 (V5.0.2) . . . . 158
8.4.3  Verify WebSphere Application Server V5.0.2 . . . . . . . . . . . . . . . . . 159

8.5  IBM GSKit installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160
8.5.1  Determine GSKit version installed  . . . . . . . . . . . . . . . . . . . . . . . . . 161
8.5.2  Uninstall the earlier GSKit version  . . . . . . . . . . . . . . . . . . . . . . . . . 161
8.5.3  Install GSKit V7.0.1.16  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162

8.6  IBM HTTP Server SSL configuration. . . . . . . . . . . . . . . . . . . . . . . . . . . . 163
8.6.1  Enable the httpd.conf file for SSL . . . . . . . . . . . . . . . . . . . . . . . . . . 163
8.6.2  Copy WebSphere plug-in entries  . . . . . . . . . . . . . . . . . . . . . . . . . . 165
8.6.3  Create the IBM HTTP Server key store  . . . . . . . . . . . . . . . . . . . . . 165
8.6.4  Create a certificate for IBM HTTP Server . . . . . . . . . . . . . . . . . . . . 166
8.6.5  Verify IBM HTTP Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 166
8.6.6  Configure SSL for IBM HTTP administration server . . . . . . . . . . . . 167

8.7  IBM WebSphere Application Server configuration  . . . . . . . . . . . . . . . . . 167
8.7.1  Certificates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168
8.7.2  Restrict ports for WebSphere Application Server . . . . . . . . . . . . . . 168

8.8  IBM DB2 Content Manager installation . . . . . . . . . . . . . . . . . . . . . . . . . . 169
8.8.1  Prerequisites for DB2 Content Manager . . . . . . . . . . . . . . . . . . . . . 169
8.8.2  Install DB2 Content Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170

8.9  IBM DB2 Content Manager verification . . . . . . . . . . . . . . . . . . . . . . . . . . 174
8.9.1  Verify the library server database . . . . . . . . . . . . . . . . . . . . . . . . . . 174
8.9.2  Verify that library server access C++ modules were generated . . . 175
8.9.3  Verify that the library server monitor is started . . . . . . . . . . . . . . . . 175
8.9.4  Verify the system administration client  . . . . . . . . . . . . . . . . . . . . . . 175
8.9.5  Verify resource manager WebSphere deployment . . . . . . . . . . . . . 175
8.9.6  Verify the resource manager database . . . . . . . . . . . . . . . . . . . . . . 176
8.9.7  Verify DB2 Content Manager installation with First Steps. . . . . . . . 176

8.10  DB2 Content Manager V8.2 Fix Pack 6 installation  . . . . . . . . . . . . . . . 178
8.11  DB2 Information Integrator for Content installation . . . . . . . . . . . . . . . . 179

8.11.1  Install DB2 Information Integrator for Content. . . . . . . . . . . . . . . . 180
8.11.2  Verify DB2 Information Integrator for Content . . . . . . . . . . . . . . . . 182
8.11.3  Install DB2 Information Integrator for Content Fix Pack 6. . . . . . . 183

8.12  IBM DB2 Content Manager eClient Version 8.2 installation . . . . . . . . . 184
8.12.1  Install Content Manager eClient  . . . . . . . . . . . . . . . . . . . . . . . . . . 185
8.12.2  Verify the eClient installation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185

8.13  DB2 Records Manager Enabler Version 8.2.820.600 installation . . . . . 186
8.13.1  Preinstallation tasks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186
8.13.2  Install the Records Manager Enabler Common Client support . . . 187
8.13.3  Install the Records Manager Enabler for Content Manager eClient 

 

 

 

 

 Contents vii



server component . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 188
8.14  Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 188

Chapter 9.  Records Management node installation . . . . . . . . . . . . . . . . . 189
9.1  Microsoft Windows 2000 Server installation . . . . . . . . . . . . . . . . . . . . . . 190

9.1.1  Windows 2000 Service Pack 4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . 190
9.1.2  Windows 2000 service levels  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 190
9.1.3  Create system users and assign user rights . . . . . . . . . . . . . . . . . . 190
9.1.4  Verify network configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191

9.2  DB2 Universal Database installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . 192
9.2.1  Install DB2 UDB V8.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 192
9.2.2  Install DB2 UDB V8.1 Fix Pack 4a  . . . . . . . . . . . . . . . . . . . . . . . . . 193
9.2.3  Verify DB2 UDB  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 195

9.3  WebSphere Application Server installation . . . . . . . . . . . . . . . . . . . . . . . 195
9.3.1  Install WebSphere Application Server Standard Edition V5.0. . . . . 195
9.3.2  Install WebSphere Application Server V5 Fix Pack 2 (V5.0.2) . . . . 197
9.3.3  Verify WebSphere Application Server V5.0.2 . . . . . . . . . . . . . . . . . 198

9.4  IBM GSKit installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 199
9.4.1  Determine GSKit version installed  . . . . . . . . . . . . . . . . . . . . . . . . . 199
9.4.2  Uninstall the earlier GSKit version  . . . . . . . . . . . . . . . . . . . . . . . . . 200
9.4.3  Install GSKit V7.0.1.16  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 201

9.5  IBM HTTP Server SSL configuration. . . . . . . . . . . . . . . . . . . . . . . . . . . . 202
9.5.1  Enable the httpd.conf file for SSL . . . . . . . . . . . . . . . . . . . . . . . . . . 202
9.5.2  Copy WebSphere plug-in entries  . . . . . . . . . . . . . . . . . . . . . . . . . . 204
9.5.3  Create the IBM HTTP Server key store  . . . . . . . . . . . . . . . . . . . . . 204
9.5.4  Create a certificate for IBM HTTP Server . . . . . . . . . . . . . . . . . . . . 205
9.5.5  Verify IBM HTTP Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 205
9.5.6  Configure SSL for IBM HTTP administration server . . . . . . . . . . . . 206

9.6  WebSphere Application Server configuration . . . . . . . . . . . . . . . . . . . . . 206
9.6.1  Certificates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207
9.6.2  Restrict ports for WebSphere Application Server . . . . . . . . . . . . . . 207

9.7  DB2 Records Manager installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 208
9.7.1  Prerequisites for DB2 Records Manager  . . . . . . . . . . . . . . . . . . . . 208
9.7.2  Install DB2 Records Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 208
9.7.3  Create the DB2 Records Manager database  . . . . . . . . . . . . . . . . . 209
9.7.4  Install DB2 Records Manager Engine . . . . . . . . . . . . . . . . . . . . . . . 211
9.7.5  Install DB2 Records Manager Version 3.1.2 Engine. . . . . . . . . . . . 212
9.7.6  Verify DB2 Records Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215
9.7.7  Install DB2 Records Manager Version 3.1.3 Engine. . . . . . . . . . . . 216

9.8  DB2 Records Manager Enabler Version 8.2.820.600 installation . . . . . . 219
9.8.1  Preinstallation tasks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 219
9.8.2  Install Records Manager Enabler Common Client support . . . . . . . 220
9.8.3  Install Records Manager Enabler CommonWin32 component . . . . 223

 

 

 

 

viii Records Management and Process Choreography



9.8.4  Install Records Manager Enabler DB2 Records Manager server 
component  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 224

9.9  Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 225

Chapter 10.  Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
10.1  Configure the Portal node . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228

10.1.1  Configure IBM Tivoli Directory Server . . . . . . . . . . . . . . . . . . . . . . 228
10.1.2  Configure Tivoli Web Administration Tool . . . . . . . . . . . . . . . . . . . 230
10.1.3  Create users in IBM Tivoli Directory Server  . . . . . . . . . . . . . . . . . 234
10.1.4  Configure WebSphere Portal for IBM HTTP Server . . . . . . . . . . . 240
10.1.5  Configure WebSphere Portal for IBM Tivoli Directory Server . . . . 241

10.2  Configure the Business Integration node  . . . . . . . . . . . . . . . . . . . . . . . 250
10.2.1  Configure WebSphere Application Server for Directory Server  . . 251
10.2.2  Configure business process container on WebSphere Application 

Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 257
10.3  Configure the Content Management node  . . . . . . . . . . . . . . . . . . . . . . 263

10.3.1  Configure DB2 Content Manager for LDAP  . . . . . . . . . . . . . . . . . 263
10.3.2  Configure the LDAP User Import Scheduler . . . . . . . . . . . . . . . . . 269
10.3.3  Configure the Content Manager eClient RME support . . . . . . . . . 273
10.3.4  Configure the DB2 Content Manager RME functions . . . . . . . . . . 276
10.3.5  Deploy DB2 Content Manager data model . . . . . . . . . . . . . . . . . . 279

10.4  Configure the Records Management node . . . . . . . . . . . . . . . . . . . . . . 288
10.4.1  Configure the RME Host Interface component . . . . . . . . . . . . . . . 288
10.4.2  Configure DB2 Records Manager . . . . . . . . . . . . . . . . . . . . . . . . . 290

10.5  Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 297

Part 4.  Deployment and execution  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 299

Chapter 11.  Solution deployment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 301
11.1  Download the ILM sample code  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
11.2  Content Management node. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
11.3  Records Management node  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 307

11.3.1  Define the DB2 Records Manager logic extensions . . . . . . . . . . . 307
11.3.2  Register the DB2 Content Manager server as a DB2 Records Manager 

host application. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 308
11.3.3  Capture the DB2 Records Manager component IDs. . . . . . . . . . . 310
11.3.4  Define DB2 Records Manager RME configuration information. . . 311
11.3.5  Configure DB2 Records Manager RME users and groups . . . . . . 315

11.4  Business Integration node. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 317
11.5  Portal node  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 324

11.5.1  Configure portlets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 324
11.5.2  Add required libraries  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329
11.5.3  Deploy portlets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329
11.5.4  Create portal pages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 330

 

 

 

 

 Contents ix



11.5.5  Set up access rights . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 336
11.6  Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 339

Chapter 12.  Solution walkthrough . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 341
12.1  Supervisor requests a report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 342
12.2  Analyst accepts assignment and creates report . . . . . . . . . . . . . . . . . . 345
12.3  Supervisor reviews report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 352
12.4  Records administrator audits report  . . . . . . . . . . . . . . . . . . . . . . . . . . . 357
12.5  Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 363

Part 5.  Appendix . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 365

Appendix A.  Additional material  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 367
Locating the Web material . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 367
Using the Web material  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 368

System requirements for downloading the Web material . . . . . . . . . . . . . 368
How to use the Web material  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 368

Related publications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 371
IBM Redbooks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 371
Other publications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 371
Online resources  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 371
How to get IBM Redbooks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 372
Help from IBM  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 372

Index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 373

 

 

 

 

x Records Management and Process Choreography



Notices

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in other countries. Consult 
your local IBM representative for information on the products and services currently available in your area. 
Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, program, or service that 
does not infringe any IBM intellectual property right may be used instead. However, it is the user's 
responsibility to evaluate and verify the operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this document. 
The furnishing of this document does not give you any license to these patents. You can send license 
inquiries, in writing, to: 
IBM Director of Licensing, IBM Corporation, North Castle Drive Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such provisions 
are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer 
of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made 
to the information herein; these changes will be incorporated in new editions of the publication. IBM may 
make improvements and/or changes in the product(s) and/or the program(s) described in this publication at 
any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any 
manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the 
materials for this IBM product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate without 
incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their published 
announcements or other publicly available sources. IBM has not tested those products and cannot confirm 
the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on 
the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them 
as completely as possible, the examples include the names of individuals, companies, brands, and products. 
All of these names are fictitious and any similarity to the names and addresses used by an actual business 
enterprise is entirely coincidental. 

COPYRIGHT LICENSE: 
This information contains sample application programs in source language, which illustrates programming 
techniques on various operating platforms. You may copy, modify, and distribute these sample programs in 
any form without payment to IBM, for the purposes of developing, using, marketing or distributing application 
programs conforming to the application programming interface for the operating platform for which the 
sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, 
therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, 
modify, and distribute these sample programs in any form without payment to IBM for the purposes of 
developing, using, marketing, or distributing application programs conforming to IBM's application 
programming interfaces. 

 

 

 

 

© Copyright IBM Corp. 2005. All rights reserved. xi



Trademarks
The following terms are trademarks of the International Business Machines Corporation in the United States, 
other countries, or both: 

AIX®
Cloudscape™
DB2 Universal Database™
DB2®
Distributed Relational Database 
Architecture™
Domino®
DRDA®
ibm.com®

IBM®
ImagePlus®
Lotus Notes®
Lotus®
NetVista™
Notes®
OS/390®
Redbooks (logo) ™
Redbooks™

Redbooks™
ThinkCentre™
Tivoli®
WebSphere®
Workplace Web Content 
Management™
Workplace™

The following terms are trademarks of other companies:

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the United States, other countries, or both. 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the 
United States, other countries, or both.

Intel, Intel Inside (logos), MMX, and Pentium are trademarks of Intel Corporation in the United States, other 
countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, and service names may be trademarks or service marks of others.

 

 

 

 

xii Records Management and Process Choreography



Preface

This IBM Redbook describes a sample implementation of a complex solution that 
addresses a key challenge being faced by many enterprises today. Document 
and record management has always been a difficult (and often manual) process. 
Enterprises need to address this challenge, not only to make their business, 
employees, partners, and customers more efficient, but also to comply with 
ever-increasing regulations.

Addressing these requirements demands a flexible solution that can be 
integrated with current and future IT systems and applications. It is also critical 
that it is driven through controllable and automated business processes.

This book describes a sample solution that integrates IBM® DB2® Records 
Manager, IBM DB2 Content Manager, IBM WebSphere® Application Server 
Enterprise process choreographer, IBM WebSphere Portal, IBM Tivoli® 
Directory Server, and other software to provide a prototype solution. Though 
basic in its function, the solution and the steps to implement it can be used to 
help architects, IT specialists, and developers get started in creating a solution 
addressing their enterprise-specific requirements.

The team that wrote this redbook
This redbook was produced by a team of specialists from around the world 
working at the International Technical Support Organization, Austin Center.

Bart Jacob is a Senior Consulting IT Specialist at IBM Corp., International 
Technical Support Organization, Austin Center. He has 24 years of experience 
providing technical support across a variety of IBM products and technologies, 
including communications, object-oriented software development, and systems 
management. He has more than 13 years of experience at the ITSO, where he 
has been writing IBM Redbooks™ and creating and teaching workshops around 
the world on a variety of topics. He holds a Master’s degree in Numerical 
Analysis from Syracuse University.

Jan Antos is a Senior Analyst/Programmer at Trask solutions s.r.o., an IBM 
Premium Business Partner in the Czech Republic. He holds a Master’s degree in 
Computer Science from Czech Technical University in Prague, where he 
currently studies in the Ph.D. program. He has more than five years of IT 
experience working mainly with the IBM WebSphere family of products, 
exploiting technologies such as J2EE, WebSphere MQ, Web services, and 

 

 

 

 

© Copyright IBM Corp. 2005. All rights reserved. xiii



Business Process Execution Language for Web Services. He is a Sun Certified 
Java™ Programmer for the Java 2 Platform and an IBM Certified WebSphere 
Studio Developer. His areas of expertise include analysis, design, and 
development of large integration projects for financial institutions.

Budi Darmwan is a Consulting IT Specialist at the International Technical 
Support Organization, Austin Center. He writes extensively and teaches IBM 
classes worldwide on all areas of systems management. Before joining the ITSO 
six years ago, Budi worked in IBM Global Services, Indonesia as a Solution 
Architect and Lead Services Implementer. His current interests include 
autonomic computing, business service management, Java programming, and 
Web security.

Mike Kerzee is an Information Technology Architect in IBM Sales and 
Distribution’s Health Care and Life Sciences solution development organization 
located in Boulder, Colorado, U.S. He has 17 years of experience in electronic 
data capture, analysis, and management solutions. Mike holds a degree in 
biology from Tarleton State University (Texas A&M). His areas of expertise 
include IBM DB2 Records Manager, IBM DB2 Content Manager, and Web 
services architecture for delivery of information life-cycle management and 
regulatory compliance solutions for long-term retention of electronic records. 
Mike has written and presented extensively about the health care and life 
sciences information life-cycle management, as well as industry standards for 
support of electronic data management within the life sciences.

Therese Sroujian is a Business Scenario Designer for the IBM Software Group 
System House in the IBM Toronto Lab, Canada. She has eight years of 
experience in software development. She holds a Bachelor of Science degree 
from York University, Toronto, Canada. Therese has expertise in J2EE 
development, content management including DB2 Content Manager, DB2 
Document Manager, and Lotus® Workplace Web Content Management™, 
records management including DB2 Records Manager, business processes 
development and deployment, and portal user interface development using 
WebSphere Portal. She has written extensively about different product 
integration topics and has consulted on other IBM Redbooks.

Become a published author
Join us for a two- to six-week residency program! Help write an IBM Redbook 
dealing with specific products or solutions, while getting hands-on experience 
with leading-edge technologies. You'll team with IBM technical professionals, 
Business Partners and/or customers. 

 

 

 

 

xiv Records Management and Process Choreography



Your efforts will help increase product acceptance and customer satisfaction. As 
a bonus, you'll develop a network of contacts in IBM development labs, and 
increase your productivity and marketability. 

Find out more about the residency program, browse the residency index, and 
apply online at:

ibm.com/redbooks/residencies.html

Comments welcome
Your comments are important to us!

We want our Redbooks to be as helpful as possible. Send us your comments 
about this or other Redbooks in one of the following ways:

� Use the online Contact us review redbook form found at:

ibm.com/redbooks

� Send your comments in an e-mail to:

redbook@us.ibm.com

� Mail your comments to:

IBM Corporation, International Technical Support Organization
Dept. JN9B  Building 905
11501 Burnet Road
Austin, Texas 78758-3493

 

 

 

 

 Preface xv

http://www.redbooks.ibm.com/residencies.html
http://www.redbooks.ibm.com/residencies.html
http://www.redbooks.ibm.com/
http://www.redbooks.ibm.com/
http://www.redbooks.ibm.com/contacts.html


 

 

 

 

xvi Records Management and Process Choreography



Part 1 Overview

In this first part of the book, we introduce the business requirement for document 
and records management within the context of business processes.

Chapter 1, “Introduction” on page 3, provides a broad overview and describes 
many of the issues that enterprises face today and the elements that might be 
included in a solution.

Chapter 2, “Solution context and overview” on page 13, provides additional 
details about a potential solution by looking at various use cases and business 
processes.

Part 1
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Chapter 1. Introduction

As businesses struggle to compete in a harsh economic climate and an 
increasingly global economy, there is renewed focus on improving profitability by 
decreasing costs. Many companies are reviewing their processes in order to get 
the most from each employee and to ensure that these processes are tightly 
controlled to meet the needs of an increasingly regulated business environment. 

To further complicate matters, businesses are being inundated with all kinds of 
information: e-mail, letters, faxes, photographs and other images, marketing 
materials, audio (voice and music), video, documents, spreadsheets, 
presentations, reports, statements and invoices, and Web content such as 
HTML, Flash and graphics. As the amount of information increases (some 
estimate the volume is doubling each year), it becomes more challenging to find 
and retrieve up-to-date information. The search is problematic due to the many 
sources of information, business processes, various applications, multiple 
intranet sites, and individual desktop systems, and just as many formats. If the 
information is not easily found, it is often unnecessarily re-created. This, in turn, 
leads to a further proliferation of information with many redundancies and, too 
often, errors. Thus, the difficulties handling the rising volumes of business 
information are causing further inefficiencies in critical business processes and, 
more importantly, undue business risk.

Clearly, it is important to control the management of business information 
throughout its life cycle, from creation to its destruction. Some of these controls 
are being mandated by specific rules and regulations, many of which apply 
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across industries. The Sarbanes-Oxley Act in the U.S. establishes standards for 
corporate accountability and penalties for wrongdoing. There is particular 
emphasis on assertions by senior management that internal controls and 
procedures for financial reporting ensure complete and accurate information. 

Similarly, in the financial industry, various rules such as NASD Rule 2711 and 
NYSE Rule 472 have also been put in place. These rules outline restrictions on 
the production of research reports by analysts and include restrictions on who 
may review or approve reports, the involvement of the compliance department, 
retention periods for draft and final reports, and disclosure requirements. These 
and other rules define records and their retention periods. 

In general, regardless of the need to comply with specific regulations, it is 
essential that organizations adopt business information handling capabilities that 
include:

� Defined processes that can be tracked and audited

� Control over who is allowed access to information and at which stages of its 
life cycle

� Identification and retention of records

� Guarantees as to authenticity of information and protection against tampering

Many organizations are adopting a strategy to transform the workforce by using 
technology to enhance employee effectiveness and productivity. This goal is 
realized by providing employees with new self-service applications, by improving 
their ability to collaborate not only within individual departments, but across 
departments and locations, and by providing easier access to existing 
applications and information. This information is growing exponentially and must 
be better managed and tightly controlled to reduce risk.

 

 

 

 

4 Records Management and Process Choreography



1.1  Problem statement and solution overview
This section highlights some of the key problems that companies often face 
related to content and records management. Along with the description of each 
problem, a short description of the key attributes of a solution are also provided. 
This will lay the groundwork for the design of an overall solution.

There are many problems that highlight the challenges businesses face in an 
effort to have a more efficient and productive organization and to deal with the 
increasing volumes of content. We categorize the problems as follows and 
provide details in the sections that follow: 

� Employee productivity inhibitors

� Information management

� Locating information

� Business risks

1.1.1  Employee productivity inhibitors
This section describes some of the key employee productivity inhibitors.

Inefficient methods of communication
Affecting all lines of business, this inhibitor makes it difficult to collaborate and 
operate effectively. Often, costly travel might be required in order to have 
face-to-face meetings.

A successful solution would facilitate communication, even across multiple sites, 
and allow employees to collaborate more effectively, increasing productivity and 
decreasing travel costs.

Dissemination of up-to-date business information
Many organizations find it challenging to disseminate up-to-date information, 
such as policies, procedures, best practices, and product information. With new 
regulatory requirements, it is even more critical that information be shard in a 
timely manner. 

The problems associated with the sharing of timely information can affect the 
ability to make decisions and respond to customers. In addition, it can be more 
difficult to ensure compliance with policies, procedures, and relevant regulations. 
Employees are less effective when not following current procedures and best 
practices.
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A solution would make business information more readily available to all 
employees.

Slow and cumbersome manual procedures
Business processes are often paper intensive and involve cumbersome manual 
routing of information that, in turn, slows the process. This can be especially true 
in human resources (HR), administration, and operations departments.

Impacts can include:

� Extended time to complete tasks

� Manual, error-prone routing with potential loss of information

� Difficulties in tracking the state of processes and handling exceptional 
business situations, such as when the required approver is absent or 
unavailable

A successful solution would reduce costs by providing employees with 
self-service capability rather than existing paper-intensive processes, easily 
define and automate many business processes, automatically route information 
and notify employees of tasks requiring their attention, allow process progress to 
be easily tracked, and generate notifications of exceptions so that they can be 
more efficiently handled.

High rates of employee turnover
High rates of employee turnover affect businesses due to the high cost of 
replacement and retraining. 

An effective solution would provide the ability to find information fast and easily, 
along with its history, so a new employee is better able to quickly gain necessary 
expertise. In addition, this could provide opportunities for enhanced employee 
development.

1.1.2  Information management
This section describes some of the key challenges associated with managing 
information.

Ensuring authenticity, integrity, and accuracy of information
With current approaches, it is difficult to find necessary information, leading to its 
re-creation. Often, information is copied and modified. In both cases, redundant 
and often incorrect information is produced.
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Time is wasted attempting to verify that available information is authentic, 
accurate, and current. This also might limit or prevent a business from assuring 
compliance with regulations.

A solution would mitigate uncertainty by providing means of easily reviewing and 
approving information to ensure accuracy. It would maintain a single copy of each 
piece of content and manage its associated versions. This makes content to be 
more easily located, thus avoiding recreation, as well as protecting the integrity of 
the content. A solution should provide the ability to discern invalid or altered 
content as pertinent to compliance with particular regulations.

Authoring and managing large documents
Large documents consisting of many parts are often created using different 
methods by several contributors. Typically, a large document is assembled from 
copies of parts of existing documents. When the parts change, the large 
document is out-of-date and must be reassembled.   The same parts are often 
used in several, different larger documents.

Such a process results in slow, often manual, processes to assemble 
documents. It is difficult to maintain the relationships of the large document to its 
parts. Multiple copies of document parts are produced during assembly into large 
documents, thus increasing the overall volume of information. There is often 
uncertainty about the accuracy of the large document because it might contain 
an out-of-date copy of a part.

A solution would allow easy authoring of parts and their combination into a large 
document. It would maintain the relationships between the overall document and 
the appropriate versions of its parts.

Using business information for multiple purposes
Often the same or similar information is used for different purposes. For instance, 
product descriptions might appear in internal documents, marketing briefs, and 
product documentation. However, this information must be formatted differently, 
and controls must be in place to ensure that only the proper information appears 
in a particular document.

In many cases, manual processes are currently used that can include cutting and 
pasting from one document to another. Errors are often introduced when 
information is copied and modified for reuse.

The relationship of copies to the original source is difficult or impossible to 
maintain. In this situation, it is difficult to keep information in copies up-to-date 
when the original information changes. 
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A solution would allow for the definition of rules for assembling information from 
parts. It would allow parts to be easily created and maintained by enabling 
information to be entered and kept separate from the description of its format. 
Alternatively, information is easily separated out of existing types to allow multiple 
formats to be applied to it.

High hard-copy documentation costs
Maintaining hard-copy documentation can be a very expensive proposition 
because it can include: 

� Physical storage costs

� Printed document and bill costs

� Manual labor expenses

� Photography costs

A solution would allow documents to be stored, retrieved, and viewed more 
cost-effectively. As need to access the content decreases, documents are 
automatically shifted to less expensive storage types. 

1.1.3  Locating information
A key challenge facing businesses, due to the increasing volumes of information 
and information sources, is locating information and expertise.

This can result in lower responsiveness and time wasted searching for 
information. Ultimately, customer service might be degraded and sales activities 
hampered.

A solution would provide quick and easy access to enterprise information and 
expertise. In addition, a solution would provide the ability to search for such 
information.

This might not only apply to documents. For instance, employee directory entries 
could provide information about an employee's job and expertise. The directory 
could be easily searched using this information as search criteria, enabling 
greater collaboration among employees.

1.1.4  Business risks
This section provides information about some of the critical risks businesses 
need to manage.
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Regulatory compliance
Regulatory compliance can be a driving force for the appropriate management of 
business content.

Problems can arise due to uncertainty regarding the credibility of information. In 
addition, possible prosecution, penalties, and punishment for non-compliance 
can be costly to the business, not only monetarily, but in terms of the firm's 
reputation.

A solution would: 

� Employ procedures and controls designed to ensure the authenticity and 
integrity of business content

� Provide support for regulatory audits used to substantiate information 
management practices such as automatically logging steps in processes and 
tracking modifications and access to business information

� Provide a means of easily capturing and executing business procedures

� Provide automatic notification of activities to those involved in the process

� Allow easy process tracking, including outstanding tasks and completion time

Maintaining proper control over access to information
It is critical to maintain proper control over access to information during its life 
cycle and ensure that it is not inappropriately modified or deleted. In fact, strict 
access policies are stipulated by some regulations, and access must be 
auditable. Current approaches depend on trusting employees to follow proper 
procedures and manual routing of information at the appropriate stage in the life 
cycle. Naturally, this is error prone and can result in inappropriate access or 
modification of documents and the inability to comply with regulations or to attest 
compliance.

A solution would provide flexible and comprehensive access control mechanisms 
that are automatically enforced throughout the document life cycle and that are 
easy to maintain. It would protect published revisions from modification and 
separate revisions from any versions produced at any point in the life cycle for the 
next revision. All access should be automatically logged to an audit trail.

Managing retention of records
Records need to be protected from tampering or deletion for specific periods of 
time, sometimes for years, both for business reasons and, increasingly, to comply 
with regulations. Records need to be created for many types of content, including 
documents, e-mail, reports, and statements. In addition, records might need to 
be held for extended periods, regardless of normal retention periods for that 
record type, perhaps due to legal action.
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Some of the business impacts and requirements related to records retention 
include:

� Escalating storage costs.

� Records need to be stored securely for the specific period and yet remain 
easily accessible before being destroyed.

� Records need to be unalterable during the retention period.

With current approaches, especially hard-copy storage, relevant records are 
difficult and time-consuming to locate in event of litigation, requests for 
substantiation, regulatory audits, or other investigations. In some cases, records 
might be irretrievable due to inappropriate destruction or simply lost.

A solution would enable the automatic handling of retention management: 
storage, accessibility, and destruction at specified times. Retention rules could be 
defined by record type, but easily overridden for individual records.

Controlling the public perception of the corporate brand
It is important to control the public perception of the corporate brand by ensuring 
that all published information reflects the desired corporate identity.

If not controlled, brand recognition might be weakened, making marketing 
activities less effective. Corporate identity is weakened or damaged by 
inconsistent messages.

A solution would maintain or strengthen a brand by providing sufficient controls 
such as approval processes on content related to the corporate image. It would 
also support processes to control the release of information.

1.2  Summary
Virtually all businesses, both in the large enterprise and SMB markets, and 
across every industry, can take advantage of a solution to address the prevalent 
problems described here. These companies need to control and manage the 
production, distribution, and retention of various forms of content, such as e-mail, 
documents, images, rich media, statements, and invoices, that support their 
business processes and record business transactions. It is crucial for content to 
be accurate, authentic, and up-to-date in order to respond to the needs of their 
customers and business partners.

A solution is particularly appealing to companies with larger numbers of 
employees. In fact, in this case, the issues around corporate communication and 
employee collaboration become more problematic. Larger companies tend to 
have more locations, which means employees are geographically separated. 
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Large enterprises will enjoy economies of scale when deploying a solution. 
Relatively fixed implementation costs are spread across a larger user population 
in such companies. 

Users of a solution have varying degrees of sophistication in computer skills and 
a wide range of experience, so providing a simple and intuitive user interface is 
important. In addition, with an increasingly global economy, companies need to 
consider the internationalization of their applications.

The solution described in this book does not provide a complete solution to all of 
the issues described here. Rather, it demonstrates how various IBM products 
can be integrated as a basis for such a solution.

The next chapter describes in a little more detail what a solution might include 
and describes various employee-centric use cases that might apply to any 
number of enterprises today. Of course, these same concepts could be applied to 
other use cases involving partners and customers.
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Chapter 2. Solution context and 
overview

This chapter provides a high-level view of an employee workplace solution that 
addresses some of the requirements described in the previous chapter. 
Specifically, it addresses some of the requirements related to document and 
records management within the context of a business process. The bulk of this 
chapter describes various use cases that are common across many enterprises. 

2

Note: The sample solution described throughout the rest of the book only 
addresses one of these use cases (and only partially), but the same or similar 
infrastructure could provide the basis for a more complete solution.
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2.1  Solution perspective
An employee workplace is a business-to-employee (B2E) application that 
integrates corporate information, an employee directory function, and 
collaborative capabilities with access to administrative and business applications. 
Document sharing, management, and publishing capabilities are provided, 
including the appropriate support for document life cycles. In addition, such a 
solution provides the means to manage and control the life cycle for information 
to be presented directly in the workplace, known as workplace content 
management. A retention management capability is provided to handle creating, 
retaining, and destroying the records of all information pertaining to the 
transaction of the business. See Figure 2-1.

Figure 2-1   Solution overview

2.2  Solution scenarios
The following sections describe various scenarios that illustrate the important 
end-to-end usage of a records and document management solution integrated 
with business processes. The goal of this book is to describe the implementation 
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and deployment of a solution that provides a user experience similar to that 
portrayed in the scenarios. Keep in mind that the solution described later in this 
book is limited in scope and meant only to show the basics of how a solution 
could be developed and deployed and not to provide all of the capabilities 
described in the following sections.

2.2.1  Use case: Analyst research reporting

In the financial industry, a “research report” is an analysis of equity securities of 
individual companies or industries delivered in written or electronic format that 
provides a recommendation and reasonably sufficient information for a reader to 
make an investment decision. The production of such reports is governed by 
NASD Rule 2711 and NYSE Rule 472 to ensure investor confidence in the 
integrity of such reports. 

Using the employee workplace, an analyst initiates the creation of a new 
research report. This is the start of the report life cycle. The report life cycle 
embodies many of the supervisory procedures necessary for regulatory 
compliance. All research reports for this firm have the same format, and the 
report consists of several parts, including the research summary, rating or price 
target, line graph of security's daily closing price, and disclosures. 

The analyst carries out the necessary research and produces a draft report. The 
analyst uses his favorite desktop authoring tool to create the report, but 
periodically stores the current draft in the employee workplace. When he is ready, 
he marks all the parts complete and allows the system to prepare the complete 
draft from its parts. The analyst previews the assembled report and then submits 
it for review and approval by the supervisory analyst. 

The supervisory analyst uses the workplace to view the report. As she reads it, 
she becomes concerned that some information is not correct. She advises that 
the draft report be sent to the subject company to verify its factual accuracy. She 
rejects approval of the report with the reason “needs verification.”

The workplace handles the verification process. First, a complete draft report is 
automatically routed to the legal department for review prior to the submission to 
the subject company. After the report is approved by the legal department, the 
system automatically assembles a draft that omits the research summary and 
rating or target price parts and routes it to the analyst who sends it to the 
company.

Note: It is this use case that provides the context for the examples described 
and implemented in this book.
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A few days later, the subject company confirms the facts presented in the report. 
The analyst forwards the response to the supervisory analyst and copies the 
legal department. The supervisory analyst creates a record for this e-mail so that 
it will be retained by the system and then reviews the report again. She adds 
some review comments suggesting some minor edits. More importantly, she 
recommends changing the rating given recent economic upheaval. She returns 
the report to the analyst for rework.

The analyst completes all the suggested rework prior to changing the rating. He 
is aware that to change the rating, authorization from the legal department is 
required in order to access and modify that part of the report. To start this 
process, the analyst must submit a justification to the legal department. After the 
legal department authorizes the change using the workplace, the system 
automatically updates the access control for that part and notifies the analyst that 
the change may proceed. The analyst makes the necessary updates to the 
rating. At this point, the report life cycle causes a record to be created for the 
draft with the original rating and notes that a record for the final report must be 
created once published. Each of these records must be retained for three years.

The report is now complete, so the analyst submits the final draft for approval. 
The supervisory analyst receives the request for approval in the employee 
workplace and reviews the report. No further changes are necessary, so she 
submits the report for approval by the legal department.

Upon receiving the request for approval in the workplace, the legal counsel 
reviews the report and approves it. After the system processes the approval, the 
research report is ready for distribution. The original Microsoft® Word format is 
automatically sent to the printer for hard-copy distribution and also automatically 
converted to HTML and published to the external Web for investors to view.

A year later, the subject company of this research report proceeds with litigation 
against the financial institution. All records related to transactions with this 
company must be discovered and their normal retention period suspended. As 
the case proceeds, records and the associated audit trails are easily retrieved by 
the legal department for the financial institution, as needed.

2.2.2  Use case: Collaborating on work products
It is time to begin the planning for the fall marketing campaign. The promotions 
manager creates a new work area for the team to share information relevant to 
the campaign and develop the various campaign work products such as 
promotion details. These work products are typical office document types, text 
documents, spreadsheets, presentations, and some images. The promotions 
manager invites the members of her promotions team and also members of the 
extended marketing team to participate in the shared work area. Only members 
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of her immediate team are able to create materials in the shared work area; 
others have only read access.

However, before proceeding with the detailed promotion planning and 
development, the promotions manager needs to review the department budget 
and the overall marketing objectives. The marketing objectives are available from 
the brand management team. The promotions manager finds and extracts the 
information she needs for the fall campaign from the overall plan in the brand 
management department's work area. She creates a new plan from the 
appropriate spreadsheet template in the promotions shared work area.

The promotions manager also needs to get her team to prepare for an up-coming 
promotion planning session. She asks one of her senior marketers to analyze the 
results from last year's fall campaign. She contacts one of the marketers to 
obtain and summarize the most recent market trend analysis, including results 
from any recent focus groups or customer survey activities, and to add this 
material to the shared work area. Finally, she creates a discussion forum for her 
team to comment on last year's fall campaign, its successes and failures.

Later that day, one of the marketers opens the invitation to the fall campaign 
shared work area. This marketer is working to create a summary of recent 
market research as requested by the promotions manager. Over the next few 
days, he works on his summary. He is a little uncertain as to how much detail the 
promotions manager needs. He notices she is online, so he sends her an instant 
message with the document link and asks her to take a brief look at it. She 
agrees.

A little later the marketer gets a message from the promotions manager: “The 
summary looks good. Finish it up and let the team know it is ready for them to 
use.”

The promotions manager has been working on the promotion plan. She needs to 
send it to the VP of marketing for approval later in the week. She e-mails her 
senior marketers and asks them to review the spreadsheet and add their 
comments to the shared work area. 

2.2.3  Use case: Meetings
The promotions manager schedules a meeting with the marketers from the 
promotions team who will work on the fall campaign. They will use the meeting to 
brainstorm about the activities and promotions to be included. The initial part of 
the meeting will be a presentation by the promotions manager on the overall 
brand strategy followed by a discussion of the budget. Many of the marketers are 
out of the office on any given day, working on aspects of the current summer 
promotions, so the promotions manager schedules a Web conference so that all 
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can easily attend. In the Web conference notice, she reminds the team to 
prepare for the meeting by reviewing the current plan and market research 
materials in the shared work area. 

The promotions team meets at the appointed time. The presentation is shown 
using the Web conference facilities. After the formal presentation of the brand 
strategy, the promotions manager opens the spreadsheet with the budget in the 
shared work area and uses the Web conference facility to share the file. The 
team is sobered by the constrained budget, but the promotions manager 
encourages the team to think of some new campaign ideas that are less costly. 
One of the marketers suggests better use of the company's public Web site for 
the fall campaign as a means of decreasing publishing and distribution costs. He 
wants to quickly sketch out some ideas for the team, so the promotions manager 
makes the marketer moderator, and he opens the shared white board. A lively 
discussion ensues as the team views the sketch. The promotions manager's 
assistant records the meeting minutes in the shared work area and notes the 
various action items. The meeting ends with the team energized and ready to 
begin generating detailed promotion ideas for the campaign.

2.2.4  Use case: Managing product information
A company is developing a new product. The product development team is 
responsible for designing, prototyping, and preparing the product for 
manufacture. As part of this process, the product development team collaborates 
to produce the approved technical specification for the product. Original CAD 
drawings are exported as images from the CAD system into the document library 
and incorporated into the technical specification document authored with 
Microsoft Word. Performance data is extracted from the final test runs as 
comma-delimited CSV files and imported into Microsoft Excel to produce the 
charts needed for the specification. All the pieces are assembled into the desired 
format and published for internal use. Because the technical specification is used 
to create other product materials, it is produced and stored in parts in the 
document library so that it can be easily reused by other organizations in the 
company.

Senior management determines the availability date for the product. It is now up 
to the marketing team to prepare for the product launch. The first step in the 
launch process is to develop the press release announcing the product. All press 
releases follow a specific process and have a standard format for release to both 
the Web and the news services. The lead marketer simply initiates the process 
and fills in the necessary information, including the announce date, to create the 
release for this product. The release is automatically routed to brand marketing 
and then the legal department for their approval. The release is automatically 
formatted and published in the workplace and released to the news service on 
the announcement date.
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Two key aspects of the launch are a glossy product brochure and a detailed 
product page for the online catalogue. The lead marketer uses the system to 
request the production of these types of materials and assigns the appropriate 
members of the team. All product brochures use the same layout and graphics. 
Similarly, the product page for the online catalogue has a standard Web design. 
Both these layouts and all the associated graphic designs and other images such 
as the company logo were developed by the creative department within the 
marketing organization and are stored in the system. All standard copy for these 
files, such as the company description and contact information, are also stored in 
the system and are made available for use in these types of marketing materials. 
The system automatically assembles these standard, available parts into the 
proper layout to form the initial draft of the new brochure and product page when 
the requests for these materials are processed.

The launch materials need product images, so the lead marketer requests that 
the photographer create a folder of suitable images. The photographer does the 
photo shoot and uploads the thumbnails and his recommendations for the final 
product images to the system for review. The lead marketer requests the full size 
images for the recommended photos and a few others. She asks others on the 
team to review the images to ensure that they meet the needs of the product 
launch. Based on the team's comments, she makes her final choices. The 
selected images are stored in a folder for use by the whole team.

Meanwhile, the copy for the product description to be used in both the brochure 
and the Web catalogue is drafted and submitted for review and approval. The 
product specification descriptions come directly from the technical specification 
published by the product development team prior to the launch.

After all the parts are reviewed and approved, the brochure and product page are 
assembled by the system and routed to the lead marketer for approval. The next 
stage is to have the legal department and the compliance office approve the 
material prior to release to the publisher for printing, for the brochure, and direct 
publish to the public Web site for the product page.

2.2.5  Use case: Managing information presented in the workplace 
All employees depend on the employee workplace to provide them with access to 
current information about corporate policies and procedures. Regardless of 
whether an employee is working at home, on the road, or in the office, the 
workplace provides information when it is needed.

The upcoming introduction of online vacation information and request processing 
using the workplace means that current manual vacation procedures will become 
obsolete. A new procedure description needs to be written and published to the 
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workplace for employees to use. The publication of the new procedure needs to 
be coordinated with the date of activation of the new online vacation process.

The human resources (HR) manager uses the employee workplace to request a 
change to the documented vacation processing procedure. A detailed description 
and rationale are provided in the request. The new procedure needs to be 
published to the employee workplace the same day as the new vacation 
processing capability is deployed. The planned deployment date is entered as 
the publication date. All authoring, review, and approval activities must be 
completed prior to this date.

All HR procedures have the same format and are presented directly in the 
workplace user interface for easy and seamless access. Prior to deploying the 
workplace solution, the HR organization worked with the creative department to 
design the overall look and feel for the HR section of the workplace and develop 
the format for corporate procedures and policies. At the same time, the HR 
organization determined the appropriate life cycle for policies and procedures 
and defined the review and approval process so that it could be automated. In 
addition, a record of any existing policy or procedure must be created 
automatically and retained by the system for two years once it is replaced by a 
new revision. This information is incorporated into the life-cycle definition.

One of the HR specialists accepts the assignment to revise the vacation 
processing procedures. She reviews the details of the update request before she 
begins.

The detailed steps for the new procedure have been documented by the 
business analyst who worked on the new online capability. The HR specialist 
uses this information when she creates the documentation for the revised 
procedure. She simply selects the correct template for this kind of corporate 
procedure and enters the new information. The workplace interface guarantees 
that the procedure format complies with corporate HR standards and the visual 
design of the workplace. While she is working on the new procedure, it is easy for 
the HR specialist to preview the way it will be presented in the workplace. When 
completed to her satisfaction, the HR specialist uses the workplace to mark the 
activity complete. The next step is to verify that the new procedure is accurate 
and matches the new online vacation processing capability under development.

Another HR specialist is the HR liaison working with development team 
responsible for a new online vacation processing feature to be made available in 
the next release of the employee workplace. The vacation processing feature is 
already deployed in a test environment and is undergoing final system testing. 
The HR liaison has access to the test environment and is assisting with the user 
testing of the interface. He attempts to verify the steps in the procedure with the 
test system. He finds that there is a missing step and rejects the verification 
activity with detailed comments about the omitted information.
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The first HR specialist is notified about the failed procedure verification. She 
makes the required changes to the documented steps and resubmits the content 
for verification.

The HR liaison receives the request to verify the corrected procedure. This time, 
the verification is successful, and the activity is marked complete. The next step 
is to have the procedure description approved by the HR manager.

The HR manager receives notification that the new vacation processing 
procedure description is ready for review. She views the new procedure online 
using the employee workplace. She knows that the procedure steps have already 
been verified. However, she feels that some additional text is needed to clarify 
some of the steps and wants to add some references to other HR policies. She 
submits specific comments with her rejection.

The HR specialist changes the procedure as recommended by the HR manager 
and resubmits for approval. This time, the HR manager approves the request. 
The new procedure is made available to employees on the release date of the 
new online vacation processing facility. A record of the previous revision of the 
procedure is created and retained for the specified retention period.

2.2.6  Use case: Monthly fund performance report
Each month, the performance team in a financial institution produces a fund 
performance report. The communications team developed the boilerplate of this 
report. The performance team decided to create the report from multiple parts: 
performance results for each fund, market commentary by fund, top 10 holdings, 
and overall market performance. This enables different roles to contribute to the 
report and to work in parallel. The overall report and the various constituent parts 
each have a life cycle that determines creation, review, and approval of each 
part. Because the monthly fund performance report is made available to the fund 
customers, the published report is associated with a record and retained for 12 
months.

The team lead initiates the process and assigns analysts from the team to the 
various parts of the report. The reporting process begins with the collection of 
performance data for each fund. The assigned analyst uses the workplace to 
access the fund performance database to determine the results and produce 
performance reports for the last month. The reports are stored as documents so 
that other members of the team can reference this material. The performance 
database also produces numeric results that are imported into a graphing tool to 
plot performance charts of the data. The charts are stored in the repository and 
will be included in the report. Further analysis is done to determine the top 10 
holdings for the month. A standard template is used to present this information as 
part of the overall report.
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Meanwhile, the financial editor on the team produces the section outlining overall 
market performance. Other analysts on the team prepare market commentaries 
that relate the performance of each fund to current market trends. The 
performance data and charts created by other team members are referenced to 
create the commentary. Often, an analyst searches the collection of stored 
documents to find past commentaries. The analyst is able to search on different 
criteria such as a range of publishing dates and the fund or author's name.

When ready, each authoring analyst uses the workplace to submit the draft 
commentary for peer review by a specific list of analysts and the financial editor. 
Some of the reviewers are optional, while some, such as the financial editor, are 
mandatory.

Each peer analyst reviews the report using the workplace, adds their comments, 
and indicates when their review is complete. The review is open to optional 
reviewers during the review period, but the review is not completed until all the 
mandatory reviewers have acknowledged their review is complete. At that point, 
the authoring analyst reviews and responds to all the comments using the 
workplace. He reworks the report as necessary. Often, the author uses instant 
messaging or e-mail to get clarification or to discuss some of the comments 
during the rework process.

When all the parts of the report are ready, they are assembled into a single report 
using the template designed by the communications team. The full report is 
reviewed and approved by the team lead and then submitted for approval to an 
editor in communications and then the legal department.

Once approved, the report is published on schedule to the Web. The previous 
months report is removed from the Web, but retained for the specified period of 
time. The same report content is assembled and formatted for printing and sent 
to the publisher for production and mailing.

2.2.7  Use case: Application integration
The employee workplace not only provides employees with up-to-date 
information and the means to communicate with other employees, but it also 
makes it easy to access any of the various human resources (HR), 
administrative, and business applications integrated into the system. In 
particular, the workplace makes it easier and enables employees to more 
effectively complete the tasks associated with these applications. This case 
describes such an interaction with an HR application.

The employee logs in to the employee workplace. The corporate headlines are 
displayed. One is a reminder that all employees intending to take vacation in the 
next quarter need to submit their vacation request to their supervisor by the end 
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of the week. The employee decides to request the vacation immediately before 
he forgets. He opens his personal calendar to check for the correct dates for the 
week he wants to take off. He marks the vacation in his calendar.

In order to make the vacation request, the employee accesses his personal HR 
information. The total vacation allotment for the year and vacation time taken is 
displayed. The employee selects the vacation request form, fills in the date and 
duration, and submits the request.

The following week, the supervisor logs in to the employee workplace and is 
reminded to process all vacation requests within three business days. The 
supervisor accesses the HR section of the workplace. This view is tailored for 
supervisors and provides access to some HR information for her employees, 
such as allotted vacation time and remaining days and years of service in 
addition to any HR requests, including vacation requests.

The supervisor reviews all outstanding requests for her employees. One 
employee has requested the same week as another employee with more 
seniority. Due to current business needs, only one employee is able to take 
vacation at any given time. The supervisor needs to consult with HR to determine 
how to resolve the conflict. Another employee has exceeded her vacation 
allotment with her request, so she rejects the request.

The supervisor does not recall her HR specialist's name because she is a recent 
replacement for the previous specialist who has retired. She searches the 
directory using the advanced search and enters “HR” in the job responsibility 
field. Several names are returned from the search, and she quickly locates the 
HR specialist for her organization.

She checks the current status of this person, but the specialist is not online; she 
must be at lunch. Instead, she easily creates an e-mail message addressed to 
the specialist and sends a brief note describing her vacation request problems. 
She then decides to have lunch herself and marks herself “away” from her desk.

The supervisor returns from lunch. She checks for new mail and finds a note 
from the HR specialist. She opens it and finds that the policy is to grant the 
request to the employee with the most service. She notices that the HR specialist 
is now online. She sends an instant message thanking the HR specialist for the 
quick response. She then returns to the list of outstanding vacation requests.

The supervisor activates an instant messaging session from the list of vacation 
requests for the employee whose request conflicts with the more senior 
employee's request. The supervisor advises the employee that she is rejecting 
his request and why. As she awaits a reply, she rejects the current request. 
Instead, she sends another message suggesting that the employee choose the 
week after the one originally requested. Not only will this resolve the conflict, but 
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that week has a statutory holiday which means one less vacation day is needed. 
The employee agrees to the change. Because the conflict is resolved, the 
supervisor approves the request made by her more senior employee.

2.3  Business processes
Business processes are critical to the smooth and consistent operation of an 
enterprise. More and more, enterprises are turning to IT solutions to help control 
business processes that are becoming more and more complex. Within the area 
of content and records management, business processes can help ensure the 
proper handling of content and compliance with business policies and 
regulations.

An important aspect of a business process can include the details of the 
interaction of business users with the content. Usually, this is known as work flow. 
Often work flow is determined by the process used to produce and manage the 
content. The following diagram (Figure 2-2 on page 25) shows a simplified 
research reporting process similar to the one described in the solution scenario 
in 2.2.1, “Use case: Analyst research reporting” on page 15. This is an 
activity-centric view of the document life cycle, from creation through review to 
publication of the document. Each activity is assigned to a particular role, and the 
document is assumed to flow through the process.
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Figure 2-2   Activity-centric view of document life cycle

The process documented in Figure 2-2 is simply an example process in the 
problem space of this solution. Other processes might need to include activities 
such as archiving or disposal of documents. For example, after a specified period 
of time, the original author would be notified to determine if the document is still 
up-to-date. If not, the author decides whether to archive the original and update 
to a new version or to dispose of the document. In addition, there might be 
regulations that stipulate the retention period and time when the document is to 
be destroyed. 

In general, documents and other content all follow a similar life cycle from 
creation (either by capturing or authoring the content) to eventual publication or 
distribution. The document is stored so that throughout its active life cycle, it is 
easily retrieved, viewed, and possibly modified to create new versions. 
Eventually, the document enters a predominantly inactive period where it is 
infrequently retrieved. The document might be archived during the latter part of 
its retention period and finally destroyed when it is no longer needed.

Alternatively, the process is viewed in a document-centric manner, as shown in 
Figure 2-3 on page 26.
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Figure 2-3   Document-centric view of life cycle

The emphasis in this case is on the state of the document rather than the flow or 
sequence of activities in the business surrounding the document. For each state, 
actions or activities that transition the document into another state are shown. 
Figure 2-3 shows the life cycle of an analyst research report as a state diagram.
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2.4  Summary
This chapter has described several use case scenarios dealing with the 
requirement for content and records management. In addition, it provided a brief 
look at business processes and how they apply to content and records 
management.

In the rest of this book, we describe an example of a partial solution to the issues 
described here. Our example focuses on one particular use case, that of the 
analyst research reporting, as described in 2.2.1, “Use case: Analyst research 
reporting” on page 15.

We chose this use case as our example, because it includes several key 
requirements and concepts that could be applied across several of the other use 
cases, while maintaining a scope that can be covered in the space available.

Although the solution that we describe is only a partial solution, it will help you to 
understand how various IBM products can be integrated to solve real content and 
record management problems.

The general design and implementation described in this book provide a proof of 
concept and proof of technology that can be used as a basis for designing and 
developing a production solution addressing your business requirements.

We provide step-by-step instructions for installing and configuring a runtime 
environment that can support our sample application. This environment is not 
trivial and it is not within the scope of this book to educate you about the details 
of each and every product involved. It is assumed that you will have experience 
or access to others with expertise dealing with the individual products and 
technologies. This book is intended to provide the information you need to create 
an environment and sample application that can take advantage of the 
integration of several products and technologies across multiple systems to 
address records and content management within the context of a business 
process.
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Part 2 Design and 
development

This part of the book addresses the design and development of a possible 
solution addressing some of the requirements described in the previous 
chapters.

Chapter 3, “Architectural decisions” on page 31, describes some of the 
architectural decisions that were made for our sample solution and introduces 
the products and environment that make up the solution.

Chapter 4, “Component design and development” on page 51, describes the 
components that needed to be designed for our sample solution. The source 
code for the various components is also available for download, as described in 
Appendix A, “Additional material” on page 367.

Chapter 5, “Development environment” on page 73, describes our development 
environment and how to set up a similar environment for your own use.

Part 2
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Chapter 3. Architectural decisions

This chapter is intended to provide a technical perspective for the architectural 
considerations explored for the evolution of the solution design.

The architectural decision detail included in this chapter documents important 
decisions (which implies that choices were available) about any aspect of the 
architecture, including the structure of the system, the provision and allocation of 
function, the contextual fitness of the system, and the adherence to standards.

The development of an architecture is understood partly through the record of 
the important decisions made during its development. A well-documented 
architecture includes its own justification and evaluation criteria for those places 
where choices seemed available. The justification and evaluation criteria might 
be recorded alongside the decision or, at least in part, by reference to more 
generally applicable principles, policies, and guidelines, which are found in other 
work products or in external references.

3
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3.1  Overview
Figure 3-1 provides a high-level view of the major components and layers of a 
complete solution. However, in this book, we focus on the implementation of a 
prototype for a solution that addresses a specific use case scenario. Still, the 
overall architecture applies even though the functions required for our scenario 
will put emphasis on some components more than others.

The following diagram shows the abstract logical subsystems that make up the 
solution architecture. Note that the terms component and subsystem are used 
interchangeably. Both terms refer to a non-trivial logical element of the 
architecture that encapsulates some behavior and exposes an interface.

Figure 3-1   High-level architectural view of a solution

In the case of our analyst reporting scenario sample application, we use IBM 
software products to provide the needed infrastructure and capabilities as 
described in this chapter.

The user interface is provided by IBM WebSphere Portal. This will provide a 
single Web browser-based user interface for all users.

IBM Tivoli Directory Server provides an LDAP interface for managing users, 
groups, and access control.
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Management of the content (reports) is handled through IBM DB2 Content 
Manager. 

Records management is enabled through IBM DB2 Records Manager, providing 
life-cycle management and auditing for the reports stored and accessed through 
DB2 Content Manager.

Finally, the business process (including the logic to ensure policy compliance) 
are controlled by IBM WebSphere Business Integration Server Foundation.

3.2  Solution component architectural concepts
This section describes the functional components of our solution. We refer to our 
solution as information life-cycle management (ILM). You will see the ILM 
acronym used throughout the rest of this book.

3.2.1  High-level solution overview
The primary components of the ILM solution have been architected to support 
the business requirements as outlined in 2.2.1, “Use case: Analyst research 
reporting” on page 15.

These business requirements have been consolidated into functional 
components, as illustrated in Figure 3-2 on page 34.
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Figure 3-2   Solution functional components

As illustrated in Figure 3-2, the business requirements are supported within the 
components shown in Table 3-1.

Table 3-1   Solution component definitions

Component Definition

Users � System administrators 
– Define document types based on descriptions provided by 

employees.
– Define types of business information to be presented 

seamlessly in the workplace user interface and assign a 
format for presenting the information and form for editing each 
type. 

– Monitor and maintain the solution.
– Handle solution exceptions and carry out problem 

determination on reported errors. 
– Restore operation of the solution in the event of failure. 
– Perform routine backups of all information and records in the 

solution.
– Restore information to the solution in the event of catastrophic 

failure. 
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� End users 
– View corporate policies, procedures, and other business 

information. 
– Communicate and collaborate with other employees to 

produce work products and execute business processes. 
– Submit business requests. With proper authority, review and 

approve business requests by other employees. 
– Define life cycles and associate with different types of 

business information. Definitions include criteria such as 
retention period.

– Modify life cycles as needed.
– Track business information throughout the life cycle and 

handle exceptional situations such as absence of approver, 
need to temporarily suspend or the reactivate life cycle, or in 
certain cases, to terminate the life cycle. 

– Author documents using the solution and submit them for 
review and approval. 

– Review documents authored by other employees, as 
requested. 

– Request a new document or assign document creation to 
another employee. 

– Approve documents according to document life cycle. 
– Contribute and preview business information intended for 

seamless publication to the workplace user interface. 
– Review and approve business information as requested, 

according to its life cycle. 
– Schedule and attend Web conferences. Share documents with 

other employees.

LDAP security Provides single sign-on (SSO) across all nodes. LDAP security 
contains all solution users and provides a detailed directory entry for 
each employee.

Portal The portal supports the shared work area feature and provides users 
with document management capabilities. With this feature, users 
create, edit, check in, check out, review, approve, share, and publish 
documents. Documents are automatically versioned when the 
document is saved to the shared work area. 
The portal also provides access control to the documents to ensure 
only those with the proper authority can view or modify documents. 

User 
management

The repository for identification and management of end users. The 
LDAP administrator uses the repository (along with a common user 
interface) to create and manage user information.

Business 
integration

An adaptable infrastructure that makes it easy to update or enhance 
the solution to meet changing business requirements.

Component Definition 
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3.2.2  User roles and work flow
When designing a solution, the user or users of the solution should be a primary 
consideration. That is, we need to understand the roles of the various users and 
what functions each will need to perform and how they will interact with the 
solution. With this in mind, we define the follow terms:

User An employee with access to use ILM is referred to as 
an ILM user.

Shared work area A virtual space that is shared by a collection of ILM 
users working together on a common project. 
Employees having access to the shared work area can 
work with documents and participate in forums 
associated with the work project. 

Process 
activities

Invocation of service presented either through automated process or 
human intervention.

Content 
management

A comprehensive framework for creating, capturing, managing, and 
distributing unstructured content.

Report data The repository for indexing, processing, and managing solution data 
and metadata.

Item types The high-level index component for definition of a data type. As an 
example, data types are associated with specific sources, formats, or 
functions, or all of these. For example, a report might be assigned one 
item type, while an insurance claim might be assigned another.

Attributes Attributes are assigned to item types to capture the required and 
optional metadata information about the data. 

Record 
management

A process for assigning and maintaining retention policy information to 
specific information assets. Modern usage of records management 
usually refers to electronic records management automation. 
However, the discipline of records management has been long 
established within regulated industries across the globe.

Record data As content moves into the retention period of its life cycle, it becomes 
a record. This milestone automatically controls the retention of 
associated records for the specified period and the destruction of the 
related content at the end of the period.

File plan Association of records to a structured data model. 

Life cycle Record life cycles are supported for each record type and controlled 
by assigning an approved process as each new record is created. 

Component Definition 
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Supervisor The supervisor user role is responsible for invoking the 
process and receiving, reviewing, and approving the 
work products of the process.

Analyst The analyst user role is responsible for accepting the 
assignment, creating the report, and submitting the 
report for review.

Records administrator The records administrator user role is responsible for 
the integrity of the records management system and 
can perform audits and other related tasks.

All user roles are provided with access to view reports and records.

3.2.3  Security
Maintaining the confidentiality of the business information and restricting access 
to business processes is a primary concern that should be taken into account for 
the solution. 

Single sign-on
Users accessing the non-public portion of the system will be challenged to prove 
their identity once per session. An authenticated user is able to access the 
information and applications and perform business processes (according to 
access rights) without providing additional verification of identity. A session can 
be ended at the user’s request or it can be ended by the system based on the 
elapsed time of the session, a non-responsive client, or other criteria as deemed 
necessary to maintain the integrity of the system’s security.

Ease of security administration
Managing a very large number of user identities, passwords, access rights, 
expiration dates, and so on is difficult. When a security administration task is 
overlooked or performed incorrectly, the system might be exposed to attack. The 
system is designed and configured to facilitate the job of administering the 
system’s security aspects (to make the security administrator’s job easier and 
less error prone). The security administrator is able to manage all access control 
policies from a central location. Rather than managing duplicate identities for a 
single user of several applications, all applications are configured to recognize 
shared credentials.

3.2.4  Portal
Our solution uses IBM WebSphere Portal to drive the user interface for our 
application. In this section, we describe some key concepts related to the user 
interface.
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Shared workplace
The solution provides a single application user interface that provides access to a 
variety of business services and applications The solution workplace appears to 
the user as a single application with a consistent look and feel across the 
underlying services and applications.

Although the workplace user interface is aggregated from a variety of sources, 
the parts of the user interface are well integrated to give it the appearance of a 
single application. 

The user interface is also designed to support further development for access 
from a variety of devices, including desktops, Web-enabled cell phones, and 
hand-held devices. However, our proof-of-concept solution is only enabled for 
desktop access.

User management
All portal applications are secured for access by registered and authorized LDAP 
users only.

The user management repository is enabled as a component of the Portal node. 
However, the deployment of any LDAP (or other) common directory service can 
be easily supported from a distributed source. 

Centralized management of the user repository is provided external to the 
solution portal interface. The security administrator is provided with access to the 
IBM Tivoli Directory Server Web Administration Tool for user directory 
management.

3.2.5  Business integration
The solution provides a Business Process Execution Language (BPEL) standard 
integration layer using the WebSphere Business Integration Server Foundation 
process choreographer. This interface enables the solution to combine business 
processes with Java 2 Platform, Enterprise Edition (J2EE) services deployed 
within the WebSphere Application Server Enterprise process choreographer, 
scripting enterprise beans to define the solution work-flow processes.

Process activities
Process activities are derived from the business process model. The business 
process model is directly related to use case scenario previously referenced in 
this chapter. Process choreographer activities define the synchronous 
relationships for each step within the business process model. High-level process 
activities have been developed to support report creation, report approval, and 
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report rework. Each of these process activities include human intervention and 
system-automated activities.

Figure 3-3 provides a view of all process activities required and provided within 
the solution. 

Figure 3-3   Business integration activity model
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3.2.6  Content and records management
The content management component is key to this solution. This component 
addresses the requirements for accurate containment and management of the 
data and metadata from the time a report is requested until the retention life cycle 
is exhausted. 

Report data
The report data is contained within a content management data model. This data 
model consists of features to secure the records, constrain record updates, 
identify the report format, categorize the report, and capture specific required 
and optional data about the report. The report data is cataloged within a library 
server and stored within a resource management server. Figure 3-4 illustrates 
the report data model.

Figure 3-4   DB2 Content Manager data model

Some attributes, as indicated in Figure 3-4, are included specifically for the 
integration of IBM DB2 Records Manager. 
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3.3  Information life-cycle management solution
This section explains the major features and components of the application. We 
divide the discussion into the following two sections:

� Solution description

� Solution components

3.3.1  Solution description
This section describes the high-level overview of the developed solution for our 
information life-cycle management sample application. The overall flow of the 
application enables the users to work with report creation and manage 
information during the life cycle of the reports. 

The solution consists of the following components:

� Report life-cycle management

� Report repository search and manipulation application

� Audit information application

Report life-cycle management is the primary flow of the application, as shown in 
Figure 3-5 on page 42.

Note: As previously mentioned, this ILM solution is a partial solution for the 
analyst reporting use case described previously. Figure 3-5 represents the 
basic business process functions enabled by our implementation of the ILM 
solution.
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Figure 3-5   High-level flow of application

As shown in Figure 3-5, there are two user roles for the application, the 
supervisor and analyst:

� The supervisor creates or initiates requests for report creation and then 
approves or rejects the report when it is finished.

� The analyst is responsible for creating the report.

An extremely important role, although not shown in the figure, is that of the 
records administrator. This role is responsible for performing audits and ensuring 
the overall integrity of the records management process.

Create report request

Supervisor Analyst

Self-assign report request

Create report

Complete request and 
assign report in it

Request for approval

Self-assign report approval 
request

Approve request
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3.3.2  Solution components
The application is hosted on a WebSphere Portal server. All user access is 
performed with the WebSphere Portal server using a Web browser. The front-end 
portions of the application are arranged into separate portal pages with various 
portlets assigned to them. Figure 3-6 shows the organization of the pages that 
we use.

Figure 3-6   Portlet pages organization

The primary menu, seen through a Web browser showing the high-level tasks, 
can be seen in the WebSphere Portal page shown in Figure 3-7 on page 44.

ITSO Sample

ILM Tasks

ILM Reports

ILM Records

ILM Audit

ILM – Create Assignment Portlet

ILM – Analyst Report Tasks Portlet

ILM – Document Details portlet

ILM – All Documents portlet

ILM – Published Reports portlet

ILM – Records Admin

ILM – Records Search portlet

ILM – Audit Search

ILM – Audit Result
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Figure 3-7   WebSphere Portal page

Table 3-2 lists the individual portlets that will be created and their functions.

Table 3-2   Portlets and their functions

Portlet Function

CreateAssignment This portlet is used by a supervisor to create a new report 
creation activity (report request).

AnalystReportTasks This is a list of unassigned report activities. For the 
analyst, this list represents the newly created report 
requests or rejected reports; while for supervisors, this list 
represents the completed activity waiting for approval.

DocumentDetails This portlet shows the content details of the report that is 
selected in the All Documents portlet.

AllDocuments This portlet lists all reports that are created by the user.

PublishedReports This portlet shows all published reports or content of a 
specific report when it is selected from the list.

RecordsAdmin This portlet allows manipulation of a single record from 
the record management system. The record here is the 
report document ID shown in the All Documents list.

RecordsSearch This portlet enables searching and listing a set of records 
from the record management tools.

AuditSearch This portlet enables searching of specific audit 
information from the record management tools.

AuditResult This portlet displays the result of the AuditSearch portlet.
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In 3.4, “Planning and solution deployment topology” on page 45, we describe and 
explain the physical topology on which our solution will be deployed. Here, as 
shown in Figure 3-8, you can see how these portlets communicate to back-end 
servers. The communications are performed using IIOP protocol between IBM 
WebSphere Application Server processes.

Figure 3-8   Server communication

3.3.3  Process choreography components
As shown in Figure 3-8, the Business Integration node (ilm-bi) runs a module 
called ReportApproval.ear. This is a J2EE enterprise application module that 
drives the report approval process. The report approval provides the process 
choreography to ensure that the business process is adhered to and the proper 
steps are taken before a report is published and throughout its life cycle. The 
logic implemented through the other modules already discussed, such as the 
portals, are choreographed by this module to ensure that steps are taken and 
completed in the proper order.

3.4  Planning and solution deployment topology
This section describes the solution nodes used to deploy the ILM proof of 
technology. Along with a description for the chosen topologies, this section 
describes the software packages and levels implemented.

ilm-ui
WebSphere Portal 

Server

ilm-cm
DB2 Content Manager

ilm-bi
Business Process

ilm-rm
DB2 Records 

Manager

BPEContainer_ilm-bi_server1
BPEWebClient_ilm-bi_server1

ReportApprovalEAR

IBM DB2 Records Manager
Records Manager WebServices

IRMClientEAR
RMECMRemoteHost

icmrm
PortalToCMEAR

AuditAdmin
New ReportCU
RecordsAdmin

ReportTasksPortlets
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3.4.1  Solution topology
The runtime environment implementation topology (as illustrated in Figure 3-9) 
was chosen to optimize distributed workload and to ensure compliance for 
software package version and fix pack level support.

Figure 3-9   Sample solution architectural topology

As shown in Figure 3-9, the complete topology includes four server nodes. These 
nodes are defined as:

� Portal node: Authentication, presentation, and solution administration (node 
name ilm-ui)

� Content Management node: Record repository (node name ilm-cm)

� Records Management node: Retention policy assignment and management 
(node name ilm-rm)

 

 

 

 

46 Records Management and Process Choreography



� Business Integration node: Process choreography runtime (node name ilm-bi)

3.4.2  Node prerequisites
For information about specific product requirements, installation, and 
configuration, refer to the IBM product guides located at the following Web sites:

� DB2 UDB for UNIX® and Microsoft Windows® library

http://www.ibm.com/software/data/db2/udb/support/manualsv8.html

� WebSphere technical library

http://www.ibm.com/software/websphere/technical/

� DB2 Content Manager for Multiplatforms library

http://www.ibm.com/software/data/cm/cmgr/mp/library.html

Hardware platforms used for this solution
We used the following hardware configurations in the ILM solution proof of 
technology:

� Portal node

IBM ThinkCentre™ M50

– 1 CPU, Intel® Pentium® IV 3.0 GHz

– 1024 MB main memory

– 76 GB DASD

� Content Management node

IBM NetVista™ R8U

– 1 CPU, Intel Pentium IV 2.4 GHz

– 1524 MB main memory

– 36 GB DASD

� Records Management node

IBM NetVista R8U

– 1 CPU, Intel Pentium IV 2.4 GHz

– 1524 MB main memory

– 36 GB DASD

� Business Integration node

IBM ThinkCentre M50

– 1 CPU, Intel Pentium 3.0 GHz
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– 2000 GB main memory

– 76 GB DASD

Software platforms used for this solution
At the time of this writing, the software platforms and product levels shown in 
Table 3-3 through Table 3-6 on page 49 were determined to be the most current 
available levels consistent with IBM product support.

Table 3-3   Portal node software details

Table 3-4   Business Integration node software details 

Table 3-5   Content Management node software details

Vendor Product name Version Fix pack level

IBM DB2 Enterprise Server Edition 8.1.4.428

IBM Global Security Toolkit (GSKit) 7.0.1.16

IBM HTTP Server 1.3.26.2

IBM Tivoli Directory Client 5.2

IBM Tivoli Directory Server 5.2

IBM Tivoli Directory Server Web 
Administration

5.2

IBM WebSphere Application Server 
Enterprise Edition

5.0.2.3

IBM WebSphere Portal for 
Multiplatforms

5.0.2.1

Microsoft Windows 2000 server 4.0 4

Vendor Product name Version Fix pack level

IBM WebSphere Business Integration 
Server Foundation

5.1.1

Microsoft Windows 2000 Server 4.0 4

Vendor Product name Version Fix pack level

IBM DB2 Content Manager Client for 
Windows

8.2.6 6

IBM DB2 Content Manager eClient 8.2.6 6

 

 

 

 

48 Records Management and Process Choreography



Table 3-6   Records Management node software details

Software downloads from IBM
In addition to the software included with IBM WebSphere Portal Extend for 
Multiplatforms V5.0.2 and IBM DB2 Content Manager for Multiplatforms V8.2, the 
installation procedures found in this chapter provide instructions about how to 

IBM DB2 Content Manager Library 
Server

8.2.6 6

IBM DB2 Content Manager Resource 
Manager

8.2.6 6

IBM DB2 Enterprise Integration Portal 8.2.6 6

IBM DB2 Enterprise Server Edition 8.1.4.428 4a

IBM HTTP Server 1.3.26.2

IBM Net Search Extender 8.1.4

IBM DB2 Records Manager Enabler 3.1.2

IBM WebSphere Application Server 
Enterprise Edition

5.0.2

Microsoft MSXML Parser 4.0

Microsoft SOAP Toolkit 3.0

Microsoft Visual C++ 6.0

Microsoft Windows 2000 Server 4.0 4

Vendor Product name Version Fix pack level

IBM DB2 Content Manager Client for 
Windows

8.2.6 6

IBM DB2 Enterprise Integration Portal 8.2.6 6

IBM DB2 Enterprise Server Edition 8.1.4.428 4a

IBM HTTP Server 1.3.26.2

IBM DB2 Records Manager Enabler 3.1.2

IBM WebSphere Application Server 
Standard

5.0.2

Microsoft Windows 2000 Server 4.0 4

Vendor Product name Version Fix pack level 
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download and install more recent fix packs and fixes for WebSphere Portal and 
DB2 Content Manager than are included in the CD distributions.

Software installation paths
Table 3-7 lists the software installation paths used to implement the Portal node 
and Content Management node. We chose to use short names for the paths to 
reduce the number of characters included in the Windows environment PATH and 
CLASSPATH variables. In addition, this can avoid problems with spaces in the 
path on the Content Management node. Lastly, we shortened the paths for easier 
access from the command line.

Table 3-7   Software installation paths

3.5  Summary
This chapter has provided a high-level view of the architecture and products 
involved in the ILM solution. In the next chapter, we describe the design and 
development of the portlets and other components required for the solution.

Software package System path

DB2 Content Manager Client C:\IBM\CMclient\

DB2 Content Manager eClient C:\IBM\eClient\

DB2 Content Manager Library Server C:\IBM\CM\

DB2 Content Manager Resource 
Manager

C:\IBM\CM\

DB2 Enterprise Information Portal (EIP) C:\IBM\EIP

DB2 UDB C:\IBM\SQLLIB\

DB2 Records Manager C:\IBM\RecordsManager\

IBM HTTP Server C:\IBM\HTTPServer\

DB2 Records Manager Enabler C:\IBM\RMenabler\

Tivoli Directory Server C:\IBM\TDS\

WebSphere Application Server C:\IBM\WebSphere\AppServer\

WebSphere Portal C:\IBM\WebSphere\PortalServer\
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Chapter 4. Component design and 
development

This chapter provides a description of the high-level component design of the 
information life-cycle management (ILM) solution concept. The contents of this 
chapter provide the resulting component design, as described in Chapter 3, 
“Architectural decisions” on page 31.

In this chapter, we describe the architectural components, system constraints, 
and subsystem interactions.

4
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4.1  Solution technology
This section provides a brief overview of the technology and components that 
make up the solution. We divide the discussion into:

� Portlet application concepts

� Enterprise JavaBeans (EJB) concepts

4.1.1  Portlet application concepts
A portlet application is a Java-based application running on a WebSphere Portal 
server engine. Users interact with portlets through a Web browser. Each portlet 
occupies an area in the Web browser window that acts much like a standard 
application window on your desktop. A portlet is typically implemented as shown 
in Figure 4-1.

Figure 4-1   Portlet structure

As shown in Figure 4-1, the components of a portlet are:

Portlet class This is the main application code that the portlet runs on 
the portal server.

JSP code This is the actual JavaServer Page (JSP) code that will 
generate the HTML to render how the portlet will look 
when viewed in a browser.

View bean A Java bean that contains information passed from the 
portlet to the JavaServer Page. There is typically a view 
bean created for each page render request.

Portlet.class
PortletPortlet

JSP code

View 
Bean

Session Bean
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Session bean A Java bean that contains session information about the 
portlet, including portlet state, persistent connection 
information, environment variables, and other information 
that needs to be preserved across page displays.

For the portlet itself, the main structure of a portlet Java class code is shown in 
Figure 4-2.

Figure 4-2   Portlet code structure

As shown in Figure 4-2, a portlet Java class is subclassed from the 
PortletAdapter class and handles events. Events are handled using an interface 
such as ActionListener or MessageListener. An ActionListener interface typically 
listens to button actions or other actions associated with the user interface, while 
a MessageListener interface receives messages from other portlets.

The portlet has the following attributes:

JSP names The JSP files are defined as static final variables, such as 
VIEW_JSP. This will be called in the doView method using 
a call such as:
getPortletConfig().getContext().include(VIEW_JSP), 
request,reponse)

View bean This is the bean class name of the view bean.

Session bean This is the bean class name of the session bean.

Action strings These are string attributes that indicate specific actions 
that can be invoked from the portlet.

Portlet.java 
extends PortletAdapter 

implements ActionListener

static final String VIEW_JSP
static final String VIEW_BEAN
static final String SESSION_BEAN

static final String FORM_ACTION

public void init(PortletConfig)
public void doView(PortletRequest, PortletResponse)
public void actionPerformed(ActionEvent)
private SessionBean getSessionBean(PortletRequest)
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The portlet has the following primary methods that must be implemented:

init This method is called to initialize the portlet.

doView This method is called every time the portlet’s Web page is 
reloaded.

actionPerformed This method defined by the ActionListener interface. It is 
called when an action button is selected.

getSessionBean This method is called to request a reference to a session 
bean, typically from the doView method.

Let us discuss these methods in more detail.

Initializing the portlet
The initialization of the portlet is typically very simple; it just calls the superclass 
initialization. You can also include any other initialization logic that you might 
require. Example 4-1 shows sample initialization method code.

Example 4-1   Sample init method

public void init(PortletConfig portletConfig) throws UnavailableException {
super.init(portletConfig);
// your initialization code can go here

}

Getting the session bean
Session beans contain the persistent storage for the portlet during a session. 
Example 4-2 shows sample code.

Example 4-2   Sample getSessionBean method

private PortletSessionBean getSessionBean(PortletRequest request) 
throws Exception {

PortletSession session = request.getPortletSession();
if (session == null) return null
PortletSessionBean sessionBean = 

(PortletSessionBean)session.getAttribute(SESSION_BEAN);
if (sessionBean == null) {

sessionBean = new PortletSessionBean();
session.setAttribute(SESSION_BEAN, sessionBean);

}
return sessionBean;

}

As shown in Example 4-2, the logic is as follows:

1. Get the current portlet session.
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2. If there is no portlet session, return a null object.

3. From the portlet session object, the session bean is stored in the 
SESSION_BEAN attribute.

4. If the SESSION_BEAN attribute is null, that means that the session bean has 
not been created. Create a new session bean and assign it to the 
SESSION_BEAN attribute.

5. Return the session bean.

A session bean conforms to the JavaBeans specifications. It is a Java class that 
supports an easily reused component model. It supports a set of properties and 
events, along with the methods to get and set properties and to trigger events. In 
the portlet environment, we typically care only about the properties of a bean as 
a means to store information. Example 4-3 shows a typical session bean 
implementation with one property called state.

Example 4-3   Sample session bean

public class PortletSessionBean {
private String state;

public PortletSessionBean() 
throws NamingException, RemoteException, CreateException {

state = new String(“INITIAL”);
}

public String getState() { return state; }
public void setState(String s) { state = s; }

}

In Example 4-3, the constructor of the session bean typically provides 
initialization values for the properties. Each property (except read-only 
properties) has get and set methods associated with it. All property manipulation 
must be performed through these methods, thus the private attribute of the 
property itself.

Displaying the portlet
When a page containing the portlet is displayed, refreshed, or updated, the 
doView method is called. Example 4-4 on page 56 shows the typical logic of this 
method.
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Example 4-4   Sample doView method

public void doView(PortletRequest request, PortletResponse response) 
throws PortletException IOException {

PortletSessionBean sessionBean = getSessionBean();
if (sessionBean==null) {

response.getWriter.println(“<B>No Portlet session</B>”);
return;

}
PortletViewBean viewBean = new PortletViewBean();
request.setAttribute(VIEW_BEAN, viewBean);
viewBean.setAttr1(“My Test Value”);
// include any other logic affecting the view
getPortletConfig().getContext().include(VIEW_JSP, request, response);

}

As shown in Example 4-4, the portlet’s doView method contains the following 
logic:

1. Establish the session bean. If the session bean is null, it means that the portal 
is not initialized. See “Getting the session bean” on page 54.

2. Create a new view bean to be passed to the JSP through the request object. 
Set the attributes of the view bean to the values that you want passed to the 
the JSP.

3. Load the JSP.

Similar to the session bean, the view bean is also a JavaBeans-compliant object. 
It typically contains a set of properties and the get and set methods to manipulate 
them.

The JSP will access the view bean to access attributes and data that will be used 
to render the HTML for the page.

Rendering the page
The page display of a portlet is performed using a JavaServer Page (JSP). It is 
typically an HTML file that has Java code interleaved in the comments. The Java 
code in the JSP can call the request object to access the session bean and the 
view bean of the portlet. A JSP does not have access to the portlet itself, only the 
bean objects.

A sample JSP that shows a message (including the value of attribute) and an OK 
button is shown in Example 4-5 on page 57.
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Example 4-5   Sample JSP code

<%@ page session="false" contentType="text/html" import="java.util.*"%>
<%@ taglib uri="/WEB-INF/tld/portlet.tld" prefix="portletAPI" %>
<portletAPI:init/>

<%
PortletViewBean viewBean =

(PortletViewBean)portletRequest.getAttribute(Portlet.VIEW_BEAN);
%>

<DIV style="margin: 12px; margin-bottom: 36px">
<CENTER>
<b> Hello world. </b> The value of Attr1 is: <% =viewBean.getAttr1()%>
<FORM method="POST" action="FORM_ACTION1">
    <INPUT class="wpsButtonText" name="OkButton" value="OK" type="submit"/>
</FORM>

</CENTER>
</DIV>

The JSP code in Example 4-5, along with the portlet methods such as that 
shown in Example 4-4 on page 56, will render the content in a portlet area of a 
Web page. Figure 4-3 shows the content.

Figure 4-3   Hello World portlet content 

Running an action
An action is triggered when a user clicks a link or a button. This invokes the 
actionPerformed method. The action is sent in the actionEvent object. You can 
retrieve the action text using the getActionString method.

Example 4-6 on page 58 shows a typical actionPerformed method.

Note: Although the structure and behavior is similar to the ActionListener 
interface from the Java Swing specification, the implementation is different. 
There are some important differences in the behavior of these two 
ActionListener classes.
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Example 4-6   Sample actionPerfomed method

public void actionPerformed (ActionEvent event) throws PortletException {
String actionString = event.getActionString();
PortletSessionBean sessionBean = getSessionBean(event.getRequest());

if (actionString.equals(FORM_ACTION1)) {
// run some actions 

} else if (actionString.equals(FORM_ACTION2) {
// run other actions

} else {
}

}

As seen in Example 4-6, the actionPerformed method usually deals with the 
action string and the session bean. Based on these two objects, you can decide 
what action to take within the logic of the method.

4.1.2  Enterprise JavaBeans (EJB) concepts
Enterprise JavaBeans (EJB) enable the creation and access of a remote Java 
bean running on another J2EE server through an Internet Inter-ORB Protocol 
(IIOP) or Java Remote Method Invocation (RMI) interface. The mechanism is 
typically invoked by creating a request client locally that communicates with a 
remote EJB server. Figure 4-4 shows this mechanism.

Figure 4-4   Enterprise JavaBean concept

A typical code snippet to establish a connection is shown in Example 4-7 on 
page 59.

WebSphere Application 
Server

WebSphere Application Server

Remote Interface

EJB1

Home Interface

Remote Interface

Home Interface

EJB2

Client

Client

Client

Client

Client
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Example 4-7   Code for connecting to a remote EJB

Properties  env = new Properties() ;
env.put(javax.naming.Context.PROVIDER_URL,"iiop://EJBserver");
env.put(javax.naming.Context.INITIAL_CONTEXT_FACTORY,

"com.ibm.websphere.naming.WsnInitialContextFactory");
InitialContext ctx = new InitialContext(env) ;
Object obj = ctx.lookup("ejb/com/ibm/EJBObjHome");
EJBObjHome lHome;
lHome = (EJBObjHome) PortableRemoteObject.narrow(obj,EJBObjHome.class);
EJBObj ejb = lHome.create();
ejb.init();

As shown in Example 4-7, the logic is as follows:

1. Create an environment with the target EJB server and context factory. For 
WebSphere, com.ibm.websphere.naming.WsnInitialContextFactory is the 
context factory for an EJB.

2. Create an initial access context using the environment. The context is used to 
locate the home object for the EJB.

3. When the home object is allocated through the network, the local EJB client is 
created and initialized for use.

Subsequent calls to the EJB object can then be performed to access the remote 
EJB application.

DB2 Content Manager interface
The DB2 Content Manager interface (Content Manager for short) is implemented 
using the PortalToCM EJB application. The source for this EJB implementation is 
the sample ILM application available for download. Authentication to the 
back-end WebSphere Application Server is performed using the Common 
Security Interoperability (CSI) authentication protocol as defined by the Object 
Management Group (OMG).

The code in the following Java files use the EJB interface to DB2 Content 
Manager:

� From the New ReportCU project:

– DocumentDetailsSessionBean.java
– AllDocumentsSessionBean.java
– PublishedDocumentsSessionBean.java

� From the ReportTasksPortlets project: ContentManagerModule.java
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Business Integration interface
The Business Integration interface is implemented using the BusinessProcess 
EJB application. Authentication to the back-end WebSphere Application Server is 
performed using CSI.

The BusinessProcessModule.java code in the ReportsTasksPortlets project uses 
the EJB interface to the process choreographer.

DB2 Records Manager interface
The DB2 Records Manager interface (Records Manager for short) is 
implemented using the standard Records Manager API. The mechanism to 
access the Records Manager facility has additional steps to invoke a login object 
after acquiring the home object.

A code snippet handling the Records Manager login is shown in Example 4-8.

Example 4-8   Records Manager EJB interface

Properties env = new Properties();
env.put(Context.PROVIDER_URL, "iiop://ilm-rm.itsc.austin.ibm.com”);
InitialContext ctx = new InitialContext(env);
Object obj = ctx.lookup("recordmanager/ejb/facade/LoginManagerEJB");
LoginManagerEJBHome lHome = (LoginManagerEJBHome) 

PortableRemoteObject.narrow(obj, LoginManagerEJBHome.class);
LoginManagerEJB lEJB = lHome.create();
ClientControllerEJB client = lEJB.login("ICMADMIN",

"password",
"recordmanager/jdbc/db2/RecMan", 
"", "en");

Because of the requirement of using a user ID and password in the API, we 
chose to store the user ID and password in a properties file. This file in the 
module is accessed and stored using the RMInfo Java class.

The code in the following Java files use the interface to DB2 Records Manager:

� From the RecordsAdmin project: RecordsSearchPortlet.java

� From the AuditAdmin project: AuditResult.java

Note: Source code modules such as those just described are available for 
download as described in Appendix A, “Additional material” on page 367. We 
provide descriptions of each of these modules in later sections of this chapter 
and details about using these modules within your development environment 
are described in Chapter 5, “Development environment” on page 73.
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4.2  Solution details
This section describes the specific modules that we created for the sample ILM 
solution. We do not explain the source code for each module in detail. Most of the 
source logic is relatively straightforward Java code, and it is expected that you 
can follow the logic by looking at the source. The WebSphere Studio Application 
Developer window in Figure 4-5 shows the various modules in the Project 
Navigator frame.

Figure 4-5   WebSphere Studio Application Developer window

The sample application is mainly implemented with the modules shown in 
Table 4-1 on page 62.

 

 

 

 

 Chapter 4. Component design and development 61



Table 4-1   Modules used to implement sample application

Now, let us discuss each of these modules in more detail.

4.2.1  AuditAdmin portlet
The AuditAdmin portlet object deals with the auditing records in Records 
Manager. Figure 4-6 on page 63 shows the overall content of the project.

Project name Type Content

AuditAdmin Portlet AuditSearch
AuditResult

New ReportCU Portlet DocumentDetails
AllDocuments
PublishedReports

RecordsAdmin Portlet RecordsAdmin
RecordsSearch

ReportTasksPortlet Portlet CreateAssignment
AnalystReportTasks

PortalToCM EJB EJB for IIOP interface to DB2 
Content Manager

PortalToCMEAR J2EE Deployment descriptor

ReportApproval EJB Report approval process definition

ReportApprovalEJB EJB EJB for ReportApproval

ReportApprovalEAR J2EE Deployment descriptor

ReportApprovalWeb War Web page that will host portlets
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Figure 4-6   Content of the AuditAdmin project

Figure 4-7 on page 64 shows the audit record search page.

AuditResult
AuditResultViewBean

AuditResultSessionBean
AuditRsult.jspILM – Audit Result

AuditSearch
AuditSearchViewBean

AuditSearchSessionBean
AuditSrch.jspILM – Audit Search

RMInfo
Connect to EJB in RM 

server
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Figure 4-7   ILM - Audit page

AuditSearch portlet
The AuditSearch portlet provides an entry form for search arguments to the DB2 
Records Manager audit entries. When a user clicks the Submit button, a query 
string is constructed and sent to the AuditResult portlet. 

AuditResult portlet
Upon receiving a message from the AuditSearch portlet, the AuditResult portlet 
invokes the clientConnectorEJB to access DB2 Records Manager. The search 
result is then put into the view bean and displayed as a table with AuditRsult.jsp.

4.2.2  New ReportCU project
The New ReportCU project deals with report creation and listing. It has the 
primary components shown in Figure 4-8 on page 65.
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Figure 4-8   Content of the New ReportCU project

The display of the ILM - Reports page is shown in Figure 4-9. The report page 
shown, only contains a single report, but more typically this page would shown 
many reports.

Figure 4-9   ILM - Reports page

When a document is selected from the AllDocuments portlet, the 
DocumentDetails portlet looks similar to the one shown in Figure 4-10 on 
page 66.

AllDocuments
AllDocumentsViewBean

AllDocumentsSessionBean
MyDocuments.jspILM – All Documents portlet

DocumentDetails
DocumentDetailsViewBean

DocumentDetailsSessionBean
ReportDetails.jspILM – Document Details 

portlet

PublishedReports
PublishedDocumentsViewBean

PublishedDocumentsSessionBean

PublishedDocs.jsp
DocumentContent.jsp

ILM – Published Reports 
portlet

PortalToCM
EJB communication to 

Content Manager
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Figure 4-10   ILM - Document Details portlet

PublishedReport portlet
The PublishedReport portlet displays the list of reports from DB2 Content 
Manager that has been published. When you select the record ID of the report, 
the portlet switches to a DocumentDetails portlet view that shows the content of 
the report.

AllDocuments portlet
The AllDocuments portlet searches DB2 Content Manager for draft reports that 
are owned by the logged-in user ID. It shows the result in a tabular format using 
MyDocuments.jsp. You can either create a new report that stores a new entry in 
DB2 Content Manager or select an existing report. 

Selecting an existing report sends a message to the DocumentDetails portlet to 
show the title and body of the report.

DocumentDetails portlet
The DocumentDetails portlet displays the title and body of a report document. 
There are two supported actions, update of title and update of body. 

4.2.3  RecordsAdmin project
The RecordsAdmin project manages records from DB2 Records Manager. 
Figure 4-11 on page 67 shows its contents.
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Figure 4-11   Content of the RecordsAdmin project

Figure 4-12 shows the display page for the record administration.

Figure 4-12   Record manipulation portlets

RecordsSearchPortlet
RecordsSearchPortletViewBean

RecordsSearchPortletSessionBean

RecordsSearch.jsp
RecordsResult.jspILM – Records search

RecordsAdminPortlet
RecordsAdminPortletViewBean

RecordsAdminPortletSessionBean

RecordsAdminPortletView.jsp
RecSuspendPortletView,jsp

RecUnsuspendPortletView.jsp
RecTransitionPortletView.jsp

ILM – Records Admin

RMInfo
EJB connection to Record 

Manager
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RecordsSearch portlet
When a query has been submitted, the RecordsSearch portlet lists the reports in 
a tabular format, as shown in Figure 4-13. (The layout and contents of the portlet 
as shown in the figure could be improved for readability and easier usage. Our 
goal is to show the basic concepts of how records information can be displayed 
in a portal, not to spend time on portlet interface and content design.)

Figure 4-13   Records search result

The record title corresponds to the report ID field shown in Figure 4-9 on 
page 65. When a record is selected, a message is sent to the RecordsAdmin 
portlet to display it.

RecordsAdmin portlet
Figure 4-14 on page 69 shows the display of a record.
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Figure 4-14   Records Admin display

In this portlet, you can open the details of a record, suspend or unsuspend a 
record, and perform a transition of a record.

4.2.4  ReportTasks portlet
The ReportTasks portlet provides the content of the ILM - Tasks page. The 
functional content of the project is shown in Figure 4-15.

Figure 4-15   Contents of the ReportTasksPortlet project

The Web page interface of the tasks is shown in Figure 4-16 on page 70.

ReportTasksPortlet
ReportTasksPortletViewBean

ReportTasksPortletSessionBean

ReportTasksPortletViewWorkItem.jsp
ReportTasksPortletViewDocuments.jsp
ReportTasksPortletViewRejection.jsp

ReportTasksPortletError.jsp
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ILM – Analyst Report Tasks
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Figure 4-16   ILM - Tasks page

Create Assignment portlet
This portlet creates a new assignment process in the process choreographer. It 
then shows a message indicating the result, whether the creation is successful or 
not.

Analyst ReportTasks portlet
Over the life cycle of the assignment, the entry is shown in the work queue in this 
portlet. You can take an unassigned activity or work on an activity that you have 
self-assigned. 

This portlet also enables you to complete an activity. Depending on your role, you 
can:

� An an analyst, correlate a report to the activity 

� An a supervisor, approve or reject the report activity
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4.2.5  PortalToCM project
The PortalToCM project is an EJB project. This and the associated enterprise 
archive (EAR) project called PortalToCMEAR make up the application to be 
deployed to the Content Management node. The PortalToCM JAR file is also 
needed by the modules that need access to DB2 Content Manager.

The PortalToCM JAR file contains the PortalToCM EJB that is deployed on the 
same WebSphere Application Server where Content Manager is deployed.

The PortalToCM EJB has a number of utility methods that can be called by any 
application requiring those methods.

Examples of these methods are the createReport() and saveBody() methods, 
which create a new report in Content Manager and update the body of an 
existing report in Content Manager, respectively.

This EJB is used by the portlets in the New Report CU project and the portlets in 
the ReportTasks portlet project and the ReportApproval project.

4.2.6  ReportApproval project
The ReportApproval project is structured as shown in Figure 4-17.

Figure 4-17   ReportApproval module

The ReportApproval project is a Business Integration service project. This project 
contains all the files needed to build the flow of activities that the report 
assignment goes through when a new report assignment is initiated.

In our sample, the report is created separately using the New ReportCU portlets. 
The ReportApproval work flow depends on the ReportsTask portlet to facilitate 
the selection of an already created report to associate with the completed 
assignment. 

Report Approval EAR

Report Approval

Report Approval EJBReport Approval Web
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To view the different activities properties, open the file in WebSphere Studio 
Application Developer Integration Edition using the BPEL editor. (See Chapter 5, 
“Development environment” on page 73, for more information about the 
development environment and WebSphere Studio Application Developer 
Integration Developer.)

This project is deployed to the WebSphere Business Integration Server 
Foundation server and work-flow instances are started in our sample application 
using the Business Process API from the CreateAssignment portlet.

4.3  Summary
This chapter described the various components of our sample information 
life-cycle management application and the role of each component. The source 
code is available for download, as described in Appendix A, “Additional material” 
on page 367. 

We have not provided line-by-line descriptions of the source code, because most 
of the implementations are straightforward, and we assume that you will be able 
to interpret the code and adapt it to your specific requirements.

In the next chapter, we describe our specific development environment and 
provide instructions about how to install and configure a similar environment and 
import the sample source code.
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Chapter 5. Development environment

This chapter describes the installation and set up of our development 
environment, including the WebSphere Studio Application Developer Integration 
Edition and IBM Portal Toolkit.

5
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5.1  Install the development node
This section describes how to set up a running development environment 
capable of developing business processes, portlets, and other J2EE components 
for our sample application. This section consists of the following topics:

� Install Microsoft Windows operating system

� Install IBM WebSphere Studio Application Developer Integration Edition 
V5.1.1

� Install IBM Portal Toolkit V5.0.2.3

5.1.1  Install Microsoft Windows operating system
Our development environment was based on a Windows environment. The 
supported versions of Windows for the WebSphere Studio Application Developer 
Integration Edition V5.1.1 include Windows 2000 Professional SP2 or later, or 
Windows XP Professional SP1 or later.

5.1.2  Install IBM WebSphere Studio Application Developer 
Integration Edition V5.1.1 

We installed the IBM WebSphere Studio Application Developer Integration 
Edition V5.1.1 from the disk images. You might have the installation disks on CD. 
In that case, it will be necessary for you to switch the CDs during the installation. 
If you decide to install from disk images, you have to copy each disk image into 
directories named diskx (that is, disk1, disk2, and so on) for the installer 
application to find the next disk image during the installation. Failing to do so will 
result in requests to enter the directory for each disk image manually.

In addition, the fix pack installation (which follows the IBM WebSphere Studio 
Application Developer Integration Edition V5.1.1 installation) requires that you 
have the installation images in the IBMWSAppDevIE-5.1.1 directory. Therefore, 
your disk images should be in the IBMWSAppDevIE-5.1.1\disk1, 
IBMWSAppDevIE-5.1.1\disk2, and so on directories.

To install IBM WebSphere Studio Application Developer Integration Edition 
V5.1.1 for Windows, complete the following steps:

1. Go to the directory where you downloaded and unpacked the installation 
images. Select the Disk1 directory. It is c:\install\IBMWSAppDevIE-5.1.1\disk1 
in our example.

2. Start the installer by running launchpad.exe.
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3. Click Install IBM WebSphere Studio Application Developer Integration 
Edition from the main installation page. Note that it takes a few minutes for 
the Install Shield to prepare the JVM.

4. When the Welcome to the InstallShield Wizard for IBM WebSphere Studio 
Application Developer Integration Edition V5.1.1 window opens, click Next.

5. When the Software License Agreement window opens, review the terms, and 
if in agreement, select I accept the terms in the license agreement, and 
then click Next.

6. When the Location to Install window opens, we entered C:\IBM\WSADIE511 
and then clicked Next. 

7. When the select features window opens, we selected the features as shown 
in Figure 5-1 on page 76, and then clicked Next:

– Select Integrated Development Environment (required).
This option is selected automatically (cannot be cleared).

– Select Integrated Test Environments.
This option is selected automatically (cannot be cleared).

– Select WebSphere Business Integration Server Foundation 5.1.1 
(required).
This option is selected automatically (cannot be cleared). This will be the 
default test environment for the business processes.

– Select WebSphere Application Server V5.0.2.
This will be the default test environment for the portlets.

Tip: Do not use the default installation path proposed by the WebSphere 
Studio Application Developer installer (C:\Program Files\IBM\WebSphere 
Studio\Application Developer\v5.1). The path for the IBM Portal Toolkit 
must not contain periods (.) or dollar sign symbols ($).
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Figure 5-1   Feature selection for installation

8. When the Installation Summary window opens, review the information and 
then click Next to begin copying files.

9. When the installation is complete, you should see a message stating, The 
InstallShield Wizard has successfully installed IBM WebSphere Studio 
Application Developer Integration Edition V5.1.1. Click Finish.

10.When the WebSphere Studio Installation Launchpad main window opens, 
click Install Embedded messaging client and server. If you closed the 
Launchpad window during the installation, you will need to run launchpad.exe 
again.

11.In the Welcome window, click Next.

12.In the Software License Agreement window, review the terms, and if in 
agreement, select I accept the terms in the license agreement, and then 
click Next.

13.In the Location to Install window, we entered C:\IBM\WebSphereMQ and then 
clicked Next. 

14.In the Installation Summary window, review the information and then click 
Next to begin copying files.

15.When the installation is complete, you should see a message stating, The 
InstallShield Wizard has successfully installed embedded messaging 
server and client. Click Finish.
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16.When the WebSphere Studio Installation Launchpad main window opens, 
click Exit.

17.Verify that WebSphere Studio Application Developer V5.1.1 installed 
correctly:

a. Start WebSphere Studio Application Developer Integration Edition by 
clicking Start → Programs → IBM WebSphere Studio → Application 
Developer Integration Edition 5.1.1.

b. When you start WebSphere Studio the first time, you will be prompted for 
the workspace directory. Do the following and then click OK:

• Change the default location for the workspace to a shorter directory 
name (for example, c:\workspaces\workspace1). 

• Clear the Use this workspace as the default and do not show this 
dialog box again option.

c. Close WebSphere Studio Application Developer.

5.1.3  Install IBM Portal Toolkit V5.0.2.3
IBM Portal Toolkit V5.0.2.3 requires that some fix packs and fixes are installed 
for IBM WebSphere Studio Application Developer Integration Edition V5.1.1 prior 
to the toolkit installation. To install IBM Portal Toolkit V5.0.2.3, you need to 
perform the following high-level tasks:

1. Prepare the required fix packs and fixes for the WebSphere Studio 
Application Developer test environment

2. Install the IBM Portal Toolkit V5.0.2.3

3. Verify the IBM Portal Toolkit V5.0.2.3 installation

Prepare the required fix packs and fixes for the WebSphere 
Studio Application Developer test environment

To prepare the required fix packs and fixes, complete the following steps:

1. From a command prompt, run the following commands:

cd C:\install\PortalToolkit5023\WTE_setup\was_image
setup_was_image C:\install

Note: It is desirable to select different workspaces (directories) at 
startup. For this reason, we recommend that you do not select the Use 
this workspace as the default and do not show this dialog box 
again option.
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Where: 

– C:\install\PTK5023 is the directory where you have the installable image of 
IBM Portal Toolkit V5.0.2.3.

– C:\install is the directory where you have the installable image of IBM 
WebSphere Studio Application Developer Integration Edition V5.1.1. If it 
is, for example, C:\install\IBMWSAppDevIE-5.1.1, you enter C:\install. 

If you are installing from CDs, it would be, for example, D:, where D is the 
CD drive. Note: “D:\” is invalid. It should be "D:". 

The C:\install\PortalToolkit5023\WTE_setup\was_image directory should then 
list these files:

– b_was5_win_compressed_0
– b_was5_win_compressed_1
– b_was5_win_compressed_2
– b_wssd_core_win_compressedFile
– setup_was_image.bat
– setup_was_image.html

2. Take your IBM WebSphere Portal V5.0 CD2 installation disk and copy the 
files from the wps directory to the 
C:\install\PortalToolkit5023\WTE_setup\wps directory.

The C:\install\PortalToolkit5023\WTE_setup\wps directory should then list 
these files and directories:

– install.bat
– install.sh
– install400.bat
– installresponse.txt
– migration
– setup_wps.html
– uninstallresponse.txt
– version.txt
– wps5_dev_install.txt
– wpsinstall.jar

3. Download the IBM WebSphere Application Server V5.0.2 Cumulative Fix 3. 
For instructions, see 6.9.1, “Download and unpack WebSphere Application 
Server V5.0.2 Cumulative Fix 3” on page 116. Unpack the 
was502_cf3_win.zip file into the 
C:\install\PortalToolkit5023\WTE_setup\was502_cf3 directory.

The C:\install\PortalToolkit5023\WTE_setup\was502_cf3 directory should 
then list these files and directories:

– docs
– earLauncher
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– fixpacks
– installer.jar
– lib
– setup_was502_cf3.html
– updateSilent.bat
– updateWizard.bat
– version.properties

4. Download the 1.3.1 Java SDK, Java Tech Edition for WebSphere Application 
Server V5 in PQ81989_win.jar file from the following location:

ftp://ftp.software.ibm.com/software/websphere/appserv/support/fixes/PQ81989
/PQ81989_win.jar

Copy it to the C:\install\PortalToolkit5023\WTE_setup\j9_fix directory. If this 
link does not work, try searching the WebSphere Application Server Support 
site, available at:

http://www.ibm.com/software/webservers/appserv/was/support/

The C:\install\PortalToolkit5023\WTE_setup\j9_fix directory should then list 
these files:

– PQ81989_win.jar
– setup_j9_fix.html

5. Download the IBM WebSphere Application Server V5.0.2.3 Fixes. For 
instructions, see 6.10.1, “Download and unpack Application Server V5.0.2.3 
Fixes” on page 118. Unpack the WAS5023CumulativeWindows.zip file into 
the C:\install\PortalToolkit5023\WTE_setup\was5023_fixes directory.

The C:\install\PortalToolkit5023\WTE_setup\was5023_fixes directory should 
then list these files and directories:

– docs
– earLauncher
– efixes
– installer.jar
– lib
– setup_was5023_fixes.html
– sums
– updateSilent.bat
– updateWizard.bat
– utils
– version.properties

6. Download the IBM WebSphere Portal V5.0 Fix Pack 2. For instructions, see 
6.6.1, “Download and unpack WebSphere Portal V5.0 Fix Pack 2” on 
page 108. Unpack the Fixpack2.zip file into the 
C:\install\PortalToolkit5023\WTE_setup\wp_ptf_502 directory.

 

 

 

 

 Chapter 5. Development environment 79

ftp://ftp.software.ibm.com/software/websphere/appserv/support/fixes/PQ81989/PQ81989_win.jar
http://www.ibm.com/software/webservers/appserv/was/support/


The C:\install\PortalToolkit5023\WTE_setup\wp_ptf_502 directory should 
then list these files and directories:

– bin
– doc
– earLauncher
– lib
– PortalUpdateInstaller.jar
– readmefirst.html
– setup_wp_ptf_502.html
– tasks
– updatePortal.bat
– updatePortal.sh
– wpcp
– WPCP_PTF_502.jar
– WP_PTF_502.jar

7. Download the IBM WebSphere Portal V5.0.2 Cumulative Fix 1. For 
instructions, see 6.11.1, “Download and unpack Portal V5.0.2 Cumulative Fix 
1” on page 121. 

Copy the WP_PTF_5021.jar file into the 
C:\install\PortalToolkit5023\WTE_setup\wp_ptf_5021 directory. 

Then, unpack the PortalUpdateInstaller.zip file to the same directory.

The C:\install\PortalToolkit5023\WTE_setup\wp_ptf_5021 directory should 
then list these files and directories:

– bin
– doc
– earLauncher
– lib
– PortalUpdateInstaller.jar
– setup_wp_ptf_5021.html
– tasks
– updatePortal.bat
– updatePortal.sh
– WP_PTF_5021.jar

Install the IBM Portal Toolkit V5.0.2.3
If you have prepared all the fix packs and fixes needed for the installation (listed 
in previous section), you can now proceed to install IBM Portal Toolkit V5.0.2.3:

1. Make sure that WebSphere Studio Application Developer is not running.

2. Run the installation program by launching 
C:\install\PortalToolkit5023\setup.exe. 

3. On the Welcome page, click Next.
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4. When the Software License Agreement window opens, review the terms, and 
if in agreement, select I accept the terms in the license agreement, and 
then click Next.

5. In the Component Selection window, select Portal Toolkit V5.0.2.3 and 
WebSphere Portal V5.0 for Test Environment and click Next.

6. When the Installation Summary for Portal Toolkit window opens, review the 
information and then click Next to begin copying files.

7. When the Installation Summary for WebSphere Portal V5.0 for Test 
Environment window opens, click Next again.

8. When the installation completes, click Finish. 

9. Start WebSphere Studio Application Developer Integration Edition by clicking 
Start → Programs → IBM WebSphere Studio → Application Developer 
Integration Edition 5.1.1.

10.You will see the Configuration Changes panel. Select the pending 
configuration change that is displayed and click Finish.

11.When the update completes, you will be prompted to restart the workbench. 
Click Yes to restart.

Verify the IBM Portal Toolkit V5.0.2.3 installation
To verify the local debug configuration, complete the following steps:

1. From the menu in WebSphere Studio Application Developer Integration 
Edition application, click File → New → Other → Server → Server and 
Server Configuration. A wizard will start. 

2. In the wizard window, enter server name TestServer01. In Server type, 
expand WebSphere Portal version 5.0. Select Test Environment and click 
Finish. 

3. In the Servers view, right-click the TestServer01 server and click Start. 

4. Verify that the server starts successfully. In the Servers view, its status should 
be Started, and in the console you should, see following message: Server 
WebSphere_Portal open for e-business. (The message is not on the last 
line of the output.)

5.2  Import the source code
There is a sample code file available with this book. See Appendix A, “Additional 
material” on page 367 for information regarding downloading the files and 
accessing the source code and other modules.
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This sample code contains a sample workspace ready to be used in IBM 
WebSphere Studio Application Developer Integration Edition V5.1.1 with IBM 
Portal Toolkit V5.0.2.3 installed. 

To import the source code, complete the following steps:

1. Unpack the workspace.zip file to a local directory on your development node. 
We suggest that you use a short path without any special characters, for 
example, C:\workspace\ILMSample.

2. Then, start WebSphere Studio Application Developer by clicking Start → 
Programs → IBM WebSphere Studio → Application Developer 
Integration Edition 5.1.1.

3. When the WebSphere Studio window opens, click Browse and navigate to 
the directory where you have unpacked the sample workspace. In our case, it 
is C:\workspaces\ILM.

4. Click OK. WebSphere Studio Application Developer will start.

5. You should see the workspace with all the projects. We recommend that you 
right-click all the projects and force the refresh and then the complete rebuild.

The projects that you will have in WebSphere Studio Application Developer are 
shown in Figure 5-2.

Figure 5-2   Projects view

Table 5-1 on page 83 also lists the projects.
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Table 5-1   Project list

A typical portal project consists of the following areas:

� Java source folder

– Java files arranged by package (code developed for this solution is in the 
Java package com.ibm.itso.ilm.*).

– Property files.

� Web Content folder

– META-INF, which contains the Manifest.MF file.
– WEB-INF, which contains the configuration XML files (such as portlet.xml 

and web.xml) and Java classes.
– JSP files.

� JAR files that are referenced as external libraries

The sample is shown in Figure 5-3 on page 84 for the RecordsAdmin project.

Project name Type

AuditAdmin Portlet

New ReportCU Portlet

PortalToCM EJB

PortalToCMEAR J2EE

RecordsAdmin Portlet

ReportApproval Java

ReportApprovalEAR J2EE

ReportApprovalEJB EJB

ReportApprovalWeb Web

ReportsTasksPortlet Portlet
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Figure 5-3   Sample portlet project

In WebSphere Studio Application Developer, each file type has a specialized 
editor that is capable of checking the syntax on the fly and providing highlighting 
for keywords and comments. In addition, specialized editors are provided for 
property files, XML files, and other types of files.

5.3  Summary
This chapter described our development environment and the steps to perform to 
recreate it. You might also want to reference the IBM Redbook, IBM WebSphere 
Portal V5: A Guide for Portlet Application Development, SG24-6076, because it 
provides an excellent step-by-step guide on application development setup for a 
WebSphere Portal environment.
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Part 3 Installation and 
configuration

In this part of the book, we provide the necessary details and procedures to 
successfully install and configure the core records management and process 
choreography solution products. These detailed procedures provide example 
configuration values consistent with the solution context.

We organize this part into the following chapters:

� Chapter 6, “Portal node installation” on page 87

� Chapter 7, “Business Integration node installation” on page 133

� Chapter 8, “Content Management node installation” on page 145

� Chapter 9, “Records Management node installation” on page 189

� Chapter 10, “Configuration” on page 227.

Part 3
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Chapter 6. Portal node installation

This chapter describes in detail the steps used to install the Portal node in our 
solution. This node includes the IBM WebSphere Portal server and an LDAP 
directory and related services.

The high-level tasks to install the Portal node are:

1. IBM DB2 Universal Database installation

2. IBM WebSphere Portal V5.0 installation

3. IBM WebSphere Application Server V5.0 Fix Pack 2 installation

4. WebSphere Application Server Enterprise V5.0 Fix Pack 2 installation

5. IBM WebSphere Application Server V5.0.2 Fixes installation

6

Note: When installing and configuring the Portal node, we referenced the 
following information sources:

� IBM Redbook Document Management Using WebSphere Portal V5.0.2 
and DB2 Content Manager V8.2, SG24-6349

� IBM WebSphere Portal Extend for Multiplatforms V5.0.2 Information 
Center, available at:

http://www.ibm.com/websphere/portal/library

� IBM Redbook IBM WebSphere Portal for Multiplatforms V5 Handbook, 
SG24-6098
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6. IBM WebSphere Portal V5.0 Fix Pack 2 installation

7. WebSphere Application Server V5.0.2 Cumulative Fix 2 installation

8. IBM WebSphere Application Server Enterprise V5.0.2 Cumulative Fix 2 
installation

9. WebSphere Application Server V5.0.2 Cumulative Fix 3 installation

10.IBM WebSphere Application Server V5.0.2.3 Fixes installation

11.IBM WebSphere Portal V5.0.2 Cumulative Fix 1 installation

12.IBM Tivoli Directory Server Version 5.2 installation

We implement this node on a Microsoft Windows 2000 Server platform.
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6.1  IBM DB2 Universal Database installation
This section describes how to install IBM DB2 Universal Database™ V8.1, 
Enterprise Server Edition and supporting Fix Pack 4a.

This section is organized into the following tasks:

� Install DB2 UDB V8.1
� Install DB2 UDB V8.1 Fix Pack 4a
� Verify DB2 UDB

6.1.1  Install DB2 UDB V8.1
To install the IBM DB2 UDB Version 8.1 Enterprise Server Edition, complete the 
following steps.

1. Insert the DB2 UDB V8.1 Enterprise Server Edition CD.

2. Navigate to the <CD_Root> and run Setup.exe to start the installation.

3. When the DB2 Installer window opens, click Install Products.

4. When the Select the Product to Install window opens, select DB2 UDB 
Enterprise Server Edition (the default and only option) and then click Next.

5. When the Welcome window for the DB2 Setup Wizard opens, click Next. 

6. When the License Agreement window opens, review the terms, and if in 
agreement, select I accept the terms in the license agreement. Click Next.

7. When the Select the installation type window opens, select Typical and then 
click Next.

8. When you see a warning message regarding the connection to remote DB2 
servers using APPC, click OK.

9. When the Select the Installation Action window opens, select Install DB2 
UDB Enterprise Server Edition on this computer and then click Next.

10.When the Select the Installation Folder window opens, we entered 
c:\ibm\sqllib. Click Next.

Note: Depending on the DB2 UDB V8.1 CD distribution you are using, the 
installation panels might be slightly different from those described here.

Note: Take note of the Save your settings to response file check box. This 
can be used to capture your selection options to be used for a future 
installation.
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11.When the Set User Information for DB2 Administration Server window opens, 
enter and select the following values and then click Next:

– Domain: We left this field blank.
– User name: DB2admin (default)
– Password: <password>
– Confirm password: <password>
– Select Use the same username and password for remaining DB2 

services (default).

12.When the Setup the Administration Contact List opens, we accepted the 
default settings (local). Click Next.

13.When the warning message Notification SMTP server has not been 
specified appears, click OK.

14.When the Configure DB2 instances window opens, we accepted the default 
(DB2). Click Next.

15.When the Prepare the DB2 tools catalog window opens, select Do not 
prepare the DB2 tools catalog on this computer and then click Next.

16.When the Specify a contact for health monitor notification window opens, 
select Defer the task after installation is complete and then click Next.

17.When the Start copying files window opens, review the selected options and 
then click Install.

18.When the Setup is Complete window opens, click Finish.

19.When the IBM DB2 First Steps window opens, click Exit First Steps. 

6.1.2  Install DB2 UDB V8.1 Fix Pack 4a
We installed IBM DB2 UDB V8.1 Fix Pack 4a for 32-bit Windows. We chose to 
use Fix Pack 4a for several reasons. First, IBM Tivoli Directory Server V5.2, 
WebSphere Portal V5.0.2, DB2 Content Manager V8.2 plus Fix Pack 6, and DB2 
Information Integrator for Content plus Fix Pack 6 officially support DB2 UDB 
V8.1 Fix Pack 4a. Also, we wanted to use the same version of DB2 fix pack on all 
of the nodes for DB2 compatibility reasons.

Note: The DB2 UDB installation with the Typical installation type takes 
approximately 376 MB of disk space.
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To download and install IBM DB2 UDB V8.1 Fix Pack 4a, complete the following 
steps:

1. You can download IBM DB2 UDB V8.1 Fix Pack 4a at:

http://www.ibm.com/cgi-bin/db2www/data/db2/udb/winos2unix/support/v8fphist.
d2w/report#WIN-32

2. We downloaded the FP4a_WR21338_ESE.exe, which is Fix Pack 4a for IBM 
DB2 Universal Database V8.1, Enterprise Server Edition. 

3. Stop all DB2 services in the Windows services.

4. Install IBM DB2 UDB V8.1 Fix Pack 4a. We accepted the default installation 
options.

5. We recommend that you restart your system after installing the fix pack to 
ensure that all fixes are applied and active in memory.

6. The internal DB2 level is 8.1.4.428 after the installation of Fix Pack 4a. In our 
example, we do not have any existing databases that need special attention 
(rebind DB2 utilities).

After the system has restarted, open a DB2 command window (or Windows 
command window) and enter the following command:

db2level

It should return 8.1.4.428 after Fix Pack 4a has been installed.

Note: For more information about the contents of IBM DB2 UDB V8.1 Fix 
Pack 4a, refer to the text file FixpackReadme, available at:

http://www.ibm.com/cgi-bin/db2www/data/db2/udb/winos2unix/support/v8fphis
t.d2w/report#WIN-32

Note: If you have trouble stopping any of the DB2 services, you can 
proceed with the fix pack installation. When the DB2 Setup Wizard 
launches for the fix pack, it will warn that certain processes are locking 
DB2 and will ask you if you want to shut them down. You can click Yes, and 
the Wizard will shut down the processes for you.
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6.1.3  Verify DB2 UDB
After you install DB2 UDB V8.1 and the fix pack and have restarted your system, 
we recommend that you verify that DB2 UDB is working properly. 

6.2  IBM WebSphere Portal V5.0 installation
This section describes how to install and configure IBM WebSphere Portal V5.0 
on the Portal node. We install the following components with this installation:

� WebSphere Application Server Enterprise Version 5.0.1 (Base and 
Enterprise), including required fixes

� IBM HTTP Server Version 1.3.26
� WebSphere Portal Version 5.0
� WebSphere Portal Content Publishing Version 5.0

Note: Rebind DB2 utilities to existing databases

If you have created databases before you installed Fix Pack 4a, you will need 
to rebind the DB2 utilities to the databases. This step is necessary for the fixes 
to become effective on existing databases. The binding procedure needs to be 
performed only once per database. Note that this is not required for databases 
created after the fix pack is installed. We summarize the rebind procedure 
found in the FixpackReadme.

To rebind existing DB2 UDB databases after installing Fix Pack 4a, enter the 
following commands from a DB2 command window for each database:

db2 terminate
db2 CONNECT TO <dbname>
db2 BIND <DB2_home>\BND\@db2ubind.lst GRANT PUBLIC
db2 BIND <DB2_home>\BND\@db2cli.lst GRANT PUBLIC
db2 terminate

Where <dbname> represents the name of a database to which the utilities 
should be bound. And, <DB2_home> represents the directory where you have 
installed DB2. The db2ubind.lst and db2cli.lst contain lists of required bind 
files used by IBM DB2 UDB V8.1.
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6.2.1  Install WebSphere Portal V5.0
To install IBM WebSphere Portal V5.0, complete the following steps:

1. Insert the IBM WebSphere Portal V5.0.2 Setup CD.

The installer will automatically start the installation process by offering a 
command prompt. If autostart is disabled, run install.bat from the root of 
the CD to start the installation.

2. When the Install Shield Language window opens, select the desired language 
(for example, English) and click OK.

3. When the Welcome window opens, you are provided with an option to launch 
the Information Center (optional). Click Next to continue installation.

4. When the License Agreement window opens, review the terms, and if in 
agreement, select I accept the terms in the license agreement and then 
click Next.

The installer checks for the required operating system and prerequisites.

5. The next window provides the installation options: Full (all components) or 
Custom (useful when components such as WebSphere Application Server 
are already installed). 

In our example, we select Full and click Next to continue.

6. The wizard displays a window for the WebSphere Application Server 
installation directory. We used the following path and then clicked Next:

C:\IBM\WebSphere\AppServer

7. The next window displays the IBM HTTP Server installation directory. We 
used the following path and then clicked Next:

C:\IBM\IBMHTTPServer

8. The next window prompts for the system logon user ID and password that will 
be used to run the WebSphere Application Server and IBM HTTP Server as a 
Microsoft Windows NT® service. If you do not want these services to be 
created, you can skip this window by clicking Next. 

Otherwise, select Run WebSphere Application Server As Service and Run 
IBM HTTP Server as a service and provide a valid user name and 
password. Note, that this user account is one of your Windows system user 
accounts, as opposed to most of the user accounts used in this book, which 
are located in the LDAP directory residing in IBM Tivoli Directory Server. The 
preferred way is to enter the user account that you are using to install the 

Note: You might have to minimize the command prompt window if it stays 
on top and obscures the language prompt.
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product. We had previously defined a Windows user ID for WPSadmin and 
therefore used the following values:

– User ID: WPSadmin
– Password: <password>

Click Next.

9. The next window prompts you for the node name and host name to be used 
for the WebSphere Application Server installation. We used the following 
values and clicked Next:

– Node name: ilm-ui
– WebSphere Application Server hostname: ilm-ui.itsc.austin.ibm.com

Note: If you do not initially configure WebSphere or start as a service, but 
want to do so after the installation, use the ASService command as follows:

ASService.exe (with no arguments starts the service)
-add <service name>

-serverName <Server>
[-wasHome <Websphere Install Directory>]
[-configRoot <Config Repository Directory>]
[-startArgs <additional start arguments>]
[-stopArgs <additional stop arguments>]
[-userid <execution id> -password <password>]
[-logFile <service log file>]
[-restart <true | false>]

-remove <service name>
-start <service name>
-stop <service name>
-status <service name>

Assume the following:

� WebSphere Application Server install path: 
C:\IBM\WebSphere\AppServer\

� WebSphere Application Server AppServer instance name: Server1

From a command prompt, enter:

cd:\C:\IBM\WebSphere\AppServer\bin

Then, execute: 

wasservice –add “IBM WAS Server1” -serverName Server1 

Note: There is no WebSphere Portal supported method to change the 
node and host name after entering them during the installation. Be sure 
that you enter the desired node and host names correctly.
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10.We are now prompted for the WebSphere Portal installation directory. We 
used the following path and clicked Next:

C:\IBM\WebSphere\PortalServer

11.The next window prompts for the Portal administrative user and password. We 
used the following values, confirmed the password, and clicked Next:

– Administrative user: WPSadmin
– Password: <password>

The password for the WPSadmin is user defined during the installation.
– Confirm Password: <password>

12.The next window displays the different components that are going to be 
installed. Click Next.

13.The Installer program will then prepare the installation. After a while, you will 
be prompted to insert CD #1-1 WebSphere Application Server Enterprise for 
Windows. It begins by locating a Java Virtual Machine and then the 
installation of WebSphere Application Server (Base and Enterprise) starts.

After this installation completes, you will be prompted to insert CD #1-6 
WebSphere Application Server Fixpack and eFixes for Windows and Linux.

The wizard then performs the following tasks, displaying a progress meter for 
each task:

– Prepares the WebSphere Application Server Fix Pack files
– Installs WebSphere Application Server Fix Pack 1
– Installs WebSphere Application Server Enterprise Fix Pack 1
– Installs WebSphere Application Server Fixes

14.When these tasks complete, the installer starts WebSphere Application 
Server (server1 application server). After the server starts, you will be 
prompted to insert CD #2 WebSphere Portal WPCP. This starts the 
installation of WebSphere Portal.

Note: For our example, we avoided the necessity of replacing CDs by 
putting the CD images on a network drive. By using the following directory 
names for each CD image (and placing the images in the same directory in 
the network), you will not be prompted to insert any CDs:

� setup
� cd1-1
� cd1-6
� cd2
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15.When this completes, the Information Center is installed, and then 
WebSphere Portal starts (WebSphere_Portal application server). The 
installation is then validated, and the portlets are installed. After this finishes, 
the installer installs the content publishing features. After the whole procedure 
completes, you should be presented with a window stating that the installation 
was successful. 

Leave the Launch First Steps option selected for and click Finish. 

16.The installation program then completes and closes. Note that as its final 
task, it loads the WebSphere Portal First Steps application.

6.2.2  Verify WebSphere Portal V5.0
If the installation completed properly, the WebSphere Portal First Steps 
application should be running. 

To verify the installation of WebSphere Portal, do the following:

1. Click Launch WebSphere Portal to test that the portal pages open properly. 
This should launch a Web browser window with the following URL 
(ilm-ui.itsc.austin.ibm.com is the host name of this node):

http://ilm-ui.itsc.austin.ibm.com:9081/wps/portal

Note: If you have restarted the system where WebSphere Portal is installed 
after the installation and WebSphere Portal and the First Steps are not 
running, do the following:

1. Start the WebSphere Portal application by clicking Start → Programs → 
IBM WebSphere → Portal Server v5.0 → Start the Server. 

Alternatively, start the WebSphere Portal application server from the com-
mand line as follows:

c:\ibm\WebSphere\AppServer\bin\startServer Webphere_Portal

2. Start the First Steps application by clicking Start → Programs → IBM 
WebSphere → Portal Server v5.0 → First Steps.

Tip: When launching WebSphere Portal from the First Steps GUI, be sure 
that the URL contains the fully qualified DNS name in case the URL has 
only the host name. This could happen if the System properties → 
Network Identification → Full computer name does not contain the 
domain name extension. If this is the case, add the computer to the domain 
or add the domain name.
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2. Log in to the portal by clicking the Log in link located in the upper-right 
corner. This takes you to a new window prompting for login information. 

– User ID: WPSadmin
This user ID was created during the WebSphere Portal installation.

– Password: <password>
This is a user-defined password created during the WebSphere Portal 
installation.

3. If the installation is successful, and you have Internet access. you should be 
presented with the personalized portal pages for the logged-in user.

If your computer does not have direct access to the Internet, you will see a 
window similar to that shown in Figure 6-1 on page 98. The errors that appear on 
the window occur only because some of the given portlets obtain content to 
display by connecting to servers available on the Internet.
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Figure 6-1   Personalized Welcome window of WebSphere Portal V5.0

6.3  IBM WebSphere Application Server V5.0 Fix Pack 2 
installation

As a prerequisite to IBM WebSphere Portal V5.0.2, we install IBM WebSphere 
Application Server Enterprise V5.0 Fix Pack 2, which requires IBM WebSphere 
Application Server V5.0 Fix Pack 2 to be installed first. Therefore, this section 
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describes the installation steps required for the IBM WebSphere Application 
Server V5.0 Fix Pack 2 installation.

The IBM WebSphere Application Server V5.0 Fix Pack 2 installation requires 
write access to the file system during the installation. For this reason, we need to 
copy the fix pack to the local file system of the target node. In addition, Fix Pack 2 
includes a later version of WebSphere Update Installer (install wizard for fix 
packs and fixes). We use WebSphere Update Installer included with Fix Pack 2 
to install the WebSphere fixes.

6.3.1  Download WebSphere Application Server V5.0 Fix Pack 2
To download IBM WebSphere Application Server V5.0 Fix Pack 2, complete the 
following steps:

1. Download IBM WebSphere Application Server V5.0 Fix Pack 2 from the 
following site:

http://www.ibm.com/support/docview.wss?rs=180&tc=SSEQTP&uid=swg24005012

Or, download it directly from:

ftp://ftp.software.ibm.com/software/websphere/appserv/support/fixpacks/was5
0/fixpack2/Windows/was50_fp2_win.zip

2. Unpack the downloaded file to a temporary directory on your Portal node. For 
our environment, we used the c:\install\was50fp2\UpdateInstaller directory.

6.3.2  Stop the servers
Prior to starting the fix pack installation, you need to make sure that the 
WebSphere Application Servers and IBM HTTP Server are not running. To 
ensure that the servers are not running, complete the following steps:

1. Stop IBM HTTP Administration by clicking Start → Programs → IBM HTTP 
Server 1.3.26 → Stop Administration Server.

1. Stop IBM HTTP Server by clicking Start → Programs → IBM HTTP Server 
1.3.26 → Stop HTTP Server.

2. Stop the WebSphere Portal server by clicking Start → Programs → IBM 
WebSphere → Portal Server v5.0 → Stop the Server.

3. Stop the WebSphere Application Server server1 by clicking Start → 
Programs → IBM WebSphere → Application Server v5.0 → Stop the 
Server.

4. Ensure that everything is stopped by checking that the following Windows NT 
services are stopped:

– IBM HTTP Server 1.3.26
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– IBM HTTP Administration 1.3.26
– IBM WebSphere Application Server V5 server1

6.3.3  Install WebSphere Application Server V5.0 Fix Pack 2
To install IBM WebSphere Application Server V5.0 Fix Pack 2, complete the 
following steps on the Portal node:

1. From a command prompt, set the environment variables by running the 
following command:

c:\IBM\WebSphere\AppServer\bin\setupCmdLine

2. Navigate to the WebSphere Update Installer directory:

cd \install\was50fp2\UpdateInstaller

3. Run the WebSphere Update Installer application:

updateWizard

4. When the WebSphere Update Installer language window opens, select the 
appropriate language for the wizard (for example, English) and then click OK.

5. When the Welcome window opens, click Next.

6. WebSphere Update Installer detects your current WebSphere Application 
Server version (IBM WebSphere Application Server V5.0.1 plus Enterprise 
V5.0.1) and installation directory (c:\ibm\WebSphere\AppServer). Click Next.

7. Select Install fix packs and then click Next.

8. Enter the directory where you have copied the fix pack. For example, we 
entered the following in the Fix pack directory field and then clicked Next:

c:\install\was50fp2\UpdateInstaller\fixpacks

9. Select the was50_fp2_win fix pack and then click Next.

10.The next window prompts you for the path to IBM HTTP Server and 
Embedded Messaging. 

We have not installed embedded messaging, so the Embedded Messaging 
Installation Directory should state Not Found and Embedded Messaging 
should not be selected. 

We installed IBM HTTP Server, so we need to install its fix pack. Make sure 
that the IBM HTTP Server option is selected and that the IBM HTTP Server 
Installation Directory is set to C:\IBM\IBMHTTPServer. See Figure 6-2 on 
page 101.
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Figure 6-2   WebSphere Application Server 5.0 Fix Pack 2 component selection

11.Review the fix pack settings and then click Next to begin the fix pack 
installation.

12.When the IBM WebSphere Application Server V5.0 Fix Pack 2 installation 
completes, click Finish.

6.4  WebSphere Application Server Enterprise V5.0 Fix 
Pack 2 installation

As mentioned in the previous section, as a prerequisite to IBM WebSphere Portal 
V5.0.2, we install IBM WebSphere Application Server Enterprise V5.0 Fix Pack 
2. This section describes the installation steps required for the IBM WebSphere 
Application Server Enterprise V5.0 Fix Pack 2 installation.

IBM WebSphere Application Server Enterprise V5.0 Fix Pack 2 requires write 
access to the file system during the installation. For this reason, we need to copy 
the fix pack to the local file system of the target node. In addition, Fix Pack 2 

Note: If you installed embedded messaging previously, you need to install 
its fix pack, too. In this case, select Embedded Messaging and provide 
the Embedded Messaging installation path.
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includes a later version of WebSphere Update Installer (install wizard for fix 
packs and fixes). We use the WebSphere Update Installer included with Fix Pack 
2 to install the WebSphere fixes.

6.4.1  Download IBM WebSphere Application Server Enterprise V5.0 
Fix Pack 2

To download IBM WebSphere Application Server Enterprise V5.0 Fix Pack 2, 
complete the following steps:

1. Download the IBM WebSphere Application Server Enterprise V5.0 Fix Pack 2 
from the following site:

http://www.ibm.com/support/docview.wss?rs=180&tc=SSEQTP&uid=swg24005055

Or, download it directly from:

ftp://ftp.software.ibm.com/software/websphere/appserv/support/fixpacks/was5
0/fixpack2_enterprise/Windows/was50_pme_fp2_win.zip

2. Unpack the downloaded file to the temporary directory on your Portal node. 
For our environment, we used the c:\install\wase50fp2\UpdateInstaller 
directory.

6.4.2  Stop the servers
Prior to starting the fix pack installation, you need to make sure that WebSphere 
Application Servers and IBM HTTP Server are not running. To ensure that the 
servers are not running, complete the following steps:

1. Stop IBM HTTP Administration by clicking Start → Programs → IBM HTTP 
Server 1.3.26 → Stop Administration Server.

1. Stop IBM HTTP Server by clicking Start → Programs → IBM HTTP Server 
1.3.26 → Stop HTTP Server.

2. Stop the WebSphere Portal server by clicking Start → Programs → IBM 
WebSphere → Portal Server v5.0 → Stop the Server.

3. Stop the WebSphere Application Server server1 by clicking Start → 
Programs → IBM WebSphere → Application Server v5.0 → Stop the 
Server.

4. Ensure that everything is stopped by checking that the following Windows NT 
services are stopped:

– IBM HTTP Server 1.3.26
– IBM HTTP Administration 1.3.26
– IBM WebSphere Application Server V5 server1
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6.4.3  Install WebSphere Application Server Enterprise V5.0 Fix Pack 2

To install IBM WebSphere Application Server Enterprise V5.0 Fix Pack 2, 
complete the following steps on the Portal node:

1. From a command prompt, set the environment variables by running the 
following command:

c:\IBM\WebSphere\AppServer\bin\setupCmdLine

2. Navigate to the WebSphere Update Installer directory:

cd \install\wase50fp2\UpdateInstaller

3. Run the WebSphere Update Installer application:

updateWizard

4. When the WebSphere Update Installer language window opens, select the 
appropriate language for the wizard (for example, English) and then click OK.

5. When the Welcome window opens, click Next.

6. WebSphere Update Installer detects your current WebSphere Application 
Server version. Click Next.

Notice that the base version is now V5.0.2, because the base fix pack has 
been installed (IBM WebSphere Application Server V5.0.2 plus Enterprise 
V5.0.1). The installation directory is c:\IBM\WebSphere\AppServer. 

7. Select Install fix packs and then click Next.

8. Enter the directory where you have copied the fix pack. For example, we 
entered the following in the Fix pack directory field and then clicked Next:

c:\install\wase50fp2\UpdateInstaller\fixpacks

9. Select the was50_pme_fp2_win fix pack and then click Next.

10.Review the fix pack settings and then click Next to begin the fix pack 
installation.

11.When the IBM WebSphere Application Server Enterprise V5.0 Fix Pack 2 
installation completes, click Finish.

Note: If the base version is not detected, enter the path to the WebSphere 
Application Server installation directory.
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6.5  IBM WebSphere Application Server V5.0.2 Fixes 
installation

This section describes how to install IBM WebSphere Application Server V5.0.2 
Fixes on top of IBM WebSphere Application Server Enterprise V5.0 Fix Pack 2.

IBM WebSphere Portal V5.0 Fix Pack 2, which we install in the next section, 
requires the following fixes to be installed on WebSphere Application Server 
before proceeding with the WebSphere Portal fix pack installation:

� PQ76567_5.0.2.jar
� PQ78166eFix_fixes_install_db_resource.jar
� PQ81248_fix.jar
� WAS_CM_08-12-2003_5.0.2-5.0.1_cumulative_Fix.jar

The following additional fixes are required for proper operation of IBM 
WebSphere Portal V5.0.2:

� PQ75469.jar
� PQ77008.jar
� PQ77142.jar
� PQ78370_Fix.jar
� PQ78382_fix.jar
� PQ78882_Fix.jar
� PQ79083_5.0.2_Fix.jar
� PQ79193_fix.jar
� PQ81020_fix.jar
� WAS_Adapter_10-30-2003_5.0.2_cumulative_Fix.jar
� WAS_Sessions_08-12-2003_5.0.2_cumulative_Fix.jar
� WAS_Security_07-07-2003_5.0.2-5.0.1-5.0.0_JSSE_cumulative_Fix.jar
� WAS_Plugin_09-03-2003_5.0.X_cumulative_Fix_Win.jar

These fixes come in a bundle and can be downloaded all in one file.

6.5.1  Download WebSphere Application Server V5.0.2 Fixes
To download the IBM WebSphere Application Server V5.0.2 Fixes, complete the 
following steps:

1. Download the IBM WebSphere Application Server V5.0.2 Fixes from the 
following site:

http://www.ibm.com/support/docview.wss?rs=688&context=SSHRKX&uid=swg2400634
3&loc=en_US&cs=utf-8&lang=en
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2. Unpack the downloaded file to the temporary directory on your Portal node. 
For our environment, we used the c:\install\was502fx\UpdateInstaller 
directory.

6.5.2  Stop the servers
Prior to starting the installation of the fixes, you need to make sure that 
WebSphere Application Servers and IBM HTTP Server are not running. To 
ensure that the servers are not running, complete the following steps:

1. Stop IBM HTTP Administration by clicking Start → Programs → IBM HTTP 
Server 1.3.26 → Stop Administration Server.

1. Stop IBM HTTP Server by clicking Start → Programs → IBM HTTP Server 
1.3.26 → Stop HTTP Server.

2. Stop the Portal server by clicking Start → Programs → IBM WebSphere → 
Portal Server v5.0 → Stop the Server.

3. Stop the WebSphere Application Server server1 by clicking Start → 
Programs → IBM WebSphere → Application Server v5.0 → Stop the 
Server.

4. Ensure that everything is stopped by checking that the following Windows NT 
services are stopped:

– IBM HTTP Server 1.3.26
– IBM HTTP Administration 1.3.26
– IBM WebSphere Application Server V5 server1

6.5.3  Install WebSphere Application Server V5.0.2 Fixes
To install IBM WebSphere Application Server V5.0.2 Fixes, complete the 
following steps on the Portal node:

1. From a command prompt, set the environment variables by running the 
following command:

c:\IBM\WebSphere\AppServer\bin\setupCmdLine

2. Navigate to the WebSphere Update Installer directory:

cd \install\was502fx\UpdateInstaller

3. Run the WebSphere Update Installer application:

updateWizard

4. When the WebSphere Update Installer language window opens, select the 
appropriate language for the wizard (for example, English) and then click OK.

5. When the Welcome window opens, click Next.
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6. WebSphere Update Installer detects your current WebSphere Application 
Server version. Click Next.

Notice that the base version is now V5.0.2, because the base fix pack has 
been installed (IBM WebSphere Application Server V5.0.2 plus Enterprise 
V5.0.2). The installation directory is c:\IBM\WebSphere\AppServer. 

7. Select Install fixes and then click Next.

8. Enter the directory where you have copied the fixes. For example, we entered 
the following in the Fixes directory field and then clicked Next:

c:\install\was502fx\UpdateInstaller\efixes

9. When the Fixes list opens, select all the fixes (defined in the previous list) and 
then click Next.

10.Review the Fixes selected to install and then click Next to begin the fixes 
installation.

11.When the IBM WebSphere Application Server V5.0.2 Fixes installation 
completes, click Finish.

6.5.4  Verify WebSphere Application Server V5.0.2
Prior to continuing to the IBM WebSphere Portal V5.0 Fix Pack 2 installation, we 
recommend that you verify that IBM WebSphere Application Server V5.0.2 is 
working properly.

Note: If the base version is not detected, enter the path to the WebSphere 
Application Server installation directory.

Note: Information describing each PQ fix is available during the fixes 
installation by selecting the fix and reviewing the Fix description text box.

Note: If any of the following steps fail for any reason, or in the case of 
installation problems, refer to the documentation provided with the fix packs 
and to the following publications:

� IBM WebSphere Portal Extend for Multiplatforms V5.0.2 Information 
Center, available at:

http://www.ibm.com/websphere/portal/library

� IBM Redbook IBM WebSphere Portal for Multiplatforms V5 Handbook, 
SG24-6098
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To verify the functionality of the IBM WebSphere Application Server V5.0.2, 
complete the following steps:

1. Start IBM HTTP Server by clicking Start → Programs → IBM HTTP Server 
1.3.26 → Start HTTP Server.

2. Open the WebSphere Application Server First Steps application by clicking 
Start → Programs → IBM WebSphere → First Steps. 

3. Start the WebSphere Application Server server1 by clicking Start the Server 
in the WebSphere Application Server - First Steps application.

4. Review the status of the server startup in the startServer.log. You should see 
the following message:

Server server1 open for e-business

5. From First Steps application, click Verify Installation.

6. The First Steps Output - Verify Installation Test window should open, and then 
some tests are performed. Check that the verification completes successfully.

7. After completing the Verify Installation, click Exit in the First Steps window.

8. Start the WebSphere administrative console by entering the following URL in 
a Web browser:

http://ilm-ui.itsc.austin.ibm.com:9090/admin

9. Log in to the WebSphere administrative console. You do not need to provide 
a user name, because the WebSphere security is turned off.

The WebSphere administrative console should open.

6.6  IBM WebSphere Portal V5.0 Fix Pack 2 installation

This section provides the installation steps required to install IBM WebSphere 
Portal V5.0 Fix Pack 2. In order to proceed, ensure that you have installed all 
prerequisites, which include:

� IBM WebSphere Application Server V5.0 Fix Pack 2
� IBM WebSphere Application Server Enterprise V5.0 Fix Pack 2
� IBM WebSphere Application Server V5.0.2 Fixes

Note: The server1 directory will not get created until the first time the 
application server is started.
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6.6.1  Download and unpack WebSphere Portal V5.0 Fix Pack 2

To download and unpack IBM WebSphere Portal V5.0 Fix Pack 2, complete the 
following steps:

1. Search for and download IBM WebSphere Portal V5.0 Fix Pack 2 from the 
following site:

http://www.ibm.com/support

2. Unpack the downloaded file to the temporary directory on your Portal node. 
For our environment, we used the c:\install\wps50fp2\UpdateInstaller 
directory.

6.6.2  Stop the servers
Prior to starting the fix pack installation, you need to make sure that WebSphere 
Application Servers are not running. To ensure that the servers are not running, 
complete the following steps:

1. From a command prompt, issue the following command to stop the 
WebSphere Portal server:

c:\IBM\WebSphere\AppServer\bin\stopServer WebSphere_Portal

2. Issue the following command to stop the WebSphere Application Server 
server1:

c:\IBM\WebSphere\AppServer\bin\stopServer server1

6.6.3  Install WebSphere Portal V5.0 Fix Pack 2
To install IBM WebSphere Portal V5.0 Fix Pack 2, complete the following steps 
on the Portal node:

1. From a command prompt, set the environment variables by running the 
following command:

c:\IBM\WebSphere\AppServer\bin\setupCmdLine

2. Navigate to the Portal Update Installer directory:

cd \install\wps50fp2\UpdateInstaller

3. Run the Portal Update Installer application:

updatePortal -fixpack -installDir c:\IBM\Websphere\PortalServer -fixpackDir 
c:\install\wps50fp2\UpdateInstaller\fixpacks -install -fixpackID WP_PTF_502
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4. When the installation completes, you should see this message:

Fix pack installation completed successfully.

6.6.4  Update the WebSphere Portal configuration
After the IBM WebSphere Portal V5.0 Fix Pack 2 installation is complete, you 
need to update the WebSphere Portal configuration.

Note: If you configured IBM WebSphere Application Server V5.0.2 security 
prior to installing IBM WebSphere Portal V5.0 Fix Pack 2, you will need to 
ensure that the WasUserid and WasPassword fields are populated 
correctly in the c:\IBM\Websphere\PortalServer\config\wpconfig.properties 
file before running Portal Update Installer.

Note: Configuration failure due to WebSphere SOAP timeout

We found that, on slower systems, the WebSphere Portal configuration for the 
post-Fix Pack 2 operation received a configuration failure on task 36 of 50, 
due to a WebSphere Application Server SOAP connector timeout. The failure 
will show up as follows in 
c:\IBM\WebSphere\PortalServer\log\ConfigTrace.log:

action-remove-ear-wmm:
..
[wsadmin] WASX7017E: Exception received while running file 
"C:\ibm\WebSphere\PortalServer/config/work/was/removeWmmEar.jacl"; 
exception information: com.ibm.bsf.BSFException: error while eval'ing 
Jacl expression: com.ibm.ws.scripting.ScriptingException: 
com.ibm.websphere.management.exception.ConfigServiceException

To work around this issue, we did the following:

1. Increase the WebSphere Application Server SOAP connector timeout in 
c:\IBM\WebSphere\AppServer\properties\soap.client.props. We changed 
the value of the com.ibm.SOAP.requestTimeout=6000 (default 180).

2. Back out the configuration by running the WebSphere Portal uninstall. See 
“Note: Configuration failure and recovery” on page 110 for details about 
how to run uninstall.

Rerun the WebSphere Portal configuration task.

 

 

 

 

 Chapter 6. Portal node installation 109



To update the WebSphere Portal configuration, complete the following steps:

1. Restart the IBM HTTP Server by clicking Start → Programs → IBM HTTP 
Server 1.3.26 → Stop HTTP Server and then clicking Start → Programs → 
IBM HTTP Server 1.3.26 → Start HTTP Server.

2. From a command prompt, enter the following command to update the 
WebSphere Portal configuration:

c:\IBM\WebSphere\PortalServer\config\WPSConfig.bat WP-PTF-502 
-DPortalAdminPwd=<password>

Where <password> is the WebSphere Portal administrator password that has 
been set during the installation of IBM WebSphere Portal V5.0.

6.6.5  WebSphere Portal Content Publisher V5.0
This section is not required for our example.

IBM WebSphere Portal Content Publisher V5.0 was installed as part of the IBM 
WebSphere Portal V5.0 installation. In our example, we do not use Content 
Publisher. Therefore, we did not install WebSphere Portal Content Publisher 
V5.0 Fix Pack 2. If you are using IBM WebSphere Portal Content Publisher V5.0, 
we recommend that you install Fix Pack 2. 

6.6.6  Document Manager search index
This section is not required for our example.

Note: Configuration failure and recovery

If the Update WebSphere Portal configuration task fails, do the following:

1. Correct the cause of the failure.

2. Uninstall the IBM WebSphere Application Server V5.0 Fix Pack 2 (uninstall 
might be better called unconfigure; this just unconfigures the failed 
configuration) as follows:

WPSconfig.bat UNINSTALL-WP-PTF-5002

3. Rerun the WebSphere Portal configuration task:

c:\IBM\WebSphere\PortalServer\config\WPSConfig.bat WP-PTF-502 
-DPortalAdminPwd=<password>

For details, refer to the IBM WebSphere Portal V5.0 Fix Pack 2 readme file 
(install_win_unix.html), available at:

http://publib.boulder.ibm.com/pvc/wp/502/ent/en/readme/install_win_unix.html
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If you installed and are using WebSphere Portal Content Publisher V5.0 and 
installed WebSphere Portal Content Publisher V5.0 Fix Pack 2, you also need to 
update the Document Manager search index. 

When the fix pack is installed, the existing search index for Document Manager is 
deleted. Before you can use the search function with Document Manager after 
installing the fix pack, WebSphere Portal must update the search index through 
the usual automated process, where the search index is updated according to a 
specified interval. You can either wait until the next scheduled update occurs, or 
you can change the interval to the shortest possible time to cause the update to 
occur sooner. 

6.6.7  Verify the WebSphere Portal V5.0.2
Now that you have installed and configured IBM WebSphere Portal V5.0 Fix 
Pack 2, we recommend that you verify that IBM WebSphere Portal V5.0.2 is 
working properly. For details, refer to “Verify WebSphere Portal V5.0” on page 96.

6.7  WebSphere Application Server V5.0.2 Cumulative 
Fix 2 installation

In this section, we describe how to install the prerequisites needed to install IBM 
WebSphere Portal V5.0.2 Cumulative Fix 1. These prerequisites need to be 
installed in the following order specified:

� IBM WebSphere Application Server V5.0.2 Cumulative Fix 2
� IBM WebSphere Application Server Enterprise V5.0.2 Cumulative Fix 2
� IBM WebSphere Application Server V5.0.2 Cumulative Fix 3
� IBM WebSphere Application Server V5.0.2.3 Fixes

IBM WebSphere Portal V5.0.2 Cumulative Fix 1 is installed after those listed 
above.

This section provides the installation steps required to install IBM WebSphere 
Application Server V5.0.2 Cumulative Fix 2.
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6.7.1  Download and unpack WebSphere Application Server V5.0.2 
Cumulative Fix 2

To download and unpack IBM WebSphere Application Server V5.0.2 Cumulative 
Fix 2, complete the following steps:

1. Download IBM WebSphere Application Server V5.0.2 Cumulative Fix 2 from 
the following site:

http://www.ibm.com/support

2. Unpack the downloaded file to the temporary directory on your Portal node. 
For our environment, we used the c:\install\was502cf2\UpdateInstaller 
directory.

6.7.2  Stop the servers
Prior to starting the fix pack installation, you need to make sure that the 
WebSphere Application Servers are not running. To ensure that the servers are 
not running, complete the following steps:

1. From a command prompt, issue the following command to stop the 
WebSphere Portal server:

c:\IBM\WebSphere\AppServer\bin\stopServer WebSphere_Portal

2. Issue the following command to stop the WebSphere Application Server 
server1:

c:\IBM\WebSphere\AppServer\bin\stopServer server1

6.7.3  Install WebSphere Application Server V5.0.2 Cumulative Fix 2

To install IBM WebSphere Application Server V5.0.2 Cumulative Fix 2, complete 
the following steps:

1. From a command prompt, set the environment variables by running the 
following command:

c:\IBM\WebSphere\AppServer\bin\setupCmdLine

2. Navigate to the WebSphere Update Installer directory:

cd \install\was502cf2\UpdateInstaller

Note: This particular fix might now be been superseded and no longer 
available, although you should be able to use the latest maintenance 
available.
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3. Run the WebSphere Update Installer application:

updateWizard

4. When the WebSphere Update Installer language window opens, select the 
appropriate language for the wizard (for example, English) and then click OK.

5. When the Welcome window opens, click Next.

6. WebSphere Update Installer detects your current WebSphere Application 
Server version. Click Next.

Notice that the base version is now V5.0.2 and the installation directory is 
c:\IBM\WebSphere\AppServer. 

7. Select Install fix packs and then click Next.

8. Enter the directory where you have copied the fix pack. For example, we 
entered c:\install\was502cf2\UpdateInstaller\fixpacks in the Fix pack 
directory text field. Click Next.

9. Select the was502_cf2_win fix pack and then click Next.

10.On the Installation Summary window, review the earlier fixes to be uninstalled 
(later versions in cumulative fix) and then click Next to begin the fix pack 
installation of files.

11.When the IBM WebSphere Application Server V5.0.2 Cumulative Fix 2 
installation completes, click Finish.

6.8  IBM WebSphere Application Server Enterprise 
V5.0.2 Cumulative Fix 2 installation

We continue installing the prerequisites needed to install IBM WebSphere Portal 
V5.0.2 Cumulative Fix 1. We already installed the IBM WebSphere Application 
Server V5.0.2 Cumulative Fix 2 fix pack

We still need to install these prerequisites:

� IBM WebSphere Application Server Enterprise V5.0.2 Cumulative Fix 2
� IBM WebSphere Application Server V5.0.2 Cumulative Fix 3
� IBM WebSphere Application Server V5.0.2.3 Fixes

This section provides the installation steps required to install IBM WebSphere 
Application Server Enterprise V5.0.2 Cumulative Fix 2.

Note: If the base version is not detected, enter the path to the WebSphere 
Application Server installation directory.
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6.8.1  Download and unpack WebSphere Application Server 
Enterprise V5.0.2 Cumulative Fix 2

To download and unpack IBM WebSphere Application Server Enterprise V5.0.2 
Cumulative Fix 2, complete the following steps:

1. Download IBM WebSphere Application Server Enterprise V5.0.2 Cumulative 
Fix 2 from the following site:

http://www.ibm.com/support/docview.wss?rs=823&context=SS4QY3&uid=swg24005954

2. Unpack the downloaded file to the temporary directory on your Portal node. 
For our environment, we used the c:\install\wase502cf2\UpdateInstaller 
directory.

6.8.2  Stop the servers
Prior to starting the fix pack installation, you need to make sure that the 
WebSphere Application Servers are not running. To ensure that the servers are 
not running, complete the following steps:

1. From a command prompt, issue the following command to stop the 
WebSphere Portal server:

c:\IBM\WebSphere\AppServer\bin\stopServer WebSphere_Portal

2. Issue the following command to stop the WebSphere Application Server 
server1:

c:\IBM\WebSphere\AppServer\bin\stopServer server1

6.8.3  Install WebSphere Application Server Enterprise V5.0.2 
Cumulative Fix 2

To install IBM WebSphere Application Server Enterprise V5.0.2 Cumulative Fix 
2, complete the following steps:

1. From a command prompt, set the environment variables by running the 
following command:

c:\IBM\WebSphere\AppServer\bin\setupCmdLine

2. Navigate to the WebSphere Update Installer directory:

cd \install\wase502cf2\UpdateInstaller

3. Run the WebSphere Update Installer application:

updateWizard

4. When the WebSphere Update Installer language window opens, select the 
appropriate language for the wizard (for example, English) and then click OK.
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5. When the Welcome window opens, click Next.

6. WebSphere Update Installer detects your current WebSphere Application 
Server version. Click Next.

Notice that the base version is now V5.0.2.2, the enterprise version is 5.0.2, 
and the installation directory is c:\IBM\WebSphere\AppServer.

7. Select Install fix packs and then click Next.

8. Enter the directory where you have copied the fix pack. For example, we 
entered c:\install\wase502cf2\UpdateInstaller\fixpacks in the Fix pack 
directory text field. Click Next.

9. Select the was502_pme_cf2_win fix pack and then click Next.

10.Review the fix pack installation information and then click Next to begin the fix 
pack installation of files.

11.When the IBM WebSphere Application Server Enterprise V5.0.2 Cumulative 
Fix 2 installation completes, click Finish.

6.9  WebSphere Application Server V5.0.2 Cumulative 
Fix 3 installation

We continue installing the prerequisites needed to install IBM WebSphere Portal 
V5.0.2 Cumulative Fix 1. We already installed following fix packs:

� IBM WebSphere Application Server V5.0.2 Cumulative Fix 2
� IBM WebSphere Application Server Enterprise V5.0.2 Cumulative Fix 2

We still need to install these prerequisites:

� IBM WebSphere Application Server V5.0.2 Cumulative Fix 3
� IBM WebSphere Application Server V5.0.2.3 Fixes

This section provides the installation steps required to install IBM WebSphere 
Application Server V5.0.2 Cumulative Fix 3.

Note: If the base version is not detected, enter the path to the WebSphere 
Application Server installation directory.
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6.9.1  Download and unpack WebSphere Application Server V5.0.2 
Cumulative Fix 3

To download and unpack IBM WebSphere Application Server V5.0.2 Cumulative 
Fix 3, complete the following steps:

1. Download IBM WebSphere Application Server V5.0.2 Cumulative Fix 3 from 
the following site:

http://www.ibm.com/support

2. Unpack the downloaded file to the temporary directory on your Portal node. 
For our sample, we used the c:\install\was502cf3\UpdateInstaller directory.

6.9.2  Stop the servers
Prior to starting the fix pack installation, you need to make sure that the 
WebSphere Application Servers are not running. To ensure that the servers are 
not running, complete the following steps:

1. From a command prompt, issue the following command to stop the 
WebSphere Portal server:

c:\IBM\WebSphere\AppServer\bin\stopServer WebSphere_Portal

2. Issue the following command to stop the WebSphere Application Server 
server1:

c:\IBM\WebSphere\AppServer\bin\stopServer server1

6.9.3  Install WebSphere Application Server V5.0.2 Cumulative Fix 3

‘To install the IBM WebSphere Application Server V5.0.2 Cumulative Fix 3, 
complete the following steps:

1. From a command prompt, set the environment variables by running the 
following command:

c:\IBM\WebSphere\AppServer\bin\setupCmdLine

2. Navigate to the WebSphere Update Installer directory:

cd \install\was502cf3\UpdateInstaller

3. Run the WebSphere Update Installer application:

updateWizard

Note: This particular fix might now have been superseded and no longer 
available, although you should be able to use the latest maintenance 
available.
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4. When the WebSphere Update Installer language window opens, select the 
appropriate language for the wizard (for example, English) and then click OK.

5. When the Welcome window opens, click Next.

6. WebSphere Update Installer detects your current WebSphere Application 
Server version. Click Next.

Notice that the base version is now V5.0.2.2 and the installation directory is 
c:\IBM\WebSphere\AppServer. 

7. Select Install fix packs and then click Next.

8. Enter the directory where you have copied the fix pack. For example, we 
entered c:\install\was502cf3\UpdateInstaller\fixpacks in the Fix pack 
directory text field. Click Next.

9. Select the was502_cf3_win fix pack and then click Next.

10.Review the fix pack installation information and then click Next to begin the fix 
pack installation of files.

11.When the IBM WebSphere Application Server V5.0.2 Cumulative Fix 3 
installation completes, click Finish.

6.10  IBM WebSphere Application Server V5.0.2.3 Fixes 
installation

We continue installing the prerequisites needed to install IBM WebSphere Portal 
V5.0.2 Cumulative Fix 1. We already installed following fix packs:

� IBM WebSphere Application Server V5.0.2 Cumulative Fix 2
� IBM WebSphere Application Server Enterprise V5.0.2 Cumulative Fix 2
� IBM WebSphere Application Server V5.0.2 Cumulative Fix 3

We still need to install the last one: IBM WebSphere Application Server V5.0.2.3 
Fixes.

This section provides the installation steps required to install IBM WebSphere 
Application Server V5.0.2.3 Fixes.

Note: If the base version is not detected, enter the path to the WebSphere 
Application Server installation directory.
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6.10.1  Download and unpack Application Server V5.0.2.3 Fixes

The following fixes are required to install IBM WebSphere Portal V5.0.2 
Cumulative Fix 1:

� WAS_Dynacache_01-30-2004_5.0.2_cumulative
� PQ78370
� PQ81248
� PQ81416
� WAS_Security_12-12-2003_5.0.2.3-5.0.2.2-5.0.2.1-5.0.2-5.0.1-5.0.0_JSSE_cu

mulative_Fix
� WAS_CM_08-12-2003_5.0.2-5.0.1_cumulative_Fix
� WAS_Adapter_10-30-2003_5.0.2_cumulative_Fix
� WAS_Plugin_02-03-2004_5.0.X_cumulative

Normally, you would need to download the fixes individually from the WebSphere 
Application Server Support Web site. However, there is a file located on the 
WebSphere Portal Support Web site that includes all of these fixes and 
specifically targets IBM WebSphere Application Server 5.0.2.3 for Windows. 

Therefore, you can download the fixes individually, or you can download all of 
the fixes bundled in one file. In order to download the bundle, you need to 
perform the following steps:

1. Go to the “Required WebSphere Application Server Fixes for Portal 5.0.2.1” 
site at:

http://www.ibm.com/support/docview.wss?rs=688&context=SSHRKX&uid=swg2400798
5&loc=en_US&cs=utf-8&lang=en

2. Under Download package, click the HTTPS link.

3. Next, review the term and conditions, and if in agreement, click I agree.

4. The next step, which is required, is to log in to the WebSphere Portal Support 
Web site. If you have not registered before, you have to do so first 
(registration is free).

5. The next window presents a link to the license agreement to which you have 
to agree to proceed.

6. On the next window, click the WAS 5.0.2.3 Fixes for Portal ToolKit 5.0.2.1 
link.

7. To download the fixes, click the Download now link in the WAS 5.0.2.3 Fixes 
for Portal ToolKit 5.0.2.1for Microsoft Windows section.

8. Unpack the downloaded file WAS5023CumulativeWindows.zip to the 
temporary directory on your Portal node. For our example, we used the 
c:\install\was5023fx\UpdateInstaller directory.
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6.10.2  Stop the servers
Prior to starting the fixes installation, you need to make sure that the WebSphere 
Application Servers are not running. To ensure that the servers are not running, 
complete the following steps:

1. From a command prompt, issue the following command to stop the 
WebSphere Portal server:

c:\IBM\WebSphere\AppServer\bin\stopServer WebSphere_Portal

2. Issue the following command to stop the WebSphere Application Server 
server1:

c:\IBM\WebSphere\AppServer\bin\stopServer server1

6.10.3  Install WebSphere Application Server V5.0.2.3 Fixes
‘To install IBM WebSphere Application Server V5.0.2.3 Fixes, complete the 
following steps:

1. From a command prompt, set the environment variables by running the 
following command:

c:\IBM\WebSphere\AppServer\bin\setupCmdLine

2. Navigate to the WebSphere Update Installer directory:

cd \install\was5023fx\UpdateInstaller

3. Run the WebSphere Update Installer application:

updateWizard

4. When the WebSphere Update Installer language window opens, select the 
appropriate language for the wizard (for example, English) and then click OK.

5. When the Welcome window opens, click Next.

6. WebSphere Update Installer detects your current WebSphere Application 
Server version. Click Next.

Notice that the base version is now V5.0.2.3 and the enterprise version is 
V5.0.2.2. The installation directory is c:\IBM\WebSphere\AppServer.

7. Select Install fixes and then click Next.

8. Enter the directory where you have copied the fixes. For example, we entered 
c:\install\was502cf3\UpdateInstaller\efixes in the Fix pack directory text 
field. Click Next.

Note: If the base version is not detected, enter the path to the WebSphere 
Application Server installation directory.
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9. When the window opens with a list of fixes, only select the following eight 
fixes and then click Next:

– WAS_Dynacache_01-30-2004_5.0.2_cumulative
– PQ78370
– PQ81248
– PQ81416
– WAS_Security_12-12-2003_5.0.2.3-5.0.2.2-5.0.2.1-5.0.2-5.0.1-5.0.0_JSSE

_cumulative_Fix
– WAS_CM_08-12-2003_5.0.2-5.0.1_cumulative_Fix
– WAS_Adapter_10-30-2003_5.0.2_cumulative_Fix
– WAS_Plugin_02-03-2004_5.0.X_cumulative

10.On the Installation Summary window, review the fixes to be installed or 
refreshed and then click Next to begin the fix pack installation of files.

11.When the IBM WebSphere Application Server V5.0.2.3 Fixes installation 
completes, click Finish.

6.10.4  Verify WebSphere Application Server V5.0.2.3
Prior to continuing to the IBM WebSphere Portal V5.0.2 Cumulative Fix 1 
installation, we recommend that you verify that the IBM WebSphere Application 
Server V5.0.2.3 is working properly.

For details about how to verify WebSphere Application Server, refer to “Verify 
WebSphere Application Server V5.0.2” on page 106.

Note: If one of the following three fixes is selected, you will receive an error 
stating that the fix or fixes are not supported on your installed products:

� PQ75469
� PQ77008
� PQ78166

In addition, we did not select PQ76567 or PQ79083, because the readme 
states that they are included in 
WAS_Dynacache_01-30-2004_5.0.2_cumulative.

Finally, there are seven remaining fixes that we did not select for two 
reasons:

� They are not required per the IBM WebSphere Portal V5.0.2 
Cumulative Fix 1 readme file. 

� We tested the selection of all fixes and eventually had issues running 
the WPSconfig.bat WP-PTF-5021 configuration task after installing IBM 
WebSphere Portal V5.0.2 Cumulative Fix 1.
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6.11  IBM WebSphere Portal V5.0.2 Cumulative Fix 1 
installation

This section describes how to install IBM WebSphere Portal V5.0.2 Cumulative 
Fix 1. This cumulative fix has several prerequisites that need to be installed. We 
provide the instructions for installing these prerequisites in the preceding 
sections.

6.11.1  Download and unpack Portal V5.0.2 Cumulative Fix 1

IBM WebSphere Portal V5.0.2 Cumulative Fix 1 needs an appropriate Portal 
Update Installer application to install itself. Because this application is not 
bundled with the cumulative fix in one file, you need to download it separately. To 
download and unpack IBM WebSphere Portal V5.0.2 Cumulative Fix 1, complete 
the following steps:

1. Go to the “WebSphere Portal 5.0.2 Cumulative Fix 1” site located at:

http://www.ibm.com/support/docview.wss?rs=688&context=SSHRKX&q1=WebSphere+P
ortal+5.0.2+Cumulative+Fix+1&uid=swg24006865&loc=en_US&cs=utf-8&lang=en

2. Under Download package, click the link for WPS 5.0.2 Cumulative Fix 1.

3. Next, review the term and conditions, and if in agreement, click I agree.

4. The next step, which is required, is to log in to the WebSphere Portal Support 
Web site. If you have not registered before, you have to do so first 
(registration is free).

5. The next window presents a link to the license agreement to which you have 
to agree to proceed.

6. On the next window, click the Utilities link.

7. To download the Portal Update Installer, click the Download now link in the 
WebSphere Portal for MultiPlatforms Update Installer section.

Note: IBM WebSphere Portal V5.0.2 will not work with the level of WebSphere 
Application Server at this stage. WebSphere Portal will work after applying 
IBM WebSphere Portal V5.0.2 Cumulative Fix 1 in the next section.

Note: More information regarding the contents of WebSphere Portal V5.0.2 
Cumulative Fix 1 is available at:

http://www.ibm.com/support/docview.wss?rs=688&context=SSHRKX&q1=cumulativ
e+fix&uid=swg24006865&loc=en_US&cs=utf-8&lang=en+en
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8. Click Back in your browser, or scroll all the way to the top of the page.

9. Click the Portal 5.0.2 Cumulative Fix 1 link.

10.To download the fixes, click the Download now link in the Portal 5.0.2 
Cumulative Fix 1 section.

11.Unpack the downloaded file PortalUpdateInstaller.zip file to the temporary 
directory on your Portal node. For our environment, we used the 
c:\install\wps502cf1\UpdateInstaller directory.

12.Copy the downloaded file WP_PTF_5021.jar file to the Portal Update Installer 
application directory on your Portal node. In our case, it would be the 
c:\install\wps502cf1\UpdateInstaller\fixpack directory.

6.11.2  Stop the servers
Prior to starting the fix pack installation, you need to make sure that WebSphere 
Application Servers and IBM HTTP Server are not running. To ensure that the 
server are not running, complete the following steps:

1. From a command prompt, issue the following command to stop the 
WebSphere Portal server:

c:\IBM\WebSphere\AppServer\bin\stopServer WebSphere_Portal

2. Issue the following command to stop the WebSphere Application Server 
server1:

c:\IBM\WebSphere\AppServer\bin\stopServer server1

3. Stop the IBM HTTP Server by clicking Start → Programs → IBM HTTP 
Server 1.3.26 → Stop HTTP Server.

6.11.3  Prepare WebSphere Portal V5.0.2 for installation
To prepare IBM WebSphere Portal V5.0.2, complete the following steps:

1. Edit the httpd.conf file for IBM HTTP Server 
(c:\IBM\IBMHttpServer\conf\httpd.conf), as shown in Example 6-1.

Example 6-1   Example httpd.conf for IBM HTTP Server

##Uncommment the following line
Listen 80

##Comment out the following four lines
#Port 80
#AfpaEnable
#AfpaCache on
#AfpaLogFile “C:\ibm\IBMHttpServer/logs/afpalog” V-EDLF
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2. Change the timeout for the SOAP client for WebSphere Application Server (if 
you have not done so previously):

a. Open the c:\IBM\WebSphere\AppServer\properties\soap.client.props file.

b. Modify the request timeout as follows (default is 180 seconds):

com.ibm.SOAP.requestTimeout=6000

c. Save and close the file.

6.11.4  Install WebSphere Portal V5.0.2 Cumulative Fix 1
To install IBM WebSphere Portal V5.0.2 Cumulative Fix 1, complete the following 
steps:

1. From a command prompt, set the environment variables by running the 
following command:

c:\IBM\WebSphere\AppServer\bin\setupCmdLine

2. Navigate to the Portal Update Installer directory:

cd \install\wps502cf1\UpdateInstaller

3. Run the Portal Update Installer application:

updatePortal -fixpack -installDir c:\IBM\Websphere\PortalServer -fixpackDir 
c:\install\wps502cf1\UpdateInstaller\fixpacks -install -fixpackID 
WP_PTF_5021

Note: In our example, we have not yet created the WebSphere Portal 
databases for DB2. Therefore, the following steps are not required.

However, for an environment where the WebSphere Portal databases have 
already been created in DB2, you can reduce deadlocks with the WebSphere 
Portal databases by doing the following:

� DB2 Version 8.1 FP4 or later users only: Use the DB2 command window to 
enter the following commands on the DB2 server with DB2 instance owner 
privileges:

db2set DB2_EVALUNCOMMITTED=YES
db2set DB2_INLIST_TO_NLJN=YES
db2 update db cfg for <portal_db using locklist 1024>

3. All database users: Connect to the WebSphere Portal database and enter 
the following commands on the database server:

CREATE INDEX <portal_db_admin_user>.IX2110D ON 
<portal_db_admin_user>.PROT_RES (PARENT_OID, OID)
CREATE INDEX <portal_db_admin_user>.IX2140B ON 
<portal_db_admin_user>.LNK_USER_ROLE (ROLE_INST_OID)
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4. When the fix pack is complete, you should see this message:

Fix pack installation completed successfully

If you receive any errors, you can review the log information in the 
c:\IBM\WebSphere\PortalServer\log directory.

5. Restart IBM HTTP Server. Note that this step is optional if you have not 
configured WebSphere Portal to use the external IBM HTTP Server. If 
following the procedure in this chapter, this step is not required.

6. In a command prompt window, run the following command to update the 
WebSphere Portal configuration:

c:\IBM\WebSphere\PortalServer\config\WPSConfig.bat WP-PTF-5021 
-DPortalAdminPwd=<password>

Where <password> is the WebSphere Portal administrator password. If 
following the procedure in this chapter, this password equals to the password 
we entered during the installation of IBM WebSphere Portal V5.0 in “Install 
WebSphere Portal V5.0” on page 93, step 8 on page 93.

Note: If you configured IBM WebSphere Application Server V5.0.2 security 
prior to installing IBM WebSphere Portal V5.0.2 Cumulative Fix 1, you 
need to ensure that the WasUserid and WasPassword fields are 
populated correctly in the 
c:\IBM\WebSphere\PortalServer\config\wpconfig.properties file before 
running the Portal Update Installer.

Note: Configuration failure/recovery

If the Update WebSphere Portal configuration task fails, do the following:

1. Correct the cause of the failure.

2. Uninstall IBM WebSphere Portal V5.0.2 Cumulative Fix 1 (uninstall 
might be better called unconfigure; this just unconfigures the failed 
configuration) as follows:

c:\IBM\WebSphere\PortalServer\config\WPSconfig.bat 
UNINSTALL-WP-PTF-5021

3. Rerun the WebSphere Portal configuration task:

c:\IBM\WebSphere\PortalServer\config\WPSConfig.bat WP-PTF-5021 
-DPortalAdminPwd=<password>

For details, refer to the IBM WebSphere Portal V5.0.2 Cumulative Fix 1 
readme file (install_win_unix.html), available at:

http://publib.boulder.ibm.com/pvc/wp/5021/ent/en/readme/install.html
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4. Restart WebSphere Application Server server1 by issuing the following 
commands:

cd c:\IBM\WebSphere\AppServer\bin
stopServer server1
startServer server1

5. Restart WebSphere Portal by issuing the following commands:

stopServer WebSphere_Portal
startServer WebSphere_Portal

6.11.5  Verify WebSphere Portal V5.0.2
Now that you have installed and configured IBM WebSphere Portal V5.0.2 
Cumulative Fix 1, we recommend that you verify that the IBM WebSphere Portal 
V5.0.2.1 is working properly. For details, refer to “Verify WebSphere Portal V5.0” 
on page 96.

6.12  IBM Tivoli Directory Server Version 5.2 installation
Tivoli Directory Server Version 5.2 is used by all application platforms as a user 
repository to facilitate single sign-on and user management. We chose to install 
this server on our Portal node as described in the following sections.

6.12.1  Create an administrator user and assign user rights
To assign user rights to the administrator ID used by the DB2 owner during 
instance creation, complete the following steps:

1. Log on to Windows as an administrator.

2. Create a user ID and add the user to the Administrators group (for example, 
we created a user called TDSadmin). Alternatively, use an existing 
administrator user. 

3. Click Start → Settings → Control Panel → Administrative Tools → Local 
Security Policy.

4. From the Local Security Settings window, select and expand Local 
Policies → User Rights Assignment.

5. Ensure that the administrator user ID (for example, TDSadmin) has user right 
assignments for the following Windows local security policies needed for DB2:

– Act as part of the operating system
– Create a token object
– Increase quotas
– Log on as a service
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– Replace a process-level token

6. Log on with your user ID (TDSadmin in our case).

7. Verify the network configuration.

Prior to installing WebSphere Commerce and the supporting software 
components, it is important that you verify that your network is configured 
properly. We recommend that you use a static TCP/IP address and verify that the 
host name can be resolved with the name server.

For example, we did the following from a command prompt window:

ping <hostname>
ping <ip_address>
or
nslookup <hostname>
nslookup <ip_address>

Ensure that the fully qualified host name is returned if resolved by a domain 
name system. Alternatively, you might be using a hosts file for a stand-alone 
development environment (use ping instead of nslookup).

6.12.2  Install IBM GSKit
This section describes how to download and install IBM GSKit V7.0.1.16. GSKit 
is used to manage key stores and certificates. GSKit includes the IBM Key 
Management Utility and libraries accessible to applications to create and 
manage certificates. 

GSKit V7.0.1.9 installed with IBM Tivoli Directory Server V5.2 on the Directory 
Server node includes root certificates that have expired. This results in the 
administrator not being able to create a new key store using the iKeyman utility. 
By installing the later version, IBM GSKit V7.0.1.16, this issue is addressed along 
with other fixes.

Determine GSKit version installed
This section describes how to determine the version of GSKit an application is 
configured to use in the Windows registry. If you are following the installation 
order documented in this chapter, this section is not necessary, because we 
install the new GSKit prior to installing components that use it.

Note: The GSKit version can be obtained by using the gsk7ver.exe command 
or by retrieving the version from the Windows registry. We chose to use the 
Windows registry method because we also needed the REGAPPS value in 
addition to the version.
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If you have not installed IBM Tivoli Directory Server or other software containing 
IBM GSKit, you can skip this section. To determine the level of the GSKit 
installed, complete the following steps:

1. Start the Windows registry editor (regedit.exe) by clicking Start → Run and 
entering regedit in the Open field. Click OK.

2. Select and expand HKEY_LOCAL_MACHINE → SOFTWARE → IBM.

3. In our example, you will see both the GSK5 and GSK7 registry entries.

4. Select GSK7 → CurrentVersion. Record the data value for the version 
name. 

5. Select REGAPPS under the CurrentVersion. This will list the name of the 
application using GSKit. Record the name of the application using this version 
of GSKit (for example, LDAP).

Uninstall the earlier GSKit version
If you are strictly following the installation of the Portal node as defined so far, 
this section is not required.

Prior to installing the new IBM GSKit V7.0.1.16, if a GSKit already has been 
installed, you must manually uninstall the existing IBM GSKit V7.0.1.9 as follows:

1. Ensure that the IBM Tivoli Directory Server V5.2 Windows service has been 
stopped, as well as other services that might be using GSKit.

2. Open a command prompt window and navigate to the c:\winnt directory.

3. Run the following command to uninstall GSKit:

gsk7bui LDAP

Where LDAP is the name of the application using the GSKit.

4. Verify that the GSK7 Windows registry has been removed.

5. Verify that the GSK7 directory has been removed (for example, C:\Program 
Files\IBM\GSK7).

Note: If files still exist such as DLLs, manually delete the C:\Program 
Files\IBM\GSK7 directory after the services that locked the files have been 
stopped.

Note: If you previously installed applications that use the earlier GSKit 
V7.0.1.9, the applications might have updated the system path to include the 
GSKit installation path. If you decide to change the default GSKit installation 
path, you might need to manually update the system path to include the 
correct GSKit installation path.
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Install GSKit V7.0.1.16
To download and install IBM GSKit Version 7.0.1.16, complete the following 
steps:

1. IBM GSKit V7.0.1.16 can be obtained by one of the following methods:

– Request GSKit V7.0.1.16 from IBM Support at:
http://techsupport.services.ibm.com/guides/tivoli_contacts.html

Or:

– Download IBM HTTP Server V1.3.28, which includes IBM GSKit V7.0.1.16 
at:
http://www.ibm.com/support/docview.wss?rs=177&context=SSEQTJ&uid=swg2400
6718

2. Open a command prompt window and navigate to the directory in which you 
unpacked the WINDOWSPQ86671IHS1.3.28.zip file.

3. Enter the following at the command line to extract the GSKit:

gsk7bas c:\temp

Where c:\temp is the directory into which to extract the GSKit installation 
files.

4. From the command window, navigate to the directory where you extracted the 
GSKit installation files (for example, c:\temp).

5. Run the GSKit installer as follows:

setup <application_name>

Where <application_name> is the name of the application using GSKit 
V7.0.1.16 (for example, LDAP).

For example:

setup LDAP

6. When the Welcome window opens, click Next.

7. When the Choose Destination Location window opens, we entered 
c:\ibm\gsk7 for the destination folder using the Browse button. Click Next to 
proceed.

8. When the setup is complete, click Finish.

Note: From the URL listed, you will have to log in as a registered user (or 
register first). After you navigate to the download page by platforms, you 
will see a list of fixes. 

We downloaded WINDOWSPQ86671IHS1.3.28.zip (PQ86671) for IBM 
HTTP Server V1.3.28 to the c:\temp directory and unpacked the ZIP file.
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6.12.3  Install IBM Tivoli Directory Server
This section describes how to install IBM Tivoli Directory Server V5.2 on the 
Directory Server node. WebSphere Portal V5.0.2 includes IBM Tivoli Directory 
Server V5.1. We chose to use IBM Tivoli Directory Server V5.2 to verify the 
configuration with the newer version.

IBM Tivoli Directory Server V5.2 includes WebSphere Application Server 
Express and the Web Administration Tool used to manage Tivoli Directory 
Server. We chose to install the Web Administration Tool on WebSphere 
Application Server (not Express).

The high-level steps to install and configure IBM Tivoli Directory Server are as 
follows:

� Create DB2 database owner
� Install Tivoli Directory Server

Create DB2 database owner
In our example, we granted the TDSadmin user the proper rights assignments for 
a DB2 user (see 9.1.3, “Create system users and assign user rights” on 
page 190). No other action is needed.

Install Tivoli Directory Server
To install IBM Tivoli Directory Server V5.2 on the Policy Server node, do the 
following:

1. Insert the IBM Tivoli Directory Server V5.2 CD.

2. Navigate to the <CD_Root>\ismp folder, and run Setup.exe to start the install.

3. Select the installer language (for example, English); this is separate from the 
IBM Tivoli Directory Server language. Click OK.

4. When the Welcome window opens, click Next.

5. When the License Agreement window opens, review the terms, and if in 
agreement, select I accept the terms in the license agreement and then 
click Next.

6. A window displays existing components. In our example, we preinstalled IBM 
GSKit and IBM DB2 UDB. Click Next.

7. We installed IBM Tivoli Directory Server in the c:\ibm\ldap directory.

8. Select the IBM Tivoli Directory Server language (for example, English) and 
click Next.
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9. When the Select features to install window opens, we selected the following 
options, as shown in Figure 6-3, and then click Next.

– Select Client SDK 5.2.
– Select Web Administration Tool 5.2.
– Select Server 5.2.
– Clear IBM WebSphere Application Server - Express 5.0.2.

We use WebSphere Application Server instead of Express.
– Clear DB2 V8.1.

A later level of DB2 UDB has already been installed.
– Clear GSKit.

A later level of the GSKit has already been installed.

Figure 6-3   IBM Tivoli Directory Server: Select features

10.When the Installation Summary window opens, review the selections and 
click Next to begin installing the files.

11.When the installation completes, review the readme files for the client and 
server and click Next.

12.When prompted, select Yes, restart my computer and click Next. Click 
Finish.
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6.13  Summary
We have now completed the installation of the Portal node. Additional 
configuration is necessary. We describe the additional configuration in 
Chapter 10, “Configuration” on page 227.
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Chapter 7. Business Integration node 
installation

This chapter describes the procedure we used to install and configure the 
Business Integration node for our example runtime environment.

The high-level tasks to install the Business Integration node are as follows:

1. WebSphere Business Integration Server Foundation V5.1 installation

2. IBM WebSphere Application Server V5.1 Fix Pack 1 installation

7

Note: When installing and configuring the Business Integration node, we 
referenced the following information sources:

� IBM WebSphere Business Integration Server Foundation, Version 5.1: 
Getting started, IBM Information Center Library, available at:

ftp://ftp.software.ibm.com/software/webserver/appserv/library/wasv51ee_gs
.pdf

� IBM WebSphere Business Integration Server Foundation, Version 5.1: 
Process Choreographer, IBM Information Center Library, available at:

ftp://ftp.software.ibm.com/software/webserver/appserv/library/ee_v512ptf_
twork.pdf
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3. IBM WebSphere Business Integration Server Foundation V5.1 Fix Pack 1 
installation

In our environment, this node was running Microsoft Windows 2000 Server. The 
administrator ID for this machine must have the following rights:

� Act as part of the operating system
� Create a token object
� Increase quotas
� Log on as a service
� Replace a process-level token
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7.1  WebSphere Business Integration Server Foundation 
V5.1 installation

This section describes how to install IBM WebSphere Business Integration 
Server Foundation V5.1 on the Process Choreographer node. We install 
following components with this installation:

� IBM WebSphere Application Server Version 5.1.0.2
� IBM Integration Server Version 5.1.0
� IBM WebSphere embedded messaging

7.1.1  Install WebSphere Business Integration Server Foundation V5.1

To install IBM WebSphere Business Integration Server Foundation V5.1, 
complete the following steps:

1. Start the installation by inserting IBM WebSphere Business Integration Server 
Foundation V5.1 Installation Disk 1. If auto start is enabled, the installation 
wizard will start automatically. If auto start is disabled, run install.bat from 
the win directory on the CD by entering the D:\win\install.bat command, 
where the D: drive is your CD-ROM drive. Start the installation from a 
read/write location and not from the CD-ROM.

2. When the Welcome window opens, you are provided with an option to launch 
the Information Center (optional). Click Next to continue the installation.

3. When the License Agreement window opens, review the terms, and if in 
agreement, select I accept the terms in the license agreement and then 
click Next.

4. The next window provides the installation options: Full (all components) or 
Custom. In our example, select Custom and click Next to continue.

5. Because we chose the custom installation, we have to choose the 
components to install in the next window. See Figure 7-1 on page 136. Make 
sure that you have selected the following components:

– Embedded messaging
– Embedded messaging: Server and Client
– Additional Integration Server Extensions
– Scheduler and Asynchronous Beans
– process choreographer

Click Next.
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Figure 7-1   WebSphere Business Integration Server Foundation component selection

6. The wizard displays a window for the WebSphere Application Server and 
Embedded Messaging installation directories. We used the following paths 
and then clicked Next:

– WebSphere Application Server V5.1 Installation directory: 
C:\IBM\WebSphere\AppServer

– Embedded Messaging Installation directory: C:\IBM\WebSphere\MQ

7. The next window prompts for the node name and the host name of the 
computer on which the server will be running. The defaults should be fine. In 
our scenario, the defaults were:

– Node Name: ilm-bi
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– Host Name or IP Address: ilm-bi.itsc.austin.ibm.com

Click Next.

8. The next window prompts for the system logon user ID and password that will 
be used to run WebSphere Application Server as a Windows NT service. If 
you do not want WebSphere Application Server running as a service, you can 
skip this window by clicking Next. Otherwise, select Run WebSphere 
Application Server As Service and provide the valid user name and 
password. Note that this user account is one of your Windows system user 
accounts, as opposed to most of the user accounts used in this book, which 
are located in the LDAP directory residing on the Tivoli Directory Server. The 
preferred practice is to enter in the user account you are using to install the 
product. We used following values:

– User ID: WASadmin
– Password: <password>

Click Next.

9. The installation starts. You will be prompted to switch the CDs.

Note: If the following message appears in the next window, you have to 
cancel the installation:

INST0056E: The user name and password specified cannot be validated 
due to insufficient privileges of current user...

Make sure that you have the appropriate rights, including:

� Act as part of the operating system
� Create a token object
� Increase quotas
� Log on as a service
� Replace a process-level token

Note: For our environment, we avoided the necessity of replacing CDs by 
putting the CD images on a network drive. By verifying that you use the 
following directory names for each CD image (and placing the images in the 
same directory in the network), you will not be prompted to insert any CDs:

� Disk1
� Disk2
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7.1.2  Verify WebSphere Business Integration Server Foundation V5.1

If the installation completed properly, the WebSphere Application Server First 
Steps application should be running. 

If it is not running because you restarted the system after the installation 
(optional), start the First Steps application by clicking Start → Programs → IBM 
WebSphere → Application Server v5.1 → InfoCenter. 

In addition, make sure that the WebSphere Application Server is running. 
(WebSphere Application Server is started by the installation process 
automatically.) If it is not running, you can start it from the First Steps application 
by clicking Start the Server.

To verify IBM WebSphere Business Integration Server Foundation V5.1, 
complete the following steps:

1. In the First Steps application, click Verify Installation.

2. The First Steps Output - Verify Installation Test window should open, and 
then some tests are performed. Check that the verification completed 
successfully.

7.2  IBM WebSphere Application Server V5.1 Fix Pack 1 
installation

In order to update IBM WebSphere Business Integration Server Foundation from 
Version 5.1.0 to Version 5.1.1, we need to upgrade the base WebSphere 
Application Server first and then update the Integration Server component.

This section describes the installation steps required for the installation of IBM 
WebSphere Application Server V5.1 Fix Pack 1.

Note: If the verification fails for any reason, or in the case of installation 
problems, refer to the following publication:

� IBM WebSphere Business Integration Server Foundation, Version 5.1: 
Getting started; IBM Information Center Library:

ftp://ftp.software.ibm.com/software/webserver/appserv/library/wasv51ee_gs.pdf
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7.2.1  Download fix pack and WebSphere Update Installer application

Fix packs for the WebSphere family of products need an appropriate WebSphere 
Update Installer application to install them. 

1. Go to the following site:

http://www.ibm.com/support/docview.wss?rs=180&context=SSEQTP&uid=swg24006036

2. Download the installer for the Windows platform and unpack its contents to 
the temporary directory, for example, c:\install\was51fp1\UpdateInstaller.

3. Download the IBM WebSphere Application Server V5.1 Fix Pack 1 from the 
following site:

http://www.ibm.com/support/docview.wss?rs=180&context=SSEQTP&uid=swg24007195

Or download it directly from:

ftp://ftp.software.ibm.com/software/websphere/appserv/support/fixpacks/was5
1/fixpack1/Windows/was51_fp1_win.zip

4. Unpack the downloaded file to the update subdirectory of your WebSphere 
Update Installer directory. In our case, it is the 
c:\install\was51fp1\UpdateInstaller\update directory.

7.2.2  Stop the server
Prior to starting the fix pack installation, you need to make sure that WebSphere 
Application Server is not running. To ensure that the server is not running, from a 
command prompt, issue the following command to stop the WebSphere 
Application Server server1:

c:\IBM\WebSphere\AppServer\bin\stopServer server1

7.2.3  Install WebSphere Application Server V5.1 Fix Pack 1
‘To install the IBM WebSphere Application Server V5.1 Fix Pack 1, complete the 
following steps:

1. From a command prompt, set the environment variables by running the 
following command:

c:\IBM\WebSphere\AppServer\bin\setupCmdLine

2. Navigate to the WebSphere Update Installer directory:

cd \install\was51fp1\UpdateInstaller

3. Run the WebSphere Update Installer application:

updateWizard
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4. When the WebSphere Update Installer language window opens, select the 
appropriate language for the wizard (for example, English) and then click OK.

5. When the Welcome window opens, click Next.

6. WebSphere Update Installer detects your current WebSphere Application 
Server version. Click Next.

Notice that the base version is now V5.1.0.2 because the base fix pack has 
been installed, and the installation directory is c:\IBM\WebSphere\AppServer.

7. Select Install fix packs and then click Next.

8. Enter the directory where you have copied the fix pack. For example, we 
entered c:\install\was51fp1\UpdateInstaller\update in the Fix pack 
directory text field. Click Next.

9. Select the was51_fp1_win fix pack and then click Next.

10.The next window prompts you for the path to IBM HTTP Server and 
Embedded Messaging. 

We have not installed IBM HTTP Server, so the IBM HTTP Server Installation 
directory should state Not Found and the IBM HTTP Server should not be 
selected. 

We installed embedded messaging, so we need to install the fix pack for it. 
Make sure that Embedded Messaging is selected and the Embedded 
Messaging Installation directory is set to C:\IBM\WebSphere\MQ. See 
Figure 7-2 on page 141.

Note: If the base version is not detected, enter the path to the WebSphere 
Application Server installation directory.

Note: If you installed IBM HTTP Server previously, you also need to install 
its fix pack. In that case, select IBM HTTP Server and provide the IBM 
HTTP Server installation path.
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Figure 7-2   WebSphere Application Server V5.1 Fix Pack 1 component selection

11.When the Information window opens, click Next.

12.Review the fix pack settings and then click Next to begin the fix pack 
installation.

13.When the IBM WebSphere Application Server V5.1 Fix Pack 1 installation 
completes, click Finish.

7.3  IBM WebSphere Business Integration Server 
Foundation V5.1 Fix Pack 1 installation

In order to update IBM WebSphere Business Integration Server Foundation from 
Version 5.1.0 to Version 5.1.1, we need to upgrade the base WebSphere 
Application Server first and then update the Integration Server component. We 
describe updating WebSphere Application Server in 7.2, “IBM WebSphere 
Application Server V5.1 Fix Pack 1 installation” on page 138.

This section describes the installation steps required for the installation of IBM 
WebSphere Business Integration Server Foundation V5.1 Fix Pack 1.
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7.3.1  Download and unpack the fix pack
Fix packs for the WebSphere family of products need the appropriate 
WebSphere Update Installer application to install them. To download and unpack 
the fix pack, complete the following steps:

1. Download IBM WebSphere Business Integration Server Foundation V5.1 Fix 
Pack 1 from the following site:

http://www.ibm.com/support/docview.wss?rs=1079&context=SS2KS6&uid=swg240074
86&loc=en_US&cs=utf-8&lang=en

Or download it directly from:

ftp://ftp.software.ibm.com/software/websphere/appserv/support/fixpacks/was5
1/fixpack1_wbisf/Windows/wbisf51_fp1_win.zip

2. Unpack the downloaded file to some temporary directory. We unpacked the 
fix pack into the c:\install\wbisf51fp1\UpdateInstaller directory.

7.3.2  Stop the server
Prior to starting the fix pack installation, you need to make sure that WebSphere 
Application Server is not running. To ensure that the server is not running, from a 
command prompt, issue the following command to stop the WebSphere 
Application Server server1:

c:\IBM\WebSphere\AppServer\bin\stopServer server1

7.3.3  Install WebSphere Business Integration Server Foundation V5.1 
Fix Pack 1

To install IBM WebSphere Business Integration Server Foundation V5.1 Fix 
Pack 1, complete the following steps:

1. From a command prompt, set the environment variables by running the 
following command:

c:\IBM\WebSphere\AppServer\bin\setupCmdLine

2. Navigate to the WebSphere Update Installer directory:

cd \install\wbisf51fp1\UpdateInstaller

3. Run the WebSphere Update Installer application:

updateWizard

4. When the WebSphere Update Installer language window opens, select the 
appropriate language for the wizard (for example, English) and then click OK.

5. When the Welcome window opens, click Next.
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6. The WebSphere Update Installer detects your current WebSphere 
Application Server and Integration Server version. Click Next.

Notice that the base version is now V5.1.1 because the base fix pack has 
been installed and the Integration Server version is still V5.1.0. The 
installation directory is c:\IBM\WebSphere\AppServer. 

7. Select Install fix packs and then click Next.

8. Enter the directory where you have copied the fix pack. For example, we 
entered c:\install\wbisf51fp1\UpdateInstaller\update in the Fix pack 
directory text field. Click Next.

9. Select the wbisf51_fp1_win fix pack and then click Next.

10.When the Information window opens, click Next.

11.Review the fix pack settings and then click Next to begin the fix pack 
installation.

12.When the IBM WebSphere Business Integration Server Foundation V5.1 Fix 
Pack 1 installation completes, click Finish.

7.3.4  Verify Business Integration Server Foundation V5.1.1

To verify the IBM WebSphere Business Integration Server Foundation V5.1.1 
installation, complete the following steps:

1. Start the WebSphere Application Server - First Steps application by clicking 
Start → Programs → IBM WebSphere → Application Server v5.1 → 
InfoCenter. 

2. Start the WebSphere Application Server server1 by clicking Start the Server 
in the WebSphere Application Server - First Steps application.

3. Review the status of the server startup in the startServer.log. You should see 
the following message:

Server server1 open for e-business

Note: If the base version is not detected, enter the path to the WebSphere 
Application Server installation directory.

Note: If any of the following steps fail for any reason, or in the case of 
installation problems, refer to the documentation provided with the fix pack 
and to IBM WebSphere Business Integration Server Foundation, Version 5.1: 
Getting started; IBM Information Center Library, available at:

ftp://ftp.software.ibm.com/software/webserver/appserv/library/wasv51ee_gs.pdf
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4. Then, click Verify Installation in the WebSphere Application Server - First 
Steps application.

5. The First Steps Output - Verify Installation Test window should open, and 
some tests are performed. Check that the verification completed successfully.

6. After completing the Verify Installation, click Exit in the First Steps window.

7. Start WebSphere administrative console by entering the following URL in a 
Web browser:

http://ilm-bi.itsc.austin.ibm.com:9090/admin

8. Log in to the WebSphere administrative console. You do not need to provide 
a user name, because the WebSphere security is turned off.

9. The WebSphere administrative console should open.

7.4  Summary
We have now completed the installation of the Business Integration node. 
Additional configuration is necessary. We describe the additional configuration in 
Chapter 10, “Configuration” on page 227.

Note: The server1 directory will not get created until the first time the 
application server is started.
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Chapter 8. Content Management node 
installation

This chapter provides detailed instructions for installing an IBM DB2 Content 
Manager library server and resource manager on one node.

The DB2 Content Manager implementation includes the following tasks:

1. IBM DB2 Universal Database installation

2. Microsoft Visual C++ installation

3. IBM WebSphere Application Server installation

4. IBM GSKit installation

5. IBM HTTP Server SSL configuration

8

Note: For more detailed information about the installation and configuration of 
IBM DB2 Content Manager for Multiplatforms V8.2, refer to the following 
product guides, available at:

http://www.ibm.com/software/data/cm/cmgr/mp/library.html

� IBM Content Manager for Multiplatforms: Planning and Installing Your 
Content Management System Version 8 Release 2, GC27-1332-02

� IBM DB2 Content Manager for Multiplatforms: System Administration 
Guide Version 8 Release 2, SC27-1335-04
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6. IBM WebSphere Application Server configuration

7. IBM DB2 Content Manager installation

8. Install DB2 Content Manager

9. IBM DB2 Content Manager verification

10.DB2 Content Manager V8.2 Fix Pack 6 installation

11.DB2 Information Integrator for Content installation

12.IBM DB2 Content Manager eClient Version 8.2 installation

13.DB2 Records Manager Enabler Version 8.2.820.600 installation
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8.1  Microsoft Windows 2000 Server installation
This section highlights the key issues addressed when installing Microsoft 
Windows 2000 Server, such as using Windows 2000 Service Pack 4, the latest 
Windows security patches, and the user rights assigned to an administrator user 
needed later for DB2.

8.1.1  Windows 2000 Service Pack 4
In our example, we installed Microsoft Windows 2000 Service Pack 4.

8.1.2  Windows 2000 service levels
We installed the latest Windows 2000 service-level critical updates on top of 
Service Pack 4.

8.1.3  Create system users and assign user rights
To assign user rights to the administrator ID used by the DB2 owner during the 
instance creation, refer to Table 8-1.

The users shown in Table 8-1 must be created to support DB2, WebSphere, and 
DB2 Records Manager.

Table 8-1   Required system user IDs

User ID Description

IBM WebSphere Application Server 
V5.0.2 system administration 
(for example, WASadmin)

This user ID is used for installation and administration of all 
WebSphere components.

DB2 Enterprise Server Edition Version 
8.1 database administration
(for example, DB2admin)

This user ID will provide the high-level access for 
configuration and management of the DB2 installation.

DB2 Content Manager database 
administrative user ID 
(for example, CMadmin)

This user ID is used if installing and managing the library 
server on the Content Management node. 

This user ID must be a member of the DB2 Admin group 
(right assignments).
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8.1.4  Add users to Administrators group
The user IDs DB2admin, CMadmin, and CMconnect need to have DB2 
administrative privileges. One simple way to accomplish this is to add DB2admin, 
CMadmin, and CMconnect to the Administrators group.

8.1.5  User rights assignments
The user IDs DB2admin, CMadmin, and CMconnect need to have the following 
Windows user rights assignments:

� Act as part of the operating system
� Create a token object
� Increase quotas
� Log on as a service
� Replace a process-level token

To assign these user rights, complete the following steps:

1. Click Start → Settings → Control Panel → Administrative Tools → Local 
Security Policy.

2. From the Local Security Settings window, select and expand Local 
Policies → User Rights Assignment.

3. Ensure that the administrator user ID (for example, admin) has user rights 
assignments for the following Windows local security policies needed for DB2:

– Act as part of the operating system
– Create a token object
– Increase quotas
– Log on as a service
– Replace a process-level token

DB2 database connectivity user ID 
(for example, CMconnect)

This user ID is used as a database connection ID from the 
client (Portal or Developer node) to the Content Management 
node. This user ID is a standard user with normal privileges 
and should not be part of the DB2 Admin group, with the 
following exception.
DB2 Content Manager makes use of PUBLIC access to DB2 
packages. If your security structure allows PUBLIC execution 
rights on all packages, it needs only to be granted CONNECT 
rights to the database. If you revoke PUBLIC access, 
CMconnect needs not only CONNECT rights to the 
databases, but also EXECUTE permission on Content 
Manager packages.

User ID Description 
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8.2  IBM DB2 Universal Database installation
This section describes how to install the IBM DB2 Universal Database V8.1, 
Enterprise Server Edition and supporting Fix Pack 4a.

This section is organized into the following tasks:

� Install DB2 UDB V8.1
� Install DB2 UDB V8.1 Fix Pack 4a
� Verify DB2 UDB

8.2.1  Install DB2 UDB V8.1
To install IBM DB2 V8.1 Enterprise Server Edition, complete the following steps.

1. Log in as the DB2admin user previously created.

2. Insert the DB2 UDB V8.1 Enterprise Server Edition CD.

3. Navigate to the <CD_Root> and run Setup.exe to start the installation.

4. When the DB2 Installer window opens, click Install Products.

5. When the Select the Product to Install window opens, select DB2 UDB 
Enterprise Server Edition (the default and only option) and then click Next.

6. When the Welcome window for the DB2 Setup Wizard opens, click Next. 

7. When the License Agreement window opens, review the terms, and if in 
agreement, select I accept the terms in the license agreement. Click Next.

8. When the Select the installation type window opens, select Typical and then 
click Next.

9. When you see a warning message regarding the connection to remote DB2 
servers using APPC, click OK.

10.When the Select the Installation Action window opens, select Install DB2 
UDB Enterprise Server Edition on this computer and then click Next.

11.When the Select the Installation Folder window opens, we entered 
c:\ibm\sqllib and then clicked Next.

Note: Depending on the DB2 UDB V8.1 CD distribution you are using, the 
installation panels might be slightly different from those described here.

Note: Take note of the Save your settings to response file check box. This 
can be used to capture your selection options to be used for a future 
installation.
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12.When the Set User Information for DB2 Administration Server window opens, 
enter and select the following values and then click Next:

– Domain: We left this field blank.
– User name: DB2admin (default)
– Password: <password>
– Confirm password: <password>
– Select Use the same username and password for remaining DB2 

services (default).

13.When the Setup the Administration Contact List opens, we accepted the 
default settings (local) and then clicked Next.

14.When the warning message Notification SMTP server has not been 
specified appears, click OK.

15.When the Configure DB2 instances window opens, we accepted the default 
(DB2). Click Next.

16.When the Prepare the DB2 tools catalog window opens, select Do not 
prepare the DB2 tools catalog on this computer and then click Next.

17.When the Specify a contact for health monitor notification window opens, 
select Defer the task after installation is complete and then click Next.

18.When the Start copying files window opens, review the selected options and 
then click Install.

19.When the Setup is Complete window opens, click Finish.

20.When the IBM DB2 First Steps window opens, click Exit First Steps. 

8.2.2  Install DB2 UDB V8.1 Fix Pack 4a
We installed IBM DB2 UDB V8.1 Fix Pack 4a for 32-bit Windows. We chose to 
use Fix Pack 4a for several reasons. First, IBM Tivoli Directory Server V5.2, 
WebSphere Portal V5.0.2, DB2 Content Manager V8.2 plus Fix Pack 6, and DB2 
Information Integrator for Content plus Fix Pack 6 officially support DB2 UDB 
V8.1 Fix Pack 4a. In addition, we wanted to use the same version of DB2 fix pack 
on all of the nodes for DB2 compatibility reasons.

Note: The DB2 UDB installation with the Typical installation type takes 
approximately 376 MB of disk space.
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To download and install IBM DB2 UDB V8.1 Fix Pack 4a, complete the following 
steps:

1. You can download IBM DB2 UDB V8.1 Fix Pack 4a at:

http://www.ibm.com/cgi-bin/db2www/data/db2/udb/winos2unix/support/v8fphist.
d2w/report#WIN-32

2. We downloaded the FP4a_WR21338_ESE.exe, which is Fix Pack 4a for IBM 
DB2 Universal Database V8.1, Enterprise Server Edition. 

3. Stop all DB2 services in the Windows services.

4. Install IBM DB2 UDB V8.1 Fix Pack 4a. We accepted the default installation 
options.

5. We recommend that you restart your system after installing the fix pack to 
ensure that all fixes are applied and active in memory.

6. The internal DB2 level is 8.1.4.428 after the installation of Fix Pack 4a. In our 
example, we do not have any existing databases that need special attention 
(rebind DB2 utilities). 

After the system has restarted, open a DB2 command window (or Windows 
command window) and enter the following command:

db2level

It should return 8.1.4.428 after Fix Pack 4a has been installed.

Note: For more information about the contents of IBM DB2 UDB V8.1 Fix 
Pack 4a, refer to the text file FixpackReadme, available at:

http://www.ibm.com/cgi-bin/db2www/data/db2/udb/winos2unix/support/v8fphis
t.d2w/report#WIN-32

Note: If you have trouble stopping any of the DB2 services, you can 
proceed with the fix pack installation. When the DB2 Setup Wizard 
launches for the fix pack, it will warn that certain processes are locking 
DB2 and will ask you if you want to shut them down. You can click Yes, and 
the Wizard will shut down the processes for you. 
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8.2.3  Verify DB2 UDB
After you install DB2 UDB V8.1 and the fix pack and have restarted your system, 
we recommend that you verify that DB2 UDB is working properly. 

8.3  Microsoft Visual C++ installation
As a prerequisite to DB2 Content Manager on Microsoft Windows, this section 
describes how to install and verify Microsoft Visual C++ Version 6.0. The 
compiler is used to generate DB2 Content Manager Library Server access 
modules.

We organize this section into the following tasks:

� Install Microsoft Visual C++ V6.0
� Configure Microsoft Visual C++ V6.0
� Verify Microsoft Visual C++ V6.0

Note: Rebind DB2 utilities to existing databases

If you have created databases before you installed Fix Pack 4a, you will need 
to rebind the DB2 utilities to the databases. This step is necessary for the fixes 
to become effective on existing databases. The binding procedure needs to be 
performed only once per database. Note that this is not required for databases 
created after the fix pack is installed. We summarize the rebind procedure 
found in the FixpackReadme.txt.

To rebind existing DB2 UDB databases after installing Fix Pack 4a, enter the 
following commands from a DB2 command window for each database:

db2 terminate
db2 CONNECT TO <dbname>
db2 BIND <DB2_home>\BND\@db2ubind.lst GRANT PUBLIC
db2 BIND <DB2_home>\BND\@db2cli.lst GRANT PUBLIC
db2 terminate

Where <dbname> represents the name of a database to which the utilities 
should be bound. And, where <DB2_home> represents the directory where you 
have installed DB2. The db2ubind.lst and db2cli.lst contain lists of required 
bind files used by IBM DB2 UDB V8.1.
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8.3.1  Install Microsoft Visual C++ V6.0
To install Microsoft Visual C++ V6.0, complete the following steps:

1. Insert the Microsoft Visual C++ V6.0 CD in the Content Management node.

2. Run Setup.exe to start the installation.

3. We accepted the default settings, with the following exceptions that must be 
specified:

– We selected Typical install.
– We selected Register Environment Variables.

8.3.2  Configure Microsoft Visual C++ V6.0
When Microsoft Visual C++ V6.0 is first installed, the environment variables are 
set as user variables, not system variables. Therefore, the Microsoft Visual C++ 
V6.0 environment is not automatically available to every user of the library 
server.

You can change the user environment variables into system environment 
variables, so all users have access to the Microsoft Visual C++ V6.0 
environment.

If you change user variables to system variables, make sure that you place the 
Visual C++ values after any DB2 values. After you make changes to the 
environment variables, you must reboot your system to make the variables 
available to the Windows services.

After the installation of Microsoft Visual C++ V6.0, complete the following steps:

1. Ensure that the Microsoft Visual C++ V6.0 environment variables are set 
correctly:

a. Log on to the system as the user that installed Microsoft Visual C++ V6.0.

b. Click Start → Settings → Control Panel.

Note: For our testing, we used Microsoft Visual C++ V6.0 Professional 
Edition.

If you install Microsoft Visual C++ V6.0 Enterprise Edition, the installation 
might prompt you as to whether to use a later Version 6.0 database format or 
to use an earlier format that is compatible with Version 5.0. This format 
decision has no impact on DB2 Content Manager.

You might be prompted to install Microsoft Developer Network Library 
(MSDN); it is not needed.
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c. Double-click the System icon.

d. Click the Advanced tab, and then click the Environment Variables 
button. 

You can see that the system variables are above the user variables for the 
user that is logged on to the system.

e. Double-click the Path variable in the User variables section of the window. 

As you can see, the variable name path is displayed in the Variable field, 
and the settings of the path variable are displayed in the Value field of the 
window.

f. Within this Value field, highlight the Microsoft Visual Studio variable. For 
example:

C:\Program Files\Microsoft Visual Studio\Common\Tools\Winnt;C:\Program 
Files\Microsoft Visual Studio\Common\vc98\bin;

g. Copy this highlighted information to your clipboard (Ctrl+C). 

h. Click Path in the System variables section of the window. 

Now, you see that the information displayed in the Value field is the value 
that is associated with the path of the system variable.

i. Place your cursor in the Value field. Scroll to the end of the information 
field (or after the DB2 values).

j. Paste (Ctrl+V) the information that you copied to your clipboard from the 
user variables to this point in the system variables. Click OK.

Make sure that there is a semi-colon (;) separating the two variables.

k. Verify that the information is correctly part of the system variable. If it is 
correct, delete the information from the User variables section. 

The C++ variables must be available in the system variables, not in the 
user variables.

l. Repeat steps for both the lib and include variables.

m. Restart your system to make that the variables are available to services.

2. You can verify the environment variables by typing the set include, set lib, 
and set path commands from a command prompt. 

You should see the values of each environment variable similar to the 
following examples. Make sure that the DB2 UDB directories are listed before 
the Microsoft Visual C++ directories:

a. Log on to the Windows system as a user other than the user you used to 
install Microsoft Visual C++ V6.0. This way, we will know that the variables 
have been properly set at the system level.
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b. Open a command window and enter:

set include

The expected results (example) are as follows (your results will be 
wrapped):

C:\ibm\sqllib\INCLUDE;
C:\ibm\sqllib\SQLLIB\LIB;
C:\Program Files\Microsoft Visual Studio\VC98\atl\include;
C:\Program Files\Microsoft VisualStudio\VC98\mfc\include;
C:\Program Files\Microsoft Visual Studio\VC98\include

c. From the command window, enter:

set lib

The expected results (example) are as follows:

C:\ibm\sqllib\LIB;
C:\Program Files\Microsoft Visual Studio\VC98\mfc\lib;
C:\Program Files\Microsoft Visual Studio\VC98\lib

d. From the command window, enter:

set path

The expected results (example) are as follows:

%SystemRoot%\system32;
%SystemRoot%
%SystemRoot%\System32\Wbem;
c:\ibm\sqllib\BIN;
c:\ibm\sqllib\FUNCTION;
c:\ibm\sqllib\SAMPLES\REPL;
C:\Program Files\Microsoft Visual Studio\Common\Tools\WinNT;
C:\Program Files\Microsoft Visual Studio\Common\MSDev98\Bin;
C:\Program Files\Microsoft Visual Studio\Common\Tools;
C:\Program Files\Microsoft Visual Studio\VC98;

8.3.3  Verify Microsoft Visual C++ V6.0
To verify the Microsoft Visual C++ V6.0 installation, start the application by 
clicking Start → Programs → Microsoft Visual C++ V6.0 → Microsoft Visual 
C++ V6.0. 

8.4  IBM WebSphere Application Server installation
This section describes how to install IBM WebSphere Application Server Version 
5.0 and Fix Pack 2 (V5.0.2).
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8.4.1  Install WebSphere Application Server V5.0
To install WebSphere Application Server V5.0, complete the following steps:

1. Insert the WebSphere Application Server CD.

2. Navigate to the <CD_Root> directory and run Install.exe to start the 
WebSphere Application Server installer.

3. When the Select the desired language to be used for the installation wizard 
opens, select the desired language (for example, English) and click OK. 

4. When the Welcome window opens, click Next.

5. When the License Agreement window opens, review the terms, and if in 
agreement, select I accept the terms in the license agreement. Click Next.

6. When the Setup Type window opens, select Custom and click Next.

7. When the features selection window opens, we selected the features shown 
in Figure 8-1 on page 157 and then clicked Next.
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Figure 8-1   WebSphere Application Server: Selected features

8. When the Features Installation directories window opens, we used the 
following values and then clicked Next:

– WebSphere Application Server: c:\ibm\WebSphere\AppServer
– IBM HTTP Server: c:\ibm\IBMHttpServer
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9. When the Node name and Host name window opens, we used the following 
values and then clicked Next:

– Node name: cmwin1
– Host name or IP Address: cmwin1.itso.ral.ibm.com

10.When the Windows Services window opens, we used the following values 
and then clicked Next:

– Clear Run WebSphere Application Server as a service.
– Select Run IBM HTTP Server as a service.
– User ID: WASadmin
– Password: <password>

11.When the Installation Summary window opens, review your selections and 
then click Next to begin copying files.

12.When the Register window opens, take the appropriate action. 

13.When the First Steps window opens, click Exit.

14.Click Finish in the Installation Wizard window.

8.4.2  Install WebSphere Application Server V5 Fix Pack 2 (V5.0.2)
To install IBM WebSphere Application Server V5 Fix Pack 2, complete the 
following steps:

1. Ensure that you have stopped all WebSphere Application Server application 
servers and nodes.

2. Ensure that you have stopped the IBM HTTP Server and IBM HTTP 
Administration Windows service (WebSphere plug-in fixes).

3. Download WebSphere Application Server V5 Fix Pack 2 at:

http://www.ibm.com/support/docview.wss?rs=860&context=SW600&q1=fixpack+2&ui
d=swg24005012&loc=en_US&cs=utf-8&lang=en+en

4. Unpack WebSphere Application Server V5 Fix Pack 2 to a temporary 
directory on the target system (for example, c:\temp\was5.fp2). Note that the 
WebSphere Update Installer Wizard needs write access.

5. Open a command window, and set the JAVA_HOME by running the following 
command provided with WebSphere Application Server:

c:\ibm\WebSphere\AppServer\bin\setupCmdLine.bat

Note: The fix pack will attempt to update IBM HTTP Server and will not be 
able to update the server if it is started.
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6. From the command window, start the WebSphere Installation Update Wizard 
by entering updateWizard.bat found in the temporary directory (for example, 
c:\temp\was5.fp2).

7. When the WebSphere Update Installer language window opens, select the 
appropriate language for the wizard (for example, English) and then click OK.

8. When the Welcome window opens, click Next.

9. The WebSphere Update Installer should detect your current WebSphere 
Application Server version and installation directory (for example, 
c:\ibm\WebSphere\AppServer). Click Next.

10.Select Install fix packs and then click Next.

11.Enter the directory where you have copied the fix pack. For example, we 
entered c:\temp\was5.fp2\fixpacks in the Fix pack directory text field. Click 
Next.

12.Select the was50_fp2_win fix pack (default) and then click Next.

13.You will be prompted for the directories for the IBM HTTP Server and the 
WebSphere Application Server embedded messaging (not installed), we used 
the following values and then clicked Next:

– Select IBM HTTP Server.
– IBM HTTP Server installation directory: c:\ibm\IBMHttpServer
– Clear Embedded Messaging (not installed).

14.Review the fix pack settings and then click Next to begin the fix pack 
installation of files.

15.When the WebSphere Application Server V5 Fix Pack 2 installation 
completes, click Finish.

8.4.3  Verify WebSphere Application Server V5.0.2
To verify the functionality of WebSphere Application Server V5.0.2 after the 
installation, complete the following steps:

1. Click Start → Programs → IBM WebSphere → First Steps. 

2. From First Steps, click Verify Installation.

If the server is not started, it will start the server and perform some tests. You 
will see the console output with the status of each test run and passed.

Note: Alternatively, you can start the Install Verification by opening a 
command prompt, navigating to the <was_home>\bin directory, and 
running ivt.bat.
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3. After completing the Verify Installation, click Exit in the First Steps window.

4. Ensure that IBM HTTP Server (WebSphere plug-in) is started.

5. Ensure that the server1 application server is started. If not, start the server as 
follows:

cd \ibm\WebSphere\AppServer\bin
startServer server1

6. Start the WebSphere administrative console by entering the following URL in 
a Web browser:

http://<was_hostname>:9090/admin

7. Log in to the WebSphere administrative console (for example, WASadmin).

8. When done verifying the WebSphere administrative console, click Logout 
and close the Web browser.

9. Stop the server1 application server as follows:

cd \ibm\WebSphere\AppServer\bin
stopServer.bat server1

8.5  IBM GSKit installation
This section describes how to download and install IBM GSKit Version 7.0.1.16. 
GSKit is used to manage key stores and certificates. GSKit includes the IBM Key 
Management Utility and libraries accessible to applications to create and 
manage certificates. 

GSKit V7.0.1.9 installed with IBM Tivoli Directory Server V5.2 on the Directory 
Server node includes root certificates that have expired. This results in the 
administrator not being able to create a new key store using the iKeyman utility. 
By installing the later version, IBM GSKit V7.0.1.16, this issue is addressed, 
along with other fixes.

Note: Review the status of the server startup in startServer.log.

For example, we used the GNU utility to view the logs:

tail -f c:\ibm\WebSphere\AppServer\logs\server1\startServer.logs

You should see the following message:

Server server1 open for e-business

The server1 directory will not get created until the first time the application 
server is started. 
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8.5.1  Determine GSKit version installed
This section describes how to determine the version of GSKit an application is 
configured to use in the Windows registry. If you are following the order of 
installing components documented in this chapter, this section is not necessary, 
because we install the new GSKit prior to installing the components that use it.

If you have not installed IBM Tivoli Directory Server or other software containing 
IBM GSKit, you can skip this section. To determine the level of GSKit installed, 
complete the following steps:

1. Start the Windows registry editor (regedit.exe) by selecting Start → Run and 
entering regedit in the Open field. Click OK.

2. Select and expand HKEY_LOCAL_MACHINE → SOFTWARE → IBM.

3. In our example, you will see both the GSK5 and GSK7 registry entries.

4. Select GSK7 → CurrentVersion. Record the data value for the version 
name.

5. Select REGAPPS under CurrentVersion. This lists the name of the 
application using GSKit. Record the name of the application using this version 
of GSKit (for example, LDAP).

8.5.2  Uninstall the earlier GSKit version
If following our procedure, this section is not required.

Prior to installing the new IBM GSKit V7.0.1.16, if a GSKit already has been 
installed, you must manually uninstall the existing IBM GSKit V7.0.1.9 as follows:

1. Ensure that the IBM IBM Tivoli Directory Server V5.2 Windows service has 
been stopped, as well as other services that might be using GSKit.

2. Open a command window and navigate to the c:\winnt directory.

3. Run the following command to uninstall GSKit:

gsk7bui LDAP

Where LDAP is the name of the application using the GSKit.

4. Verify that the GSK7 Windows registry has been removed.

Note: The GSKit version can be obtained by using the gsk7ver.exe command 
or by retrieving the version from the Windows registry. We chose to use the 
Windows registry method because we also needed the REGAPPS value in 
addition to the version.
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5. Verify that the GSK7 directory has been removed (for example, C:\Program 
Files\IBM\GSK7).

8.5.3  Install GSKit V7.0.1.16
To download and install IBM GSKit V7.0.1.16, complete the following steps:

1. IBM GSKit V7.0.1.16 can be obtained by one of the following methods:

– Request the GSKit V7.0.1.16 from IBM Support at:
http://techsupport.services.ibm.com/guides/tivoli_contacts.html

Or:

– Download IBM HTTP Server V1.3.28, which includes IBM GSKit V7.0.1.16 
at:
http://www.ibm.com/support/docview.wss?rs=177&context=SSEQTJ&uid=swg2400
6718

2. Open a command window and navigate to the directory in which you have 
unpacked the WINDOWSPQ86671IHS1.3.28.zip file.

3. Enter the following at the command line to extract the GSKit:

gsk7bas c:\temp

Where c:\temp is the directory into which to extract the GSKit installation 
files.

Note: If files still exist such as DLLs, manually delete the C:\Program 
Files\IBM\GSK7 directory after the services that locked the files have been 
stopped.

Note: If you have previously installed applications that use the earlier GSKit 
V7.0.1.9, the application might have updated the system path to include the 
GSKit installation path. If you decided to change the default GSKit installation 
path, you might need to manually update the system path to include the 
correct GSKit installation path.

Note: From the URL listed, you will have to log in as a registered user (or 
register first). After you navigate to the download window by platforms, you 
will see a list of fixes. 

We downloaded the WINDOWSPQ86671IHS1.3.28.zip (PQ86671) for IBM 
HTTP Server V1.3.28 to the c:\temp directory and unpacked the ZIP file.
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4. From the command window, navigate to the directory where you extracted the 
GSKit installation files (for example, c:\temp).

5. Run the GSKit installer as follows:

setup <application_name>

Where <application_name> is the name of the application using GSKit 
V7.0.1.16 (for example, LDAP).

For example:

setup LDAP

6. When the Welcome window opens, click Next.

7. When the Choose Destination Location window opens, we entered 
c:\ibm\gsk7 for the destination folder using the Browse button. Click Next to 
proceed.

8. When the setup is complete, click Finish.

8.6  IBM HTTP Server SSL configuration
As a prerequisite to DB2 Content Manager resource manager, this section 
describes how to configure SSL for IBM HTTP Server and IBM HTTP 
administration server.

We organize this section into the following tasks:

� Enable the httpd.conf file for SSL
� Copy WebSphere plug-in entries
� Create the IBM HTTP Server key store
� Create a certificate for IBM HTTP Server
� Verify IBM HTTP Server

8.6.1  Enable the httpd.conf file for SSL
To modify the httpd.conf file to enable SSL support, complete the following steps:

1. Stop the IBM HTTP Server V1.3.26 Windows service.

2. Back up the original httpd.conf file. For example:

cd \<ihs_home>\conf
copy httpd.conf httpd.conf.org

3. Copy the httpd.conf.sample containing the commented SSL directives to 
httpd.conf. For example:

copy httpd.conf.sample httpd.conf
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4. Open the <ihs_home>\conf\httpd.conf file with a text editor.

5. Search for the following lines, uncomment the # symbol, and modify the 
settings as follows:

– Verify the ServerName value. This should include your fully qualified host 
name (for example, ilm-cm.itsc.austin.ibm.com):

ServerName <fully_qualified_hostname>

– Uncomment the IBM SSL module for the given SSL encryption level (56 or 
128 bit). For example:

LoadModule ibm_ssl_module modules/IBMModuleSSL128.dll

– Uncomment the following line to listen on port 443 for HTTPS:

Listen 443

– Uncomment and update the VirtualHost with your host name as follows:

<VirtualHost hostname.domain.com:443>

– Uncomment:

SSLEnable

– Uncomment:

</VirtualHost>

– Uncomment and update the following:

Keyfile "<ihs_home>/ssl/keyfile.kdb"

– Uncomment:

SSLV2Timeout 100
SSLV3Timeout 1000

6. Save the changes to the httpd.conf file.

Note: Where 56 or 128 is the appropriate encryption level for your 
locale, for example, 128 for 128-bit encryption in the U.S. and Canada.

Note: Substitute your fully qualified host name in this line (for example, 
<VirtualHost ilm-cm.itsc.austin.ibm.com:443>).

Note: The keyfile path has been modified to include ssl instead of keys. 

For example:

Keyfile "c:\ibm\IBMHttpServer/ssl/keyfile.kdb"
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8.6.2  Copy WebSphere plug-in entries
During the installation of the IBM HTTP Server and WebSphere plug-in, the 
httpd.conf file was updated with the plug-in entries. Now that we have copied the 
httpd.conf.sample file in the previous section to enable the SSL directives, we 
now also need to add the WebSphere plug-in entries to the httpd.conf file. To 
copy the plug-in entries, complete the following steps:

1. Change to the directory the IBM HTTP Server <ihs_home>\conf directory.

2. Modify the httpd.conf file, adding the following for the WebSphere plug-in at 
the end of the file:

LoadModule ibm_app_server_http_module 
"c:\ibm\WebSphere\AppServer/bin/mod_ibm_app_server_http.dll"

WebSpherePluginConfig 
"c:\ibm\WebSphere\AppServer/config/cells/plugin-cfg.xml"

8.6.3  Create the IBM HTTP Server key store
To create the IBM HTTP Server key store database used to store certificates, 
complete the following steps:

1. From Windows, click Start → Programs → IBM HTTP Server 1.3.26 → Start 
Key Management Utility.

2. From the menu bar, click Key Database File → New.

3. In the New window, enter and select the following values and then click OK:

– Key Database Type: CMS key database file
– File name: keyfile.kdb
– Location: <ihs_home>\ssl (for example, c:\ibm\IBMHttpServer\ssl)

4. In the Password Prompt window, enter and select the following values and 
then click OK:

– Password: <your_password> (to protect the key store file).
– Select Set expiration time and enter the number of days before the 

password will expire. If no expiration is required, do not select this option.

Tip: The above text is two separate lines. Within the httpd.conf file, the 
lines are not wrapped.

If you backed up the httpd.conf.org file you can cut and paste the plug-in 
entries to the SSL enabled httpd.conf file.

Note: This path must match the keyfile path in the httpd.conf file.
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– Select Stash the password to a file.

5. When the information window opens with the following message, click OK:

The password has been encrypted and saved in the file:
c:\ibm\IBMHttpServer\ssl\keyfile.sth

8.6.4  Create a certificate for IBM HTTP Server
For development and testing purposes, we create a new self-signed certificate. 
The following steps outline the creation of a new self-signed certificate:

1. From the Key Management Utility menu bar, select Create → New 
Self-Signed Certificate.

If you closed the Key Management Utility, you need to open the key store first.

2. Fill in the information about the form and click OK. For example, we used the 
following values:

– Key Label: IBM HTTP Server key
– Common Name: <fully_qualified_hostname> 
– Organization: <your_organization_name> (for example, ibm)

3. When done, close the Key Management Utility.

8.6.5  Verify IBM HTTP Server
After the IBM HTTP Server configuration, we recommend that you complete the 
following verification tests.

Note: Although not required in a development environment, we 
recommend that you set an expiration period for all key stores used in 
production environments.

Note: IBM HTTP Server accesses the password-protected key store.

Note: For the production IBM HTTP Server, you should create a new 
certificate request (do not use a self-signed certificate).
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Start IBM HTTP Server
Restart the IBM HTTP Server service for the changes to take effect. It can be 
started by one of the following methods:

� IBM HTTP Server 1.3.26 Windows service

Or:

� From the command line or batch file containing the following:

net start “IBM HTTP Server 1.3.26”

Verify the IBM HTTP Server
To verify that the IBM HTTP Server is working properly, enter the following URLs 
in a Web browser after IBM HTTP Server has been started:

� Verify HTTP:

http://<hostname>

� Verify HTTPS:

https://<hostname>

Backup the httpd.conf file
After you have verified that IBM HTTP Server is working properly with SSL 
enabled, we recommend that you make a backup of the 
<ihs_home>\conf\httpd.conf file to httpd.conf.was.ssl. 

8.6.6  Configure SSL for IBM HTTP administration server
For details about configuring SSL for the IBM HTTP administration server, refer 
to IBM Content Manager for Multiplatforms: Planning and Installing Your Content 
Management System Version 8 Release 2, GC27-1332-02. 

For our example, we did not complete this step because we will not manage the 
IBM HTTP Server using the administration server.

8.7  IBM WebSphere Application Server configuration
This section describes the need to get proper certificates on the Content 
Management node for the WebSphere Application Server and WebSphere 
plug-in. In addition, we provide a procedure for restricting ports to WebSphere 
Application Server.
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8.7.1  Certificates
By default after installation, the WebSphere Application Server Secure Sockets 
Layer (SSL) is configured with a dummy certificate. Before moving to production 
with DB2 Content Manager, ensure that the WebSphere Application Server and 
WebSphere plug-in certificate are updated with a proper certificate.

8.7.2  Restrict ports for WebSphere Application Server
For security reasons, restrict the ports of your resource manager application 
server to localhost. 

To restrict ports for WebSphere Application Server V5.0.1, complete the 
following steps:

1. Start the server1 application server where the WebSphere administrative 
console enterprise application is installed.

cd \ibm\WebSphere\AppServer\bin
startServer server1

2. Start the WebSphere administrative console by entering the following URL in 
a Web browser:

http://<was_hostname>:9090/admin

3. Log in to the WebSphere administrative console (for example, admin).

4. Click Servers → Application Servers.

5. Click server1.

6. Click Web Container → HTTP transports.

7. Update the host field for each port from * to localhost.

8. For each port you changed for your WebSphere Application Server, you must 
click Environment → Virtual Hosts → <default_host> → Host Aliases and 
update the specific port from * to localhost.

9. Update the WebSphere plug-in.

10.Restart IBM HTTP Server for the new plugin-cfg.xml file to be read 
immediately and the changes to become active.

Note: For development testing purposes, this step is not required.

Note: This step is recommended for a production environment, but not 
required for development purposes.
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8.8  IBM DB2 Content Manager installation
This section describes how to install the IBM DB2 Content Manager resource 
manager on the Resource Manager node.

8.8.1  Prerequisites for DB2 Content Manager
This section outlines the prerequisites that must be completed prior to installing 
DB2 Content Manager. The prerequisite steps listed in this section should 
already have been completed if you have followed the procedure in this 
document. Review the following prerequisites to ensure that you meet all of them:

� Microsoft Visual C++ Version 6.0 is installed and verified.

� IBM DB2 Universal Database V8.1, Enterprise Server Edition with Fix Pack 
4a is installed.

� WebSphere Application Server is installed.

� SSL is enabled for IBM HTTP Server.

� WebSphere Application Server is configured in preparation for DB2 Content 
Manager.

� User IDs with rights and privileges for DB2 Content Manager are created.

� You have enough temporary space (at least 100 MB of temporary free space).

� Your %PATH% is not too long. Remove duplicate path entries if they exist. 
Windows has a 1024 character limit for environment variables.

Note: The installation program refers to the IDs by the default names, and you 
should substitute the names you use if you are not using the default names.

Important: The CMconnect user ID is a DB2 Content Manager ID used when 
a DB2 Content Manager user needs to perform a certain task, for example, 
when you need to define an item type on the DB2 Content Manager server. 
DB2 Content Manager uses this ID to connect the DB2 Content Manager user 
to DB2. The user (for example, CMconnect) should be assigned privilege set 
UserDB2Connect in DB2 Content Manager. The encrypted CMconnect 
password is stored in the c:\ibm\cmgmt\cmbicmenv.ini file.

In our example, the CMconnect ID needs only to be granted DB2 CONNECT 
authority to the icmnlsdb database for the reasons stated in the product guide, 
IBM Content Manager for Multiplatforms: Planning and Installing Your Content 
Management System Version 8 Release 2, GC27-1332-02. 
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8.8.2  Install DB2 Content Manager
To install the DB2 Content Manager library server and system administrator 
client on the Library Server node, complete the following steps.

1. Ensure that you are logged into Windows with an administrator user ID, as 
defined in 8.1.3, “Create system users and assign user rights” on page 147 
(for example, CMadmin).

2. Insert the IBM DB2 Content Manager V8.2 CD. 

3. Navigate to the <CD_root>\English directory and run Setup.exe to start the 
installer.

4. When the Welcome window opens, click Next.

5. When the License Agreement window opens, review the terms, and if in 
agreement, click I accept the terms of the license agreement. Click Next.

6. When the select features window opens, select all the features as shown in 
Figure 8-2 on page 171. Click Next.

Avoid problems: During our development and testing, one of our DB2 
Content Manager database user IDs did not have a valid password, thus the 
database creation/population failed. This can be avoided by ensuring that the 
user IDs are created properly (password set, privileges, and so on). In 
addition, you can log on with the new ID to verify that it works.
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Figure 8-2   DB2 Content Manager: Features selection

7. In the next window, enter the following values:

Identification:

– Library server database name: ICMNLSDB
– Library server schema name: ICMADMIN

Authentication:

– Library server database administration ID: CMadmin
– Password: <password>
– Confirm password: <password>
– Database connection ID: CMconnect

Click Next to continue the installation. 

8. In the Configure Library Server Options window, enter the following values:

– Library Server ID: 1
– Installation Drive: C:
– Select Enable Unicode.

Note: When sharing common files between DB2 Content Manager and 
DB2 Information Integrator for Content, you must use Unicode for the 
database.
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– Select Enable Text Search.

Click Next to continue the installation. 

9. In the Configure Resource Manager Options window, enter the following 
values:

– Resource Manager database name: RMDB
– Resource Manager database administration ID: CMadmin
– Password: <password>
– Confirm Password: <password>

Click Next to continue the installation. 

10.In the next Configure Resource Manager Options window, enter the following 
values:

– Installation drive: C:
– Mount point: C:\
– Path: C:\staging

Click Next to continue the installation. 

11.In the Deploy Resource Manager Server With WebSphere Application Server 
window, enter the following values:

– Application server name: icmrm (default)
– Web application path: /icmrm (default)
– Web application name: icmrm (default)
– Services port: 7500 (default)

Click Next to continue the installation. 

12.In the Configure System Administrative Client window, enter the following 
values:

– WebSphere administrator user ID: WASadmin
– WebSphere administrator password: <password>
– Confirm password: <password>
– Node name: ilm-cm (or your Windows server host name)

Click Next to continue the installation. 

13.In the next Configure System Administrative Client window, enter the following 
values:

– Library server database name: ICMNLSDB (default)
– Library server schema name: ICMADMIN (default)
– Authentication type: Server (default)
– Database connection ID: CMconnect (default)

Note: This option must be selected if using DB2 Net Search Extender 
(NSE), which is the case in our example.
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– Password: <password>
– Do not select Enable single sign-on.

Click Next to continue the installation. 

14.In the Define Location of System Configuration Information window, enter the 
following values:

– Select Local and enter c:\ibm\cmgmt.
– Do not select Web server.
– Do not select LDAP.

Click Next to continue the installation. 

15.In the Connect Library Server to Resource Manager Server window, enter the 
following values:

– Resource manager server host name: ilm-cm.itso.austin.ibm.com (or 
your Windows server host name)

– Resource manager database name: RMDB (default)
– Web application port: 80 (default) 
– Secure Web application port (HTTPS): 443 (default)
– Web application path: /icmrm (default)
– Resource manager server operating system: Windows, in our case
– Token duration (hours): 48 (default)

Click Next to continue the installation. 

16.In the Configure Components for LDAP window, leave all the fields blank and 
click Next to continue the installation. 

17.In the DB2 Content Manager Installation Features Summary window, review 
the selections and then click Next to begin the installation process.

18.When the installation completes, click Finish to exit the installation wizard.

Note: Single sign-on will be configured post-installation.

Note: The installer will supply the host name. If you do not manually 
enter the fully qualified host name, you will get a warning dialog when 
you click Next.

Note: The installer does not provide an installation progress indicator. We 
used the Windows task manager to gage the activity of the installation.

 

 

 

 

 Chapter 8. Content Management node installation 173



19.Review the following installation and configuration log files found in the 
<cm_home>\logs directory:

– database.log

– icm82install.log
– icmbdlsdb.log
– icmcrlsdb.log

8.9  IBM DB2 Content Manager verification
Now that DB2 Content Manager has been installed, we recommend that you 
verify that the installation and configuration completed properly by completing the 
following verification tasks:

� Verify the library server database
� Verify that library server access C++ modules were generated
� Verify that the library server monitor is started
� Verify the system administration client

8.9.1  Verify the library server database
To verify that the library server database was created successfully, complete the 
following steps:

1. Open a DB2 command window, and connect to the library server database as 
follows:

db2 connect to <icmnlsdb> user <cmadmin> using <password>

You should see a message similar to the following:

Database Connection Information
Database server DB2/NT 8.1.4
SQL authorization ID = CMADMIN
Local database alias = ICMNLSDB

2. Check the database tables by entering the following command:

db2 list tables

You should see 130 tables listed.

Note: This file is created only if errors occurred during the database 
creation.
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8.9.2  Verify that library server access C++ modules were generated
During the DB2 Content Manager installation, Microsoft Visual C++ V6.0 was 
used to generate C++ access modules for DB2 Content Manager item types. To 
verify that these modules were generated, complete the following steps:

1. Verify that the <cm_home>\logs\icm82install.log has statements with the 
following message:

Generating access module for view with ID: XXX
....
All access modules rebuilt

2. Verify that .dll files are found in the <cm_home>\<icmnlsdb>\dll directory.

8.9.3  Verify that the library server monitor is started
During the installation of the DB2 Content Manager library server, the ICM LS 
Monitor ICMNSLDB Windows service is added. This service is set to automatic 
start. However, if you have not restarted your system after installing DB2 Content 
Manager, it will not have been started. Start the service manually or restart the 
system.

8.9.4  Verify the system administration client
After the installation, we recommend that you start the system administration 
client. To start the client, complete the following steps:

1. Click Start → Programs → IBM DB2 Content Manager for Multiplatforms 
V8.2 → System Administration Client.

2. When prompted to log on, enter the following values and then click OK:

– Server Type: DB2 Content Manager (default)
– Server: ICMNLSDB (default)
– User ID: CMadmin
– Password: <password>

8.9.5  Verify resource manager WebSphere deployment
To verify that the DB2 Content Manager resource manager component was 
deployed properly to WebSphere Application Server, complete the following 
steps:

1. Ensure that WebSphere Application Server server1 is started. By default, the 
WebSphere administrative console enterprise application is deployed to 
server1.

2. Log in to the WebSphere administrative console.
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3. Click Servers → Application Servers. 

You should see the icmrm application server listed.

4. Click Applications → Enterprise Applications.

You should see the icmrm enterprise application listed.

5. Log out and close the WebSphere administrative console.

6. Start the icmrm application server. For example, from a command window, 
enter the following:

cd \ibm\WebSphere\bin
startServer icmrm

7. Enter the following URLs in a Web browser to verify that the icmrm application 
server is started:

http://<cm_hostname>/icmrm/snoop
https://<cm_hostname>/icmrm/snoop

8.9.6  Verify the resource manager database
To verify that the resource manager database was created successfully, 
complete the following steps:

1. Open a DB2 command window, and connect to the library server database as 
follows:

db2 connect to <rmdb> user <cmadmin> using <password>

You should see a message similar to the following:

Database Connection Information
Database server DB2/NT 8.1.2
SQL authorization ID = CMADMIN
Local database alias = RMDB

2. Check the database tables by entering the following command:

db2 list tables

You should see 26 tables listed.

8.9.7  Verify DB2 Content Manager installation with First Steps
To verify the DB2 Content Manager installation using the First Steps application, 
complete the following steps:

1. Ensure that the following servers are started:

– Library Server node
• DB2 Windows services
• ICM LS Monitor ICMNLSDB Windows service
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– Resource Manager node
• DB2 Windows services
• IBM HTTP Server V1.3.26 Windows service
• icmrm application server

2. Click Start → Programs → IBM DB2 Content Manager for Multiplatforms 
V8.2 → First Steps on the Library Server node.

3. Click Load Sample Data, enter the following values, and then click OK:

– Library Server database name: icmnlsdb
– Resource Manager database name: rmdb
– User ID: CMadmin (library server user ID)
– Password: <password>

It takes a few minutes to load the sample data. 

4. When the data finishes loading, check the following file to verify that the 
sample data load was successful:

<cm_home>\bin\FirstSteps\cm\icmcrsample.log

5. Click Work With Sample Data from the First Steps window to start the DB2 
Content Manager system administration client.

Alternatively, start the system administration client by clicking Start → 
Programs → IBM DB2 Content Manager for Multiplatforms V8.2 → 
System Administration Client.

6. Log in using the library server user ID (for example, CMadmin).

A successful logon verifies that the connection between the system 
administration client and the library server are working properly.

7. Verify that the data was loaded successfully by at the sample item type 
definitions beginning with the prefix XYZ by selecting Data Modeling → Item 
Types.

8. Exit the DB2 Content Manager system administration client.

9. Click Remove Sample Data from the First Steps main menu. Enter the same 
information provided for the logon information and click OK to begin removing 
the sample data.

It takes a few minutes to remove the sample data. 

10.After removing the sample data, check the following file to verify that the 
sample data was deleted successfully:

<cm_home>\bin\FirstSteps\cm\icmdlsample.log

11.When done, click Exit to close First Steps.
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8.10  DB2 Content Manager V8.2 Fix Pack 6 installation
This section describes how to download and install IBM DB2 Content Manager 
V8.2 Fix Pack 6. To download and install DB2 Content Manager V8.2 Fix Pack 6, 
complete the following steps:

1. The fix pack can be downloaded from the following location:

ftp://ftp.software.ibm.com/ps/products/content_manager/fixes/v8.2/win/820.600/

2. We chose the English language fix pack (CM_win_ENU_820.600.zip). Make 
sure that the language of the fix pack matches the language of your 
installation.

3. Stop all running servers.

If the following services are installed, stop them:

– Stop the ICM LS Monitor ICMNLSDB Windows service.
– Stop all library server processes.
– Stop and restart the DB2 instance.
– Stop WebSphere Application Server.
– Stop all running resource manager processes.
– Stop and restart the DB2EXT - DB2 (Net Search Extender) Windows 

service.

4. Unzip the fix pack into a temporary directory (for example, 
c:\temp\CM_win_ENU_820.600).

5. Navigate to the temporary directory and run Update_CM_win_ENU.exe to start 
the installer.

6. When the Welcome window opens, click Next.

7. When prompted, enter the information for the library server, as shown in 
Figure 8-3 on page 179.

Note: Refer to the fix pack installation readme files for details.
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Figure 8-3   DB2 Content Manager Fix Pack 6: Library server information

8. When the CM Update will be installed in the following location window opens, 
review the path and then click Next.

9. Click Finish to complete the installation. 

10.We recommend that you review <cm_home>\Fixpack6\logs\update.log for 
errors.

11.Verify the DB2 Content Manager installation.

For details, refer to 8.9, “IBM DB2 Content Manager verification” on page 174.

8.11  DB2 Information Integrator for Content installation
This section describes how to install, configure, and verify IBM DB2 Information 
Integrator for Content V8.2. DB2 Information Integrator for Content will be used 
to support the DB2 Content Manager eClient (Web-based Content Manager user 

Tip: Be patient. The fix pack installation can take 20-40 minutes, 
depending on the system hardware. During the fix pack installation, several 
black text windows might open. Do not close them, because they are 
artifacts of the running update operation. When the corresponding 
operation is finished, they will close automatically.
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interface) as a prerequisite to DB2 Content Manager and DB2 Records Manager 
“Records Manager Enabler” integration.

8.11.1  Install DB2 Information Integrator for Content
To install DB2 Information Integrator for Content (EIP), complete the following 
steps:

1. Insert the IBM DB2 Information Integrator for Content (EIP) v8.2 CD.

2. Navigate to the <CD_root>\English directory and run Setup.exe to start the 
installer.

3. When the License Agreement window opens, review the terms, and if in 
agreement, click Accept.

4. When the Welcome window opens, click Next.

5. When the Select Machine Type window opens, select EIP Development 
Workstation to get the Enterprise Information Portal (EIP) local connectors.

This option is for development and testing purposes. The EIP Development 
Workstation also installs the EIP local connectors. This selection also installs 
the toolkit and samples that will be used later for verification of the 
configuration.

6. When the EIP Destination Directory window opens, enter the following values 
and then click Next:

– EIP directory: C:\IBM\EIP
– EIP and DB2 Content Manager shared files: C:\IBM\CMgmt

7. When the Component Selection window opens, enter the following values and 
then click Next:

– Highlight Local connectors:
• Select DB2 Content Manager V8 connector.
• Select Federated connector.
• Select Relational database connector.

– Highlight Connector toolkit and samples and select Content Manager 
V8 connector.

– Select Information Center (optional, but might useful when just getting 
started).

We did not select any other components.

Note: This is optional. But, if you do not select this option, you will not 
be able to test the connection using the samples.
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8. When the Specify RMI Host Name and Port Number window opens, enter the 
following values and then click Next:

– Specify the RMI server connection to the Administration Database:

• Host name: <library_server_node_fully_qualified_hostname>

For our example, we entered ilm-cm.itso.austin.ibm.com.

• Port number: 1919

– Specify the RMI server connection to the Workflow or Information Mining 
Server: 

• Host name: <library_server_node_fully_qualified_hostname>

For our example, we entered ilm-cm.itso.austin.ibm.com.

• Port number: 1920

9. When the Specify Location for System Files window opens, select Local for 
the location of the files to install and then click Next.

10.When the Configure Federated Server Connection window opens, enter and 
select the following values and then click Next:

– Database name: ICMNLSDB
– Schema name: ICMADMIN
– Authentication type: Server
– Database connection ID: CMconnect
– Password: <password>
– Clear Catalog remote database.

11.When the Configure DB2 Content Manager V8 Server Connection window 
opens, we used the following values and then clicked Next:

– Database name: ICMNLSDB
– Schema name: ICMADMIN
– Authentication type: Server
– Database connection ID: CMconnect
– Password: <password>

12.When the Start Copying Files window opens, review your selections and then 
click Next to begin copying files.

13.When the installation completes, select Yes, I want to restart my computer 
now and then click Finish.
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14.Open a Windows command prompt and navigate to the <eip_home> 
directory:

cd C:\IBM\EIP

15.Ensure that the following environment variable values in the cmbenv81.bat 
script for your installation paths are correct: 

– CMBROOT
– DB2HOME
– JAVAHOME

For example:

if "%CMBROOT%"==""  set CMBROOT=c:\ibm\eip
if "%DB2HOME%"==""  set DB2HOME=c:\ibm\sqllib
if "%JAVAHOME%"=="" set JAVAHOME=%CMBROOT%\jdk

8.11.2  Verify DB2 Information Integrator for Content
This procedure tests the DB2 Information Integrator for Content (EIP) DB2 
Content Manager V8 connector connection from the Portal node to DB2 Content 
Manager:

1. Ensure that the DB2 Content Manager servers are started:

– Library Server node:
• DB2 Windows services
• ICM LS Monitor ICMNLSDB Windows service

– Resource Manager node:
• DB2 Windows services
• IBM HTTP Server V1.3.26 Windows service
• icmrm application server

2. Open a command window and navigate to the c:\ibm\eip directory.

Note: When you configure DB2 Information Integrator for Content to share 
the DB2 Content Manager database, there will be a dependency between 
the two products. Until you have installed Fix Pack 6 of DB2 Information 
Integrator for Content, your entire installation, including DB2 Content 
Manager V8.2 Fix Pack 6 and DB2 Information Integrator for Content, will 
not work. In other words, the dependency between DB2 Content Manager 
and DB2 Information Integrator for Content is such that neither will work 
unless both are on a matching fix pack level.

Note: Some of these environment variables might already be defined in 
your Windows system or user environment. We recommend that you make 
this update regardless to ensure that the environment is set correctly.

 

 

 

 

182 Records Management and Process Choreography



3. Enter the following command to set up the environment:

cmbenv81.bat

4. Verify the EIP DB2 Content Manager V8 connector connection to DB2 
Content Manager by entering the following commands.

a. Navigate to the EIP toolkit samples directory:

<eip_home>\samples\java\icm

b. Compile as follows:

javac SConnectDisconnectICM.java

c. Verify the connection using a DB2 Content Manager user ID as follows:

java SConnectDisconnectICM icmnlsdb CMadmin <password>

You should see output similar to the following:

Connection to datastore (Database ‘icmnlsdb’, UserName ‘CMadmin’)...
Sample program completed.

d. Repeat the previous step to test the connection using the CMconnect DB2 
Content Manager user ID.

8.11.3  Install DB2 Information Integrator for Content Fix Pack 6
To download and install IBM DB2 Information Integrator for Content V8.2 Fix 
Pack 6, complete the following steps:

1. Ensure that the DB2 Information Integrator for Content is not in use prior to 
installing the fix pack to avoid a situation where the files are locked and not 
updated properly.

2. Download the IBM DB2 Information Integrator for Content V8.2 Fix Pack 6 
from the following site:

ftp://ftp.software.ibm.com/ps/products/enterprise_information_portal/fixes/
v8.2/win/820.600/

Note: The cmbenv81.bat script is in the <eip_home> directory, which is 
added to the system path variable.

Note: If you did not select the Connector toolkit and samples (Content 
Manager V8 connector) during the installation, the sample files will not be 
available to test the connection. 

Important: If this test does not work, you should not continue until the 
problem is resolved.
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We downloaded the following files to the c:\temp\eip82.fp6 directory on our 
Portal node:

– EIP_win_ENU_820.600.zip (Fix Pack 6 ZIP file for U.S. English)
– cm82FP6fixes_descriptions.pdf
– cm82FP6install_knownissues.pdf
– cm82FP6new_functionality.pdf
– cm82FP6readme.pdf

3. Unpack the EIP_win_ENU_820.600.zip to a temporary directory (for example, 
c:\ibm\eip82.fp6).

4. Navigate to the temporary directory and run Update_EIP_win_ENU.exe to start 
the installer.

5. When the Welcome window opens, click Next.

6. When the EIP Update Summary window opens, click Next to begin copying 
files.

7. When the installation completes, click Finish.

8. After the DB2 Information Integrator for Content V8.2 Fix Pack 6 is installed, 
verify that the EIP connection is working properly.

8.12  IBM DB2 Content Manager eClient Version 8.2 
installation

This section provides instructions about how to install the eClient on the Content 
Management Windows node.

The IBM DB2 Content Manager eClient is a Web application that enables users 
to search for and retrieve documents from content servers. The content servers 
that the eClient can access include:

� IBM DB2 Content Manager for Multiplatforms

� IBM DB2 Content Manager OnDemand

� IBM DB2 Content Manager ImagePlus® for OS/390®

� Other content servers

With the eClient, you can connect to Enterprise Information Portal (EIP) and 
perform searches across a variety of data sources simultaneously. You can also 
use the eClient to connect directly to content servers. The eClient supports 
Enterprise Information Portal Version 8.2 work flow and Content Manager 
Version 8.2 document routing.
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8.12.1  Install Content Manager eClient
To install the eClient, complete the following steps:

1. Start the WebSphere Application Server server1 by clicking Start → 
Programs → IBM WebSphere → Application Server v5.0 → Start the 
Server.

2. Insert the eClient CD into the CD drive. The launchpad starts automatically. If 
the launchpad does not start automatically, execute launchpad.bat from the 
launchpad directory.

3. In the launchpad, click Install to start the eClient installation program.

4. Follow the instructions in the installation windows. 

5. Change the installation directory for the eClient to be consistent with your 
other installation targets, such as C:\IBM\CMeClient. 

6. After you install the eClient files, the installation program checks for 
WebSphere. After the installation program detects WebSphere, you can 
continue with the automatic configuration of the Web application for the 
eClient.

8.12.2  Verify the eClient installation
To verify the installation of the eClient, complete the following steps:

1. Start the eClient.

To start the eClient from a Windows command prompt, change to the 
C:\IBM\CMeClient\Save subdirectory and execute the startIDMServer.bat 
file. 

2. Launch the eClient.

To launch the eClient load your Web browser and enter the following URL:

http://ilm-cm/eClient82/IDMInit

3. Log in to the eClient:

– User ID: CMadmin

– Password: <password>

– Server: ICMNLSDB (CM8)

4. Log out of the eClient.
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8.13  DB2 Records Manager Enabler Version 8.2.820.600 
installation

This section describes the steps required to install the IBM DB2 Records 
Manager Enabler for Content Manager on the Content Manager server node. 

8.13.1  Preinstallation tasks 
Before installing Records Manager Enabler (RME), complete the following tasks: 

1. Set up RME install folder.

On the systems that you plan to install one or more of the RME components, 
you need to create a RME installation folder. For our example, we created the 
C:\IBM\RMenabler RME folder. 

2. Create and update your Windows system environment variables:

a. Create a new system environment variable called RMEROOT and set its 
value to the RME install folder created in the previous step. In our 
environment, the variable is set to RMEROOT=C:\IBM\RMenabler.

b. Create a new system environment variable called RMELANG and set its 
value to the appropriate language for your installation. In our environment, 
the English language is used, so the variable is set to RMELANG=en. 
Table 8-2 shows the supported languages for Records Manager Enabler.

Table 8-2   Records Manager Enabler supported languages

RMELANG value Language

de German

en English (U.S.)

es Spanish

fr French

it Italian

ja Japanese

ko Korean

pt Brazilian Portuguese

zh Simplified Chinese

zh_TW Traditional Chinese
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8.13.2  Install the Records Manager Enabler Common Client support
The Records Manager Enabler Common Client support includes the RME 
support for all Windows-based client applications (for example, DB2 Content 
Manager Client for Windows, Lotus Notes® client, and Microsoft Outlook 2000 
client). Therefore, it needs to be installed on all RME client application machines. 
The DB2 Records Manager server uses the Content Manager V8 connector to 
communicate with the Content Manager server, and therefore, it requires the 
installation of the Content Manager V8 connector only.

The Content Manager V8 connector can be installed as a component of the DB2 
Information Integrator for Content client installation or by installing the DB2 
Content Manager Client for Windows Version 8.2 with Fix Pack 6.0. For our 
purposes, we install the Content Manager Client for Windows, because this client 
will also provide a convenient user interface to access the Content Manager 
content.

Microsoft SOAP Toolkit and MSXML Parser installation
All of the Records Manager Enabler Windows-based applications require the 
Microsoft Simple Object Access Protocol (SOAP) Version 3.0 and Microsoft 
MSXML Parser Version 4.0 packages. 

You can download and install the Microsoft SOAP Toolkit Version 3.0 package 
from the Microsoft download Web site. Go to the following link and search for 
SOAP:

http://www.microsoft.com/downloads

Follow the installation instructions in the package to install the SOAP Toolkit. The 
installation might install Microsoft MSXML Parser Version 4.0 for some of the 
Windows system platforms. If the SOAP Toolkit installation does not install the 
Microsoft MSXML Parser Version 4.0 package, download it from the Microsoft 
Web site and install it separately.

Install the Records Manager Enabler CommonWin32 
component

The RME CommonWin32 component contains the files required to support the 
Windows-based RME client applications. To install the CommonWin32 
component, complete the following steps:

1. Unzip the RME_CommonWin32.zip file to the RME install folder 
c:\IBM\RMenabler.

2. Register the SOAP DLL.

After the installation of the RME_CommonWin32.zip file, you need to register 
the SoapHeaderHandler.dll.
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3. Open a command prompt window. 

4. Change the directory to the bin folder in the RME install folder: 

c:\IBM\RMenabler\bin 

5. Enter the following command to register the SoapHeaderHandler.dll:

regsvr32 SoapHeaderHandler.dll 

The regsvr32 command will return the following message if it is successful:

DllRegisterServer in SoapHeaderHandler.dll succeeded

8.13.3  Install the Records Manager Enabler for Content Manager 
eClient server component

To install the Content Manager eClient server component, complete the following 
steps: 

1. Stop the Content Manager eClient application server. 

2. Install the RME_CommonJava.zip file. Unzip the RME_CommonJava.zip file 
to the RME install folder C:\IBM\RMenabler.

3. Install the RME_eClient.zip file. Unzip the RME_eClient.zip file to the eClient 
server install folder 
C:\IBM\CMeClient\installedApp\IBM_eclient_82.ear\eclient82.war.

8.14  Summary
We have now completed the installation of the Content Management node. 
Additional configuration is necessary, which we provide in Chapter 10, 
“Configuration” on page 227.

Note: You must reregister the SoapHeaderHandler.dll every time you reinstall 
the RME_CommonWin32.zip file on the system.
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Chapter 9. Records Management node 
installation

This chapter describes the procedure we used to install and configure the 
Records Management node for our working example runtime environment on the 
Microsoft Windows 2000 Server platform.

The high-level tasks to install the Records Management node are as follows:

1. Microsoft Windows 2000 Server installation

2. DB2 Universal Database installation

3. WebSphere Application Server installation

4. IBM GSKit installation

5. IBM HTTP Server SSL configuration

6. WebSphere Application Server configuration

7. DB2 Records Manager installation

8. DB2 Records Manager Enabler Version 8.2.820.600 installation

9
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9.1  Microsoft Windows 2000 Server installation
This section highlights the key issues addressed when installing Microsoft 
Windows 2000 Server, such as using Windows 2000 Service Pack 4, the latest 
Windows security patches, and the user rights assigned to an administrator user 
needed later for DB2.

9.1.1  Windows 2000 Service Pack 4
In our example, we installed Windows 2000 Service Pack 4.

9.1.2  Windows 2000 service levels
We installed the latest Windows 2000 service-level critical updates on top of 
Service Pack 4.

9.1.3  Create system users and assign user rights
To assign user rights to the administrator ID used by the DB2 owner during 
instance creation, refer to Table 9-1.

The users shown in Table 9-1 must be created to support DB2, WebSphere, and 
DB2 Records Manager.

Table 9-1   Required system user IDs

For each of these users, ensure that the following local security policy rights 
assignment have been enabled:

� Act as part of the operating system
� Create a token object
� Increase quotas
� Lock pages in memory
� Log on as a service

User ID Description

IBM WebSphere Application Server 
V5.0.2 system administration
(for example, WASadmin)

This user ID is used for installation and 
administration of all WebSphere components.

DB2 Records Manager database and 
engine user ID
(for example, RMADMIN)

This user ID is used for database installation 
and administration.

DB2 database administration user ID
(for example, DB2admin)

This user ID is used for DB2 installation and 
database administration.
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� Replace a process-level token

User creation and rights assignment
To create the users and provide the proper user rights assignments, complete 
the following steps:

1. Log on to Windows as an administrator.

2. Create each user ID and then add the users to the Administrators group. 

3. Click Start → Settings → Control Panel → Administrative Tools → Local 
Security Policy.

4. From the Local Security Settings window, select and expand Local 
Policies → User Rights Assignment.

5. Ensure that the administrator user ID (for example, admin) has user rights 
assignments for the following Windows local security policies needed for DB2:

– Act as part of the operating system
– Create a token object
– Increase quotas
– Lock pages in memory
– Log on as a service
– Replace a process-level token

6. Log on as RMADMIN. 

9.1.4  Verify network configuration
Prior to installing the Records Manager supporting software components, it is 
important that you verify that your network is configured properly. We 
recommend that you use a static TCP/IP address and verify that the host name 
can be resolved with the name server.

For example, we did the following from a command window:

ping <hostname>
ping <ip_address>
or
nslookup <hostname>
nslookup <ip_address>

Note: Any administrative user ID can be used for all the remaining installation 
steps. However, we chose to use the user ID (RMADMIN), which is most 
closely associated to the functional objectives of this server node.
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Ensure that the fully qualified host name is returned if resolved by a domain 
name system server. Alternatively, you might be using a hosts file for an 
environment such as development (use ping instead of nslookup).

9.2  DB2 Universal Database installation
This section describes how to install the IBM DB2 Universal Database V8.1, 
Enterprise Server Edition and supporting Fix Pack 4a.

This section is organized into the following tasks:

� Install DB2 UDB V8.1
� Install DB2 UDB V8.1 Fix Pack 4a
� Verify DB2 UDB

9.2.1  Install DB2 UDB V8.1
To install the IBM DB2 V8.1 Enterprise Server Edition, complete the following 
steps.

1. Insert the DB2 UDB V8.1 Enterprise Server Edition CD.

2. Navigate to the <CD_Root> and run Setup.exe to start the installation.

3. When the DB2 Installer window opens, click Install Products.

4. When the Select the Product to Install window opens, select DB2 UDB 
Enterprise Server Edition (default and only option) and then click Next.

5. When the Welcome window for the DB2 Setup Wizard opens, click Next. 

6. When the License Agreement window opens, review the terms, and if in 
agreement, select I accept the terms in the license agreement and click 
Next.

7. When the Select the installation type window opens, select Typical and then 
click Next.

8. When you see a warning message regarding connection to remote DB2 
servers using APPC, click OK.

9. When the Select the Installation Action window opens, select Install DB2 
UDB Enterprise Server Edition on this computer and then click Next.

Note: Depending on the DB2 UDB V8.1 CD distribution you are using, the 
installation panels might be slightly different from those described here.
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10.When the Select the Installation Folder window opens, we entered 
c:\ibm\sqllib and then clicked Next.

11.When the Set User Information for DB2 Administration Server window opens, 
enter and select the following values and then click Next:

– Domain: We left this field blank.
– User name: DB2admin (default)
– Password: <password>
– Confirm password: <password>
– Select Use the same username and password for remaining DB2 

services (default).

12.When the Setup the Administration Contact List opens, we accepted the 
default settings (local) and then clicked Next.

13.When the warning message Notification SMTP server has not been 
specified, click OK.

14.When the Configure DB2 instances window opens, we accepted the default 
(DB2). Click Next.

15.When the Prepare the DB2 tools catalog window opens, select Do not 
prepare the DB2 tools catalog on this computer and then click Next.

16.When the Specify a contact for health monitor notification window opens, 
select Defer the task after installation is complete and then click Next.

17.When the Start copying files window opens, review the selected options and 
then click Install.

18.When the Setup is Complete window opens, click Finish.

19.When the IBM DB2 First Steps window opens, click Exit First Steps. 

9.2.2  Install DB2 UDB V8.1 Fix Pack 4a
We installed IBM DB2 UDB V8.1 Fix Pack 4a for 32-bit Windows. We chose to 
use Fix Pack 4a for several reasons. First, IBM Tivoli Directory Server V5.2, 
WebSphere Portal V5.0.2, DB2 Content Manager V8.2 plus Fix Pack 6, and DB2 
Information Integrator for Content plus Fix Pack 6 officially support DB2 UDB 

Note: Take note of the Save your settings to response file check box. This 
can be used to capture your selection options to be used for a future 
installation.

Note: The DB2 UDB installation with the Typical installation type takes 
approximately 376 MB of disk space.
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V8.1 Fix Pack 4a. In addition, we wanted to use the same version of DB2 fix pack 
on all of the nodes for DB2 compatibility reasons.

To download and install the IBM DB2 UDB V8.1 Fix Pack 4a, complete the 
following steps:

1. You can download IBM DB2 UDB V8.1 Fix Pack 4a at:

http://www.ibm.com/cgi-bin/db2www/data/db2/udb/winos2unix/support/v8fphist.
d2w/report#WIN-32

2. We downloaded the FP4a_WR21338_ESE.exe, which is the Fix Pack 4a for 
IBM DB2 Universal Database V8.1, Enterprise Server Edition. 

3. Stop all DB2 services in the Windows services.

4. Install the IBM DB2 UDB V8.1 Fix Pack 4a. We accepted the default 
installation options.

5. We recommend that you restart your system after installing the fix pack to 
ensure that all fixes are applied and active in memory.

6. The internal DB2 level is 8.1.4.428 after the installation of Fix Pack 4a. In our 
example, we do not have any existing databases that need special attention 
(rebind DB2 utilities). 

After the system has restarted, open a DB2 command window (or Windows 
command window) and enter the following command:

db2level

It should return 8.1.4.428 after Fix Pack 4a has been installed.

Note: For more information about the contents of the IBM DB2 UDB V8.1 Fix 
Pack 4a, refer to the text file FixpackReadme, available at:

http://www.ibm.com/cgi-bin/db2www/data/db2/udb/winos2unix/support/v8fphis
t.d2w/report#WIN-32

Note: If you have trouble stopping any of the DB2 services, you can 
proceed with the fix pack installation. When the DB2 Setup Wizard 
launches for the fix pack, it will warn that certain processes are locking 
DB2 and will ask you if you want to shut them down. You can click Yes, 
and the Wizard will shut down the processes for you. 
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9.2.3  Verify DB2 UDB
After you install DB2 UDB V8.1 and the fix pack and have restarted your system, 
we recommend that you verify that DB2 UDB is working properly. 

9.3  WebSphere Application Server installation
This section describes how to install WebSphere Application Server Standard 
Edition V5.0 and Fix Pack 2 (V5.0.2).

9.3.1  Install WebSphere Application Server Standard Edition V5.0
To install WebSphere Application Server V5.0, complete the following steps:

1. Insert the WebSphere Application Server CD

2. Navigate to the <CD_Root> directory and run Install.exe to start the 
WebSphere Application Server installer.

3. When the Select the desired language to be used for the installation wizard 
opens, select the desired language (for example, English) and click OK. 

4. When the Welcome window opens, click Next.

Note: Rebind DB2 utilities to existing databases

If you have created databases before you installed Fix Pack 4a, you will need 
to rebind the DB2 utilities to the databases. This step is necessary for the fixes 
to become effective on existing database. The binding procedure needs to be 
performed only once per database. Note that this is not required for databases 
created after the fix pack is installed. We summarize the rebind procedure 
found in the FixpackReadme.txt.

To rebind existing DB2 UDB databases after installing Fix Pack 4a, enter the 
following commands from a DB2 command window for each database:

db2 terminate
db2 CONNECT TO <dbname>
db2 BIND <DB2_home>\BND\@db2ubind.lst GRANT PUBLIC
db2 BIND <DB2_home>\BND\@db2cli.lst GRANT PUBLIC
db2 terminate

Where <dbname> represents the name of a database to which the utilities 
should be bound. And, where <DB2_home> represents the directory where 
you have installed DB2. The db2ubind.lst and db2cli.lst contain lists of 
required bind files used by IBM DB2 UDB V8.1.
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5. When the License Agreement window opens, review the terms, and if in 
agreement, select I accept the terms in the license agreement. Click Next.

6. When the Setup Type window opens, select Full and click Next, as shown in 
Figure 9-1.

Figure 9-1   WebSphere Application Server: Select Full installation

7. When the Node name and Host name window opens, we used the following 
values and then clicked Next:

– Node name: ilm-rm
– Host name or IP Address: ilm-rm.itso.austin.ibm.com

8. When the Windows Services window opens, we used the following values 
and then clicked Next:

– Clear Run WebSphere Application Server as a service.
– Select Run IBM HTTP Server as a service.
– User ID: WASadmin
– Password: <password>

9. When the Installation Summary window opens, review your selections and 
then click Next to begin copying files.

10.When the Register window opens, take the appropriate action. 

11.When the First Steps window opens, click Exit.

12.Click Finish in the Installation Wizard window.
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9.3.2  Install WebSphere Application Server V5 Fix Pack 2 (V5.0.2)
To install IBM WebSphere Application Server V5 Fix Pack 2, complete the 
following steps:

1. Ensure that you have stopped all WebSphere Application Server application 
servers and nodes.

2. Ensure that you have stopped the IBM HTTP Server and IBM HTTP 
Administration Windows service (WebSphere plug-in fixes).

3. Download WebSphere Application Server V5 Fix Pack 2 at:

http://www.ibm.com/support/docview.wss?rs=860&context=SW600&q1=fixpack+2&ui
d=swg24005012&loc=en_US&cs=utf-8&lang=en+en

4. Unpack WebSphere Application Server V5 Fix Pack 2 to a temporary 
directory on the target system (for example, c:\temp\was5.fp2). Note that the 
WebSphere Update Installer Wizard needs write access.

5. Open a command window, and set the JAVA_HOME by running the following 
command provided with WebSphere Application Server:

c:\ibm\WebSphere\AppServer\bin\setupCmdLine.bat

6. From the command window, start the WebSphere Installation Update Wizard 
by entering updateWizard.bat found in the temporary directory (for example, 
c:\temp\was5.fp2).

7. When the WebSphere Update Installer language window opens, select the 
appropriate language for the wizard (for example, English) and then click OK.

8. When the Welcome window opens, click Next.

9. The WebSphere Update Installer should detect your current WebSphere 
Application Server version and installation directory (for example, 
c:\ibm\WebSphere\AppServer). Click Next.

10.Select Install fix packs and then click Next.

11.Enter the directory where you have copied the fix pack. For example, we 
entered c:\temp\was5.fp2\fixpacks in the Fix pack directory text field. Click 
Next.

12.Select the was50_fp2_win fix pack (default) and then click Next.

Note: The fix pack will attempt to update IBM HTTP Server and will not be 
able to update the server if it is started.
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13.You will be prompted for the directories for the IBM HTTP Server and the 
WebSphere Application Server embedded messaging (not installed), we used 
the following values and then clicked Next:

– Select IBM HTTP Server.
– IBM HTTP Server installation directory: c:\ibm\IBMHttpServer
– Clear Embedded Messaging (not installed).

14.Review the fix pack settings and then click Next to begin the fix pack 
installation of files.

15.When the WebSphere Application Server V5 Fix Pack 2 installation 
completes, click Finish.

9.3.3  Verify WebSphere Application Server V5.0.2
To verify the functionality of WebSphere Application Server V5.0.2 after the 
installation, complete the following steps:

1. Verify the WebSphere Application Server installation by clicking Start → 
Programs → IBM WebSphere → First Steps. 

2. From First Steps, click Verify Installation.

If the server is not started, it will start the server and perform some tests. You 
will see console output with the status of each test run - passed.

3. After completing the Verify Installation, click Exit in the First Steps window.

4. Ensure that IBM HTTP Server (WebSphere plug-in) is started.

5. Ensure that the server1 application server is started. If not, start the server as 
follows:

cd \ibm\WebSphere\AppServer\bin
startServer server1

Note: Alternatively, you can start the Install Verification by opening a 
command prompt, navigating to the <was_home>\bin directory, and running 
ivt.bat.
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6. Start the WebSphere administrative console by entering the following URL in 
a Web browser:

http://<was_hostname>:9090/admin

7. Log in to the WebSphere administrative console (for example, admin).

8. When done verifying the WebSphere administrative console, click Logout 
close the Web browser.

9. Stop the server1 application server as follows:

cd \ibm\WebSphere\AppServer\bin
stopServer.bat server1

9.4  IBM GSKit installation
This section describes how to download and install IBM GSKit V7.0.1.16. GSKit 
is used to manage key stores and certificates. GSKit includes the IBM Key 
Management Utility and libraries accessible to applications to create and 
manage certificates. 

GSKit V7.0.1.9 installed with IBM Tivoli Directory Server V5.2 on the Directory 
Server node includes root certificates that have expired. This results in the 
administrator not being able to create a new key store using the iKeyman utility. 
By installing the later version, IBM GSKit V7.0.1.16, this issue is addressed, 
along with other fixes.

9.4.1  Determine GSKit version installed
This section describes how to determine the version of GSKit an application is 
configured to use in the Windows registry. If you are following the order of 
installing components documented in this chapter, this section is not necessary, 
because we install the new GSKit prior to installing components that use it.

Note: Review the status of the server startup in startServer.log.

For example, we used the GNU utility to view the logs:

tail -f c:\ibm\WebSphere\AppServer\logs\server1\startServer.logs

You should see the following message:

Server server1 open for e-business

The server1 directory will not get created until the first time the application 
server is started.
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If you have not installed IBM Tivoli Directory Server or other software containing 
IBM GSKit, you can skip this section. To determine the level of GSKit installed, 
complete the following steps:

1. Start the Windows registry editor (regedit.exe) by clicking Start → Run and 
entering regedit in the Open field. Click OK.

2. Select and expand HKEY_LOCAL_MACHINE → SOFTWARE → IBM.

3. In our example, you will see both the GSK5 and GSK7 registry entries.

4. Select GSK7 → CurrentVersion. Record the data value for the version 
name. 

5. Select REGAPPS under the CurrentVersion. This lists the name of the 
application using the GSKit. Record the name of the application using this 
version of the GSKit (for example, LDAP).

9.4.2  Uninstall the earlier GSKit version
If following our procedure, this section is not required.

Prior to installing the new IBM GSKit V7.0.1.16, if a GSKit already has been 
installed, you must manually uninstall the existing IBM GSKit V7.0.1.9 as follows:

1. Ensure that the IBM IBM Tivoli Directory Server V5.2 Windows service has 
been stopped, as well as other services that might be using the GSKit.

2. Open a command window and navigate to the c:\winnt directory.

3. Run the following command to uninstall the GSKit:

gsk7bui LDAP

Where LDAP is the name of the application using the GSKit.

4. Verify that the GSK7 Windows registry has been removed.

5. Verify that the GSK7 directory has been removed (for example, C:\Program 
Files\IBM\GSK7).

Note: The GSKit version can be obtained by using the gsk7ver.exe command 
or by retrieving the version from the Windows registry. We chose to use the 
Windows registry method because we also needed the REGAPPS value in 
addition to the version.

Note: If files still exist such as DLLs, manually delete the C:\Program 
Files\IBM\GSK7 directory after the services that locked the files have been 
stopped.
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9.4.3  Install GSKit V7.0.1.16
To download and install IBM GSKit V7.0.1.16, complete the following steps:

1. IBM GSKit V7.0.1.16 can be obtained by one of the following methods:

– Request the GSKit V7.0.1.16 from IBM support at:
http://techsupport.services.ibm.com/guides/tivoli_contacts.html

Or:

– Download the IBM HTTP Server V1.3.28, which include IBM GSKit 
V7.0.1.16 at:
http://www.ibm.com/support/docview.wss?rs=177&context=SSEQTJ&uid=swg2400
6718

2. Open a command window and navigate to the directory in which you have 
unpacked the WINDOWSPQ86671IHS1.3.28.zip file.

3. Enter the following at the command line to extract the GSKit:

gsk7bas c:\temp

Where c:\temp is the directory into which to extract the GSKit installation 
files.

4. From the command window, navigate to the directory where you extracted the 
GSKit installation files (for example, c:\temp).

Note: If you have previously installed applications that use the earlier GSKit 
V7.0.1.9, they might have updated the system path to include the GSKit 
installation path. If you decided to change the default GSKit installation path, 
you might need to manually update the system path to include the correct 
GSKit installation path.

Note: From the URL listed, you will have to log in as a registered user 
(or register first). After you navigate to the download page by platforms 
you will see a list of fixes. 

We downloaded the WINDOWSPQ86671IHS1.3.28.zip (PQ86671) for 
IBM HTTP Server V1.3.28 to the c:\temp directory and unpacked the 
ZIP file.
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5. Run the GSKit installer as follows:

setup <application_name>

Where <application_name> is the name of the application using GSKit 
V7.0.1.16 (for example, LDAP).

For example:

setup LDAP

6. When the Welcome window opens, click Next.

7. When the Choose Destination Location window opens, we entered 
c:\ibm\gsk7 for the destination folder using the Browse button. Click Next to 
proceed.

8. When the setup is complete, click Finish.

9.5  IBM HTTP Server SSL configuration
As a prerequisite to DB2 Content Manager resource manager, this section 
describes how to configure SSL for IBM HTTP Server and the IBM HTTP 
administration server.

We organize the section into the following tasks:

� Enable the httpd.conf file for SSL
� Copy WebSphere plug-in entries
� Create the IBM HTTP Server key store
� Create a certificate for IBM HTTP Server
� Verify IBM HTTP Server

9.5.1  Enable the httpd.conf file for SSL
To modify the httpd.conf file to enable SSL support, complete the following steps:

1. Stop the IBM HTTP Server V1.3.26 Windows service.

2. Back up the original httpd.conf file. For example:

cd \<ihs_home>\conf
copy httpd.conf httpd.conf.org

3. Copy the httpd.conf.sample containing the commented SSL directives to 
httpd.conf. For example:

copy httpd.conf.sample httpd.conf

4. Open the <ihs_home>\conf\httpd.conf file with a text editor.
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5. Search for the following lines, uncomment the # symbol, and modify the 
settings as follows:

– Verify the ServerName value. This should include your fully qualified host 
name (for example, cmrm1.itso.ral.ibm.com):

ServerName <fully_qualified_hostname>

– Uncomment the IBM SSL module for the given SSL encryption level (56 or 
128 bit). For example:

LoadModule ibm_ssl_module modules/IBMModuleSSL128.dll

– Uncomment the following line to listen on port 443 for HTTPS:

Listen 443

– Uncomment and update the VirtualHost with your host name as follows:

<VirtualHost hostname.domain.com:443>

– Uncomment:

SSLEnable

– Uncomment:

</VirtualHost>

– Uncomment and update the following:

Keyfile "<ihs_home>/ssl/keyfile.kdb"

– Uncomment:

SSLV2Timeout 100
SSLV3Timeout 1000

6. Save the changes to the httpd.conf file.

Note: Where 56 or 128 is the appropriate encryption level for your 
locale. For example, 128 for 128-bit encryption in the U.S. and Canada.

Note: Substitute your fully qualified host name in this line (for example, 
<VirtualHost ilm-rm.itsc.austin.ibm.com:443>).

Note: The keyfile path has been modified to include ssl instead of keys. 

For example:

Keyfile "c:\ibm\IBMHttpServer/ssl/keyfile.kdb"
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9.5.2  Copy WebSphere plug-in entries
During the installation of the IBM HTTP Server and WebSphere plug-in, the 
httpd.conf file was updated with the plug-in entries. Now that we have copied the 
httpd.conf.sample file in the previous section to enable the SSL directives, we 
now also need to add the WebSphere plug-in entries to the httpd.conf file. To 
copy the plug-in entries, complete the following steps:

1. Change to the directory the IBM HTTP Server <ihs_home>\conf directory.

2. Modify the httpd.conf file, adding the following for the WebSphere plug-in at 
the end of the file:

LoadModule ibm_app_server_http_module 
"c:\ibm\WebSphere\AppServer/bin/mod_ibm_app_server_http.dll"

WebSpherePluginConfig 
"c:\ibm\WebSphere\AppServer/config/cells/plugin-cfg.xml"

9.5.3  Create the IBM HTTP Server key store
To create the IBM HTTP Server key store database used to store certificates, 
complete the following steps:

1. From Windows, click Start → Programs → IBM HTTP Server 1.3.26 → Start 
Key Management Utility.

2. From the menu bar, click Key Database File → New.

3. In the New window, enter the following values and then click OK:

– Key Database Type: CMS key database file
– File name: keyfile.kdb
– Location: <ihs_home>\ssl (for example, c:\ibm\IBMHttpServer\ssl)

4. In the Password Prompt window, enter the following values and then click OK:

– Password: <your_password> (to protect the key store file).
– Select Set expiration time and enter the number of days before the 

password will expire. If no expiration is required, do not select this option.

Tip: The above text is two separate lines. Within the httpd.conf file, the lines 
are not wrapped.

If you backed up the httpd.conf.org file, you can cut and paste the plug-in 
entries to the SSL enabled httpd.conf file.

Note: This path must match the keyfile path in the httpd.conf.
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– Select Stash the password to a file.

5. When the information window opens with the following message, click OK:

The password has been encrypted and saved in the file:
c:\ibm\IBMHttpServer\ssl\keyfile.sth

9.5.4  Create a certificate for IBM HTTP Server
For development and testing purposes, we create a new self-signed certificate. 
The following steps outline the creation of a new self-signed certificate:

1. From the Key Management Utility menu bar, select Create → New 
Self-Signed Certificate.

If you closed the Key Management Utility, you need to open the key store first.

2. Fill in the information about the form and click OK. For example, we used the 
following values:

– Key Label: IBM HTTP Server key
– Common Name: <fully_qualified_hostname> 
– Organization: <your_organization_name> (for example, ibm)

3. When done, close the Key Management Utility.

9.5.5  Verify IBM HTTP Server
After the IBM HTTP Server configuration, we recommend that you complete the 
following verification tests.

Note: Although not required in a development environment, we 
recommend that you set an expiration period for all key stores used in 
production environments.

Note: IBM HTTP Server accesses the password-protected key store.

Note: For the production IBM HTTP Server, you should create a new 
certificate request (do not use a self-signed certificate).

 

 

 

 

 Chapter 9. Records Management node installation 205



Start IBM HTTP Server
Restart the IBM HTTP Server service for the changes to take effect. It can be 
started by one of the following methods:

� IBM HTTP Server 1.3.26 Windows service

Or:

� From the command line or batch file containing the following:

net start “IBM HTTP Server 1.3.26”

Verify the IBM HTTP Server
To verify that IBM HTTP Server is working properly, enter the following URLs in a 
Web browser after IBM HTTP Server has been started:

� Verify HTTP:

http://<hostname>

� Verify HTTPS:

https://<hostname>

Backup the httpd.conf file
After you have verified that IBM HTTP Server is working properly with SSL 
enabled, we recommend that you make a backup of the 
<ihs_home>\conf\httpd.conf file to httpd.conf.was.ssl. 

9.5.6  Configure SSL for IBM HTTP administration server
For details about configuring SSL for IBM HTTP administration server, refer to 
IBM Content Manager for Multiplatforms: Planning and Installing Your Content 
Management System Version 8 Release 2, GC27-1332-02. 

For our example, we did not complete this step because we will not manage IBM 
HTTP Server using the Administration Server.

9.6  WebSphere Application Server configuration
This section describes the need to get proper certificates on the Content 
Management node for the WebSphere Application Server and WebSphere 
plug-in. In addition, we provide a procedure for restricting ports to WebSphere 
Application Server.
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9.6.1  Certificates
By default after installation, the WebSphere Application Server Secure Sockets 
Layer (SSL) is configured with a dummy certificate. Before moving to production 
with DB2 Content Manager, ensure that the WebSphere Application Server and 
WebSphere plug-in certificate get updated with a proper certificate.

9.6.2  Restrict ports for WebSphere Application Server
For security reasons, restrict the ports of your resource manager application 
server to localhost. 

To restrict ports for WebSphere Application Server V5.0.1, complete the 
following steps:

1. Start the server1 application server with the WebSphere administrative 
console enterprise application is installed.

cd \ibm\WebSphere\AppServer\bin
startServer server1

2. Start the WebSphere administrative console by entering the following URL in 
a Web browser:

http://<was_hostname>:9090/admin

3. Log in to the WebSphere administrative console (for example, admin).

4. Click Servers → Application Servers.

5. Click server1.

6. Click Web Container → HTTP transports.

7. Update the host field for each port from * to localhost.

8. For each port you changed for your WebSphere Application Server, you must 
click Environment → Virtual Hosts → <default_host> → Host Aliases and 
update the specific port from * to localhost.

9. Update the WebSphere plug-in.

10.Restart IBM HTTP Server for the new plugin-cfg.xml file to be read 
immediately and the changes to become active.

Note: For development testing purposes, this step is not required.

Note: This step is recommended for a production environment, but not 
required for development purposes.
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9.7  DB2 Records Manager installation
This section describes how to install the DB2 Content Manager resource 
manager on the Resource Manager node.

9.7.1  Prerequisites for DB2 Records Manager
This section outlines the prerequisites that must be completed prior to installing 
DB2 Records Manager. All prerequisite steps listed in this section should already 
have been completed if you have followed the procedure in this document. 
Review the prerequisites to ensure that you meet all of them:

� IBM DB2 Universal Database V8.1, Enterprise Server Edition with Fix Pack 
4a is installed.

� WebSphere Application Server is installed.

� SSL is enabled for the IBM HTTP Server.

� User IDs with rights and privileges for DB2 Records Manager are created.

� You have enough temporary space (at least 100 MB of temporary free space).

� Your %PATH% is not too long. Remove duplicate path entries if they exist. 
Windows has a 1024 character limit for environment.

9.7.2  Install DB2 Records Manager
To install DB2 Records Manager, complete the following steps

1. Ensure that you are logged in to Windows with the RMADMIN administrator 
user ID.

2. Ensure that the WebSphere Application Server server1 is started, 
c:\IBM\WebSphere\AppServer\startServer.bat server1.

Before you begin
You must install an IBM DB2 Records Manager database before you can install 
and use DB2 Records Manager. Although the IBM DB2 Records Manager 
installation application guides you through this process, you should be familiar 
with the database creation procedure and terminology. Refer to your DB2 
documentation. See Table 9-2 on page 209 for a description of the required 
database attributes.
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Table 9-2   Required database attributes

9.7.3  Create the DB2 Records Manager database
To create the DB2 Records Manager database, complete the following steps:

1. Insert the DB2 Records Manager CD. Cancel the automatic installation and 
then navigate to the CD-ROM directory and execute the 
irm312_dbinstall_win32.exe setup program to begin the database 
installation.

Field Description Our example values

DB2 Node/Instance 
Name

The name defined for the server instance 
within the DB2 Command Center.

DB2

Database Name The name of the database to be created. RecManDB

Default Disk Physical storage location for the database 
file to be installed. This is usually 
designated by a drive letter.

C

Folder for Database 
Containers

The directory for the installation of the 
database files.

C:\IBM\RecordsManagerData\

User Name The Records Manager administrative ID. RMADMIN

User Password The Records Manager administrative ID 
password.

<password>

Territory The locale that is mapped to the country 
code for internal processing by the 
database manager default.

<default>

Collating Sequence The sequence in which the characters are 
ordered for the purpose of sorting, merging, 
comparing, and processing indexed data 
sequentially.

System

DB language If the database language is different from 
the default language on your computer, you 
can specify a language identifier. The 
language must be available on the platform 
where you are running the installation.

English

Sys Admin User Name Name of the database user with system 
administrator privileges for the DB2 
database instance.

DB2admin

Sys Admin User 
Password

Password of the database user with system 
administrator privileges for the DB2 
database instance.

<password>
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2. Select the language of the text to be displayed while the InstallShield Wizard 
runs. Click Next to continue the installation. 

3. The Software License Agreement window opens. Read the DB2 Records 
Manager license terms. If you accept the license terms, click I accept the 
terms of the license agreement. If you do not accept the license terms, the 
installation program terminates. Click Next to continue the installation. 

4. The Readme window opens. Review the contents of the DB2 Records 
Manager readme. The readme contains last-minute information and tips you 
should know before the installation. Click Next.

5. In the Install directory window, choose the directory where the DB2 Records 
Manager database files will be installed. The field displays the default 
location. We installed the database in the C:\IBM\RecordsManagerData\ 
directory. Click Next. 

6. When the select database type window opens, select DB2 and provide the 
path to the JDBC driver. We entered C:\IBM\SQLLIB\java. Click Next.

7. Next, the DB2 Database Configuration window opens. Refer to Table 9-2 on 
page 209 for descriptions of the attributes required in this window. We entered 
the values shown in Figure 9-2. Click Next.

Figure 9-2   Records Manager database configuration value entry

8. In the Database File Plan Information window, select the type of database file 
plan you want to install. You have two choices. Select Empty if you want to 
install an empty database. Select Sample if you want to install a sample 
database. We installed the sample data. Click Next.

9. In the Summary information window, review the summary information and 
then click Next to begin the installation. After the installation completes, the 
Finished window opens. 
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10.The installation is now complete. Click Finish to exit the DB2 Records 
Manager database installation.

11.After installing the database, launch the DB2 Command Line Processor from 
a Windows command prompt using the following command:

connect to RecManDB user RMADMIN using <password>

12.issue the following command to list all the tables:

list tables

13.Without samples, you should see 95-96 tables listed; with samples, you 
should see 111-112 tables listed.

14.issue the following commands to disconnect:

connect reset
exit

15.Do not reboot the system.

9.7.4  Install DB2 Records Manager Engine
This section describes how to install the DB2 Records Manager Engine. 

Before you begin
During the DB2 Records Manager installation, you will be prompted to enter 
information regarding your WebSphere Application Server configuration. Before 
you begin the installation, gather the WebSphere information shown in Table 9-3 
so that you are ready when prompted.

Table 9-3   WebSphere information required for Records Manager installation

Note: Be patient, the installer does not provide a progress indicator.

Field Description Our example value

Host Name or IP Address Host name or IP address of the physical 
computer on which you are installing 
WebSphere Application Server.

ilm-rm.itsc.austin.ibm.
com

Connector Type Type of communication interface between the 
server and clients. The application uses 
SOAP.

SOAP

Connector Port Port number that the WebSphere Application 
Server messag.e queue will use for message 
queues

8880
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9.7.5  Install DB2 Records Manager Version 3.1.2 Engine
Although the target version is DB2 Records Manager Version 3.1.3, we must first 
install the Version 3.1.2 Engine as a prerequisite for V3.1.3.

To install the DB2 Records Manager Version 3.1.2 Engine, complete the following 
steps:

1. Ensure that WebSphere Application Server server1 is running.

2. Insert the DB2 Records Manager CD. Cancel the automatic installation and 
then navigate to the CD-ROM directory and execute the 
irm312_engine_win32.exe setup program to begin the engine installation.

3. Select the language of the text to be displayed while the InstallShield Wizard 
runs. Click Next to continue the installation. 

4. The Software License Agreement window opens. Read the DB2 Records 
Manager license terms. If you accept the license terms, click I accept the 
terms of the license agreement. If you do not accept the license terms, the 
installation program terminates. Click Next to continue the installation. 

5. The Readme window opens. Review the contents of the DB2 Records 
Manager readme. The readme contains last-minute information and tips you 
should know before the installation. Click Next.

Cell Cell is an arbitrary, logical grouping of one or 
more nodes in a WebSphere Application 
Server distributed network.

ilm-rm

Node Node is a physical computer system with a 
distinct IP host address.

ilm-rm

Server Server name of the WebSphere Application 
Server instance to be created to contain the 
DB2 Records Manager Engine application.

server1

Field Description Our example value

Note: For our installations, we verified that the server is running by 
launching the WebSphere Application Server administrative client. You 
can also verify that the server is running by viewing the server SystemOut 
log file located within the WebSphere Application Server logs\server1 
directory. For our installation, this log file is located at 
C:\IBM\WebSphere\AppServer\logs\server1\SystemOut.log
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6. In the Install directory window, choose the directory where the DB2 Records 
Manager database files will be installed. The field displays the default 
location. We installed the database in the C:\IBM\RecordsManager\ directory. 
Click Next. 

7. When the select setup type window opens, select Custom. Click Next.

8. In the Installation features window, select all components, as shown in 
Figure 9-3. Click Next.

Figure 9-3   Records Manager features

9. When the installation deployment options window opens, choose I want 
installer to do deployment and configuration for me. Click Next.

10.The WebSphere Application Server connection window opens. Enter the 
values as shown in Table 9-3 on page 211. For our installation, we entered 
the values listed Figure 9-4. Click Next.

Figure 9-4   Records Manager: Application Server Connection Information

11.In the Records Manager Administrative Client window, accept the default 
values for Root and Engine Server ORB Port. Enter the host name of your 
Records Manager server in the Engine Server Name field. For our 
installation, we entered the values shown in Figure 9-5 on page 214. Click 
Next.
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Figure 9-5   Records Manager: Admin Client Configuration

12.In the Specify JDBC driver class path window, enter the path to your DB2 java 
installation directory. For our installation, we entered C:\IBM\SQLLIB\java. 
Click Next.

13.In the DB2 Data Source Configuration window, enter the values for your DB2 
database configuration as defined in 9.7.3, “Create the DB2 Records 
Manager database” on page 209. For our installation, we entered the values 
shown in Figure 9-6. Click Next.

Figure 9-6   Records Manager: DB2 Data Source Configuration

14.In the Web Services Configuration window, accept the default values for 
Engine Server ORB Port and Web Services Node Name. Enter the values for 
your Records Manager server in the Engine Server Node Name and Web 
Services Node Name fields. For our installation, we entered the values shown 
in Figure 9-7 on page 215. Click Next.
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Figure 9-7   Records Manager: Web Services Configuration

15.In the Summary information window, review the summary information and 
then click Next to begin the installation. After the installation completes, the 
Finished window opens. 

16.The installation is now complete. Click Finish to exit the DB2 Records 
Manager Engine installation.

9.7.6  Verify DB2 Records Manager

After installing IBM DB2 Records Manager Version 3.1.2, perform the following 
installation verification steps:

1. Start the WebSphere administrative console.

2. Expand Applications.

3. Select Enterprise Applications.

4. Verify that the following three Records Manager applications are installed:

– DB2 Records Manager
– DB2 Records Manager WebServices
– IRMClientEAR

5. Stop server1. Click Start → Programs → IBM WebSphere → WebSphere 
Application Server 5.0 → Stop the Server. 

Alternatively, stop server1 from the command line as follows:

c:\ibm\WebSphere\AppServer\bin\stopServer server1

6. Start server1. Click Start → Programs → IBM WebSphere → WebSphere 
Application Server 5.0 → Start the Server. 

Alternatively, start server1 from the command line as follows:

c:\ibm\WebSphere\AppServer\bin\startServer server1

7. Launch the WebSphere administrative console.
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8. Verify that IBM DB2 Records Manager, IBM DB2 Records Manager 
WebServices, and IRMClientEAR are now started (green arrows in the Status 
column).

9. Validate that the Records Manager application is functional. Use the following 
URL to verify the connection to the applications:

http://<IRMserver>:9080/IRMClient/doLogin.do?lang=en

10.The IBM DB2 Records Manager Administrator Login window opens:

– Log in with the following credentials:

• Name: Administrator

• Password: cronos

– Log out.

The installation of DB2 Records Manager Version 3.1.2 Engine is now complete.

9.7.7  Install DB2 Records Manager Version 3.1.3 Engine
The purpose of this Fix Pack is to provide compatibility with DoD 5015.2 v7.5 test 
cases. V7.5 introduced changes that required modifications to DB2 Records 
Manager.

To install DB2 Records Manager Version 3.1.3 Engine, complete the following 
steps:

1. Stop all running Records Manager applications:

– DB2 Records Manager
– IBM DB2 Records Manager WebServices
– IRMClientEAR

To stop these Records Manager applications, complete the following steps:

a. Launch the WebSphere administrative client.

b. Expand Applications → Enterprise Applications.

c. Select the following Records Manager applications:

• DB2 Records Manager
• IBM DB2 Records Manager WebServices

Note: In IBM DB2 Records Manager Version 3.1.3, there are no new database 
components; the same database components exist for Version 3.1.1 and 
3.1.2. DB2 Records Manager V3.1.3 supports WebSphere Application Server 
5.0.2 and currently does not support previous or future versions of 
WebSphere.
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• IRMClientEAR

d. Click Stop.

e. Ensure that all three applications stop successfully as indicated by the 
application status column symbol represented a circle with a red cross. 
Figure 9-8 illustrates this.

Figure 9-8   Records Manager: WebSphere Application Server configuration (Stop)

2. Insert the DB2 Records Manager CD. Cancel the automatic installation and 
then navigate to the CD-ROM directory and execute the 
irm313_engine_win32.exe setup program to begin the engine installation.

3. Select the language of the text to be displayed while the InstallShield Wizard 
runs. Click Next to continue the installation. 

4. The Software License Agreement window opens. Read the DB2 Records 
Manager license terms. If you accept the license terms, click I accept the 
terms of the license agreement. If you do not accept the license terms, the 
installation program terminates. Click Next to continue the installation. 

5. The Readme window opens. Review the contents of the DB2 Records 
Manager readme. The readme contains last-minute information and tips you 
should know before the installation. Click Next.

6. In the Install directory window, choose the directory where the DB2 Records 
Manager database files will be installed. The field displays the default 
location. We installed the database in the C:\IBM\RecordsManager\ directory. 
Click Next. 

7. When the select setup type window opens, select Custom. Click Next. 
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8. Complete the DB2 Records Manager Version 3.1.3 upgrade by following 
steps 7-21 in 9.7.5, “Install DB2 Records Manager Version 3.1.2 Engine” on 
page 212.

9. Start the following Records Manager applications:

– DB2 Records Manager
– IBM DB2 Records Manager WebServices
– IRMClientEAR

To start these Records Manager applications, complete the following steps:

a. Launch the WebSphere administrative client.

b. Expand Applications → Enterprise Applications.

c. Select the following Records Manager applications:

• DB2 Records Manager
• IBM DB2 Records Manager WebServices
• IRMClientEAR

d. Click Start.

e. Ensure that all three applications stop successfully as indicated by the 
application status column symbol represented as a green arrow. 
Figure 9-9 illustrates this.

Figure 9-9   Records Manager: WebSphere Application Server configuration (Start)

10.Validate that the Records Manager application is functional. Use the following 
URL to verify connection to the applications:

http://<IRMserver>:9080/IRMClient/doLogin.do?lang=en
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11.The IBM DB2 Records Manager Administrator Login window opens:

– Log in with the following credentials:

• Name: Administrator

• Password: cronos

– Log out.

The installation of DB2 Records Manager Version 3.1.3 Engine is now complete.

9.8  DB2 Records Manager Enabler Version 8.2.820.600 
installation

This section describes the steps required to install the IBM DB2 Records 
Manager Enabler for Content Manager on the Content Manager server node. 

9.8.1  Preinstallation tasks 
Before installing Records Manager Enabler (RME), complete the following tasks: 

1. Set up the Records Manager Enabler install folder.

On systems that you plan to install one or more of the RME components, you 
need to create a RME install folder. For our example, we created the 
C:\IBM\RMenabler RME folder. 

2. Create and update system environment variables:

– Create a new system environment variable called RMEROOT and set its 
value to the C:\IBM\RMenabler install folder created in the previous step. 
In our environment, the variable is set to RMEROOT=C:\IBM\RMenabler.

– Create a new system environment variable called RMELANG and set its 
value to the appropriate language for your installation. In our environment, 
the English language is used, so the variable is set to RMELANG=en. 
Table 9-4 shows the supported languages for Records Manager Enabler.

Table 9-4   Records Manager Enabler supported languages

RMELANG value Language

de German

en English (U.S.)

es Spanish

fr French
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9.8.2  Install Records Manager Enabler Common Client support
The RME Common Client support includes the RME support for all 
Windows-based client applications (for example, the DB2 Content Manager 
Client for Windows, Lotus Notes client, and Microsoft Outlook 2000 client). 
Therefore, it needs to be installed on all RME client application machines. The 
DB2 Records Manager server uses the Content Manager V8 connector to 
communicate with the Content Manager server, and therefore, it requires the 
installation of the Content Manager V8 connector only.

The Content Manager V8 connector can be installed as a component of the DB2 
Information Integrator for Content client installation or by installing the DB2 
Content Manager Client for Windows Version 8.2 with Fix Pack 6.0. For our 
purposes, we install the Content Manager Client for Windows, because this client 
will also provide a convenient user interface for access to Content Manager 
content.

IBM DB2 Content Manager Client for Windows installation
This section describes how to install the IBM DB2 Content Manager Client for 
Windows Version 8.2 on a remote node to the Content Management node for 
administration purposes. 

To install the Content Manager Client for Windows, complete the following steps:

1. Ensure that the WebSphere Application Server server1 application server on 
the Content Management node is started.

2. Insert the Content Manager V8.2 Client for Windows CD.

3. Navigate to the root of the CD start the installation by running Setup.exe.

4. Select the language.

5. When the Welcome window opens, click Next.

it Italian

ja Japanese

ko Korean

pt Brazilian Portuguese

zh Simplified Chinese

zh_TW Traditional Chinese

RMELANG value Language 
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6. When the Destination Folder window opens, click Change and set the install 
directory (for example, c:\ibm\CMw32Client). Click OK to return to the 
Destination Folder and then click Next to continue.

7. Select the Typical Install and then click Next.

8. When the Content Manager Version 8 Properties File Location window opens, 
review the information in the window carefully. Enter the directory of the 
Content Manager properties files (for example, c:\ibm\CMgmt) and then click 
Next.

9. When the DB2 Content Manager Initialization Files Location - Remote 
window opens, leave the http:// field blank and click Next.

10.When the DB2 Content Manager Initialization Files Location - Local window 
opens, enter the directory of the DB2 Content Manager initialization files (for 
example, c:\ibm\CMgmt) and then click Next.

11.When the DB2 Content Manager Initialization Files - Create window opens, 
enter the following values:

– Datastore Alias Name: icmnlsdb
– Database Schema Name: icmadmin

– User ID: CMadmin
– Password: <password>
– Database Location: <Remote>
– Authentication: Server

12.When the Content Manager - Remote Database Catalog Information window 
opens, enter the following values and then click Next:

– Hostname of database server: ilm-cm.itsc.austin.ibm.com 
– Database Node name: DB2
– Port number: 50000

Note: The database schema name is determined by the user ID that 
was logged in to create the database. If you are not sure, use the DB2 
Control Center and select the tables for the database. The schema 
name will be displayed.

Note: The connection port is defined in the DB2 dbm SVCENAME. To 
see to what the SVCENAME is set, enter the following:

db2 get dbm cfg | more

When you know the SVCENAME value, you can look at the 
/winnt/system32/drivers/etc/services file to determine the 
corresponding port number.
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– Remote Database Name: icmnlsdb
– Operating System of server: WinNT/2000

13.When the Ready to Install the Program window opens, click Install.

14.Click Finish to close the wizard.

DB2 Content Manager Client for Windows V8.2 Fix Pack 6 
installation

This section describes the installation steps for DB2 Content Manager Client for 
Windows V8.2 Fix Pack 6.

The fix pack can be downloaded from the following site and will provide you with 
a list of fix packs:

http://www.ibm.com/support/search.wss?rs=86&rankfile=8&tc=SSRS7Z&dc=D420&dtm

To install DB2 Content Manager Client for Windows V8.2 Fix Pack 6, complete 
the following steps:

1. Select Fix Pack 6 and download it to a local disk.

2. Stop all running servers as follows:

– Stop WebSphere Application Server.
– Stop and restart the DB2 instance.

3. Click Update to begin the fix pack installation.

4. Click Finish to complete the installation.

DB2 Content Manager Client for Windows verification
If there are no error messages during the installation, it was successful.

You can verify this by checking the product version in the support information of 
the Add or Remove Programs panel in Windows.

After restarting all components, you should be able to log in to the Client for 
Windows and work with your data.

To verify that the IBM DB2 Content Manager V8.2 Client for Windows was 
installed and configured correctly, complete the following services:

1. To start the DB2 Content Manager Client for Windows, click Start → 
Programs → IBM Content Manager V8 → Client for Windows.

Note: The DB2 instance is running at this point.
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2. Log on as a Content Manager user. For example:

– Server: ICMNLSDB
– User ID: CMadmin
– Password: <password>

Click OK.

3. When the Welcome window opens, click Search. 

4. When the Basic Search window opens, specify your search criteria and click 
OK. A result folder should be displayed.

Microsoft SOAP Toolkit and MSXML Parser installation
All of the RME Windows-based applications require the Microsoft Simple Object 
Access Protocol (SOAP) Version 3.0 and MSXML Parser Version 4.0 packages. 

You can download and install the Microsoft SOAP Toolkit Version 3.0 package 
from the Microsoft download Web site. Go to the following site and search for 
SOAP:

http://www.microsoft.com/downloads

Follow the installation instructions in the package to install the SOAP Toolkit. The 
installation might install Microsoft MSXML Parser Version 4.0 for some of the 
Windows system platforms. If the SOAP Toolkit installation does not install the 
Microsoft MSXML Parser Version 4.0 package, download it from the Microsoft 
Web site and install it separately.

9.8.3  Install Records Manager Enabler CommonWin32 component

The RME CommonWin32 component contains the files required to support the 
Windows-based RME client applications. To install the CommonWin32 
component, complete the following steps:

1. Unzip the RME_CommonWin32.zip file to the RME install folder 
c:\IBM\RMenabler.

2. Register the SOAP DLL.

After the installation of the RME_CommonWin32.zip file, you need to register 
the SoapHeaderHandler.dll.

3. Open a command prompt window. 

4. Change directory to the bin folder in the RME install folder:

c:\IBM\RMenabler\bin 

5. Enter the following command to register the SoapHeaderHandler.dll:

regsvr32 SoapHeaderHandler.dll
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The regsvr32 command will return the following message if it is successful:

DllRegisterServer in SoapHeaderHandler.dll succeeded

9.8.4  Install Records Manager Enabler DB2 Records Manager server 
component

The Records Manager Enabler DB2 Records Manager server component 
enables the DB2 Records Manager server to communicate with the Content 
Manager server to provide support for the RME functions. The RME functions 
allow the DB2 Records Manager server to support Content Manager users and 
user groups, retrieve record contents from Content Manager, delete contents 
from Content Manager, and enforce record life-cycle rules on declared Content 
Manager items.

To install the RME DB2 Records Manager server component, complete the 
following steps: 

1. Stop the DB2 Records Manager Web applications 

– Start the WebSphere administrative console.
– Select Applications → Enterprise Applications.
– Select IBM DB2 Records Manager.
– Select IRMClientEAR.
– Click Stop.

2. Install RME_CommonJava.zip. Unzip RME_CommonJava.zip to the RME 
install folder C:\IBM\RMenabler.

3. Install RME_IRMClient.zip. Unzip the RME_IRMClient.exe to the DB2 
Records Manager server install folder 
C:\IBM\WebSphere\AppServer\installedApps\ilm-rm\IRMClientEAR.ear\IRM
Client.war (replace “ilm-rm” with the host name for your installation).

4. Update the WEB-INF config RME configurations.

Note: You must reregister the SoapHeaderHandler.dll every time you 
reinstall the RME_CommonWin32.zip file on the system.

Note: The RME_CommonJava.zip file contains the Java common code 
and the Records Manager Enabler Host Interface component.
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5. Execute the RMEUpdate.bat utility:

a. Stop the WebSphere Application Server server1.

b. Open a command prompt window and change the directory to 
C:\IBM\WebSphere\AppServer\installedApps\ilm-rm\IRMClientEAR.ear\IR
MClient.war (replace “ilm-rm” with the host name for your installation).

c. Enter the following from the command prompt:

RMEUpdate.bat C:\IBM\WebSphere WEB-INF

Replace “IBM” with the WebSphere parent directory for your installation.

d. Close the command prompt window.

9.9  Summary
We have now installed the Content Management node. Additional configuration 
is necessary, which we provide in Chapter 10, “Configuration” on page 227.

Important: You must run the RMEUpdate.bat utility to update the DB2 
Records Manager struts-config.xml and tiles-def.xml files to support 
Records Manager Enabler enhancements on the DB2 Records Manager 
server. You must run this utility whenever a fix pack is installed on DB2 
Records Manager software.

This utility will update struts-config.xml and tiles-defs.xml which are located 
in WEB-INF directory. Backups of the existing struts-config.xml and 
tiles-defs.xml files will be created as: struts-config.xml.orig and 
tiles-defs.xml.orig.
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Chapter 10. Configuration

This chapter describes the configuration tasks needed after the successful 
installation of all four nodes. These configuration tasks must be done before 
deployment of the application components.

This chapter is organized into the following configuration sections:

� Configure the Portal node:

– Configure IBM Tivoli Directory Server
– Create users in IBM Tivoli Directory Server
– Configure WebSphere Portal for IBM HTTP Server
– Configure WebSphere Portal for IBM Tivoli Directory Server

� Configure the Business Integration node:

– Configure WebSphere Application Server for Directory Server
– Configure business process container on WebSphere Application Server

� Configure the Content Management node:

– Configure DB2 Content Manager for LDAP
– Configure the LDAP User Import Scheduler 
– Configure the DB2 Content Manager RME functions
– Configure the RME Host Interface component

� Configure the Records Management node:

– Configure the RME Host Interface component
– Configure DB2 Records Manager

10
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10.1  Configure the Portal node
Recall that our Portal node includes several software components including IBM 
WebSphere Portal and IBM Tivoli Directory Server.

This section explains how to configure all software components running on the 
Portal node in order to run the sample application described in this book.

10.1.1  Configure IBM Tivoli Directory Server
The steps described in the following sections must be performed to ensure that 
IBM Tivoli Directory Server is configured properly for our environment.

Start the IBM Tivoli Directory Server Configuration Tool
During the first restart of your system after the IBM Tivoli Directory Server 
installation, the IBM Tivoli Directory Server Configuration Tool will be launched 
automatically.

Alternatively, start the Configuration Tool by clicking Start → Programs → IBM 
IBM Tivoli Directory Server V5.2 → Directory Configuration.

Set the administrator DN and password
To set the administrator distinguished name (DN) and password using the IBM 
Tivoli Directory Server Configuration Tool, complete the following steps:

1. Click Administrator DN/password under Choose a task (see Figure 10-1 on 
page 229).

Note: When configuring the Portal node, we referenced the following 
information:

� IBM Redbook Document Management Using WebSphere Portal V5.0.2 
and DB2 Content Manager V8.2, SG24-6349

� IBM WebSphere Portal Extend for Multiplatforms V5.0.2 Information 
Center at:

http://www.ibm.com/websphere/portal/library

� IBM Redbook IBM WebSphere Portal for Multiplatforms V5 Handbook, 
SG24-6098 

� IBM Redbook A Secure Portal Using WebSphere Portal V5 and Tivoli 
Access Manager V4.1, SG24-6077
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2. Enter the Administrator DN and password and click OK:

– Administrator DN: cn=TDSadmin
– Password: <your_password>

3. When prompted with Administrator DN and password successfully 
updated, click OK.

Figure 10-1   Setting the Tivoli Directory Server Administrator DN and password

Create and configure the directory database
To create and configure the IBM Tivoli Directory Server directory database from 
the IBM Tivoli Directory Server Configuration Tool, complete the following steps:

1. Click Configure database under Choose a task.

2. Select Create a new database and then click Next.

3. When the Configure database - User ID page opens, enter the User ID and 
password created in “Create DB2 database owner” on page 129 (for example, 
DB2admin) and then click Next.

4. When the Configure database name page opens, enter the database name to 
be created (for example, ldapdb) and click Next.

5. When the Configure database code page opens, select Create a universal 
DB2 database (UTF-8/UCS-2) and click Next.

6. When the Configure database location opens, select the drive (for example C) 
and click Next.

7. When the Configuration Summary page opens, review selections and click 
Finish.
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8. During the configuration the configuration status will be displayed. Notice that 
a DB2 instance is created with the name of the user designated as the DB2 
owner (for example, DB2admin). 

You should see the following messages if successful:

Configured IBM IBM Tivoli Directory Server Database.
IBM IBM Tivoli Directory Server Configuration complete.

When complete, click Close.

10.1.2  Configure Tivoli Web Administration Tool
For our example, we installed the Web Administration Tool on IBM WebSphere 
Application Server Version 5.0.2, which is capable of being configured for 
WebSphere Application Server security. 

Deploy the Web Administration Tool
To deploy the Web Administration Tool on the WebSphere Application Server 
server1, complete the following steps:

1. Ensure that the WebSphere Application Server server1 is started. If it is not 
started, start server1 by entering the following:

c:\ibm\WebSphere\AppServer\bin\startServer server1

2. Start the WebSphere administrative console by entering the following URL in 
a Web browser:

http://<hostname>:9090/admin

3. Log in to the WebSphere administrative console (for example, admin).

4. Click Applications → Install New Application in the console navigation tree.

5. When the Preparing for the application installation page opens, enter the 
following values (as shown in Figure 10-2 on page 231) and then click Next:

– Path: Local path
– Local path: c:\ibm\ldap\idstools\IDSWebApp.war

This is the full path of the Web Administration Tool application stand-alone 
IDSWebApp.war file.

– Context Root: /IDSWebApp 

Note: The file can be either on the client machine (the machine that 
runs the Web browser) or on the server machine (the machine to which 
the client is connected).
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Figure 10-2   Deploying the Web Administration Tool

6. When the Generate bindings page opens, accepted the default settings and 
click Next.

7. When the Step 1: Provide options to perform the installation page opens, 
accept the default settings and click Next:

– Application Name: IDSWebApp_war (default)

8. When the Step 2: Map virtual hosts for Web modules page opens, enter the 
following and then click Next:

– Virtual Host: default_host (default)
– Web Module: IBM Tivoli Directory Server Web Application v2.0 

9. When the Step 3: Map modules to application servers window opens, accept 
the default and then click Next.

10.When the Step 4: Summary Review installation options page opens, click 
Finish. 

You should see a message similar to the following message:

Application IDSWebApp_war installed successfully.

11.When the configuration update is complete, click the Save to Master 
Configuration link.

12.When the Save to Master Configuration page opens, click Save.

13.Start IBM Tivoli Directory Server:

a. From the Web Administration Tool, click Applications → Enterprise 
Applications. 
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b. From the Enterprise Application page, select IDSWebApp_war and then 
click Start.

14.Log out of the WebSphere administrative console by clicking Logout.

Web Administration Tool configuration
This section describes how to configure the IBM Tivoli Directory Server Web 
Administration Tool.

Define the Directory Server node to the Web Administration Tool
To define Tivoli Directory Server to the Web Administration Tool, complete the 
following steps:

1. Ensure that the WebSphere Application Server server1 is started.

2. Access the Web Administration Tool from a Web browser:

http://localhost:9080/IDSWebApp/IDSjsp/Login.jsp

3. From the Web Administration Tool, enter the following and then click Login:

– LDAP Hostname: Console Admin
– Username: superadmin (default)
– Password: secret (default)

4. Modify the default Console Administration user ID and password:

a. Select Console Administration → Change console administration 
login.

b. When the Change Console administrator logon page opens, enter the 
following and click OK:

• Console administrator login: webadmin 
We created the administrator webadmin, but this could be any name 
you want.

• Current password: <password>
The default is secret.

c. Select Change console administrator password. Enter the current and 
new password. Click OK.

5. Add the Directory Server node.

a. Click Console administration → Manage console servers.

b. Click Add.

c. Enter the Directory Server host name and change the port numbers if not 
using the defaults (for example, ilm-ui.itsc.austin.ibm.com) and click 
OK:

• Hostname: ilm-ui.itsc.austin.ibm.com
• Port: 389
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• Administration port: 3538
• Clear SSL enabled (default).

You should see the new server listed after adding it.

d. Click Logout to log out of the Web Administration Tool.

Verify administration to Tivoli Directory Server
Now that the Web Administration Tool is configured for Tivoli Directory Server, we 
recommend that you verify that it is working properly by connecting to the 
Directory Server:

1. Ensure that the IBM Tivoli Directory Server V5.2 Windows service is started.

2. Access the IBM Tivoli Directory Server Web Administration Tool from a Web 
browser:

http://localhost:9080/IDSWebApp/IDSjsp/Login.jsp

3. From the Web Administration Tool, do the following and then click Login:

– Select the newly created server (for example, 
ilm-ui.itsc.austin.ibm.com) from the list on the Login page. 

– Username: cn=TDSadmin 

– Password: <password>

4. To start IBM Tivoli Directory Server, click Server administration → 
Start/stop/restart server.

5. Click Start (do not select Start/restart in configuration only mode).

You should see the status message: Server started.

Change the password encryption method
We recommend that you change the password encryption method from the 
default imask to SHA or crypt from the Web Administration Tool. The primary 
reason is that imask is a 2-way encoding format, and both SHA and crypt are one 
way.

We configured the password encryption as follows:

1. From the Web Administration Tool, select Server administration → Manage 
security properties.

Note: For first-time users of LDAP (or distinguished naming 
conventions), take note that the user name: For the LDAP login, it must 
include the “cn=” designator. 

For example, the user name listed in this step is not “root”, but rather 
“cn=root”.
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2. From the Manage security properties page, click Password policy.

3. Select SHA from the Password encryption list and then click OK at the bottom 
of the page.

10.1.3  Create users in IBM Tivoli Directory Server
This section describes how to create users and groups for our example 
environment.

The section is organized into the following tasks:

� Create a suffix
� Create LDIF file containing users and groups
� Import the LDIF file to create users and groups

Create a suffix
To create a suffix using the IBM Tivoli Directory Server Configuration Tool, 
complete the following steps on the Portal node where IBM Tivoli Directory 
Server is installed:

1. Stop the IBM Tivoli Directory Server V5.2 Windows NT service.

2. Start the IBM Tivoli Directory Server Configuration Tool by clicking Start →  
Programs → IBM Tivoli Directory Server V5.2 → Directory Configuration.

3. Select Manage suffixes under Choose a task.

4. On the Suffix page, we used dc=com for the Suffix DN for our example and 
then clicked Add.

5. Click OK.

Create LDIF file containing users and groups
Users and groups can be created for the IBM Tivoli Directory Server from the 
Web Administration Tool or by importing a Lightweight Directory Interchange 
Format (LDIF) file containing users and groups. Figure 10-3 on page 236 
displays the main structure of the ilm-itso.ldif file. 

The ilm-itso.ldif file is included in the sample code available for download. It is 
located in the SG246481-Samples\config\ldap directory (see Appendix A, 
“Additional material” on page 367). Example 10-1 on page 236 provides a listing 
of the file. 

As you can see, we created groups of users for various roles used in our example 
scenario (analysts, supervisors, and records administrators). We also created a 
group of administrators (sysadmins) to be used as a common administrator 
account for different servers. We populated each group with at least one user 
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(more users can be added later). Our primary system administrator account will 
be sysadmin1. The user account binduser1 is used for authentication while 
binding WebSphere Application Servers to LDAP.

Note: You can design your own LDAP structure to suit your business needs. In 
that case, we have some recommendations:

� Use attribute cn for your DN name (for example, 
cn=analyst1,cn=users,dc=itso,dc=ibm,dc=com) and not the uid attribute 
(for example, uid=analyst1,cn=users,dc=itso,dc=ibm,dc=com) in order to 
prevent security problems. (This uid attribute causes the failure of remote 
JNDI lookup between two secured WebSphere Application Servers. The 
error message is UNSUPPORTED KEYWORD UID.)

� Include the uid attribute in your schema. This uid attribute is used by 
WebSphere Portal to identify users in listings.
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Figure 10-3   LDAP structure used in our example

Example 10-1   Example LDIF file with LDAP structure (ilm-itso.ldif)

version: 1

# ITSO example: ilm-itso.ldif file

dn: dc=com
objectclass: domain
objectclass: top
dc: com

dn: dc=ibm,dc=com
objectclass: domain
objectclass: top
dc: ibm

dn: dc=itso,dc=ibm,dc=com

dc=itso,dc=ibm,dc=com

cn=users cn=groups

cn=binduser1

cn=sysadmin1

cn=analyst1

cn=analyst2

cn=supervisor1

cn=sysadmins

cn=analysts

cn=supervisors

cn=recordadmin1 cn=recordsadmins
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objectclass: domain
objectclass: top
dc: itso

dn: cn=users,dc=itso,dc=ibm,dc=com
objectclass: container
objectclass: top
cn: users

dn: cn=groups,dc=itso,dc=ibm,dc=com
objectclass: top
objectclass: container
cn: groups

# bind user for ldap

dn: cn=binduser1,cn=users,dc=itso,dc=ibm,dc=com
objectclass: organizationalPerson
objectclass: person
objectclass: top
objectclass: inetOrgPerson
userpassword: password
sn: LDAP Bind In User 1
cn: binduser1
uid: binduser1

# system administrators

dn: cn=sysadmin1,cn=users,dc=itso,dc=ibm,dc=com
objectclass: organizationalPerson
objectclass: person
objectclass: top
objectclass: inetOrgPerson
userpassword: password
sn: System Administrator 1
cn: sysadmin1
uid: sysadmin1

# individual users

dn: cn=analyst1,cn=users,dc=itso,dc=ibm,dc=com
objectclass: organizationalPerson
objectclass: person
objectclass: top
objectclass: inetOrgPerson
userpassword: password
sn: Analyst User 1
cn: analyst1
uid: analyst1
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dn: cn=analyst2,cn=users,dc=itso,dc=ibm,dc=com
uid: analyst2
userpassword: password
objectclass: organizationalPerson
objectclass: person
objectclass: top
objectclass: inetOrgPerson
cn: analyst2
sn: Analyst User 2

dn: cn=supervisor1,cn=users,dc=itso,dc=ibm,dc=com
objectclass: organizationalPerson
objectclass: person
objectclass: top
objectclass: inetOrgPerson
userpassword: password
sn: Supervisory User 1
uid: supervisor1
cn: Supervisor1

dn: cn=recordadmin1,cn=users,dc=itso,dc=ibm,dc=com
uid: sysadmin1
userpassword: password
objectclass: organizationalPerson
objectclass: person
objectclass: top
objectclass: inetOrgPerson
sn: Record Administrator 1
cn: recordadmin1

# user roles

dn: cn=sysadmins,cn=groups,dc=itso,dc=ibm,dc=com
cn: sysadmins
objectclass: groupOfUniqueNames
objectclass: top
uniquemember: cn=sysadmin1,cn=users,dc=itso,dc=ibm,dc=com

dn: cn=analysts,cn=groups,dc=itso,dc=ibm,dc=com
cn: analysts
objectclass: groupOfUniqueNames
objectclass: top
uniquemember: cn=analyst1,cn=users,dc=itso,dc=ibm,dc=com
uniquemember: cn=analyst2,cn=users,dc=itso,dc=ibm,dc=com

dn: cn=supervisors,cn=groups,dc=itso,dc=ibm,dc=com
cn: supervisors
objectclass: groupOfUniqueNames
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objectclass: top
uniquemember: cn=supervisor1,cn=users,dc=itso,dc=ibm,dc=com

dn: cn=recordadmins,cn=groups,dc=itso,dc=ibm,dc=com
objectclass: groupOfUniqueNames
objectclass: top
cn: recordadmins
uniquemember: cn=recordadmin1,cn=users,dc=itso,dc=ibm,dc=com

Import the LDIF file to create users and groups
To import the ilm-itso.ldif file to create users and groups to IBM Tivoli Directory 
Server, complete the following steps on the Portal node:

1. Stop the IBM Tivoli Directory Server V5.2 Windows NT service.

2. Copy the provided \config\ldap\ilm-itso.ldif file to a temporary directory on the 
Portal node, for example, c:\install\ldap\config.

3. Start the IBM Tivoli Directory Server Configuration Tool by clicking Start → 
Programs → IBM Tivoli Directory Server V5.2 → Directory Configuration.

4. Select Import LDIF data.

5. When the Import LDIF Data page opens, we used the following values:

– Path and LDIF file name: c:\install\ldap\config\ilm-itso.ldif
– Select Standard import.

Click Import (bottom of page).

After the import has finished successfully, a message will be displayed 
reporting how many entries have been imported into the Directory Server. 

6. When the import is complete, click Close and close the Configuration Tool.

7. Restart the IBM Tivoli Directory Server V5.2 Windows NT service.

8. Verify that the LDAP entries were created properly by performing an LDAP 
search. For example, we entered the following from a command window on 
the Directory Server node:

ldapsearch -h ilm-ui.itsc.austin.ibm.com -b dc=itso,dc=ibm,dc=com -D 
cn=sysadmin1,cn=users,dc=itso,dc=ibm,dc=com -w <password>

Where ilm-ui.itsc.austin.ibm.com is the Portal node where IBM Tivoli 
Directory Server is installed and <password> is password that you entered for 
the sysadmin1 user in the ilm-itso.ldif file.
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10.1.4  Configure WebSphere Portal for IBM HTTP Server
We now reconfigure WebSphere Portal to use an external Web server instead of 
the internal HTTP service of WebSphere Application Server. For our example, 
we use IBM HTTP Server as our external Web server.

To configure an external IBM HTTP Server for WebSphere Portal in place of the 
WebSphere Application Server internal HTTP service, complete the following 
steps:

1. Verify that IBM HTTP Server is started.

2. Stop the WebSphere_Portal application server.

3. Navigate to the c:\IBM\WebSphere\PortalServer\config directory.

4. Back up the WebSphere Portal configuration properties found in the 
wpconfig.properties file by entering the following command:

wpsconfig backup-main-cfg-file

5. Change the wpconfig.properties values as shown in Table 10-1.

Table 10-1   The wpconfig.properties values for external Web server in Portal server

6. Save the updated wpconfig.properties file.

7. Enter the following command to configure WebSphere Portal for the external 
Web server:

wpsconfig httpserver-config

8. The next step is to increase the Post Size Limit. This property limits the 
amount of data that can be uploaded in a single POST operation. One of the 
portlets of our sample application has large libraries included and therefore is 
bigger then the allowed 10 MB limit. In order to deploy this portlet, we can 
either upload the portlet to the Portal node manually, or increase this Post 
Size Limit. 

Open the plugin-cfg.xml file for editing. The file is located at 
c:\IBM\WebSphere\AppServer\config\cells\plugin-cfg.xml.

Note: For a detailed description of each of the keywords, refer to the IBM 
WebSphere Portal Information Center and search “Configuring your Web 
server.”

Section in 
wpconfig.properties file

Keyword Our example value

WebSphere Application 
Server

WpsHostName ilm-ui.itsc.austin.ibm.com

WpsHostPort 80
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Look for the node 
/Config/ServerCluster[@name=WebSphere_Portal_ilm-ui_Cluster"] and 
change the property PostSizeLimit from 10000000 to 20000000. Then, save the 
file.

9. Restart IBM HTTP Server.

10.From a command prompt, issue the following commands to restart the 
WebSphere Portal server:

c:\IBM\WebSphere\AppServer\bin\stopServer WebSphere_Portal
c:\IBM\WebSphere\AppServer\bin\startServer WebSphere_Portal

11.Verify that WebSphere Portal works properly with the external Web server. 
You should be able to browse your WebSphere Portal server using the 
external Web server host name:

http://ilm-ui.itso.austin.ibm.com/wps/portal

10.1.5  Configure WebSphere Portal for IBM Tivoli Directory Server
This section describes how to enable LDAP security for WebSphere Portal and 
how to verify it. The configured IBM Tivoli Directory Server is needed for this 
activity. In addition, ensure that you created the LDAP user structure, as 
described in 10.1.3, “Create users in IBM Tivoli Directory Server” on page 234.

Note: This change will get lost if you regenerate this plugin-cfg.xml file in 
the future. If you need to upload large portlets after the regeneration of the 
file, you will have to manually change this value again.

Note: Prior to adding the external Web server, you need to include the port 
number 9081 for the internal HTTP port the WebSphere Portal server was 
using in the URL, for example:

http://ilm-ui.itso.austin.ibm.com:9081/wps/portal

Now that we have configured the external Web server, we do not need to 
specify the port (it will use the default port 80) in the URL:

http://ilm-ui.itso.austin.ibm.com/wps/portal
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Configure WebSphere Portal for security with LDAP
On the Portal node, there are preconfigured templates that can be customized to 
configure WebSphere Portal for LDAP. Complete the following steps:

1. From a command prompt, navigate to the 
c:\IBM\WebSphere\PortalServer\config directory:

cd c:\IBM\WebSphere\PortalServer\config

2. Back up the WebSphere Portal configuration properties found in the 
wpconfig.properties file by entering the following command:

wpsconfig backup-main-cfg-file

3. Change the wpconfig.properties values as shown in Table 10-2. A brief 
description of the individual values in the table follows.

Table 10-2   Example wpconfig.properties values for LDAP security

Note: For a detailed description of the wpconfig.properties values for the 
LDAP security configuration with WebSphere Portal, refer to the 
Information Center and search “Configuring WebSphere Portal for IBM 
Directory Server.”

Tip: The helper configuration files found in the ../config/helpers directory 
can be used to automate the update of the wpconfig.properties file on 
multiple systems. We used the security_ibm_dir_server.properties helper 
file to update the wpconfig.properties file. The helper files include 
comments that are self-documenting.

Section in 
wpconfig.properties file

Keyword Our example value

WebSphere Application 
Server Properties

WasUserId cn=sysadmin1,cn=users,d
c=itso,dc=ibm,dc=com

WasPassword <password>

Portal Configuration 
Properties

PortalAdminId cn=sysadmin1,cn=users,d
c=itso,dc=ibm,dc=com

PortalAdminIdShort sysadmin1

PortalAdminPwd <password>

PortalAdminGroupId cn=sysadmins,cn=groups,
dc=itso,dc=ibm,dc=com

PortalAdminGroupIdShort sysadmins
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WebSphere Portal 
Security LTPA and SSO 
Configuration

LTPAPassword <password>

LTPATimeout 120

SSODomainName itsc.austin.ibm.com

LDAP Properties 
Configuration

Lookaside false

LDAPHostName ilm-ui.itsc.austin.ibm.
com

LDAPPort 389

LDAPAdminUId cn=TDSadmin

LDAPAdminPwd <password>

LDAPServerType IBM_DIRECTORY_SERVER

LDAPBindID cn=sysadmin1,cn=users,d
c=itso,dc=ibm,dc=com

LDAPBindPassword <password>

Advanced LDAP 
Configuration

LDAPSuffix dc=itsc,dc=ibm,dc=com

LdapUserPrefix cn

LDAPUserSuffix cn=users

LdapGroupPrefix cn

LDAPGroupSuffix cn=groups

LDAPUserObjectClass inetOrgPerson

LDAPGroupObjectClass groupOfUniqueNames

LDAPGroupMember uniqueMember

LDAPUserFilter (&(cn=%v)(objectclass=i
netOrgPerson))

LDAPGroupFilter (&(cn=%v)(objectclass=g
roupOfUniqueNames))

LDAPsslEnabled false

Section in 
wpconfig.properties file

Keyword Our example value 
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Here, we describe the wpconfig.properties values listed in Table 10-2 on 
page 242:

WasUserId The user ID for WebSphere Application 
Server security authentication. This should 
be the fully qualified distinguished name 
(DN) and not contain any spaces. Because 
we have not set the WebSphere Application 
Server security on yet, you can choose any 
user from your LDAP directory. This user will 
become the system administrator for 
WebSphere Application Server after 
finishing these steps. 

WasPassword Password for the user account, as defined in 
the WasUserId property.

PortalAdminId The user ID for WebSphere Portal security 
authentication. This should be the fully 
qualified distinguished name (DN) 
containing no spaces.

PortalAdminIdShort The short form of the user ID for the 
WebSphere Portal administrator, as defined 
in the PortalAdminId property.

PortalAdminPwd Password for the user account as defined in 
the PortalAdminId property.

PortalAdminGroupId The group ID for the group to which the 
WebSphere Portal administrator belongs. 
This should be the fully qualified 
distinguished name (DN) containing no 
spaces.

PortalAdminGroupIdShort The short form of the group ID for the 
WebSphere Portal administrator, as defined 
in the PortalAdminGroupId property.

LTPAPassword The password for the LTPA bind. LTPA 
password is a password used to encrypt and 
decrypt the LTPA keys. You can choose any 
password you want; this password is defined 
here and is not related to any user.

LTPATimeout This sets the time out for the LTPA bind.

 

 

 

 

244 Records Management and Process Choreography



SSODomainName Single Sign-On domain, for example, 
SSODomainName=yourcompany.com. This 
property is needed for the WebSphere 
Application Server ability to perform single 
sign-on. Entering an incomplete or 
misspelled domain here might result in 
strange behavior of WebSphere Application 
Server.

Lookaside The purpose of a Lookaside database is to 
store attributes that cannot be stored in your 
LDAP server. We are not going to use this 
kind of database in our sample.

LDAPHostName The host name of the LDAP server that 
WebSphere Portal will use. If following our 
scenario, this is the host name of the Portal 
node, because our IBM Tivoli Directory 
Server resides on the Portal node.

LDAPPort The port number for the LDAP server. 
Default ports are 389 for non-SSL 
communication and 636 for SSL 
communication.

LDAPAdminUId The LDAP access ID, for example, 
LDAPAdminUId=cn=root. This is the ID that 
WebSphere Portal (Member Manager) will 
use to access the LDAP directory. This does 
not have to be the root admin ID for the 
directory, simply an ID that has sufficient 
privileges to the directory to allow the 
operations that WebSphere Portal will 
perform. In our sample, we used the admin 
user ID of our IBM Tivoli Directory Server 
installation, which is cn=TDSadmin.

LDAPAdminPwd Password for the user account, as defined in 
the LDAPAdminUId property.

LDAPServerType Type of LDAP server to be used.

LDAPBindID User ID for LDAP bind authentication. This is 
any user in LDAP directory. In our scenario, 
we created a special user account for this 
role: binduser1.

LDAPBindPassword Password for the user account, as defined in 
the LDAPBindID property.
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LDAPUserFilter User filter used for user authentication. 
Simply said, it specifies which entries in the 
LDAP directory structure are considered 
user entries.

LDAPGroupFilter Group filter used for user authentication. 
Similar to LDAPUserFilter.

LDAPSuffix LDAP suffix of your directory structure. This 
is the part specifying your organization, for 
example, dc=yourdomain,dc=com. Together 
with LDAPUserPrefix and LDAPUserSuffix, 
this specifies the fully qualified user DN 
name. These make it possible for users to 
enter only their user name in a login form 
instead of having to specify the complete DN 
name.

LDAPUserPrefix DN name prefix of the user directory entry. 
This is usually the user attribute, which is 
unique for each user. In our case it is cn=. 
See the LDAPSuffix description.

LDAPUserSuffix Part of the DN name immediately following 
the user name attribute, for example, 
cn=users. See the LDAPSuffix description.

LDAPGroupPrefix See the LDAPUserPrefix description.

LDAPGroupSuffix See the LDAPUserSufix description.

LDAPUserObjectClass User object class representing a user 
directory entry.

LDAPGroupObjectClass Group object class representing a group 
directory entry.

LDAPGroupMember This specifies the attribute name specifying 
the user entries that are members a given 
group.

LDAPsslEnabled True if SSL is used for communication 
between WebSphere Portal and the LDAP 
server. We highly recommend that you use 
the SSL in a production environment, but in 
our sample, we do not use the SSL 
communication.

4. Save the updated wpconfig.properties file.
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5. Issue the following commands:

c:\IBM\WebSphere\AppServer\bin\startServer server1
c:\IBM\WebSphere\AppServer\bin\stopServer WebSphere_Portal

6. Change to the c:\IBM\WebSphere\PortalServer\config directory and enter the 
following command:

WPSconfig.bat validate-ldap

If an error occurs, review the values in wpconfig.properties (typographical 
errors are quite often the cause of an error on this step) and the settings in the 
LDAP server. Also, ensure that the LDAP server is running.

7. If the validation was successful, enable security by issuing the following 
command:

WPSconfig.bat enable-security-ldap

If the task completes successfully, you will see the message BUILD 
SUCCESSFUL. 

8. Issue the following commands:

c:\IBM\WebSphere\AppServer\bin\stopServer server1 -user sysadmin1 -password 
<password>

Where sysadmin1 is the WebSphere Administrator user ID and <password> is 
the password for this user ID.

Note: If you are not using an external HTTP server, you will want to set the 
WpsHostName property in the wpconfig.properties file. For example:

WpsHostName=ilm-ui.itsc.austin.ibm.com

Note: After WebSphere security is enabled, you will need to specify the 
user sysadmin1 and <password> as parameters for the stopServer com-
mand:

stopServer server1 -user sysadmin1 -password <password>

On a development system, you can add the user ID and password values 
to the soap.client.props file to eliminate keystrokes. Modify the following in 
the c:\IBM\Websphere\AppServer\properties\soap.client.props file:

com.ibm.SOAP.loginUserid=system1
com.ibm.SOAP.loginPassword=<password>

After making this modification, you do not need to supply the user ID and 
password:

stopServer server1
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9. Start the servers by entering the following:

c:\IBM\WebSphere\AppServer\bin\startServer server1
c:\IBM\WebSphere\AppServer\bin\startServer WebSphere_Portal -user sysadmin1 
-password <password>

Verify the LDAP configuration
To verify the WebSphere Portal and LDAP configuration, complete the following 
steps:

1. Verify that WebSphere security is working properly by starting the 
WebSphere administrative console and logging in as user ID sysadmin1. 
WebSphere security in this case provides the authentication. If security was 
not working, you would not be able to log in with the sysadmin1 user ID.

http://ilm-ui.itsc.austin.ibm.com:9090/admin

Note that you will be redirected to the secured connection prior to login 
(https://ilm-ui.itsc.austin.ibm.com:9043/admin/logon.jsp).

2. Verify that WebSphere Portal works properly with the LDAP configuration and 
WebSphere security by logging in to WebSphere Portal and browsing its 
pages. Go to the WebSphere Portal site (remember to use the fully qualified 
host name):

http://ilm-ui.itsc.austin.ibm.com/wps/portal

Click Log in at the top-right corner (for example, we used the sysadmin1 user 
ID and <password>).

Enable identity assertion
To enable secure communication with IBM WebSphere Business Integration 
Server Foundation installed on the Business Integration node, you need to 
enable identity assertion in WebSphere Application Server on the Portal node.

To enable identity assertion, complete the following steps (Figure 10-4):

Important: Using localhost or just the host name for accessing 
WebSphere Application Server or WebSphere Portal might cause 
problems after configuring LDAP security. Always use the fully qualified 
host name for browsing.

Note: Sometimes trying to log in to WebSphere Portal from a window that 
has been used to log in to the WebSphere administrative console results in 
erroneous behavior. We recommend that you open new a browser window 
for the WebSphere Portal login.
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1. Log in to the WebSphere administrative console with the sysadmin1 user ID:

https://ilm-ui.itsc.austin.ibm.com:9043/admin

2. Go to the CSI Authentication → Outbound page by selecting Security → 
Authentication Protocol → CSIv2 Outbound Authentication.

3. Select Supported for the Basic Authentication property and select the 
Identity Assertion property.

4. Log out from the WebSphere administrative console.

Figure 10-4   Setting identity assertion
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Configure access to additional configuration files
In our applications, which we will deploy later, we use specific configuration files. 
We decided to store these files in the WebSphere Application Server directory. 
Because we have Java 2 security on, we need to specify the access rights to this 
directory:

1. Create the directory:

C:\IBM\WebSphere\AppServer\config\optionalConfigs

2. Open the security policy file for editing:

C:\IBM\WebSphere\AppServer\config\cells\ilm-ui\nodes\ilm-ui\app.policy

3. In the grant codeBase "file:${application}" section add the following line 
(the line has been broken into two lines below, you should enter it as one line):

permission java.io.FilePermission 
"${was.install.root}${/}config${/}optionalConfigs${/}-", "read";

4. Save the app.policy file.

Restart the WebSphere Application Servers
Restart the WebSphere Application Servers server1 and WebSphere_Portal in 
order to pick up the changes. 

Restart WebSphere Portal server and WebSphere Application Server server1 by 
issuing the following in a command window:

cd c:\IBM\WebSphere\AppServer\bin
stopServer server1 -user sysadmin1 -password password
stopServer WebSphere_Portal -user sysadmin1 -password <password>
startServer server1
startServer WebSphere_Portal -user sysadmin1 -password <password>

10.2  Configure the Business Integration node
This section explains how to configure all software components running on the 
Business Integration node in order to run the sample application described in this 
book.
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10.2.1  Configure WebSphere Application Server for Directory Server

This section describes the steps needed to turn on WebSphere security. We use 
the same IBM Tivoli Directory Server as we used to configure WebSphere Portal. 
This implies that we use the same users as described in the 10.1.3, “Create 
users in IBM Tivoli Directory Server” on page 234.

To set WebSphere security with IBM Tivoli Directory Server, complete the 
following steps:

1. In your Web browser, go to the WebSphere administrative console login page 
at:

http://ilm-bi.itsc.austin.ibm.com:9090/admin

2. Do not fill in any user name (security is off) and click OK. The WebSphere 
administrative console opens.

3. Go to the LDAP User Registry window by clicking Security → User 
Registries → LDAP.

4. In the LDAP User Registry window, fill in the following values.

For your server user ID, you can use any user account from our LDAP user 
structure. In our sample, we chose the sysadmin1 user. The user has to be 
specified with the fully qualified DN name. Unless you did not change the 
sysadmin1 password, enter the password specified in the LDIF file:

– Server User ID: cn=sysadmin1,cn=users,dc=itso,dc=ibm,dc=com
– Server User Password: <password>

Note: When configuring the Business Integration node, we referenced the 
following information:

� WebSphere Application Server Version 5.1.x Information Center, available 
at:
http://publib.boulder.ibm.com/infocenter/ws51help/index.jsp

� IBM WebSphere Business Integration Server Foundation, Version 5.1: 
Process Choreographer, IBM Information Center Library, available at:

ftp://ftp.software.ibm.com/software/webserver/appserv/library/ee_v512ptf_
twork.pdf

� The IBM Redbook IBM WebSphere V5.0 Security, WebSphere Handbook 
Series, SG24-6573, available at:

http://www.redbooks.ibm.com/pubs/pdfs/redbooks/sg246573.pdf
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Enter the LDAP server, which is IBM Tivoli Directory Server installed on the 
Portal node:

– Type: IBM_Directory_Server
– Host: ilm-ui.itsc.austin.ibm.com
– Port: 389

– Base Distinguished Name (DN): dc=itso,dc=ibm,dc=com
For the base distinguished name (DN), enter the LDAP suffix, matching 
your organization structure, for example, dc=itso,dc=com.

Next, enter the user ID for the LDAP bind authentication. This can be any user 
in the LDAP directory. In our scenario, we created a special user account for 
this role: binduser1.

– Bind Distinguished Name (DN): 
cn=binduser1,cn=users,dc=itso,dc=ibm,dc=com

– Bind Password: <password>
– Select Ignore Case.

The Ignore Case property is required by the LDAP configuration.

For simplicity reasons, we do not use the SSL communication to access the 
LDAP server in our example. Note that in a production environment, we highly 
recommend that you use the SSL communication.

– Do not select SSL Enabled.

You can leave the other values with the default values. Click Apply.

See Figure 10-5 on page 253.
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Figure 10-5   LDAP server configuration

5. Go to the Advanced LDAP Settings page by clicking Security → User 
Registries → LDAP → Advanced LDAP Settings.

6. Values specified on the Advanced LDAP Settings page narrow the number of 
LDAP objects considered to be a user or group entry. They also enable 
WebSphere Application Server to allow users to log in without specifying the 
fully qualified DN name. Based on the LDIF file we used to import the users, 
enter the following values:

– User Filter: (&(cn=%v)(objectclass=inetOrgPerson))
– Group Filter: (&(cn=%v)(objectclass=groupOfUniqueNames))
– User ID Map: *:cn
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– Group ID Map: *:cn
– Group Member ID Map: 

ibm-allGroups:member;ibm-allGroups:uniqueMember

You can leave the other values with the default values. Click OK.

See Figure 10-6.

Figure 10-6   Advanced LDAP configuration

Note: In the WebSphere administrative console if you click Apply and later 
click OK, your values will be overwritten by the old ones. To be sure that 
your values were not overwritten, come to this section again after you save 
changes to the master configuration and check the values.
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7. Save the changes to the master configuration by clicking the Save link at the 
top of the page and then by clicking the Save button at the bottom of the 
page.

8. Go to the LTPA page by clicking Security → Authentication Mechanisms → 
LTPA.

9. Enter the LTPA password. The LTPA password is a password used to encrypt 
and decrypt the LTPA keys. You can choose any password you want; this 
password is defined here and is not related to any user. Click Apply.

10.Go to the Single Signon (SSO) page by clicking Security → Authentication 
Mechanisms → LTPA → Single Signon (SSO).

11.On the Single Signon (SSO) page, enable the single signon and specify the 
domain name:

– Select Enabled
– Domain Name: itsc.austin.ibm.com

Click OK.

12.Go to the CSIv2 Inbound Authentication page by clicking Security → 
Authentication Protocol → CSIv2 Inbound Authentication.

13.We need to set up the identity assertion. This will allow WebSphere 
Application Servers to pass the user authentication tokens between each 
other. This is needed to invoke the EJB methods residing on this server from 
remote servers. We need to set up the following:

– Basic Authentication: Supported
– Client Certificate Authentication: Supported
– Select Identity Assertion.
– Trusted Servers: *
– Select Stateful.
– Clear Security Attribute Propagation.

Then click OK.

14.Save the changes to the master configuration by clicking the Save link at the 
top of the page and then by clicking the Save button at the bottom of the 
page.

Note: From this point on, you will need to enter a fully qualified DNS name 
for your URLs. For example, instead of invoking the WebSphere 
administrative console by typing http://ilm-bi:9090/admin or 
http://localhost:9090/admin, you will have to enter 
http://ilm-bi.itsc.austin.ibm.com:9090/admin. Not entering the fully 
qualified DNS name might result in strange application behavior and 
various errors.
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15.Go to the Global Security page by clicking Security → Global Security.

16.So far, we have prepared all the settings. The last step is to turn on 
WebSphere security. We turn this on in the Global Security page by selecting 
the following values:

– Select Enabled.
– Select Enforce Java 2 Security.
– Active Protocol: CSI and SAS
– Active Authentication Mechanism: LTPA
– Active User Registry: LDAP

Click OK. You should be presented with a list of informational messages and 
warnings at the top of the page. If there are any errors, fix these errors before 
proceeding to next steps. For problem resolution, refer to the IBM Redbook: 
IBM WebSphere V5.0 Security: WebSphere Handbook Series, SG24-6573.

17.Save the changes to the master configuration by clicking the Save link at the 
top of the page and then by clicking the Save button at the bottom of the 
page.

18.Log out from the WebSphere administrative console.

19.From a command prompt, restart the WebSphere Application Server server1 
by entering the following commands:

c:\IBM\WebSphere\AppServer\bin\stopServer server1
c:\IBM\WebSphere\AppServer\bin\startServer server1

20.Check the WebSphere Application Server log file for possible errors at 
c:\IBM\WebSphere\AppServer\logs\server1\SystemOut.log.

If there are no errors, you should see the following message at the end of file:

Server server1 open for e-business

Note: After WebSphere security is enabled, you need to specify the user 
sysadmin1 and password as parameters for the stopServer command. 

stopServer server1 -user sysadmin1 -password <password>

On a development system, you can add the user ID and password values 
to the soap.client.props file to eliminate keystrokes. Modify the following in 
the c:\IBM\WebSphere\AppServer\properties\soap.client.props file:

com.ibm.SOAP.loginUserid=sysadmin1
com.ibm.SOAP.loginPassword=password

After making this modification, you will not need to supply the user ID and 
password.

stopServer server1
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21.Verify the installation by logging in to the WebSphere administrative console 
by using the following URL address: 

http://ilm-bi.itsc.austin.ibm.com:9090/admin 

Note that you have to enter the full DNS name. You will be redirected to the 
secure connection. Or, you can directly enter the secured URL:

https://ilm-bi.itsc.austin.ibm.com:9043/admin

22.Log in with your server user ID and password (for example, with the 
sysadmin1 user ID in our example).

10.2.2  Configure business process container on WebSphere 
Application Server

We have not yet configured the business process container that is required to run 
business processes (process choreography). This container is installed as a part 
of IBM WebSphere Business Integration Server Foundation, but it has to be 
configured separately.

This section describes the following high-level tasks:

� Create an IBM Cloudscape database for the business process container
� Configure the business process container
� Configure embedded messaging resources with Java 2 security
� Configure access to additional configuration files
� Restart the WebSphere Application Server server1

Create an IBM Cloudscape database for the business process 
container

The business process container requires a database. This section describes how 
to create the database for the process choreographer.

In our scenario, we use the IBM Cloudscape™ database that is bundled with the 
IBM WebSphere Business Integration Server Foundation V5.1.1 product. The 
Cloudscape version that comes with this product includes the Cloudscape 
Network Server that enables client/server JDBC access over Distributed 

Note: If you have problems logging in with your plain user ID, you might try to 
log in using the fully qualified name 
(cn=sysadmin1,cn=users,dc=itso,dc=ibm,dc=com, for example) and check the 
LDAP User Registry and Advanced LDAP Settings pages.

Refer to IBM WebSphere V5.0 Security: WebSphere Handbook Series, 
SG24-6573 for details.

 

 

 

 

 Chapter 10. Configuration 257



Relational Database Architecture™ (DRDA®) protocol. Because Cloudscape 
Network Server has no Extended Architecture (XA) support, the process 
choreographer can only use the embedded Cloudscape version that cannot be 
accessed remotely.

To create a Cloudscape database named BPEDB, complete the following steps:

1. Because we did not install IBM WebSphere Business Integration Server 
Foundation to its default location in the Program Files folder, edit the 
createDatabaseCloudscape.ddl script located at c:\IBM\WebSphere\
AppServer\ProcessChoreographer\createDatabaseCloudscape.ddl.

Change the line nr.17: 

connect ’BPEDB;create=true’ as BPEDB; 

To: 

connect 
’c:\IBM\WebSphere\AppServer\ProcessChoreographer\BPEDB;create=true’ as 
BPEDB

2. From a command prompt, enter the command to run the database creation 
script using the Cloudscape command line processor:

C:\IBM\WebSphere\AppServer\java\jre\bin\java
-Djava.ext.dirs=C:\IBM\WebSphere\AppServer\cloudscape\lib 
-Dij.protocol=jdbc:db2j: 
com.ibm.db2j.tools.ij 
C:\IBM\WebSphere\AppServer\ProcessChoreographer\createDatabaseCloudscape
.ddl 

The Cloudscape database BPEDB for process choreographer should be 
created.

Configure the business process container
You must configure the necessary resources and install the business process 
container before you can use it. This section describes how to do so using the 
installation wizard: 

1. In your Web browser, go to the WebSphere administrative console login page 
at:

https://ilm-bi.itsc.austin.ibm.com:9043/admin

Note: If you do not use the default location, 
install_root\ProcessChoreographer\BPEDB, you must also remember to 
change the custom properties field when selecting the database. You will 
have to change the value of the property databaseName to your fully 
qualified database location.
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2. Log in with your server user ID and password (the sysadmin1 user ID in our 
example).

3. Go to the server1 configuration page by clicking Servers → Application 
Servers → server1.

4. In the Additional Properties section, click Business Process Container.

5. Scroll down past the Business Process Container settings. Near the bottom of 
the page, click the Business Process Container Install Wizard link.

Figure 10-7   Selecting the Business Process Container Install Wizard

Note: The settings provided in the following steps are the recommended 
settings for our example. For a further explanation of the properties 
mentioned in these steps, see IBM WebSphere Business Integration 
Server Foundation, Version 5.1: Process Choreographer, IBM Information 
Center Library, available at:

ftp://ftp.software.ibm.com/software/webserver/appserv/library/ee_v512p
tf_twork.pdf

 

 

 

 

 Chapter 10. Configuration 259

ftp://ftp.software.ibm.com/software/webserver/appserv/library/ee_v512ptf_twork.pdf
ftp://ftp.software.ibm.com/software/webserver/appserv/library/ee_v512ptf_twork.pdf


6. In the “Step 1: Select the Database Configuration for the business process 
container” page, select or enter the following:

– JDBC Providers: Cloudscape 5.1 (Cloudscape JDBC Provider (XA))
– Implementation class name: com.ibm.db2j.jdbc.DB2jXADataSource
– Classpath: ${CLOUDSCAPE_JDBC_DRIVER_PATH}/db2j.jar
– Datasource User Name: Empty
– Datasource Password: Empty
– Custom Properties: Leave to default

Click Next.

7. In “Step 2: Select JMS Provider and Security,” select or enter the following:

– JMS Providers: Websphere JMS Provider
– Queue Manager: Empty
– Classpath: Empty
– JMS User ID: sysadmin1
– JMS Password: <password>
– Scheduler Calendar: Empty
– Security Role Mapping: cn=sysadmins,cn=groups,dc=itso,dc=ibm,dc=com
– JMS API User ID: cn=sysadmin1,cn=users,dc=itso,dc=ibm,dc=com
– JMS API Password: <password>

Click Next.

8. In “Step 3: Select JMS Resources and Web Client,” select or enter the 
following:

– Select Create new JMS resources using default values.
– Select Install the Process Choreographer Web Client.

Click Next.

9. In “Step 4: Summary,” review the settings and click Finish.

Important: You cannot change these fields after they have been applied. If 
you want to change any of these values after the container is configured, 
you must uninstall and reinstall the BPEContainer.ear enterprise 
application file. This action can result in the loss of data, such as pending 
messages in queues, process templates, and process instances in the 
process choreographer database.

Note: The summary includes reminders of which external resources are 
necessary. If you have not already created them, you can continue 
configuring the business process container, but you must create the 
resources before you activate the business process container.
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10.The progress will be shown on the Installing page:

– If the container did not install successfully, check for any error messages 
that can help you correct the problem, and then repeat this task from step 
1. 

– If the container was installed successfully, click Save Master 
Configuration, and then click the Save button.

11.Do not restart the server at this moment, because the business process 
container installation wizard did not set properly the Java 2 security properties 
for the newly created resources. The restart would, therefore, throw a large 
number of security-related exceptions. We fix these properties in the following 
section.

Configure embedded messaging resources with Java 2 
security

This section describe how to set additional Java 2 security properties for the 
resources created by the business process container installation wizard in the 
previous section.

To set these properties, complete the following steps:

1. We need to create a JAAS entry to authenticate to the various resources. We 
use our system administrator sysadmin1 user for this purpose. Go to the J2C 
Authentication Data Entries page by selecting Security → JAAS 
Configuration → J2C Authentication Data and clicking New.

2. Fill in the following values:

– Alias: SysAdminID
– User ID: sysadmin1
– Password: <password>

Click OK. Figure 10-8 on page 262 shows the panel after creation.
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Figure 10-8   J2C Authentication Data Entries page

3. The next step is to use this JAAS entry to authenticate JMS connection 
factories. Go to the WebSphere JMS Provider page by selecting 
Resources → WebSphere JMS Provider.

4. Select Server scope at the top of the page and click Apply.

5. Click WebSphere Queue Connection Factories at the bottom of the page.

6. Click the BPECF link. The property page for the BPECF Queue Connection 
Factory opens.

7. For the “Component-managed Authentication Alias” property, select the 
ilm-bi/SysAdminID alias from the list. 

8. Select the same ilm-bi/SysAdminID alias for the “Container-managed 
Authentication Alias” property. 

9. Click OK.

10.Click BPECFC and repeat steps 7 through 9.

11.Log out of the WebSphere administrative console.

Configure access to additional configuration files
In our application, we use specific configuration files. We decided to store these 
files in the WebSphere Application Server directory. Because we have Java 2 
security on, we need to specify the access rights to this directory:

1. Create the directory:

C:\IBM\WebSphere\AppServer\config\optionalConfigs
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2. Open the security policy file for editing:

C:\IBM\WebSphere\AppServer\config\cells\ilm-bi\nodes\ilm-bi\app.policy

3. In the grant codeBase "file:${application}" section, add the following line 
(the line is broken into two lines to fit here; however, you should enter it as one 
line):

permission java.io.FilePermission 
"${was.install.root}${/}config${/}optionalConfigs${/}-", "read";

4. Save the app.policy file.

Restart the WebSphere Application Server server1
Restart the WebSphere Application Server server1 in order to pick up the 
changes:

1. From a command prompt, restart the WebSphere Application Server server1 
by entering the following commands:

c:\IBM\WebSphere\AppServer\bin\stopServer server1 -user sysadmin1 -password 
<password>
c:\IBM\WebSphere\AppServer\bin\startServer server1

2. Check the WebSphere Application Server log file for possible errors at 
c:\IBM\WebSphere\AppServer\logs\server1\SystemOut.log.

If there are no errors, you should see following message at the end of file:

Server server1 open for e-business

10.3  Configure the Content Management node
The following sections describe various configuration tasks for Content 
Management node that must be performed.

10.3.1  Configure DB2 Content Manager for LDAP
This section describes how to configure IBM DB2 Content Manager with LDAP 
using IBM Tivoli Directory Server. In addition, we included configuration tasks for 
enabling trusted logon between WebSphere Portal and DB2 Content Manager 
for single sign-on.

IBM DB2 Content Manager can be configured to use an LDAP directory for user 
authentication. DB2 Content Manager can be enabled for LDAP during the 
installation of DB2 Content Manager or after the installation, as described in this 
section.
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DB2 Content Manager includes support for LDAP user authentication. In 
addition, DB2 Content Manager includes an LDAP utility used to import and 
synchronize users between DB2 Content Manager and LDAP. 

The following directory servers are supported by DB2 Content Manager:

� IBM Tivoli Directory Server
We used the IBM Tivoli Directory Server V5.2 for our example.

� IBM Lotus Domino® Directory

� Microsoft Active Directory

High-level steps
The high-level steps to configure DB2 Content Manager for LDAP are as follows:

1. Prerequisite software for LDAP user authentication
2. Back up the DB2 Content Manager databases
3. Generate the cmbcmenv.properties file
4. Copy the cmbcmenv.properties file
5. Copy the icmxlslg.dll(user exit)
6. Enable trusted logons for the library server
7. Create the ClientUserEditSSO privilege set
8. Set the UserDB2TrustedConnect privilege set for the CMconnect user
9. Configure the LDAP User Import Scheduler
10.Verify the DB2 Content Manager LDAP configuration

Prerequisite software for LDAP user authentication
Prior to configuring DB2 Content Manager for LDAP, ensure that the following 
prerequisite software components are installed:

� Directory Server node

– IBM GSKit V7.0.1.16 
– IBM Tivoli Directory Server V5.2 

Note: For more information about configuring DB2 Content Manager for LDAP, 
refer to the following product guides:

� IBM Content Manager for Multiplatforms: Planning and Installing Your 
Content Management System Version 8 Release 2, GC27-1332-02

� IBM DB2 Content Manager for Multiplatforms: System Administration 
Guide Version 8 Release 2, SC27-1335-04

Note: If following procedures in this book, the installation of these 
components is included in the implementation of the nodes.
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� Library Server node

– IBM GSKit V7.0.1.16 
– IBM Tivoli Directory Server V5.2, client and SDK component 

Back up the DB2 Content Manager databases
Prior to importing users and groups from LDAP into DB2 Content Manager, we 
recommend that you back up the library server (icmnlsdb) and resource manager 
(rmdb) databases at this stage. When you start developing the data model, you 
might want to restore the pristine databases for further testing from a known 
state.

Generate the cmbcmenv.properties file
The cmbcmenv.properties file contains configuration settings shared by DB2 
Content Manager and DB2 Information Integrator for Content. The CMCOMMON 
environment variable is used to define the path to the shared directory. In our 
example, it is CMCOMMON=c:\ibm\cmgmt (the path defined during the DB2 Content 
Manager installation).

This section describes how to generate a cmbcmenv.properties file with LDAP for 
DB2 Content Manager enabled. Complete the following steps:

1. Ensure that the ICM LS Monitor (ICMNLSDB) Windows service is started.

2. Ensure that the IBM Tivoli Directory Server V5.2 Windows service is started.

3. Start the system administration client by clicking Start → Programs → IBM 
DB2 Content Manager for Multiplatforms V8.2 → System Administration 
Client.

4. When prompted to log in, enter and select the following values and then click 
OK:

– Server Type: DB2 Content Manager (default)
– Server: ICMNLSDB (default)
– User ID: CMadmin
– Password: <password>

5. From the menu bar, click Tools → LDAP Configuration.

6. Click the LDAP tab.

7. From the LDAP tab, select Enable LDAP User Import and Authentication.

Note: In a development environment, IBM GSKit and IBM Tivoli Directory 
Server, client and SDK components, should be installed on the Document 
Management node where DB2 Content Manager is installed. If following 
procedures in this book, the installation of these components is included in the 
implementation of the nodes.
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8. Click the Server tab. 

9. From the Server tab, enter and select the following values and then click OK 
(see Figure 10-9):

– Server type: LDAP
– LDAP server hostname: ldap://ilm-ui.itsc.austin.ibm.com

The ldap:// will be inserted into the LDAP server hostname value 
automatically.

– Base DN: Lookup from Server and then DC=ITSO,DC=IBM,DC=COM
– User attribute: cn
– User name: cn=TDSadmin
– Password: <password>

Figure 10-9   DB2 Content Manager LDAP configuration

You should see a message similar to the following:

LDAP - Configuration update successful
Config file : c:\ibm\cmgmt\cmbcmenv.properties

10.Click OK and close the system administration client.

Copy the cmbcmenv.properties file
The cmbcmenv.properties file is used by the DB2 Content Manager system 
administration client, library server, and resource manager. When DB2 Content 
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Manager is enabled for LDAP, the cmbcmenv.properties file is generated to 
include the LDAP configuration settings. This LDAP-aware cmbcmenv.properties 
file needs to be available for each of the DB2 Content Manager components. If all 
components are installed on the same node, the following procedure is not 
needed.

Copy the cmbcmenv.properties files to the library server
If the library server is on a different node than the system administration client, 
you will need to copy the generated cmbcmenv.properties file to the node where 
the library server is installed. 

Enable trusted logons for the library server
As part of the single sign-on configuration between the portal and DB2 Content 
Manager, this section describes how to enable the DB2 Content Manager library 
server for a trusted logon (receive token). Complete the following steps:

1. Ensure that the ICM LS Monitor (ICMNLSDB) Windows service is started.

2. Ensure that the IBM Tivoli Directory Server V5.2 Windows service is started.

3. Start the system administration client by clicking Start → Programs → IBM 
DB2 Content Manager for Multiplatforms V8.2 → System Administration 
Client.

4. When prompted to log in, enter and select the following values and then click 
OK:

– Server Type: DB2 Content Manager (default)
– Server: ICMNLSDB (default)
– User ID: CMadmin
– Password: <password>

5. From the menu bar, click Library Server Parameters → Configurations.

6. Double-click Library Server Configurations.

7. When the Library Server Configuration window opens, click the Definition 
tab, select Allow trusted logon, and then click OK.

Create the ClientUserEditSSO privilege set
The default privilege set for DB2 Content Manager is ClientUserReadOnly. We 
need to assign the users of the DB2 Content Manager application a higher 
privilege set for the access permissions to work properly for our example 
application. The ClientUserEdit system-defined privilege set contains the vast 

Note: In our example runtime environment and development environment, the 
system administration client is on the same node as the library server, thus the 
procedure is not needed.
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majority of the privileges needed for the example portal document management 
application. In addition, we need to add two additional privileges 
(AllowConnectToLogon and AllowTrustedLogon) because we are passing a 
token from the portlet application to DB2 Content Manager for a trusted logon for 
the purposes of single sign-on.

To create the ClientUserEditSSO privilege set, complete the following steps:

1. Ensure that the ICM LS Monitor (ICMNLSDB) Windows service is started.

2. Ensure that the IBM Tivoli Directory Server V5.2 Windows service is started.

3. Start the system administration client by clicking Start → Programs → IBM 
DB2 Content Manager for Multiplatforms V8.2 → System Administration 
Client.

4. When prompted to log in, enter and select the following values and then click 
OK:

– Server Type: DB2 Content Manager (default)
– Server: ICMNLSDB (default)
– User ID: CMadmin
– Password: <password>

5. From the menu bar, click Authorization → Privilege Sets.

6. Select the ClientUserEdit privilege set.

7. Right-click Copy.

8. When the Copy Privilege Set window opens, enter and select the following 
values and then click OK:

– Name: ClientUserEditSSO
– Privileges:

• AllowConnectToLogon
• AllowTrustedLogon

Note: In total, 36 privileges should be defined for the ClientUserEditSSO 
privilege set. The two privileges added above are needed for single sign-on 
(SSO).
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Set the UserDB2TrustedConnect privilege set for the 
CMconnect user

The CMconnect user is a special user the client application uses for connection 
to DB2 Content Manager. This section describes how to set the 
UserDB2TrustedConnect privilege set for the CMconnect user. This privilege set 
is needed for the trusted logon (single sign-on configuration). Complete the 
following steps:

1. Ensure that the ICM LS Monitor (ICMNLSDB) Windows service is started.

2. Ensure that the IBM Tivoli Directory Server V5.2 Windows service is started.

3. Start the system administration client by clicking Start → Programs → IBM 
DB2 Content Manager for Multiplatforms V8.2 → System Administration 
Client.

4. When prompted to log in, enter and select the following values and then click 
OK:

– Server Type: DB2 Content Manager (default)
– Server: ICMNLSDB (default)
– User ID: CMadmin
– Password: <password>

5. From the menu bar, click Authentication → Users.

6. Double-click the CMCONNECT user to open the user properties.

7. From the Privilege set list, select the UserDB2TrustedConnect privilege, and 
then click OK.

10.3.2  Configure the LDAP User Import Scheduler
This section describes how to configure the DB2 Content Manager LDAP User 
Import Scheduler to import LDAP users into DB2 Content Manager. Complete 
the following steps:

1. Click Start → Programs → IBM DB2 Content Manager for Multiplatforms 
V8.2 → LDAP User Import Scheduler. See Figure 10-10 on page 270.

Note: For more information about the settings of the LDAP User Import 
Scheduler, refer to the online help available from the tool.
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Figure 10-10   DB2 Content Manager: LDAP User Import Scheduler

2. When the LDAP User Import Scheduler window opens, enter and select the 
following values, as shown in Figure 10-10, and then click Save. 

LDAP Directory (Source):

– LDAP object class for groups: groupOfNames
This value should match the group object class in the LDAP directory.

– LDAP search scope: member
– LDAP root DN: cn=TDSadmin
– LDAP root DN password: <password>

Import Schedule:

– Select Enable for the ICMNLSDB database.
– Admin ID: CMadmin
– Admin ID Password: <password>
– User group:

• Select Maintain the LDAP group names.
In our example, we want the import utility to create that groups found in 
the LDAP directory in DB2 Content Manager and add users to those 
groups.

Or:

• Select Put all users in one group, and enter <group>.
– Schedule time: <24_hour_time>
– Day of week: <day>

To select more than one day use the control key.
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– User filter: (objectclass=inetOrgPerson)
The LDAP user filter provides a query string to match users in the LDAP 
user registry. The default user filter we defined will retrieve all the 
inetOrgPerson user objects.

– Privilege set: ClientUserEditSSO

3. When message window with the following message, click OK:

Successfully updated cmbschinfo.ini with schedule information. 

Note: We found the <wp_home>\config\wpconfig.properties file useful 
for determining the proper values and looking at the LDAP directory 
schema implemented.

Note: The default privilege set is ClientUserReadOnly. Due to the security 
model of DB2 Content Manager, we needed to assign the users of the DB2 
Content Manager application a higher privilege set (ClientUserEdit) for the 
access permissions to work properly.

In our example, we are passing a token from the portlet to DB2 Content 
Manager for a trusted logon. We needed to create a privilege set with two 
additional privileges (AllowConnectToLogon and AllowTrustedLogon) 
beyond the system-defined ClientUserEdit privilege set. We created the 
ClientUserEditSSO privilege set in Create the ClientUserEditSSO privilege 
set.

Remember all the users in the LDAP directory will be created in DB2 
Content Manager with the privilege set defined in the LDAP User Import 
Scheduler. If your system resources are properly protected with access 
control lists (ACLs), this should not be an issue. However, it might be 
preferred to create users with a restrictive privilege set and only add more 
powerful privilege sets to users that require the access.
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Verify the DB2 Content Manager LDAP configuration
Now that the environment is configured, we recommend that you perform some 
basic tests to verify that DB2 Content Manager for LDAP is working properly. 
When the WebSphere Portal server was configured to use LDAP, we imported 
the WPSadmin and WPSbind users, and WPSadmins group through the 
wp-itso.ldif file. The DB2 Content Manager LDAP Import Scheduler Utility should 
import the users and groups from the LDAP directory into DB2 Content Manager 
when the scheduled event transpires. The users and groups should be visible 
using the DB2 Content Manager system administration client.

SSL for LDAP server communication
By default, SSL is not enabled on IBM Tivoli Directory Server. Also, the 
communication to the LDAP server from clients such as WebSphere Portal and 
DB2 Content Manager needs to be configured to use SSL. When communicating 
with the LDAP server on port 389, the communications are in clear text. When 
using the SSL-enabled communication on port 636, the data is encrypted.

Tip: Windows scheduled task

The configuration data for the DB2 Content Manager LDAP User Import 
Scheduler is saved to the c:\ibm\cmgmt\cmbschinfo.ini file. When saving 
the settings, the LDAP User Import Scheduler creates a Windows 
scheduled task, which will run the following batch file:

c:\ibm\cmgmt\admin\common\cmldapimpusers81.bat ICMNLSDB ICM

The output from running the task can be found in 
c:\ibm\cmgmt\admin\common\cmldapimpusers81.ICMNLSDB.ICM.log.

The settings for this scheduled task can be modified according to your 
environment. Keep in mind that if you have an LDAP directory with a very 
large number of users and groups, this could have a performance impact 
on the system. 

Note: In our environment, we experienced the following two anomalies. We 
did not have time to pursue these to identify their cause or if a fix was 
available.

� When a user is deleted from LDAP, the DB2 Content Manager LDAP User 
Import Scheduler is supposed to delete a user or group from DB2 Content 
Manager and does not.

� The DB2 Content Manager LDAP User Import Scheduler does not modify 
an existing group with a new user.
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SSL enabling the LDAP server and communication between nodes using LDAP 
is very much needed for a secure runtime environment. In a development 
environment, it is an optional configuration.

SSL enablement and security in general are out of the scope of this book. For 
information about how to enable SSL for IBM Tivoli Directory Server (LDAP) and 
SSL communication between WebSphere Portal and IBM Tivoli Directory Server, 
see Chapter 11, “Security hardening,” in Develop and Deploy a Secure Portal, 
Using WebSphere Portal V5.0.2 and Tivoli Access Manager 5.1, SG24-6325. For 
more information about SSL communication between DB2 Content Manager and 
IBM Tivoli Directory Server, see IBM Content Manager for Multiplatforms: 
Planning and Installing Your Content Management System Version 8 Release 2, 
GC27-1332-02

10.3.3  Configure the Content Manager eClient RME support 
The following sections describe the configuration steps to support the Records 
Manager Enabler RME) on the Content Management node.

Configure the eClient server to include RME support 
Because the eClient server is supported as a WebSphere application, we need 
to add the RME JAR files to the WebSphere configurations. 

Complete the following steps:

1. Open the WebSphere administrative console by entering:

http://servername:9090/admin/ 

(Or, click Start → Programs → IBM WebSphere → Application Server 
v5.0 → Administrative Console). 

2. Log in to the WebSphere administrative console.

3. On the left pane, click Environment → Shared Libraries. 

4. Select Browse Servers to the right of the Server input field. 

5. Select eClient_Server. 

6. Click Apply.

The listing at the bottom of the main pane should show an entry called 
eClientLib, as shown in Figure 10-11 on page 274.
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Figure 10-11   Setting Shared Libraries

7. Click the eClientLib entry.

You will see the WebSphere configuration settings. One of them should be the 
Classpath, with a list of JAR files in the class path (see Figure 10-12 on 
page 275).

8. Add the following JAR file paths to the beginning of the list:

– C:\IBM\RMenabler\lib\log4j-1.2.8.jar
– C:\IBM\RMenabler\lib\rmecm82.jar
– C:\IBM\RMenabler\lib\IRMAPI.jar
– C:\IBM\RMenabler\lib\rmeacl82.jar

9. Click OK to save your changes.

Note: Correct the JAR file path definitions to indicate your directory naming 
convention.
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Figure 10-12   Specified JAR files

10.After you have added the JAR file entries, click Apply.

11.On the top left of the page, click Save. 

12.From the main pane, click the Save button to save your changes to the master 
configuration. 

13.On the top left of the page, click Logout.

14.Restart the Content Manager eClient server.

Customize the eClient server to support new MIME types
The following step is an optional, but recommended, addition to the RME 
configuration to ensure new MIME-type compatibility beyond the scope of this 
example.

Important: If you are configuring a Content Manager eClient server on 
IBM AIX® or Sun Solaris system platform, make sure that you specify the 
path names for the JAR files in the correct case, because these system 
platforms are case-sensitive.
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To enable the Content Manager eClient to process DXL MSG formats, you need 
to add support for two new MIME application types by completing the following 
steps:

1. Edit the IDMadminDefaults.properties file in the Content Manager eClient 
install folder C:\IBM\CMeClient. 

2. Add the following to the MIME-Type entries section: 

– application/msg=launch 
– application/dxl=launch 

3. Add the following entries to the file extension entries section: 

– application/dxl.extension=dxl 
– application/msg.extension=msg 

4. Stop and restart the Content Manager eClient server.

10.3.4  Configure the DB2 Content Manager RME functions
Although there is no RME code to be installed on the DB2 Content Manager 
server, there are configuration steps that need to be performed on the Content 
Manager server. 

Complete the following configuration steps:

1. Log in to the Content Manager server as CMadmin.

2. Set the ACL binding level to support RME access controls. Modify the ACL 
binding to be “At item level” as follows (see Figure 10-13 on page 277):

a. Log in to the Content Manager system administrator client as CMadmin.
b. Select Library Server Parameters → Configurations → Properties.
c. On the Definition tab, click the Advanced button.
d. Select Public access enabled.
e. Under ACL binding level, select At item level.
f. Click OK.
g. Click OK to save this setting to the library server configuration.

Note: These MIME-Types should match the MIME-Types that are defined in 
the Content Manager server using the Content Manager system 
administration client. See IBM DB2 Content Manager for Multiplatforms/IBM 
Information Integrator for Content: Installing, Configuring, and Managing the 
eClient, SC27-1350, for more information about customizing the eClient.
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Figure 10-13   Setting the ACL binding

3. Populate the Content Manager server RME objects.

RME provides an RMECMSetup tool (included in the RME_CommonJava.zip) 
to automatically set up a Content Manager server to support RME functions. 
The functions that will be performed by the RMECMSetup tool are: 

– Create the RMEADMIN user ID.
– Create RME attributes. 
– Create RME item types.
– Create new MIME types: – DXL – MSG – OLET

4. Execute the setup tool:

a. Start Windows Explorer and navigator to the RME install folder\setup 
folder (for example, C:\IBM\RMEenabler\setup).

b. Double-click RMECMSetup.bat to start. 
c. The RMECMSetup tool will prompt you for the following information:

• CM Server name: ilm-cm (your Content Manager Windows platform 
host name)
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• CM Resource Manager name: RMDB
• CM Administrator user ID: CMadmin
• CM Administrator user password: <password>
• Password for the RMEADMIN user ID: <password>

5. Create RME-enabled item types.

An RME-enabled item type can be any Content Manager item type that 
includes the RME required attributes (eRecord, eRecordID) and uses 
item-level access control list checking. You can only declare Content Manager 
items as records that belong to a RME-enabled item type. During records 
declaration, RME automatically copies the values of the Content Manager 
attributes to the DB2 Records Manager record component attributes if they 
have the same attribute names. 

To create sample RME-enabled item types, complete the following steps:

a. Start Windows Explorer and navigator to the RME install folder\setup 
folder (C:\IBM\RMenabler\setup).

b. Double-click RMECMSampleSetup.bat to start.

The RMECMSampleSetup tool will log its processing and error information in 
the RMECMSetup.log file that is located in the setup folder of the RME install.

6. Configure Content Manager to filter out RME authorization objects.

The RME functions can create some new Content Manager authorization 
objects such as special privileges, privilege groups, privilege sets, and access 
control lists. These special authorization objects have names prefixed with 
$$ICM. Because these authorization objects are for the RME functions 
internal use only, you might want to filter them out and not to display them to 
the general users when accessing through the Authorization → Privileges 
function in the Content Manager system administration client. To filter out 
these $$ICM authorization objects, you need to set a new option called 
filterOpt in the Content Manager system administration properties file 
(cmadmin.properties). 

Note: The RMECMSetup tool will log its processing and error information 
in the RMECMSetup.log file that is located in the setup folder of the RME 
install folder. If the RMECMSetup process completed successfully, it 
creates all the RME required user ID, attributes, and item types on the 
Content Manager server.
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To enable filtering, complete the following steps:

a. Edit the cmadmin.properties file on the Content Manager system. 

This file is located in the %CMCOMMON%\Admin\Common directory. The 
path is C:\IBM\CMgmt\Admin\Common\cmbadmin.properties in our 
installation.

b. Add a new line with filterOpt = 1 to the end of the cmadmin.properties 
file. 

This will hide the $$ICM authorization objects when the Content Manager 
system administration client Authorization → Privileges function is 
selected. 

Table 10-3 shows the possible values of the filterOpt option. The default 
value is 0.

Table 10-3   Content Manager system administration client filterOpt values

10.3.5  Deploy DB2 Content Manager data model
The DB2 Content Manager data model will be defined against the use cases and 
scenarios discussed earlier in this document. Within Content Manager, we must 
create the following data model components:

� Attributes

� Item types

� Users

� Groups

� Access control lists

Create the DB2 Content Manager attributes
This section describes how to create attributes using the DB2 Content Manager 
system administration client.

We create the attributes shown in Table 10-4 on page 280.

Value Meaning

0 Displays all authorization objects. This is the default.

1 Hide $$ICM authorization objects. Displays only the regular 
authorization objects.

2 Displays only the $$ICM authorization objects.
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Table 10-4   DB2 Content Manager attributes

To create the attributes, complete the following steps:

1. Start the DB2 Content Manager system administration client by clicking 
Start →  Programs → IBM Content Manager for Multiplatforms V8.2 → 
System Administration Client.

2. Invoke the New Attribute window by right-clicking the Attributes submenu 
under Data Modeling, and then clicking New.

3. Fill in the attribute information as shown in Figure 10-14 on page 281.

Attribute Description Type Maximum size

A_CommentBody Body comments varchar 200

A_RepAuthor Author of the research 
report

varchar 60

A_RepLastMod Last modified date of the 
report

time stamp System default

A_RepTitle Title of the research 
report

varchar 60

A_RepTopic Topic of the research 
report

varchar 60
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Figure 10-14   DB2 Content Manager Attribute creation

4. Repeat the process for all the attributes listed in Table 10-4 on page 280.

Create the DB2 Content Manager item types
We create the item types shown in Table 10-5.

Table 10-5   DB2 Content Manager item types

To create the item types, complete the following steps:

1. Start the DB2 Content Manager system administration client by clicking 
Start →  Programs → IBM Content Manager for Multiplatforms V8.2 → 
system administration client.

2. Invoke the New Item Type Definition window by right-clicking the Item Types 
submenu under Data Modeling, and then clicking New.

Item type name Description Classification

A_Comment Comment Item

A_PublishedFl Folder that has all the published documents Item

A_Report Research report Document

 

 

 

 

 Chapter 10. Configuration 281



3. Fill in the item type information as shown in Figure 10-15, Figure 10-16, and 
Figure 10-17 on page 283. 

Figure 10-15   DB2 Content Manager Item Type creation (Definition)

Figure 10-16   DB2 Content Manager Item Type creation (Access Control)
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Figure 10-17   DB2 Content Manager Item Type creation (Attributes)

4. Repeat the process for all the item types listed in Table 10-5 on page 281.

Create access control lists
During the Content Management node configuration (described in 10.3.2, 
“Configure the LDAP User Import Scheduler” on page 269), we established a 
schedule for the importation of LDAP users into DB2 Content Manager. As 
implied, that configuration step establishes a schedule for LDAP resource 
synchronization. Now, we add specific access control list (ACL), user, and group 
objects into DB2 Content Manager for the deployment of the solution example. 

The ACLs shown in Table 10-6 on page 284 must be created prior to importing 
LDAP users and groups.
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Table 10-6   DB2 Content Manager ACL and groups

To create ACLs using the system administration client, complete the following 
steps:

1. Start the DB2 Content Manager system administration client by clicking 
Start →  Programs → IBM Content Manager for Multiplatforms V8.2 → 
system administration client.

2. Invoke the New Access Control List Definition window by right-clicking the 
Access Control Lists submenu under Authorization, and then clicking New.

3. Fill in the Name field according to the values in Table 10-6.

4. You can fill in the optional Description field if you want.

5. Select the privilege set according to the information in Table 10-6 and 
Figure 10-18 on page 285.

6. Click OK to save the new ACL.

7. Repeat these steps to create the remaining ACLs.

ACL name Group name Privilege set

ACLAnalysts analysts ClientUserEdit

supervisors NoPrivs

sysadmins AllPrivs

recordsadmins AllPrivs

ACLSupervisors supervisors ClientUserEdit

analysts NoPrivs

sysadmins AllPrivs

recordsadmins AllPrivs

ACLSysAdmins sysadmins AllPrivs

supervisors NoPrivs

analysts NoPrivs

recordsadmins NoPrivs

ACLRecAdmin sysadmins AllPriv

supervisors NoPriv

analysts Nopriv

recordsadmins AllPriv
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Figure 10-18   DB2 Content Manager ACL creation

Import LDAP users to DB2 Content Manager
The users listed in Table 10-7 must be imported from LDAP.

Table 10-7   DB2 Content Manager users and groups

User name Group name

analyst1 analysts

supervisor1 supervisors

sysadmin1 sysadmins

recordadmin1 recordsadmins
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To import users in DB2 Content Manager using the system administration client, 
complete the following steps:

1. Start the DB2 Content Manager system administration client by clicking 
Start →  Programs → IBM Content Manager for Multiplatforms V8.2 → 
system administration client.

2. Invoke the New User window by right-clicking the Users submenu under 
Authentication, and then clicking New.

3. Click the LDAP button to launch the LDAP user selection window.

4. Choose the user or users to import by first clicking the Show All button.

5. After the users are loaded into the New User window, complete the import 
process as illustrated in Figure 10-19, Figure 10-20, and Figure 10-21.

Figure 10-19   DB2 Content Manager user import (Define Users)

Tip: In the test environment, we only defined three users, so selecting 
“Show all” is not an issue. However, for a production implementation, the 
list of LDAP users can quickly overwhelm the process. In these instances, 
be sure to limit the number of users returned by providing filtered search 
criteria within the LDAP user selection window.
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Figure 10-20   DB2 Content Manager user import (Assign to Groups)

Figure 10-21   DB2 Content Manager user import (Set Defaults)

6. Click OK to save the user information.

7. Repeat for all the required users specified in Table 10-7 on page 285.

Create DB2 Content Manager groups
To create users in DB2 Content Manager using the system administration client, 
complete the following steps:

1. Start the DB2 Content Manager system administration client by clicking 
Start →  Programs → IBM Content Manager for Multiplatforms V8.2 → 
system administration client.

2. Invoke the New User Group window by right-clicking the User Groups 
submenu under Authentication, and then clicking New.

3. Fill in the user information as shown in Figure 10-22 on page 288.

 

 

 

 

 Chapter 10. Configuration 287



Figure 10-22   DB2 Content Manager User Group definition

4. You can either use search and find to list the desired users, or simply click 
Show All to list all the available users. Scroll up or down to select the users of 
this group, and then click Add to add the users to the group. You can select 
more than one user at a time by holding down the Shift or Ctrl key when 
selecting users.

10.4  Configure the Records Management node
The steps below must be performed to properly configure the records 
management node.

10.4.1  Configure the RME Host Interface component 
The RME Host Interface front-end is a WebSphere application that runs 
alongside the IBM DB2 Records Manager Web applications. The complete Web 
application is contained in the RMECMRemoteHost82.ear file, which must be 
deployed before it can be used. 
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To deploy the RME Host Interface Web application, complete the following steps: 

1. Log in to the WebSphere administrative console. 

2. Click <hostname> → Applications → Install New Application.

3. In the Path section, select the Local path and select the 
RMECMRemoteHost82.ear file (for example, c:\Program 
Files\IBM\CM82\RME\lib\RMECMRemoteHost82.ear). Click Open.

4. Click Next.

5. Continue to click Next (about five times) until you get to the page that has the 
Finish button.

6. Click Finish. WebSphere will start to process the deployment request. Wait 
until you see a page displaying the “Application RMECMRemoteHost installed 
successfully” message and asking you to save the new changes:

7. Click Save to save the changes to the master configuration.

Defining RME JAR files to WebSphere as a new shared library
There is a set of JAR files that needs to be defined to the WebSphere 
environment in order to support the RME functions on the DB2 Records Manager 
server. 

To define these JAR files to the WebSphere environment, complete the following 
steps: 

1. Log in to the WebSphere administrative console. 

2. Click Environment → Shared Libraries. 

3. Set the Scope to server1 by completing the following steps: 

a. Click the Browse Servers button. 

b. Select server1. 

c. Click OK.

d. Click Apply. 

4. Scroll down and click the New button to add a new shared library. 

5. Enter RMEJars for the Name.

6. Enter the path for the following JAR files in the CLASSPATH input field: 

– ICM Connector JAR (cmbsdk81.jar)
– Apache Log4J JAR (log4j-1.2.8.jar) 
– RME Common JAR (rmecm82.jar) 
– RME Host Interface JAR (RMECMHost82.jar) 
– RME security support JAR (rmeacl82.jar) 
– WebSphere SOAP JAR (soap.jar)
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7. Add the db2java.zip file to the CLASSPATH. For example, add c:\Program 
Files\IBM\SQLLIB\java\db2java.zip to the CLASSPATH. 

8. Add the Content Manager system administration path to the CLASSPATH. For 
example, add c:\Program Files\IBM\CMgmt to the CLASSPATH. 

9. After you have entered all the JAR files to the CLASSPATH input field, click 
the Apply button. 

10.Click the Save link on top of the page and click the Save button in the Save to 
Master Configuration section to save the new RMEJars shared library.

RMEJars shared library references to RMECMRemoteHost 
To add the RMEJars library as a RMECMRemoteHost reference, complete the 
following steps: 

1. Log in to the WebSphere administrative console. 

2. Click Application → Enterprise Applications. 

3. Click the RMECMRemoteHost link. 

4. Scroll down until you see the Additional Properties section. 

5. Click the Libraries link. 

6. Click the Add button. 

7. Select RMEJars. 

8. Click OK. 

9. Click Save on the top of the page and click the Save button to save the 
changes to the master configuration. 

10.4.2  Configure DB2 Records Manager
In order for the RME components to communicate with the Content Manager 
server, two Content Manager configuration files (cmbicmsrvs.ini and 
cmbicmenv.ini) must be configured to include the Content Manager server and 
database connection information. For the DB2 Records Manager server, you 
need to perform the following procedure to add the Content Manager server to 
the Content Manager configuration files:

1. Add the Content Manager server to the Content Manager cmbicmsrvs.ini 
configuration file.

Edit the c:\program files\ibm\cmgmt\cmbicmsrvs.ini file and add an entry for 
the Content Manager server. In our installation, we populated the file with the 
following values:

– ICMSERVER=ICMNLSDB
– ICMSERVERREPTYPE=DB2

 

 

 

 

290 Records Management and Process Choreography



– ICMSCHEMA=ICMADMIN
– ICMSSO=FALSE
– ICMDBAUTH=SERVER
– ICMREMOTE=TRUE
– ICMHOSTNAME=ilm-cm.itsc.austin.ibm.com
– ICMPORT=50000
– ICMREMOTEDB=ICMNLSDB
– ICMNODENAME=ilm-cm.itsc.austin.ibm.com
– ICMOSTYPE=NT

2. Add database connect information to the cmbicmenv.ini file.

This INI file contains Content Manager database connect information. 
Whenever you need to connect to a new, remote Content Manager database, 
you need to add an entry to this INI file. You can use the Content Manager 
system administration client Java utilities to add an entry to this INI file. 
Complete the following steps:

– From a Windows command prompt, change to the %CMCOMMON% path, 
for example, cd\C:\IBM\CMgmt.

– Execute the cmbicmenv81.bat file to set the Java-enabled environment, for 
example, C:\IBM\EIP\cmbenv81.bat.

– Execute the Java-based Content Manager connection utility. 

The following example adds an entry to the cmbicmenv.ini file for 
ICMNLSDB with the connection user ID CMconnect and password 
<password>:

java com.ibm.mm.sdk.util.cmbenvicm -a add -s ICMNLSDB-u CMCONNECT-p 
<password>

Your system is now configured to communicate with the Content Manager 
server and database.

Configure DB2 Records Manager RME components
RME requires the following DB2 Records Manager components to be defined on 
the DB2 Records Manager server:

� Document record component
� Email record component
� Physical record component (optional)
� Cross-Reference 
� Supersedes view
� Versions view

RME requires at least one record component for declaring electronic documents 
and e-mail messages. If you installed the sample file plan during the IBM DB2 
Records Manager installation, the Document record component is already 
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defined on the system. You can use the same record component for processing 
both document and e-mail records. You can also create your own record 
components, and you can name them whatever name you want. The only 
requirement is to register the record component ID for the Document and Email 
components with RME using the RME Configuration Tool. 

When you install the DB2 Records Manager server, if you have installed the 
sample file plan database, the Document record component is already defined 
on the system. Otherwise, you have to create at least one record component for 
RME to use. 

To create the required DB2 Records Manager components, complete the 
following:

1. Launch the DB2 Records Manager Web administrator client, for example:

http://ilm-rm:9080/IRMClient

2. Log in to DB2 Records Manager client with a user account that has file plan 
design authority using the following values:

– Login Name: administrator 
– Password: cronos (Records Manager default for this account)

3. Create the Primary View component:

a. From the main menu, click File Plan Design → Views.
b. Click Add to add a new view. 
c. In the New View window, select the following values: 

• View Name: File Plan
• Type: Hierarchical

d. Click Save.

4. Create a new file plan Document record component.

a. From the main menu, click File Plan Design → Components and click 
Add.

b. Enter the values illustrated in Figure 10-23 on page 293.
c. Click Save to save the new component.

Note: When you installed the DB2 Records Manager server, if you chose 
to install the Sample file plan database, the Document record component is 
already defined on the system. 
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Figure 10-23   Records Manager record-type component creation

5. Add new attributes to the Document record component.

On the Component window, you can edit the properties of the newly defined 
component:

a. Click the View/Edit Properties smart icon.
b. Click the Add button.

Figure 10-24 on page 294 shows an example of adding a new attribute 
called eRecordID for the Document record component. 

c. Click Save to save the new component attribute.
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Figure 10-24   Records Manager component attribute creation

6. Create a new file plan Email record component:

a. From the main menu, click File Plan Design → Components and click 
Add.

b. Enter and select the following values:
• Component Definition Name: Email
• Component Definition Type: Record
• Primary View Name ID: File Plan

c. Click Save to save the new component.

7. Add new attributes to the Email record component:

a. Click the View/Edit Properties smart icon. 
b. Click the Add button. 

Note: For user-defined attributes, the DB2 Records Manager system 
automatically prefixes the attribute names with TS_. For example, for the 
eRecordID attribute we created earlier, its attribute name will be changed 
to be TS_eRecordID.
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c. Add the following component attributes:
• Attribute Name: From
• Attribute Caption: Author or Originator
• Data Type: String
• Data Type Maximum Length: 100

d. Click Save to save the new component attribute.

Repeat this procedure to add all of the attributes in Table 10-8 to the Email 
component

Table 10-8   Email component attributes

8. Create the required relationship views.

RME requires the following relationship views to be defined on the DB2 
Records Manager system:

– Cross-Reference
– Supersedes
– Versions

Complete the following steps:

a. Log in to the DB2 Records Manager client with a user ID that has file plan 
design authority.

b. From the main menu, click File Plan Design → Views.

c. Click the Add button to add a new view. 

d. In the New View window, enter and select the following values: 

• View Name: Supersedes 
• View Type: Link 

e. Click Save to create the Supersedes view. 

Attribute name Attribute caption Data type Data type 
maximum length

Addressees Addressee(s) String 200

OtherRecipients Other 
Addressee(s)

String 200

EmailSentDate Date Sent String 50

EmailReceivedDate Date Received String 50

Note: If you installed the Default database during the DB2 Records 
Manager installation, the Cross-Reference view is already defined on the 
system. If not, you can follow this procedure to create the 
Cross-Reference, Supersedes view, and Versions view.
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f. Click the View/Edit Properties icon for the Supersedes view you just 
created.

g. Click the Add Relationship button to add new relationships.

h. On the Relationship - New window, enter: 

Relationship Definition Name = Document Supersedes Document 
Relationship Capacity = 0 
Source Component = Document 
Target Component = Document 
Click Save to save the relationship. 

i. Click Close to close the edit window after all relationships have been 
added.

Repeat this procedure to create a new view called Versions:

a. Create a view called Versions:

View Name = Versions 
View Type = Link 

b. Define the following relationships for Versions: 

Relationship Definition Name = Document new versions of Document
Relationship Capacity = 0
Source Component = Document
Target Component = Document

Relationship Definition Name = Email new versions of Email
Relationship Capacity = 0
Source Component = Email
Target Component = Email

Next, create a view called Cross-Reference and add relationships to this view:

a. Create a view called Cross-Reference:

View Name = Cross-Reference
View Type = Link 

b. Add relationships to the Cross-Reference view.

The Cross-Reference view is already defined on the DB2 Records 
Manager system after the DB2 Records Manager installation. You just 
need to add the following relationships: 

• Relationship Definition Name: Document (main) to Document 
(supporting)

Relationship Capacity = 0
Source Component = Document
Target Component = Document– 
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• Relationship Definition Name: Email (main) to Email (supporting)

Relationship Capacity = 0
Source Component = Email
Target Component = Email– 

• Relationship Definition Name: Document (main) to Email (supporting)

Relationship Capacity = 0
Source Component = Document
Target Component = Email– 

• Relationship Definition Name: Email (main) to Document (supporting)

Relationship Capacity = 0
Source Component = Email
Target Component = Document

10.5  Summary
Although installation and configuration go hand-in-hand for many out-of-the-box 
products, this solution example involves many products and many integration 
points to support complex business processes. We provided the details within 
this configuration chapter for post-installation solution configuration. The order of 
configuration, if strictly followed, will provide you with a functional solution 
environment, but more importantly, an in-depth understanding of the solution 
components and dependencies.

At this point, you should have a running environment where we can deploy the 
sample application and test it. We describe deploying and running our application 
in the next part of this book.
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Part 4 Deployment and 
executionxecution

In this part of the book, we describe how the application modules, as described 
in Part 2, “Design and development” on page 29, can be deployed to and 
executed in the runtime environment, as described in Part 3, “Installation and 
configuration” on page 85.

We organize the part into the following topics:

� Solution deployment

� Solution walkthrough

Part 4
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Chapter 11. Solution deployment

The information life-cycle management (ILM) sample solution consists of several 
modules. Each of these modules has to be deployed individually to its 
appropriate node. See Chapter 4, “Component design and development” on 
page 51 for a description of the modules. The purpose of this chapter is to 
describe the steps needed to deploy the whole solution.

11
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11.1  Download the ILM sample code
This chapter reference the sample code. Refer to Appendix A, “Additional 
material” on page 367 for information about how to download the sample code 
and other files referenced in this chapter.

11.2  Content Management node
The following steps must be carried out on the Content Management node 
(ILM-CM).

PortalToCM application deployment
The PortalToCM application is a Java 2, Enterprise Edition (J2EE) enterprise 
application module that needs to be deployed to WebSphere Application Server 
running on the Content Management node. PortalToCM is a utility application 
that makes Content Manager functions accessible from remote WebSphere 
Application Server servers by IIOP protocol.

1. The PortalToCM application needs a Java library called cmbsdk81.jar. This 
file is provided with the installation of DB2 Information Integrator for Content. 
It is also available in the sample code included with this book in the 
SG246481-Samples\requiredLibraries directory. 

You can use the file provided with the sample code, but be aware that it might 
be specific to the Version 8.2 of the DB2 Information Integrator for Content. If 
you are using another version for your implementation, the file provided might 
need to be altered. Upload this file to the Content Management node:

a. Create the following directory:

C:\IBM\WebSphere\AppServer\optionalLibraries\ContentManager

b. Upload or copy the cmbsdk81.jar file to the 
C:\IBM\WebSphere\AppServer\optionalLibraries\ContentManager 
directory.

2. Log in to the WebSphere administrative console:

a. Open a Web browser and navigate to the WebSphere administrative 
console located at:

http://ilm-cm.itsc.austin.ibm.com:9090/admin/

b. Click OK. Security on this server has not been turned on as currently 
configured, so you do not need to provide a user name.
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3. Create a shared library entry for the cmbsdk81.jar file (see Figure 11-1 and 
Figure 11-2 on page 304):

a. Go to the Shared Libraries page by clicking Environment → Shared 
Libraries.

b. Click Browse Servers.

c. Select the server1 entry.

d. Click OK.

e. Click Apply.

f. Click New.

g. Fill in the description of the new shared library:

• Name: cmbsdk81.jar

• Classpath: 
C:/IBM/WebSphere/AppServer/optionalLibraries/ContentManager/cm
bsdk81.jar

Click OK.

Figure 11-1   Defining the cmbsdk81.jar file
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Figure 11-2   Shared Libraries

4. The cmbsdk81.jar library references properties files contained within the 
Content Manager installation. These files provide the actual specification of 
connection parameters to Content Manager. If you followed the instructions in 
this book, these files should be located in C:\IBM\Cmgmt.

If you installed Content Manager on a remote computer, you will need to copy 
these files to the computer with the PortalToCM application. 

The path to these properties files is added to the PortalToCM application as a 
shared library, so we need to create new shared library entry (see Figure 11-3 
on page 305):

a. Go to the Shared Libraries page by clicking Environment → Shared 
Libraries.

b. Click Browse Servers.

c. Select the server1 entry.

d. Click OK.

e. Click Apply.

f. Click New.

g. Fill in description of the new shared library:

• Name: Cmgmt_Lib

• Classpath: C:/IBM/Cmgmt

Click OK.
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Figure 11-3   Defining Cmgmt_Lib shared libraries

5. Next, install the PortalToCM enterprise application:

a. Go to the Enterprise Applications page by clicking Applications → 
Enterprise Applications. 

b. Click Install.

c. Click Browse and select the PortalToCMEAR.ear file (available with the 
sample code in the SG246481-Samples/sampleModules directory).

d. Click Next.

e. Select Generate Default Bindings and click Next.

f. For the next five installation pages or steps, leave all the settings to the 
defaults. Keep clicking the Next button until you reach the Summary page.

g. At the Summary page, click Finish. You will see the progress of the 
installation on the next page. If the installation succeeds, you will see the 
Application PortalToCMEAR installed successfully message. 

h. Save the changes by following the Save to Master Configuration link.
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i. Click Save to confirm the changes.

6. After the application is installed, you need to associate the shared libraries to 
it.

We add the two shared libraries created in the previous steps:

a. Go to PortalToCMEAR application page by clicking Applications → 
Enterprise Applications → PortalToCMEAR.

b. Select the Libraries link from the Additional Properties section.

c. Click Add.

d. Select the cmbsdk81.jar entry and click OK.

e. Select the Libraries link from the Additional Properties section.

f. Click Add.

g. Select the Cmgmt_Lib entry and click OK.

h. Click the Save link at the top of the page and then click the Save button at 
the bottom of the page.

7. The deployment of the PortalToCM application is now complete. Next, we 
start the application:

a. Click Applications → Enterprise Applications.

b. Select the PortalToCMEAR option.

c. Click Start.

d. You should see the Application PortalToCMEAR on server server1 and 
node ilm-cm started successfully message.

Note: Shared libraries need to be added after each update of the 
application, because they are lost during the update.

Note: If an error occurs during the application start up, you can find details in 
the log file C:\IBM\WebSphere\AppServer\logs\server1\SystemOut.log.

For further information, see the WebSphere Application Server Information 
Center, available at:

http://publib.boulder.ibm.com/infocenter/ws51help/index.jsp
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11.3  Records Management node
To deploy of the Records Management node, we must now extend the previous 
configuration tasks to include solution-specific component integration into DB2 
Records Manager. 

In this section, we complete the following tasks:

� Define the DB2 Records Manager logic extensions

� Register the DB2 Content Manager server as a DB2 Records Manager host 
application

� Capture the DB2 Records Manager component IDs

� Define DB2 Records Manager RME configuration information

� Configure DB2 Records Manager RME users and groups

11.3.1  Define the DB2 Records Manager logic extensions
Records Manager Enabler (RME) added some logic extensions for processing 
electronic documents and e-mail messages. In order to deploy these logic 
extensions to the DB2 Records Manager Engine server, you need to define 
these logic extensions to all the record components defined on the DB2 Records 
Manager system.

To add the logic extensions, complete the following steps (see Figure 11-4 on 
page 308):

1. Log in to the IBM DB2 Records Manager client 
(http://ilm-rm.itsc.austin.ibm.com:9080/IRMClient/) with a user account that 
has file plan design authority. 

2. From the main menu, click the Tools → Extensions.

3. Click the Add Logic Extension button.

4. Select Document from the Component Definition list.

5. In the Fully Qualified Logic Extension Class Name field, enter the extension 
and type the Java package name:

com.ibm.rme.ext.RMEListener

6. Select Enabled.
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Figure 11-4   Defining Logic Extensions

7. Click Save to save the RME logic extension definition.

8. Repeat these steps to define a logic extension for the Email record 
component and all other defined components that will be used with the 
Records Manager Enabler.

11.3.2  Register the DB2 Content Manager server as a DB2 Records 
Manager host application

In order for the IBM DB2 Records Manager server to know which Host Interface 
module to launch to communicate with a specific Content Manager server, the 
Content Manager server must be registered with the DB2 Records Manager 
server as a host application. Complete the following steps:

1. Log in to DB2 Records Manager using the DB2 Records Manager client with 
a user account that has Record Host Management authority.

2. From the main menu, click Tools → Host Configuration.

3. Click Add to add a new host application.

4. Enter and select the following values:

– Host Name: ICMNLSDB

– Host Server Name/Address: ilm-rm.itsc.austin.ibm.com
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– Host JNDI Port field: 2809

– Host Integration Component JNDI Name: ejb/com/host/RMECMRemoteHost

– Select On Permission Change.

– Select Allow Content Retrieval.

– Fill in the Password and Confirm Password fields.

Figure 11-5 on page 310 illustrates the details of the host application 
configuration.

5. Click Save to create a new host application entry.

Note: The Host Server Name/Address should identify the host name of 
the machine where the RME Host Interface Web application is 
deployed. This is usually the same machine as the system from which 
the DB2 Records Manager Web Admin is running.

Note: The host application password is defined by this entry action. 
That is, the RME can support multiple host applications, but the host 
application password must be the same for all instances. 
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Figure 11-5   DB2 Records Manager Host Configuration

11.3.3  Capture the DB2 Records Manager component IDs 
After the host definition, views, and components have been created, we need to 
capture the component IDs for subsequent configuration steps. The easiest 
procedure for capturing these IDs is as follows:

1. Go to the Component page to display all the components by clicking File 
Plan Design → Component.

2. Hover over the component “Actions” smart icon to reveal the component ID # 
within the browser status bar, as shown in Figure 11-6 on page 311.
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Figure 11-6   Records Manager Component ID: Display ID

3. Record the number in Table 11-1 and repeat this process for each component 
listed.

Table 11-1   DB2 Records Manager file plan component definition IDs

11.3.4  Define DB2 Records Manager RME configuration information

In order for the different RME components to communicate with each other, we 
need to maintain information about the RME system configurations. The 
RMEconfig tool is used to input and maintain RME system configurations so that 
the RME components can access them. The RMEconfig tool is part of the 
RME_CommonWin32.zip file and it is installed in the RME installation folder 
during the RME installation. The RMEconfig tool should be executed on the DB2 

Component name Component ID (FlPlnCmpntDefID)

Document Component ID

Email Component ID

Cross-Reference View ID

Supersedes View ID

Versions View ID

Host Application ID
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Records Manager server machine after all the previous post-installation 
configuration steps have been completed successfully. 

Execute the RMEconfig tool 
To execute the configuration tool, complete the following steps on the Records 
Management node: 

1. From the Windows Start menu, click Start → Run.

2. Enter rmeconfig and then click OK.

3. The RME Configuration Tool interface opens, as shown in Figure 11-7.

Figure 11-7   DB2 Records Manager RME Configuration Tool interface

4. Click Connect → Logon. 

5. Select a Content Manager server from the drop-down list next to Server. 

6. Enter the password for the RMEadmin user ID to log in to the Content 
Manager server. 

7. Click OK. 

Note: Only the DB2 Records Manager Server button is enabled the first 
time you log in to the RMEconfig tool. The other buttons are enabled after 
you enter and save the information specified when using the DB2 Records 
Manager Server button.

Important: If the Content Manager server you want is not listed, this 
means that it is not configured to communicate with this DB2 Records 
Manager server. You have to configure it by completing the steps in 10.4.1, 
“Configure the RME Host Interface component” on page 288.
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Specify DB2 Records Manager server information 
To input the DB2 Records Manager server information into the RMEconfig 
database, complete the following steps (see Figure 11-8 on page 314): 

1. Click the DB2 Records Manager Server button on the RMEconfig main 
page.

2. In the Server Host Name field, enter the host name or the fully qualified host 
name for the DB2 Records Manager server.

3. In the Server URL field, enter the URL for the DB2 Records Manger Web 
services server, for example:

http://ilm-rm.itsc.austin.ibm.com:9080/IRMWebServices/

4. In the Server ORB Port field, enter the ORB port number to which the DB2 
Records Manager Engine server is listening, for example, 2809.

5. From the Server Database list, select the DB2 Records Manager database. 

6. In the Client URL field, enter the URL for the Records Manager client logon 
page, for example:

http://ilm-rm.itsc.austin.ibm.com:9080/IRMClient/

7. In the Administrator Password field, enter the password for the administrator 
user ID on the DB2 Records Manager server.

Important: The first time you execute the RMEconfig tool to log in to the 
Content Manager server, the password for the RMEadmin user ID will be 
saved in the system for subsequent use until the next time the password is 
changed. Whenever the RMEadmin password is changed, you have to run the 
RMEconfig tool on the DB2 Records Manager server machine and log in to 
RMEadmin so that it will save the changed password on the system. 

Note: If the Server Database list is empty, either the DB2 Records 
Manager server URL is incorrect or the DB2 Records Manager server is 
not started.

Note: The DB2 Records Manager Web client default administrator logon 
information is:

� User Name: administrator
� Password: cronos
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Figure 11-8   Records Manager DB2 Server definition

8. Click Save to save the server information.

Specify DB2 Records Manager definitions information 
To input the DB2 Records Manager file plan and component definitions 
information into the RMEconfig database, complete the following steps: 

1. Click the DB2 Records Manager Definitions button. 

2. Enter the values recorded in Table 11-1 on page 311.

3. Click Save to save the server definitions information.

Specify the DB2 Records Manager host application 
To input the DB2 Records Manager host application information into the 
RMEconfig database, complete the following steps: 

1. Click the DB2 Records Manager Host Application button.

2. Enter the host application ID for the Content Manager server, as recorded in 
Table 11-1 on page 311.

3. In the Host Application Password field, enter the password for the host 
application.

4. Click Save to save the host application information.

Specify DB2 Content Manager information 
To input the DB2 Content Manager information into the RMEconfig database, 
complete the following steps: 

1. Click the DB2 Content Manager button.
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2. In the Microsoft Outlook Item Type field, click the down-arrow and select a 
Content Manager item type to be used to store declared Outlook e-mail 
messages and attachments. 

3. Click Save to save the information

4. On the RMEconfig main page, click Connect → Exit to exit the RME 
Configuration Tool.

11.3.5  Configure DB2 Records Manager RME users and groups
Users can use the same user accounts to log in to both the IBM DB2 Content 
Manager system and the DB2 Records Manager system. The DB2 Records 
Manager system supports users and user groups that are defined on the Content 
Manager system. (This also satisfies any single user account and password 
requirement for the Records Management application.)

The user and group accounts are first created on the Content Manager system 
and then imported into the Records Manager system. The user IDs, passwords, 
and members in a group are defined and maintained on the Content Manager 
server by the Content Manager system administrator. When users log in to the 
Records Manager system, users need to specify the Content Manager server 
name, user ID, and password. Records Manager will authenticate the user 
account and password with the specified Content Manager server. At logon time, 
the Content Manager group information for the user is also passed to Records 
Manager so that Records Manager will grant all the permissions that are defined 
for the group to the user.

Import DB2 Content Manager users and groups
To import new users, user groups, or both, complete the following steps (see 
Figure 11-9 on page 316): 

1. First, create users or groups in DB2Content Manager using the Content 
Manager system administration client. 

2. Import the users or groups into DB2 Records Manager using the DB2 
Records Manager client.

3. Click Security → Users.

Important: Do not assign any Content Manager privilege set that contains 
the ItemSuperAccess privilege (for example, ALLPrivs) to any general 
user. Users who have the ItemSuperAccess privilege will bypass all 
Content Manager item access controls, including the RME record access 
controls.
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4. Select the Host Name.

5. Click Import.

Figure 11-9   User definitions in Records Manager

Assign permissions and record access control to the users or 
groups 

When users log in to Records Manager, the system authenticates with Content 
Manager on the user account and password. The Content Manager group 
membership information is also extracted during logon for verifying group-related 
permissions for the user.

Note: If you successfully import a user from a Content Manager system into 
the Records Manager system, the Records Manager server and the RME 
Host Interface components are installed and configured correctly.

 

 

 

 

316 Records Management and Process Choreography



11.4  Business Integration node
You must perform the following steps to deploy the sample application 
components on the Business Integration node (ilm-bi).

ReportApproval process deployment
The ReportApproval application is a J2EE enterprise application module that 
needs to be deployed to WebSphere Application Server running on the Business 
Integration node. The ReportApproval application contains the Business Process 
module that runs the Report Approval process. 

Complete the following steps:

1. The ReportApproval application needs a Java library called IRMapi.jar. This 
file is provided with the installation of DB2 Records Manager. It is also 
available within the sample code included with this redbook in the 
SG246481-Samples\requiredLibraries directory.

You can use the file provided with the sample code, but be aware that it might 
be specific to the Version 8.2 of the DB2 Information Integrator for Content. If 
you are using another version for your implementation, the file provided might 

Note: All groups are defined and maintained in Content Manager only. This 
means that the Content Manager administrators are responsible for adding or 
removing members from groups on the Content Manager server. 

You only need to import the Content Manager group names into Records 
Manager. You do not have to import or define group membership in Records 
Manager.

Tip: When a user logs on to the Records Manager system, the system 
extracts the group membership information from the Content Manager server 
for that user. The Records Manager access permissions that are associated 
with a Content Manager group will apply to all Content Manager users that 
belong to the Content Manager group.

Tip: Changing user passwords: Passwords changed within the Microsoft 
Windows environment are inherited into Content Manager. Because Records 
Manager authentication references the Content Manager user credentials, be 
aware that subsequent Records Manager logons will be affected by these 
password changes.
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need to be altered. You need to upload this file to the Business Integration 
Node:

a. Create the following directory:

C:\IBM\WebSphere\AppServer\optionalLibraries\RecordManager

b. Upload or copy the IRMapi.jar file to the 
C:\IBM\WebSphere\AppServer\optionalLibraries\RecordManager 
directory.

2. The ReportApproval application also needs a Java library called 
PortalToCM.jar. This file contains the classes deployed to the Content 
Management node for the PortalToCM application. It is needed by the 
ReportApproval application in order to make the remote calls to the 
PortalToCM enterprise beans. The file is available with the sample code 
included with this book in the SG246481-Samples\requiredLibraries directory. 
If you make changes to the PortalToCM application code, you will need to 
update this file as well.

Copy the PortalToCM.jar file to the 
C:\IBM\WebSphere\AppServer\optionalLibraries\RecordManager directory.

3. Log in to the WebSphere administrative console:

a. Open a Web browser and navigate to the WebSphere administrative 
console at:

https://ilm-bi.itsc.austin.ibm.com:9043/admin/logon.jsp

b. Log in with your server user ID and password. If following the steps in this 
book, the user ID should be sysadmin1.

4. Create a shared library entry for the IRMapi.jar file:

a. Go to the Shared Libraries page by clicking Environment → Shared 
Libraries.

b. Select server1.

c. Click Apply.

d. Click New.

e. Fill in the description of new shared library:

• Name: IRMapi.jar

• Classpath: 
C:/IBM/WebSphere/AppServer/optionalLibraries/RecordManager/IRM
api.jar

Click OK.
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5. Repeat the same steps for the PortalToCM.jar file:

a. Go to the Shared Libraries page by clicking Environment → Shared 
Libraries.

b. Select server1.

c. Click Apply.

d. Click New.

e. Fill in description of new shared library:

• Name: PortalToCM.jar

• Classpath: 
C:/IBM/WebSphere/AppServer/optionalLibraries/RecordManager/Por
talToCM.jar

Click OK.

6. The next step is to create a configuration file for the ReportApproval 
application. A sample configuration file is included as 
SG246481-Samples\config\process\ReportApprovalConfig.properties within 
the sample code.

a. Upload this sample configuration file to the 
C:\IBM\WebSphere\AppServer\config\optionalConfigs directory on the 
Business Integration node.

b. Open the uploaded ReportApprovalConfig.properties for editing.

c. Modify the values to suit your scenario. The descriptions of the properties 
are as follows:

RMRecordHostId DB2 Records Manager host application 
component ID.

RMRecordHostName Host application component name.

RMLifeCycleCodeId Life-cycle code ID.

RMLifeCyclePhaseIdForSubmittedPhase 
Life-cycle phase ID representing the 
“Submitted” life cycle phase.

RMLifeCyclePhaseIdForPublishedPhase
Life-cycle phase ID representing the 
“Published” life-cycle phase.

RMDisposeAuthorityId Disposal authority ID.
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RMFilePlanComponentDefinitonID
File plan component definition ID, which is 
unique for each component definition. 
Records of the same type will share this 
value.

RMFilePlanComponentParentID
This is the unique ID of the new file plan 
component's parent. The new file plan 
component will be added as a child to this 
parent.

RMServerAddress This is the physical address of the Records 
Management node. You need to specify the 
fully qualified DNS name.

RMHostName DB2 Records Manager host application 
name.

RMLoginId DB2 Records Manager user account that 
has the component create authority. If 
following the steps in this book, this would 
be CMadmin.

RMLoginPassword Password for the user account previously 
mentioned.

RMDatabaseJNDI JNDI name for the DB2 Records Manager 
database. This JNDI entry resides on the 
Records Management node.

CMHostName This is the physical address of the Content 
Management node. You need to specify the 
fully qualified DNS name.

d. Save the file.

7. After we create a configuration file, we need to make a URL resource 
reference to it so that the ReportApproval sample application can find it:

a. In the WebSphere administrative console, go to the URL Providers page 
by clicking Resources → URL Providers.

b. Select server1.

c. Click Apply.

d. Click the Default URL Provider link.

e. Click the URLs link in the Additional Properties section.

f. Click New.
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g. Enter the following values:

• Name: ReportApprovalConfig

• JNDI name: url/com/ibm/itso/ilm/process/config

• Specification: 
file:C:/IBM/WebSphere/AppServer/config/optionalConfigs/ReportA
pprovalConfig.properties

h. Click OK.

8. Save the changes by clicking the Save link at the top of the page and then the 
Save button at the bottom of the page.

9. The next step is to deploy the ReportApproval application itself:

a. Go to the Enterprise Applications page by clicking Applications → 
Enterprise Applications. 

b. Click Install.

c. Click Browse and select the ReportApprovalEAR.ear file (available with 
the sample code in the SG246481-Samples/sampleModules directory).

d. Click Next.

e. Select Generate Default Bindings and click Next.

f. In the next pages or steps, leave all the settings to the defaults. Keep 
clicking the Next button until you reach the Step 12 page.

g. On the Step 12 page, select Create tables. This creates the tables 
needed to support ReportApproval staff activities. Click Next.

h. On the Summary page, click Finish. You will see the progress of the 
installation on the next page. If the installation succeeds, you will see the 
message Application ReportApprovalEAR installed successfully.

i. Save the changes by following the Save to Master Configuration link.

j. Click the Save button to confirm the changes.

10.After the application is installed, you need to associate the shared libraries to 
it.

Restriction: You need to match this value exactly, because this 
string is currently hardcoded in our sample application.

Note: Shared libraries need to be added after each update of the 
application because they are lost during the update.
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We add the two shared libraries created in the previous steps:

a. Go to PortalToCMEAR application page by clicking Applications → 
Enterprise Applications → ReportApprovalEAR.

b. Select the Libraries link from the Additional Properties section.

c. Click Add.

d. Select the IRMapi.jar entry and click OK.

e. Select the Libraries link from the Additional Properties section.

f. Click Add.

g. Select the PortalToCM.jar entry and click OK.

h. Click the Save link at the top of the page and then click the Save button at 
the bottom of the page.

11.The deployment of the ReportApproval application is now complete. Next, we 
start the application:

a. Click Applications → Enterprise Applications.

b. Select the ReportApprovalEAR option.

c. Click Start.

d. You should see the Application ReportApprovalEAR on server server1 
and node ilm-bi started successfully message.

Note: If an error occurs during the application start up, you can find details 
in the log file C:\IBM\WebSphere\AppServer\logs\server1\SystemOut.log.

For further information, see the WebSphere Application Server Information 
Center, available at:

http://publib.boulder.ibm.com/infocenter/ws51help/index.jsp
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If you want to test the newly deployed process, you can do so in Process 
Choreographer Web Client:

http://ilm-bi.itsc.austin.ibm.com:9080/bpe/logon.jsp

You will need the users of following groups to perform all of the process tasks:

sysadmins Sysadmins users administer the process and have all 
the access rights to the process and its activities.

supervisors Supervisors can start the process and can complete 
the ApproveReport activities.

analysts Analysts can only complete the CreateReport and 
ReworkReport activities.

Important: If you want to stop the application, you need to stop the 
business process first. In order to stop the business process, you need to 
stop and delete all the instances of that process. To stop and delete all the 
instances, complete the following steps:

1. Go to the Process Choreographer Web Client at:

http://ilm-bi.itsc.austin.ibm.com:9080/bpe/logon.jsp

2. Log in as sysadmin1 user (or any user that is part of the sysadmins 
group in your LDAP schema).

3. Select the Administered By Me link and terminate and delete all the 
ReportApproval process instances.

4. Log out of the Process Choreographer Web Client.

5. Go to the WebSphere administrative console at:

https://ilm-bi.itsc.austin.ibm.com:9043/admin/logon.jsp

6. Log in with your server user ID (for example, sysadmin1).

7. Click Applications → Enterprise Applications → 
ReportApprovalEAR → EJB Modules → ReportApprovalEJB.jar → 
Business Processes.

8. Select the ReportApprovalProcess option and click Stop.

9. Save the changes to the master configuration.

Now, you can stop the ReportApproval application. If you update it and 
then start it again, the process will be started automatically. If you just stop 
and start the ReportApproval application, the process will not get started, 
and you will have to navigate to the above destination to start the process 
manually.
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recordsadmins Record administrators can perform audit-related 
actions.

11.5  Portal node
The deployment steps for the Portal node consist of the following tasks:

1. Configure portlets

2. Add required libraries

3. Deploy portlets

4. Create portal pages

5. Set up access rights

11.5.1  Configure portlets
All of the portlets deployed to WebSphere Portal are going to make remote 
connections to other nodes and modules. We need to provide configuration files 
for these portlets. This section describes the content of these files and where and 
how they have to be deployed. You must complete this step before starting the 
portlet deployment.

ReportTasks and CreateAssignment portlets
The ReportTasks and CreateAssignment portlets use the 
ILMPortletsConfig.properties file. A sample of this file is provided with the sample 
code in the SG246481-Samples\config\portlets directory. Complete the following 
steps:

1. Copy the sample ILMPortletsConfig.properties file to this location:

C:\IBM\WebSphere\AppServer\config\optionalConfigs\ILMPortletsConfig.properties

2. Open the sample file from the above location and edit the following values:

BIHostName Fully qualified DNS name of the Business Integration 
node (that is, the server, where IBM WebSphere 
Business Integration Server Foundation with the 
Report Approval Process is running).

CMHostName Fully qualified DNS name of the Content Management 
node (that is, the server where WebSphere Application 
Server with the PortalToCM application is running).

Save the file.
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3. The next step is to create a URL resource pointing to this file so that the 
portlet applications can locate it:

a. Open a Web browser window and go to the WebSphere administrative 
console at:

https://ilm-ui.itsc.austin.ibm.com:9043/admin/logon.jsp

b. Log in using your server user ID. If following steps in this book, this would 
be sysadmin1.

c. Go to the URL Providers page by clicking Resources → URL Providers.

d. Click Browse Servers.

e. Select the WebSphere_Portal entry.

f. Click OK.

g. Click Apply.

h. Click the Default URL Provider link.

i. Click the URLs link in the Additional Properties section.

j. Click New.

k. Enter the following values:

• Name: ILMPortletsConfig

• JNDI name: url/com/ibm/itso/ilm/portlets/config 

• Specification: 
file:C:/IBM/WebSphere/AppServer/config/optionalConfigs/ILMPort
letsConfig.properties

l. Click OK.

m. Save the changes by clicking the Save link at the top of the page and then 
the Save button at the bottom of the page.

AllDocuments, DocumentDetails, and PublishedReports 
portlets

The AllDocuments, DocumentDetails, and PublishedReports portlets need a 
configuration file. This file contains the connection options to the Content 
Management node, so the portlets can display DB2 Content Manager data. This 

Restriction: You need to match this value exactly, because this 
string is hardcoded in the application.
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file is part of the WAR archive file together with the portlets code. You have 
several options of how to modify the configuration file:

� You can modify it in WebSphere Studio Application Developer and then 
export the new WAR file.

� You can use the Application Assembly Tool provided with your IBM 
WebSphere Portal V5.0 installation.

� You can edit the properties file embedded in the WAR file.

We use the third option. We used a third-party ZIP application that enabled us to 
view the files contained within the WAR file and edit them in place:

1. Copy the SG246481-Samples/sampleModules/ReportCU.war file into a 
temporary directory.

2. Rename the file. Change the .war extension to a .zip extension.

3. Use a ZIP utility to unpack the ZIP archive. 

4. Locate the file Web-inf/classes/ServersInfo.properties file and open it for 
editing.

5. Adjust the following value to fit your scenario:

CMServer Fully qualified DNS name of your DB2 Content 
Manager server (that is, the DNS name of the Content 
Management node in our scenario).

Ignore the other entries, because we do not use them.

6. Save the ServersInfo.properties file.

7. Repack the original ZIP file with the updated files. Make sure that the 
directory structure is exactly the same as the one in the original file.

8. Rename the file. Change the .zip extension to a .war extension.

RecordsAdmin and RecordsSearch portlets
The RecordsAdmin and RecordsSearch portlets need a configuration file. This 
file contains the connection options to the Records Management node so that the 
portlets can display DB2 Records Manager records. This file is part of the WAR 
archive file together with the portlets code. You have several options of how to 
modify the configuration file:

� You can modify it in WebSphere Studio Application Developer and then 
export the new WAR file.

� You can use the Application Assembly Tool provided with your IBM 
WebSphere Portal V5.0 installation.

� You can edit the file in the WAR file using the ZIP utility.
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We use the third option. We used a third-party ZIP application that enabled us to 
view the files contained within the WAR file and edit them in place:

1. Copy the SG246481-Samples/sampleModules/RecordsAdmin.war file into a 
temporary directory.

2. Rename the file. Change the .war extension to .zip extension.

3. Use a ZIP utility to unpack the ZIP archive.

4. Locate the file Web-inf/classes/ServersInfo.properties file and open it for 
editing.

5. Adjust the following values to fit your scenario:

RMServer Fully qualified DNS name of your DB2 Records 
Manager server (that is, the DNS name of the Records 
Management node in our scenario).

RMHost DB2 Records Manager host application component 
name.

RMHostAdmin DB2 Records Manager user account that has 
component view, update, suspend, and un-suspend 
authority. If following steps in this book, this would be 
CMadmin.

RMHostAdminPassword
Password for the RMHostAdmin user account.

RMDatabase JNDI name for the DB2 Records Manager database. 
This JNDI entry resides on the Records Management 
node.

RMFilePlanComponentDefinitionID
File plan component definition ID that is unique for 
each component definition. Records of the same type 
will share this value.

Ignore the other entries, because we do not use them.

6. Save the ServersInfo.properties file.

7. Repack the original ZIP file with the updated files. Make sure that the 
directory structure is exactly the same as in the original file.

8. Rename the file. Change the .zip extension to a .war extension.

AuditSearch and AuditResult portlets
The AuditSearch and AuditResult portlets need a configuration file. This file 
contains the connection options to the Records Management node so that the 
portlets can display DB2 Records Manager audit logs. This file is part of the WAR 
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archive file together with the portlets code. You have several options of how to 
modify the configuration file:

� You can modify it in WebSphere Studio Application Developer and then 
export the new WAR file.

� You can use the Application Assembly Tool provided with your IBM 
WebSphere Portal V5.0 installation.

� You can edit the file in the WAR file using the ZIP utility.

We use the third option. We used a third-party ZIP application that enabled us to 
view the files contained within the WAR file and edit them in place:

1. Copy the SG246481-Samples/sampleModules/AuditAdmin.war file into a 
temporary directory.

2. Rename the file. Change the .war extension to a .zip extension.

3. Use a ZIP utility to unpack the ZIP archive.

4. Locate the file Web-inf/classes/ServersInfo.properties file and open it for 
editing.

5. Adjust the following values to fit your scenario:

RMServer Fully qualified DNS name of your DB2 Records 
Manager server (that is, DNS name of the Records 
Management node in our scenario).

RMHost DB2 Records Manager host application component 
name.

RMHostAdmin DB2 Records Manager user account that has 
component view, update, suspend, and un-suspend 
authority. If following steps in this book, this would be 
CMadmin.

RMHostAdminPassword
Password for the RMHostAdmin user account.

RMDatabase JNDI name for the DB2 Records Manager database. 
This JNDI entry resides on the Records Management 
node.

Ignore the other entries, because we do not use them.

6. Save the ServersInfo.properties file.

7. Repack the original ZIP file with the updated files. Make sure that the 
directory structure is exactly the same as in the original file.

8. Rename the file. Change the .zip extension to a .war extension.
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11.5.2  Add required libraries
Our sample portlets require a number of additional Java libraries to run properly. 
These libraries are provided with the sample code and are already embedded in 
the deployment files of portlets (these files are called Web archives). If you 
installed other software versions of the IBM products, or if you have made 
changes to the code of any of the sample modules provided with this book, you 
need to update these libraries in the war files.

A “quick and dirty” way to accomplish this is to update the libraries in the WAR 
files as follows:

1. Change the file extension of the WAR files from .war to .zip.

2. Open with a ZIP utility.

3. Update the necessary libraries. These libraries are located in the web-inf/lib 
directory.

4. Change the file extension from .zip back to .war.

These mentioned steps will not always work. If the names of objects or methods 
have changed, or if the signatures of the methods have changed, you will need to 
open the portlets source code in WebSphere Studio Application Developer, 
change the source code to accommodate these changes, and then compile the 
source code and export new WAR files.

11.5.3  Deploy portlets
The following subsections describe the steps to deploy the various portlets.

ReportTasks and CreateAssignment portlets
The ReportTasksPortlets application is J2EE Web application module that needs 
to be deployed to WebSphere Application Server running on the Portal node. 
The ReportTasksPortlets.war file contains the ReportTasks portlet that manages 
the user tasks appearing in the ReportApproval process. It also contains the 
CreateAssignment portlet that is used by a supervisor to create a new report 
assignment (and thus start the new process instance).

To deploy the portlets, complete the following steps (see Figure 11-10 on 
page 330):

1. Open a Web browser window and navigate to the WebSphere Portal title 
page:

http://ilm-ui.itsc.austin.ibm.com/wps/portal

2. Click the Log in link in the upper-right corner.
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3. Enter your Portal administrator ID and password. If following steps in this 
book, this would be sysadmin1.

4. Go to installation page by clicking Administration → Portlets → Install.

Figure 11-10   Portlet install page

5. Select the ReportTasksPortlets.war. This file is available in the sample code 
of this book under the SG246481-Samples\sampleModules directory.

6. Click Next.

7. Click Install.

8. You should see a message stating that the portlets have been installed 
successfully. 

AllDocuments, DocumentDetails, and PublishedReports 
portlets

Repeat the process in “ReportTasks and CreateAssignment portlets” on 
page 329 for the ReportCU.war file.

RecordsAdmin and RecordsSearch portlets
Repeat this process for the RecordsAdmin.war file.

AuditSearch and AuditResult portlets
Repeat this process for the AuditAdmin.war file.

11.5.4  Create portal pages
After we deploy the portlets, we need to make them available on the portal 
pages. You can use any existing Web page and add portlets to that page, or you 
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can create new pages. We decided to create new pages in order to make the 
content well-organized.

We create a new page on the same level as the default WebSphere Portal 
Welcome page. We name this page ILM Sample Application. We then create four 
pages under this main page. These four pages will contain the portlets.

To set up the pages, complete the following steps:

1. Open a Web browser window and navigate to the WebSphere Portal title 
page:

http://ilm-ui.itsc.austin.ibm.com/wps/portal

2. Click the Log in link in the upper-right corner.

3. Enter your Portal administrator ID and password. If following steps in this 
book, this would be sysadmin1.

4. Click Administration → Portal User Interface → Manage Pages.

5. Select My Portal.

6. On next page, click the New Page button in the Pages in My Portal section.

7. Enter ILM Sample Application for the title.

8. Click OK.

9. You should see the ILM sample Application has been created 
successfully message. Click OK.

10.Click the up arrow icon for the ILM Sample Application entry. The ILM Sample 
Application page should move one row up in the list. Do this several times 
until the page appears at the top of the list. The result should look similar to 
the page shown in Figure 11-11 on page 332.
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Figure 11-11   Creating Portal pages: Adding the ILM Sample Application page

11.Select the newly created ILM Sample Application page by clicking it.

12.On the next page, click the New Page button.

13.Enter ILM - Tasks for the title.

14.Click OK.

15.You should see the ILM - Tasks has been created successfully message. 
Click OK.

16.Click the Edit Page Layout icon (pencil) for the ILM - Tasks entry.

17.Select One column for the page layout, and click OK in the pop-up dialog 
box.

18.Click the Add portlets button.

19.Select the following portlets:

– ILM - Create Assignment Portlet
– ILM - Analyst Report Tasks Portlet 

Use the search functionality to search for the ILM portlets. Then, click OK.

 

 

 

 

332 Records Management and Process Choreography



20.You should see a page similar to the one shown in Figure 11-12. Click Done.

Figure 11-12   Creating Portal pages: Designing the ILM - Tasks page

21.Click New Page.

22.Enter ILM - Reports for the title.

23.Click OK.

24.You should see the ILM - Reports has been created successfully 
message. Click OK.

25.Click the Edit Page Layout icon (pencil) for the ILM - Reports entry.

26.Select One column for the page layout, and click OK in the pop-up dialog 
box.

27.Click the Add portlets button.

28.Select the following portlets:

– ILM - Document Details Portlet
– ILM - All Documents Portlet
– ILM - Published Reports Portlet
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Use the search functionality to search for the ILM portlets. Then, click OK.

29.You should see a page similar to the one shown in Figure 11-13. Click Done.

Figure 11-13   Creating Portal pages: Designing the ILM - Reports page

30.Click New Page.

31.Enter ILM - Records for the title.

32.Click OK.

33.You should see the ILM - Records has been created successfully. 
message. Click OK.

34.Click the Edit Page Layout icon (pencil) for the ILM - Records entry.

35.Select One column for the page layout, and click OK in the pop-up dialog 
box.

36.Click Add portlets.
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37.Select the following portlets:

– ILM - Records Admin 
– ILM - Records search portlet

Use the search functionality to search for the ILM portlets. Then, click OK.

38.You should see page similar to the one shown in Figure 11-14. Click Done.

Figure 11-14   Creating Portal pages: Designing the ILM - Records page

39.Click New Page.

40.Enter ILM - Audit for the title.

41.Click OK.

42.You should see the ILM - Audit has been created successfully message. 
Click OK.

43.Click the Edit Page Layout icon (pencil) for the ILM - Audit entry.

44.Select One column for the page layout, and click OK in the pop-up dialog 
box.

45.Click Add portlets.
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46.Select the following portlets:

– ILM - Records Admin
– ILM - Audit Search
– ILM - Audit Result

Use the search functionality to search for the ILM portlets. Then, click OK.

47.You should see page similar to the one shown in Figure 11-15. Click Done.

Figure 11-15   Creating Portal pages: Designing the ILM - Records page

11.5.5  Set up access rights
All the portlets and pages created in the previous sections need to have their 
access rights set. At this point, only an administrator can use these resources. 
We decided that all authenticated users should be able to use all of the pages 
and portlets except the audit log page and portlets. The audit log will be 
accessible only to administrators (that is, sysadmins) and supervisors.
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To set up the access rights, complete the following steps (see Figure 11-16):

1. Click Administration → Portal User Interface → Manage Pages.

2. Select My Portal.

3. Click the Set Page Permission icon (key) for the ILM sample Application 
entry.

Figure 11-16   Setting access rights for portals

4. Click the Edit Role icon (pencil) for the User entry.

5. Click Add.

6. Select all authenticated portal users and click OK.

7. Click Done, click OK, and then click Done again.

8. Select the ILM Sample Application page.

9. Repeat steps 3 through 7 to set the access rights for the ILM - Tasks page.

10.Repeat steps 3 through 7 to set the access rights for the ILM - Records page.

11.Repeat steps 3 through 7 to set the access rights for the ILM - Reports page.

12.We set the different access rights for the ILM - Audit page. Click the Set Page 
Permission icon (key) for the ILM - Audit entry.

13.Click the Edit Role icon (key) for the User entry.

14.Click Add.
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15.Enter recordadmin in the search field and click Search.

16.Select recordadmins and click OK.

17.Click Done, click OK, and then click Done again.

18.Click Administration → Access → Resource Permissions → Portlets.

19.Enter ILM in search field and click Search.

20.Click the Assign Access icon (key) for the ILM - All Documents Portlet entry.

21.Click the Edit Role icon (key) for the User entry.

22.Click Add.

23.Select all authenticated portal users and click OK.

24.Click Done, and then click OK.

25.Repeat steps 20 through 24 to select the same access rights for the following 
portlets:

– ILM - Analyst Report Tasks Portlet 

– ILM - Assign Activity Portlet 

– ILM - Create Assignment Portlet 

– ILM - Document Details Portlet 

– ILM - Owned Activities Portlet 

– ILM - Published Reports Portlet 

– ILM - Records Admin

26.Click the Assign Access icon (key) for the ILM - Audit Result entry.

27.Click the Edit Role icon (key) for the User entry.

28.Click Add.

29.Enter recordadmin in the search field and click Search.

30.Select recordadmins and click OK.

31.Click Done, then click OK.

32.Repeat steps 26 through 31 to select the same access rights for the ILM - 
Audit Search portlet.

Now, you have set up all the pages and portlets and you can explore them with 
the appropriate users.
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11.6  Summary
We have now completed the development, installation, and deployment of our 
sample ILM solution. In the next and final chapter, we provide a short 
walkthrough of the application from the users’ perspective.
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Chapter 12. Solution walkthrough

In this final chapter, we describe the use of the information life-cycle 
management (ILM) application from the users’ perspective. Based on the use 
case for which this sample was built, there are two primary users, the supervisor 
and the analyst.

The complete life cycle was not implemented within our business process and 
supporting modules. Instead, we focused on putting the infrastructure in place 
and providing enough logic in the modules to show what is possible. In our case, 
we have the logic for a supervisor to request a report, an analyst to submit a 
report to satisfy the request, and the supervisor to review and approve or reject 
the report. In a more complete solution, the entire life cycle would need to be 
managed, including the archiving of reports and their eventual destruction when 
policy dictates.

12
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12.1  Supervisor requests a report
Our newly created and installed business process and application for analyst 
reporting is in place. The first step in the process is for a supervisor to request a 
report be generated for a specific topic. The supervisor will use a Web browser to 
access our IBM WebSphere Portal server.

In our environment, the supervisor uses a predefined link to access the following 
URL: 

http://ilm-ui.itsc.austin.ibm.com/wps/myportal

WebSphere Portal server will handle this request and display the login page. Our 
supervisor (supervisor1) will log in, as shown in Figure 12-1.

Figure 12-1   Portal login page
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After supervisor1 has logged in, the page shown in Figure 12-2 opens. This page 
is based on the set up of our portal page, as described in 11.5.4, “Create portal 
pages” on page 330.

Figure 12-2   Initial view of ILM Sample Application page

In the window shown in Figure 12-2, we can see that the ILM Sample Application 
portal is selected. There are also other portals available such as Welcome, 
Content Publishing, and Documents. These are default portlets that were 
installed with WebSphere Portal server. We have not configured or modified 
these, and there is no implementation behind them. However, we left them in 
place so that you can see how different applications would be accessed from the 
same browser window. 
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For our ILM application, the supervisor would now like to create a request for a 
report. By selecting the ILM - Tasks submenu, Figure 12-3 opens, showing the 
CreateTask portlet and a list of outstanding activities. (In this case, there are no 
outstanding activities, because this is a newly installed application and this is our 
first use of it.)

Figure 12-3   Create request report portlet

In this case, the supervisor creates a request for a report on the “Viability of ZXY 
acquisition.”
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By selecting the Create button, the request is created. Figure 12-4 shows the 
confirmation page.

Figure 12-4   Assignment created confirmation

At this point, the supervisor is able to create more requests or to move on to 
other work. We will return to the supervisor after checking in on the analyst and 
seeing the application from her perspective.

12.2  Analyst accepts assignment and creates report
In our use case, the analyst is the individual responsible for generating a report 
to satisfy the supervisor’s request. The analyst will log in to the portal in the same 
way as the supervisor. However, as a member of the analysts group, the 
information seen and actions that are possible will be different.

Figure 12-5 on page 346 shows what the analyst sees when she logs in to the 
portal and selects the ILM - Tasks option.

As you can see, the analyst is presented with a list of outstanding requests 
(unassigned and assigned) that have been submitted by supervisors. In this 
case, the list consists of a single unassigned request. Note also that the analyst 
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does not have the option to create a new request, because this is a supervisor 
only function.

Figure 12-5   Analyst view of ILM - Tasks portlet

The analyst can take ownership of the requested task by clicking the Start 
Working link. At this point, the activity is moved from the unassigned list to the 
assigned list, as shown in Figure 12-6.

Figure 12-6   Activity assigned to analyst
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At this point, the analyst would begin her research and eventually create a report. 
It is important that this report not just be stored on the analyst’s computer. It must 
be entered into the content management system so that it can be managed, 
tracked, audited, and so on. When the analyst is ready to create the report, she 
will navigate to the ILM - Reports section of our application, as shown in 
Figure 12-7.

Figure 12-7   ILM - Reports page

This page is made up of multiple portlets that will enable the analyst to create a 
report and enter it into the content management system and see a list of existing 
reports. At this time, there are no other reports.
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The analyst selects the Create New Report button. The page shown in 
Figure 12-8 opens.

Figure 12-8   Defining the report

Figure 12-8 shows three portlets. The top portlet shows the details of the current 
document (report), including the title body. The second portlet (including the 
Create New Report button) contains a list of reports that are currently in 
progress. The currently selected report in this list is the one whose details are 
shown in the top portlet. The third portlet, shown at the bottom of the window, 
displays a list of the currently published reports. 

For the current report being created, the fields for the title and body are initially 
given default values. The analyst makes the appropriate changes and includes 
the body of the report. In a more robust implementation, the body would likely 
include a separate document created by a word processing application. However, 
in our simple scenario, we create minimal content just to prove the concept. We 
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change the default title of the project and then enter the report body, as shown in 
Figure 12-9.

Figure 12-9   Filling in the report details

In addition to the portlets on this page, other portlets can be built, for example, to 
show all reports that are due to expire or are under legal review.

Now that a report has been created and entered into the content management 
system, the analyst can submit this report as a response to the supervisor’s 
original request.
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To do this, the analyst would navigate back to the ILM - Tasks window and select 
the Complete option, as shown in Figure 12-10.

Figure 12-10   Preparing to complete the task
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The analyst would select the report that should be submitted to meet the 
supervisor’s request. Again, normally, there could be many reports to choose 
from, but in our case, we have only created one. When the analyst clicks the 
Select link, a page showing a confirmation that the task is complete, indicating 
that the report has been submitted to the supervisor for approval, as shown in 
Figure 12-11.

Figure 12-11   Selecting the report to complete the activity

When a report is associated to an assignment, a record is automatically created 
in IBM DB2 Records Manager. The ILM - Records portlet can be used to search 
for and view these entries. We see this capability later in this walkthrough from 
the records administrator view.

After selecting the OK button, the analyst is returned to the ILM tasks window 
where she can select other tasks with which to work. 
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12.3  Supervisor reviews report
Now that the analyst has completed the report and submitted it for approval, the 
supervisor needs to complete this (shortened) business process by reviewing the 
report and approving or rejecting it.

The supervisor opens the ILM - Tasks window. If it was already open before the 
analyst submitted the report, the supervisor might need to refresh the portal. 
Figure 12-12 shows the supervisor’s view.

Figure 12-12   Supervisor selecting activity to start approval process
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The supervisor sees a list of unassigned activities. In our simple example, this list 
consists of reports ready to be reviewed and approved or rejected. The 
supervisor clicks Start Working to select the activity with which to work. By 
selecting this, the activity is now moved to the supervisor’s My Activities list.

Figure 12-13   Prepare to complete the assigned activity

Now that the supervisor has assigned the activity to himself, he can start the 
approval process by clicking Complete.
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The supervisor views the page shown in Figure 12-14 to review the report and 
selects to Reject or Approve the report.

Figure 12-14   Reviewing the report
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Assuming that the report is acceptable, the supervisor selects Approve, as 
shown in Figure 12-14 on page 354, and receives confirmation, as shown in 
Figure 12-15.

Figure 12-15   Activity completed confirmation page
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After this step, the report is then published and appears in the Published Reports 
list, as shown in Figure 12-16.

Figure 12-16   Report appears in the Published Reports list
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Any users with access to the PublishedReports portlet can select the report to 
view, as shown in Figure 12-17.

Figure 12-17   Viewing a published report

We have completed a simplified version of the report creation process. Additional 
portlets can be created, steps added to the process for legal review, and so on.

12.4  Records administrator audits report
An important role in any records management solution is that of the records 
administrator. Let us take a quick look at the portals we created that can be used 
by the records administrator.

The records administrator will log in to the same portal interface as our analysts 
and supervisor. However, the records administrator will have full access to the 
audit functions.
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The first step might be for the administrator to view the ILM - Reports portal, as 
shown in Figure 12-18.

Figure 12-18   ILM - Records portal initial view
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By selecting the Query option in the RecordsSearch portlet, the user is 
presented with a page that can be used to search the Records Manager 
database. In the example shown in Figure 12-19, we simply place an asterisk (*) 
in the record ID field to search all records.

Figure 12-19   Searching for records

 

 

 

 

 Chapter 12. Solution walkthrough 359



This results in the search results being displayed, as shown in Figure 12-20. (The 
results show many more records than were entered in this walkthrough. These 
results are based on many records that we entered during testing.)

Figure 12-20   Search results view

In our case, the record for our ZXY study is displayed at the bottom of our list (out 
of sight in the view in Figure 12-20) and has a record ID of 441. We use this 
information in the next step.

The records administrator would now like to use the ILM - Audit page to access 
the Audit portlet and review the details of a specific record.
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Figure 12-21 shows the ILM - Audit page.

Figure 12-21   Searching for a record to audit
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By entering the record ID (441, in this case) in the appropriate field, the record 
administrator can search for the audit entries associated with this record. 
Figure 12-22 shows the result.

Figure 12-22   Result of audit query

The records administrator can now see the details of the specified report and the 
various actions that have been taken during its creation and approval.

The Document ID in the AuditResult portlet is linked to the RecordsAdmin portlet. 
Therefore, selecting a record in the AuditResult portlet will enable the records 
administrator to view the record and perform all other RecordsAdmin portlet 
available actions.
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This completes the simple walkthrough of our sample ILM application. We leave 
it to you to explore these portlets and processes in more detail in conjunction with 
the source code provided.

12.5  Summary
This final chapter has provided a brief walkthrough of the sample information 
life-cycle management application that is the subject of this book. The application 
logic and implementation is admittedly simple, incomplete, and not designed with 
ease of use in mind. Instead, it is meant to show the basis of how a variety of IBM 
products (WebSphere Portal, DB2 Content Manager, DB2 Records Manager, 
Tivoli Directory Server, process choreographer, and others), along with a minimal 
amount of user-written logic, can form the basis for a records management 
solution controlled through a business process.

Note: If you look at the details of the report shown in Figure 12-22, you will 
notice that the originator user ID for each of the phases of this document’s life 
cycle is CMadmin. This is an unfortunate consequence of our simple 
implementation of our portlets, where the CMadmin ID was passed to the 
records manager instead of the actual user (supervisor1, analyst1). In an 
implementation designed for production use, this implementation would be 
changed to reflect the actual user performing the action in ensure that the 
audit capability is meaningful.
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Part 5 Appendix

This part contains information about the sample code available with this book.

Part 5
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Appendix A. Additional material

This IBM Redbook refers to additional material that can be downloaded from the 
Internet as described in this appendix. 

Locating the Web material
The Web material associated with this redbook is available in softcopy on the 
Internet from the IBM Redbooks Web server. Point your Web browser to:

ftp://www.redbooks.ibm.com/redbooks/SG246481

Alternatively, you can go to the IBM Redbooks Web site at:

ibm.com/redbooks

Select Additional materials and open the directory that corresponds with the 
redbook form number, SG246481.

A
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Using the Web material
The additional Web material that accompanies this redbook includes the 
following file:

File name Description
6481Sample.zip Contains source code, configuration files and modules as 

described within this book.

System requirements for downloading the Web material
The 6481Sample.zip file is intended to be used on a development system 
running IBM WebSphere Studio Application Developer Integration Edition 
running on a Microsoft Windows environment, as described in Chapter 5, 
“Development environment” on page 73. 

How to use the Web material
Create a subdirectory (folder) on your workstation, and unzip the contents of the 
Web material .zip file into this folder.

Assuming that the directory you extract these files to is called 
SG246481-Samples, the directory structure shown in Figure A-1 will be built.

Figure A-1   Directory structure of the .zip file contents

The config directory contains various configuration files used during the set up 
and deployment of the sample application. 

The requiredLibraries directory contains .jar files that are required by our 
application. As documented in this book, these libraries are available elsewhere, 
but we included them here as a convenience.
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The sampleModules directory contains the prebuilt sample application .war 
and .ear files. This might prevent you from having to rebuild these modules 
before deploying the sample (although, based on variations between your 
environment and the one described in this book, it might be necessary to rebuild 
your application anyhow).

The sourceCode directory contains a another .zip file, called ILMworkspace.zip. 
This file, when unzipped to a directory, contains the entire WebSphere Studio 
Application Developer Integration Edition workspace, providing the source code 
and other files required to modify and rebuild the modules that make up the 
sample information life-cycle management (ILM) application described in this 
book.
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Related publications

The publications listed in this section are considered particularly suitable for a 
more detailed discussion of the topics covered in this redbook.

IBM Redbooks
For information about ordering these publications, see “How to get IBM 
Redbooks” on page 372. Note that some of the documents referenced here may 
be available in softcopy only. 

� IBM WebSphere Portal V5: A Guide for Portlet Application Development, 
SG24-6076

� IBM WebSphere Portal for Multiplatforms V5 Handbook, SG24-6098

� Document Management Using WebSphere Portal V5.0.2 and DB2 Content 
Manager V8.2, SG24-6349

� A Secure Portal Using WebSphere Portal V5 and Tivoli Access Manager 
V4.1, SG24-6077

� IBM WebSphere V5.0 Security: WebSphere Handbook Series, SG24-6573

Other publications
� IBM DB2 Content Manager for Multiplatforms: System Administration Guide 

Version 8 Release 2, SC27-1335-04

� IBM Content Manager for Multiplatforms: Planning and Installing Your 
Content Management System Version 8 Release 2, GC27-1332-02

� IBM DB2 Content Manager for Multiplatforms/IBM Information Integrator for 
Content: Installing, Configuring, and Managing the eClient, SC27-1350

Online resources
These Web sites and URLs are also relevant as further information sources:

� IBM DB2 Content Manager for Multiplatforms library

http://www.ibm.com/software/data/cm/cmgr/mp/library.html
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� IBM DB2 Records Manager home page

http://www.ibm.com/software/data/cm/cmgr/rm/

� IBM DB2 UDB for UNIX and Microsoft Windows library

http://www.ibm.com/software/data/db2/udb/support/manualsv8.html

� IBM DB2 UDB Support

http://www.ibm.com/software/data/db2/udb/support/

� IBM Support and Downloads

http://www.ibm.com/support

� IBM Technical Support

http://techsupport.services.ibm.com

� IBM WebSphere Application Server Support site

http://www.ibm.com/software/webservers/appserv/was/support/

� IBM WebSphere Portal Extend for Multiplatforms V5.0.2 Information Center

http://www.ibm.com/websphere/portal/library

� IBM WebSphere Technical Library

http://www.ibm.com/software/websphere/technical/

� Microsoft SOAP Toolkit (search for SOAP)

http://www.microsoft.com/downloads

How to get IBM Redbooks
You can search for, view, or download Redbooks, Redpapers, Hints and Tips, 
draft publications and Additional materials, as well as order hardcopy Redbooks 
or CD-ROMs, at this Web site: 

ibm.com/redbooks

Help from IBM
IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services
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